
 

 

 

VERSION 2025.06.1.0 RELEASED ON JUNE 24, 2025 

 
Spotlight: Accounting Updates 

We are excited to announce a powerful set of Accounting Updates for users subscribed 

to CORE Accounting, designed to improve how accountants and billing managers track, 

reconcile, and report financial activity. These updates bring more accuracy, transparency, 

and structure to your financial workflows, helping you stay compliant with US GAAP 

standards by making it easier to manage monthly financials, automate revenue handling, 

and maintain a clear, auditable record of every transaction. Check out our recent 

announcement for more details, including links to trainings and explainer videos . 

The update includes: 

• Accounting Periods – Define fiscal years and then open and close books monthly 

to control when transactions post and ensure cleaner financials. 

• Automated Revenue Recognition – Recognize revenue based on time and 

expense activity using two methods: Billed (revenue recognized when invoiced) or 

Billed + WIP (revenue recognized as work-in-progress before invoicing with 

reversal of those journal entries after invoicing to reflect actual billed revenue). 

• Enhanced Transaction Audit Trail – Expansion of the existing feature (previously 

known as Record History) to help you track changes across all key financial 

records like vendor bills, journal entries, and payments for better verification, error 

detection, and audit tracking. 

Note: Accounting Periods and Revenue Recognition are turned off by default and can 

be enabled from Settings when you are ready to use them.  

Additionally, the update includes several supporting enhancements that improve the 

usability of the new accounting features including: Accounting dates on all transactions, 

enhanced reporting filters, revamped date filtering on screens linked to financials, new 

project rules and accounting notifications, and improved cost handling for time entries. 

 

https://corehelpcenter.bqe.com/hc/en-us/community/posts/32538001637655-Accounting-Updates-Coming-Soon
https://corehelpcenter.bqe.com/hc/en-us/community/posts/32538001637655-Accounting-Updates-Coming-Soon


Key Features 

CORE Mobile – Report Center Enhancements 

The Report Center in CORE Mobile (iOS and Android apps) now supports the same 

powerful configuration options as the CORE web app, giving you greater control and 

flexibility on the go. These updates make it easier to view and customize reports directly 

from your mobile device, without needing to switch to the web app. 

• New Templates tab to quickly access all updated report templates 

• Run templates with adjustable filters without saving the configuration – perfect 

for quick, one-time use 

• Template Info View to understand a report’s purpose before running it 

• Flexible Saved Reports that let you modify filters before running, without 

overwriting the original. 

• Column Chooser now supported for compatible reports 

Project Planner – Edit Resource Allocations & Other Improvements 

The Project Planner gets several upgrades to improve usability, visibility, and efficiency –

led by the highly requested ability to edit resource allocations directly. 

• Edit Resource Allocation: You can now click any activity row in the top section to 

update the assigned resource and adjust allocated hours directly within Project 

Planner. This streamlined option brings focus to individual edits and reduces 

reliance on the Resource Allocation tab. 

• Improved Filtering: We have refactored Advanced Filters for better performance 

and smoother project selection. Key improvements include a configurable page 

size limit (up to 1000 projects), removal of infinite scroll, clearer messaging when 

results exceed the page limit, and enhanced Select All and search functionality for 

faster, more efficient selection. 

Report Enhancements 

We have updated several reports for improved clarity, accuracy, and consistency: 

• The Employee Time Detail report now includes a Show Amount As option to toggle 

between Entry Amount (Actual Hours) and Bill Amount (Client Hours). 

• The Billable Work History and WIP with AR reports have been updated to reflect 

standardized KPI terminology and calculations, including the correct inclusion of 

purchase tax under expenses and consistent labeling. 

 



Dashboards – Interactive Legend in Income and Expense Widgets 

We have enhanced these widgets by adding a color-coded legend on the right side, 

matching the theme colors and descending order of the bars. Each legend item 

corresponds to an account, making it easier to identify and interpret key values. You can 

also hover over a legend item to highlight its respective bar while dimming others, 

allowing for quicker, more focused analysis.  

Fixes & Improvements 

This update includes numerous fixes and minor enhancements, many of which are based 

on customer feedback. Key changes are listed below and organized by module: 

• Accounting 

o You can now edit start and end dates for financial budgets created with 

custom date ranges. 

o General Journal entries with multiple lines were incorrectly grouped by 

account, ignoring differences in linked records. This resulted in the Payer 

column in the drill-down of the Profit and Loss (Cash Basis) report not 

accurately showing the linked records. This is fixed now. 

• Allocation & Forecasting 

o Data was not loading correctly in Forecasting – Manual View in specific 

scenarios. This is fixed. 

• Billing 

o When previewing invoices using the Actions > Email > Client Contact 

option, incorrect email recipients were populated not matching the 

recipients when emailed without preview in a specific scenario. This is fixed. 

o Incorrect refunded retainer amount was displayed on the Retainers screen 

in a specific scenario. This is fixed. 

o Saving a bulk payment highlighted only one invoice instead of all selected 

invoices. This is fixed. 

o Active filter was not working as expected on the Recurring Invoices screen. 

This is fixed. 

• CORE Mobile 

o We have revamped action menus across key CORE iOS screens with 

grouped actions and a consistent layout for improved usability and cleaner 

user experience. 

o Client hours were not populating correctly when entering time via Time 

Card. This is fixed. 

• CRM 

o We have added a new Project column and filter to the Opportunities screen 

for easier tracking of opportunities that have projects associated with them. 



It is particularly beneficial for sales and project management teams that 

align opportunities with ongoing or past projects. 

• Dashboards 

o The Resource Allocation & Schedule Details widget was not loading data 

properly. This is fixed. 

o Clicking Today in the filter calendar did not apply the date in any of the 

dashboard widgets. This is fixed. 

o The Retainer Balances widget incorrectly doubled the retainer amount after 

changing a project’s client and selecting No on the subsequent prompt. This 

is fixed now, and the widget accurately displays the correct received and 

remaining balances, and retainer refunds via credit memos reflect the 

proper amount. 

• Integrations 

o Excessive API calls were being generated due to a duplicate custom field 

mapping in QuickBooks Desktop Utility. This is fixed along with an 

improvement to assist future error tracking. 

o We have added a new voidDate property to the Invoice object in CORE 

Public APIs to capture the date an invoice was voided, enhancing support 

for voided invoice tracking. 

o To support the Accounting Updates, we have added the accountingDate 

property to all financial models and the useAccountingPeriods property in 

the Company model in CORE Public APIs. 

o The PATCH method is now supported for workflow nested in the Time Entry 

object in CORE Public APIs. This is part of our larger effort to add PATCH 

support for all nested objects. 

o Files with identical names were not attaching to different records when 

using the Dropbox cloud storage. This is fixed. 

o Duplicate payment, vendor bill, credit card, and time entry records were 

transferred into CORE from QuickBooks Desktop in a specific scenario. This 

is fixed. 

o Sending multiple payments through the QuickBooks Desktop Utility would 

fail if one of them was a Use Retainer payment on a draft invoice. This is 

fixed. 

o Errors seen when syncing vendor bills and credit card charges to CORE using 

the QuickBooks Desktop Utility in specific scenarios. This is fixed. 

• Project Planner 

o Resource Group column was previously non-functional in the bottom 

section. It is fixed now and displays the group associated with each 

allocation at the activity level. Additionally, we have removed the non-

functional Status and Flag columns for a streamlined experience. 



o Gantt chart info bars in the top section now reflect the same project status 

icons used in the main Projects screen, ensuring a unified and recognizable 

interface. 

o End dates were not displaying on Project Planner, despite being correctly 

entered and visible on the Projects screen. This is fixed. 

o Selected projects within Project Planner’s project tree were not consistently 

retained. This is fixed. 

o On clearing the project selection and trying to select projects again, the 

Apply Filter button would be disabled. This is fixed. 

o Time entries made against the All Activities allocation were treated as 

Unplanned Time Entries. This is fixed. 

• Projects 

o We have added a new Not In filter for Project Groups to the Projects list 

view, allowing users to exclude specific groups for more refined filtering. 

o On updating a project hierarchy, the success message showed an incorrect 

record count. This is fixed. 

o On the Budget tab for phased projects, the Contract Amount column was 

not visible if the Include Phases option was unchecked. This is fixed. 

o KPI values were not getting updated using the Refresh button under 

different scenarios. This is fixed. 

o Users were unable to associate phases and sub-phases with a parent phase 

or project belonging to a different client. This is fixed. 

o On sorting any column in Projects > Transaction tab, the Total values would 

disappear. This is fixed. 

o The outdated label Charge Amount appears when exporting a budget or 

budget template to CSV format. This is fixed. 

o Project KPIs reflected data from the first invoice only when it was part of a 

joint invoice. This is fixed. 

o Batch updating custom fields by selecting all projects would fail. This is fixed. 

o The complete contact address was not populating on the Projects > 

Assignment tab. This is fixed. 

• Reports 

o Selecting a newly created account in the Registers screen and then running 

the Account Register (Splits) on-screen report resulted in an error. This is 

fixed. 

o The General Ledger and General Ledger Extended reports showed incorrect 

accounts payable balance when a vendor bill was fully paid using discount. 

This is fixed. 

o The Allocated vs. Earned Revenue with Forecast report previously 

miscalculated the Allocated Amount when a fee schedule assigned to a 



project included an activity group, and an activity from that group was used 

in the allocation. This is fixed. 

o The Top N Clients report showed fewer results than specified. This is fixed. 

o The Account filter was not getting applied on some on-screen reports in the 

Registers screen. This is fixed. 

o Retainer Register on-screen report did not match the Registers screen data 

in a specific scenario. This is fixed. 

• Search 

o Search in multiple screens returned the full list instead of the filtered results. 

This is fixed. 

• Time & Expense Reviewer 

o We have added a sortable Resource Manager column to improve visibility 

and streamline follow-ups on unapproved time. 

• User Interface 

o We added a new Text Alignment option in the Message on Invoice section in 

Settings > Billing & Invoices > Invoice Templates > Template Detail . This fixes 

the inconsistent alignment of indented text in invoice previews. 

o Project drop-down in Time Entries and Expense Entries screen as well as 

some tooltips on the Projects > Overview tab had UI issues. These are fixed. 

 

  



 

 

 

 

 

VERSION 2025.05.2.0 RELEASED ON MAY 21, 2025 
 

Spotlight: Refined project manager permissions 

We’ve refined the Time Entries and Expense Entries permissions for project managers to 

give you more clear and predictable control over employee visibility. This change was 

made based on feedback to our Support Team and CORE-Ideas@bqe.com.  

The change was made to project manager access and permission name. The permissions 

now work as follows, from least to most permissive. 

• Standard employee: disable all three permissions (Allow access to entries of 

Projects I Manage, Allow access to Employees I Manage, and Allow access to entries 

of all Employees). The user will only see their own entries on screen and in reports. 

• Employee manager: enable Allow access to Employees I Manage. The user will see 

the entries of employees that the user manages. 

• Project manager: enable Allow access to entries of Projects I Manage. The user will 

see all entries on their projects, regardless of the employee or employee manager 

on the entry. The project manager will also see all employees in the filters on pages 

and report configuration.  

• View all entries: enable Allow access to entries of all Employee. Applies regardless 

of whether Allow access to Employees I Manage or Allow access to entries of Projects 

I Manage are enabled. 

 

For existing security profiles with Allow access only to entries of Projects I Manage enabled, 

Allow access to entries of all Employees has been turned off with this release to preserve 

intended access levels.  

 

As a reminder, security permissions are defined for Expense Entry separately from Time 

Entry. Reports and screens which show both time and expense entries will continue to 

display entries based on the respective security permissions. 

 

 

 

mailto:CORE-ideas@bqe.com


Product Enhancements 

Project Overview: project progress monitoring and locked entry visibility 

The General Information section now displays the project’s % Complete value. A visual 

flag appears when the Budget % Spent exceeds the % Complete, helping you quickly spot 

and address potential delays in project progress. 

 

Locked time and expense entries are now treated as approved and included in the 

Unbilled Time and Unbilled Expenses widgets, as well as in all reports that reference 

approved entries. Entries become locked when they are included on a draft invoice or in 

an invoice batch.  

 

Project Status dashboard widget: visual alerts for contract overruns 

The Project Status widget now displays a red icon when either Billed or Spent exceed the 

Contract Amount, helping you quickly identify and address contract overruns. Hovering 

over the icon shows a tooltip with specific details, such as:  

• Billed exceeds contract by $X 

• Spent exceeds contract by $X 

 

Project Structure: Improved column management  

The Column Chooser now groups available columns under headers that match the screen, 

making it easier to quickly find the column you’re looking for. 

 

Project Filters: Custom Fields added to split filter categories 

The split filter on the Projects list now includes a Custom Fields category, allowing you to 

quickly search and filter projects by your custom field values. Date and Dropdown fields 

are not supported in this search. This was a customer request submitted to CORE-

ideas@bqe.com. 

 

Resource Allocation: enhanced Copy from Budget option 

The Copy from Budget option in Resource Allocation now offers more control when 

working with parent projects and their child phases. You are prompted to choose whether 

to copy the budget from the selected parent project only, or both the parent project and 

its child phases.  

 

 

 

 

mailto:CORE-ideas@bqe.com
mailto:CORE-ideas@bqe.com


Time Entries & Expense Entries: hide Client in Project drop-down 

To improve readability of long project names, we have added a new Show Client toggle 

in the Project drop-down. This toggle is enabled by default and its state is saved per user, 

providing a consistent and customizable experience. 

 

New columns in Time & Expense Reviewer 

Three new columns – Created On, Last Updated By, and Last Updated – are now available 

as optional fields on the Time & Expense Reviewer screen. These additions provide greater 

visibility into when records were created and who last updated them, helping you review 

entries with more context and accountability. 

 

New date filters in Opportunities report 

The Opportunities report now includes additional date filtering options. You can filter data 

based on the Created On date, Target Date, and/or the Closed On date, making it easier 

to analyze opportunities over specific time periods. 

 

Cloud Feeds enhancements: custom labels and improved usability 

You can now define a custom label for Cloud Feeds in the Company module, allowing you 

to align the terminology with your organization’s naming conventions or preferences. The 

label can be updated at any time. Additionally, the Description field in incoming feeds now 

wraps text within the visible area, eliminating the need for horizontal scrolling. Key actions 

like Add New and Find Match remain visible, improving readability and overall usability. 

 

KPI updates and usability improvements across multiple reports 

Several reports have been updated to align with our standardized KPI terminology and 

calculations – for example, the Spent column now accurately accounts for purchase tax 

and $0 cost rates on expense entries. In addition to these KPI updates, filters, labels, and 

configuration options have also been improved to enhance clarity and reporting flexibility. 

Below is a list of reports that were updated along with the usability improvements where 

applicable. 

• Time and Expenses by Parent Project report 

o New display option to show root project contract amount as entered or 

summed from phases 

o New display option to show amounts as Entry Amount (Actual Hours) or Bill 

Amount (Client Hours) 

• Budget Comparison by Phase and Budget Comparison reports 

o New display option to include or exclude extras 



• Monthly Billing Statement report 

o Relabeled Net Billed to Net Billed with Tax 

• Percentage Billed report 

o Relabeled Gross Billed Contract to Billed Contract and Contract Balance to 

Contract Billed Remaining 

• Project Contract Status report 

• Write Up Write Down report 

 

Application Stability 

This update fixes many issues reported by our customers. Key fixes are listed below and 

are organized by module:  

 

• Accounting 

o An issue causing a starting balance discrepancy in Reconciliations has 

been resolved. 

o An issue with clicking ‘Find Match’ in a cloud feed sometimes giving an 

error has been fixed. 

• Billing 

o Issue when converting Final invoices to Draft invoices not triggering the 

Last Updated field to be updated has been fixed. 

• HR 

o An issue where benefits were overriding one another with regards to 

earned hours calculations has been fixed. 

• Integrations 

o An issue with PUT calls causing Accounts Payable options to disappear has 

been resolved. 

o Not being able to select certain clients as a prospect when creating an 

opportunity through the API has been fixed. 

o An issue causing webhooks not to trigger for time entries when updated 

through a draft invoice has been fixed. 

o CORE Public APIs now support the PATCH method support for 

assignedGroups in the Opportunity, Prospect, and Lead modules. This 

allows you to make targeted updates without needing to send the full 

payload, offering a more efficient and flexible alternative to using PUT. 

• Mobile 

o An issue with accessing the PRO and Comp Hours widget on the 

dashboard has been fixed. 

o An issue where iCloud Keychain autofill was not working with the mobile 

app has been fixed. 



• Projects 

o An issue causing phased projects to disappear after unlinking them from a 

parent has been fixed. 

o An issue where projects could not be merged if the project’s code was 

showing in the name has been fixed. 

o Batch update not working properly after applying quick filters on the 

Projects screen has been fixed. 

o Inability to filter by a Resource Group has been fixed. 

o An issue where selecting a child project and updating a resource schedule 

in Project Planner would throw an exception has been fixed. 

o An issue where opening and closing the calendar without making any 

changes would cause an update to the data has been fixed. 

o An issue in Allocations where copying from Budget would incorrectly set 

the End Date has been fixed. 

o Resource Filter in Project Planner not returning correct values for 

employee groups after the employee has been removed from a group has 

been fixed. 

o An issue where a null reference exception is thrown when creating an 

allocation from a budget has been fixed. 

o Budgeted hours showing as N/A at the activity level even when in sync 

with budgets has been fixed. 

o An issue where ‘Copy from Budget’ would trigger the action without a 

project being selected in Resource Allocation has been fixed. 

o On the Resource Allocation screen, required fields (e.g., Project, Resource 

Group, Item) are now enforced. Further, checking the box and not 

providing a value will clear fields like Resource, End Date, Memo with 

Overwrite. 

o Project Planner was not showing a validation when no projects were 

selected for search. This is fixed. 

o Project Planner would display the wrong value for Used Hours in a certain 

scenario. This is fixed. 

• Reports 

o A report discrepancy issue between the Scheduled Project Allocation 

report and the Time Entries screen has been fixed. 

o A security settings issue related to project managers’ access to time entry 

reports for employees they manage has been fixed. 

o An issue with drill through actions on the Sales Forecast Distributive report 

has been fixed. 

• Miscellaneous 



o An issue with global search functionality with custom fields has been 

resolved. 

o A minor UI improvement to the left menu closing too easily making 

navigation challenging has been improved. 

 

 

VERSION 2025.05.1.0 RELEASED ON MAY 13, 2025 
 

Spotlight: New project planning setting 

A new Planning section is now available under Settings > Projects, which allows you to 

control how users in your firm interact with project planning screens. These settings allow 

you to ensure your employees are using the project planning tools consistently as they 

determine how you allocate resources, plan those resources, and forecast activities and 

revenue.  

 

Settings include: 

• Controlling which pages are available to your firm – you can choose to hide 

Resource Allocation – Gantt Chart, Forecasting – Distributive, Smart, or Manual 

Views, or the Project Planner. 

• Setting the Planning Scale for monthly or weekly planning. This setting affects how 

values can be viewed or edited across the Forecasting and Project Planner screens. 

 

Product Enhancements  

New columns on Project Structure 

As requested by submission to CORE-ideas@bqe.com, we have added the ability to view 

and edit project status directly from the Projects > Structure tab. For parent projects, you 

will be prompted to apply any changes to the child projects. Also, we have added a 

Contract Billed Remaining column (calculated as Contract Amount – Contract Billed). This 

column is not visible by default but can be displayed from the column chooser. 

 

Improved Contract widget in Project Overview  

The Billed + Unbilled chart in the Contract widget on Project Overview has been updated 

to reflect the billable values on a month-by-month basis. This allows you to track the value 

of billable entries over time and compare them to the Billed values. Billable values are 

now used in the Project Snapshot > Progress widget and Client Performance > Progress 

widget. 

 

mailto:CORE-ideas@bqe.com


Project Planner – improved filtering & export 

We have added new advanced filter options for Client, Manager, Principal, and Project 

Status to the Project Planner. These filters give you better control of the data that returns 

to the page. 

 

You can now export the top section of the Project Planner, including the Gantt chart to 

PDF. This allows you to quickly take the visual offline to share it with consultants or clients. 

The options to export to CSV and Excel remain.   

 

Improved Forecasting against Contract Billed Remaining 

You now have another forecasting option in CORE, allowing you to compare what you've 

forecast into the future. Previously, the functionality centered around forecasting against 

the contract amount only, but we have added new columns to help forecast the balance 

left to bill against your contract. These 3 new columns are configurable via the More menu 

> Show/Hide Columns: 

• Contract Billed  

• Contract Billed Remaining (Contract Amount - Contract Billed) 

• Sched in View + Future (Sum of Scheduled in View + Future Periods) 

 

More efficient copying from Budget to Allocations 

You can now save time copying budget items into allocations for the parent project and 

all its phases with a single click. To support this enhanced behavior of copying budgets 

from both parent and child projects at once, you will be prompted to confirm copying all 

the budget items from both into their allocations. 

 

Project Contact Management 

We are excited to announce a significant update to project contact management with the 

improved Add Contact and Contacts List screens available from Projects > Settings > 

Assignments. With the addition of extra columns (such as ID, Contact Of, Primary, etc.) 

and options (such as adding contacts to parent and child projects), this enhancement 

focuses on improving usability, ensuring consistency, and increasing data visibility for a 

better user experience. 

 

Improvements to Time & Expense Reviewer 

We have introduced the split filter to improve the performance of the T&E Reviewer 

screen. The Filter Search can be based on: Project, Employee, Invoice Number, or Item 

details. 



 

New PTO Setting in CORE HR 

You now have a new PTO setting for HR Benefits that allows you to choose whether 

employees continue to accrue vacation and sick time while they’re out on PTO. When 

enabled, it ensures that Time Card Hours-based accruals include vacation and sick time 

entries, just like regular worked hours. This setting is available under Settings > Time & 

Expenses > Personal Time Off. 

 

Report updates to align with KPI standards 

The following reports have been updated to align with the project KPIs and new 

terminology: 

• Actual and Billing Hours Comparison Report: Key changes include relabeling fields 

and adding a new display option to include or exclude non-billable entries from 

the Bill Amount. 

• Allocation Reports Start Date & End Date Filter: The Allocation Weekly Manual View 

report is now consistent with the new Project Planner screen. The report returns all 

allocations which overlap the filter window, including those that span partly or 

whose start dates or end dates fall in the filter window. 

• Employee Expenses Report: Key changes include relabeling fields; adding a Cost 

column; and improved handling of Purchase Tax and $0 cost rates for greater 

accuracy. Reimbursable Amount and Reimbursable Due now reflect reimbursable 

expenses only. 

• Employee Profitability Report: Key changes include relabeling fields: ‘Billable 

Amount’ to ‘Gross Billed and Unbilled’, ‘Profit/Loss’ to ‘Profit (Billed and Unbilled)’, 

and ‘Cost’ to ‘All Cost’. Purchase Tax is also included in key columns. 

• Employee Time Detail Report: Key changes include relabeling field ‘Hours’ to 

‘Actual Hours’; adding new columns such as Gross Billed and Billable WIP; and 

improved handling of Purchase Tax for more accurate reporting. 

• WIP Reconciliation Report: Key changes include adding a new Date row above 

report columns; relabeling fields such as Opening Billable WIP, Period Billable WIP, 

Period Invoiced Billable WIP, Write-Up/Down on Inv. Billable WIP, and Closing 

Billable WIP; improved handling of Purchase Tax and $0 cost rates for greater 

accuracy; and adding a new option to display the Root Project Contract Amount 

for greater clarity. The report includes Write-Up/Down (WUD) but excludes tax 

across all columns.  

• Work in Progress Details Report: Key changes include relabeling ‘Unbilled’, ‘Billable 

Amt’, ‘Cost Amt’, ‘Owed’, ‘Ret Paid’, and ‘Ret Avail’; and improved handling of 

Purchase Tax and $0 cost rates for greater accuracy. 



 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Accounting 

o A Grand Total field has been added to the Registers screen, displaying the 

cumulative total of all transactions for an account, in addition to the total 

for the specific period. 

o An issue where the General Journal screen would refresh unexpectedly 

while searching has been fixed. 

o An issue related to custom fields in credit memos has been fixed. 

• Billing 

o The invoice number dropdown showing “No Record” in the invoice screen 

when utilizing batch update to make changes has been resolved. 

o Manual invoices created from a billing schedule resulting in an empty 

invoice have been fixed. 

o An issue where the net bill calculator was not working correctly in the 

invoice batch screen has been resolved. 

o Emailing ePayments not working in certain scenarios has been fixed. 

o An issue with batch update not working properly on fee schedules when 

updating the Bill Rate Multiplier field has been fixed. 

o Copying and pasting logos from one email to another not including the 

pasted logo in the sent email in certain scenarios has been fixed. 

o An issue with which invoices are included in CSV exports from the Invoices 

page has been fixed. 

o Multiple spacing issues related to statements have been fixed. 

o An issue where the row actions were not changing the Last Updated field 

of an invoice has been fixed. 

o Screen freezing after clicking “View Memo” of an invoice has been fixed. 

• Dashboards 

o The Income and Expense widgets on the Dashboard now display data 

using a vertical bar chart to show positive and negative values more 

clearly. 

• HR 

o An issue related to the search options in the Employee screen has been 

fixed. 

• Integrations 



o The PATCH function can now be used for certain nested properties via the 

Public API (PAPI), including Assigned Groups for Client, Project, Employee, 

and Vendor objects. This allows for more flexibility, simplifies updates, and 

eliminates the need to use PUT when you are updating existing data. 

o Draft invoices accessed via the PAPI now return the unique invoice number 

in the response body instead of custom invoice number, preventing 

confusion when referencing them. 

o An issue related the updating main project properties through PATCH 

because it has multiple addresses has been fixed. 

o Webhooks dropping in certain scenarios where concurrent users are 

involved has been fixed. 

o An issue where AssignedGroup would be added on using the “Replace” 

operation has been fixed. 

o Webhooks dropping when updating some values related to time entries 

has been fixed. 

o An issue related to adding multiple addresses for a project through the 

PAPI has been fixed. 

o An issue where updating custom fields through batch updates would not 

trigger webhooks has been fixed. 

• Mobile 

o An issue where an outdated version of menus would be displayed when 

using a specific gesture has been fixed. 

o Multiple tweaks to the Home screen in the mobile application have been 

added. 

• Projects 

o “Done” not showing in the notes section of the Projects screen after 

editing 25 entries has been fixed. 

o An issue with the Notes page filter has been fixed. 

o Overdue invoices KPI not including payments that were written off has 

been fixed. 

o Incorrect data being displayed for Approved or Unbilled metrics on the 

Project screen has been fixed. 

o Timeline sorting not following phase order of the project has been fixed. 

o An issue where copying from budgets does not apply the correct week ID 

related to the default resource schedule has been fixed. 

o Security permissions related to the Contract Amount column have been 

added for the Forecasting page. 

o Transferred retainers not deducting from the source project in the 

Structure tab of a project has been fixed. 



o An issue where the Budgeted Hours field would always show zero in 

Project Planner has been fixed. 

o Multiple issues related to filters in Project Planner have been fixed. 

o An issue where changing an invoice from Final to Draft did not properly 

update KPIs has been fixed. 

o An issue where the Address field was not properly retaining a set value 

after saving in the Project screen has been fixed. 

o An issue with deleting project assignments has been fixed. 

o An issue related to the Client Performance screen showing incorrect data 

for the Billable KPI has been fixed. 

o An issue where a discount entered under a manual invoice would deduct 

the amount twice has been fixed. 

• Reports 

o Insufficient funds (NSF) payments not showing on the Payment Details 

report has been fixed. 

o An issue related to launching reports from the row actions in the 

Reconciliation screen causing Edge browser to crash has been fixed. 

o Incorrect calculation of the Billed Cost in the Cost Analysis report has been 

fixed. 

o An issue related to the display of child phases in some reports has been 

fixed. 

o Multiple issues related to the Project List report have been resolved. 

• Time & Expense 

o Clicking an attachment causing a UI glitch where the display shifts to the 

left in certain scenarios has been fixed. 

o An issue related to time card locking when the start of the week and the 

last day of the locking period are the same has been fixed. 

o A few UI glitches related to scrolling behavior on Time Entries and Expense 

Entries pages have been fixed. 

o An issue related to “Remove from my recent Activities” causing a UI glitch 

in the Time Card screen has been fixed. 

o Clicking the icon to stop a timer not opening the “Edit Time Entry” dialog 

and the screen becoming unresponsive has been fixed. 

o An issue occurring in limited scenarios where time entries would be 

incorrectly marked non-billable has been fixed. 

 

 

 

VERSION 2025.04.2.0 RELEASED ON APRIL 24, 2025 



 

Spotlight: Project Planner – now available for all customers! 

The Project Planner has been enabled for all customers! Find out more about the changes 

we announced in February. 

 

We’ve also made the following improvements to the Planner, Resource Allocation, and 

Forecasting: 

• Filtering on the Project Planner is now more robust with options to filter your project list 

by Activity, Project Group, Resource, or Resource Group. We also addressed some bugs 

with filtering. We will be adding more advanced filter options in the coming months. 

• We removed clicks in the Copy/Paste Special process on the Resource Allocation tab. Use 

the new Duplicate option from the Actions menu to launch the process in a click! 

• The Task Allocation widget now has a new option to toggle to view Resource 

Schedule (Forecasting) values. Previously, only Resource Allocation values were 

available. With that, the widget has been renamed to "Resource Allocation & 

Schedule Details". The terminology and the working of the widget now aligns with 

that of the Project Planner, Resource Allocation, and Forecasting screens. 

 

Product Enhancements  

Project Overview – see Billable items only in Unbilled Time and Unbilled Expense widgets 

You can now set whether the Unbilled Time and Unbilled Expense widgets at the top of 

the Project Overview include non-billable time or not. Set your preference using the … 

menu.  

 

This setting will apply to the reports and filtered view of pages launched from these 

widgets. 

 

Further Collections improvements 

The Invoice Collections screen now has separate columns for "Last Collection Note" and 

"Last Collections Note Date". The latter is sortable. These columns allow you to quickly 

see invoices with collections updates and the note associated. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Accounting 

https://corehelpcenter.bqe.com/hc/en-us/community/posts/29786408248855-New-Project-Planner-Coming-Soon
https://corehelpcenter.bqe.com/hc/en-us/community/posts/29786408248855-New-Project-Planner-Coming-Soon


o An issue where the Chart of Accounts Save & Add Another was not 

working has been resolved. 

o Linked Records not being updated when importing a journal entry from 

CSV has been resolved. 

o In Cloud Feeds, clicking “Included in CORE” will open the full transaction 

details in a new browser tab, letting you see more information without 

losing your place.  

• Billing 

o An issue where exporting an invoice to LEDES would not sort the line items 

by date has been resolved. 

• HR 

o Rollover hours not populating in the PTO screen has been fixed. 

• Integrations 

o An issue with MYOB AccountRight integration related to invoices has been 

resolved. 

o An issue where mapping and unmapping invoices from the integration 

tool was taking too long to load has been fixed. 

o An issue with the Public API not working correctly in combination with the 

isVoid filter when looking at invoice fields has been resolved. 

o The CORE Outlook Add-In will stay open even when you switch between 

different emails if the add-in is pinned. Previously, the Add-In would 

disappear every time you selected another message. 

o In the Public API, you can now filter Fee Schedules by their status—Active 

or Inactive, giving you more control over which schedules are returned. 

• Mobile 

o The Report Center in iOS has been upgraded with enhanced interactions 

with saved reports, improved report grouping, and fixes to filter chip 

behavior. 

• Project 

o An issue where the cost rate in the services and expenses within a budget 

would only be brought in when a resource is selected using a mouse has 

been resolved. 

o Issues exporting budgets to CSV have been resolved. 

o Cloning a phase or adding a parent to a phase with a different client not 

inheriting the client from the parent project has been fixed. 

o Multiple issues related to saving changes on custom fields on a project 

have been resolved. 

o Rate lookup not honoring the “Rates by Classification” project rule in 

Forecasting has been fixed. 



o Incorrect AR balances being shown in the Project List, Structure tab, and 

Project Status widget have been fixed. 

o Expanding a root project will now expand all tiers of the hierarchy, saving 

you clicks when viewing your projects. The last expanded root will remain 

expanded when you next visit the page. 

o The Budget tab was incorrectly categorizing unapproved entries as 

Unbudgeted Items. These entries will now be included in Spent. 

o We’ve tightened security on projects where different phases have different 

project managers for users with the "Allow access to other managers' 

data" security bit disabled. Now, certain fields and values will be hidden on 

the Project Overview and Snapshot, protecting sensitive information. 

o In Project Planner, editing the hours in the bottom section and hitting tab 

would not move to the next cell. This is fixed. 

o Information and totals being missing in the Forecasting screen have been 

fixed. 

o Units Spent not showing correctly in the Units Spent Distributive Forecast 

has been fixed. 

o Being unable to delete projects which have an allocation associated with it 

has been fixed. 

o An issue where creating monthly allocations consecutively would span the 

whole allocation in the first month has been resolved. 

o Forecasting not creating rows with the same Resource Group & Resource 

combination has been fixed. 

o An issue where a credit payment amount would get reflected in the Open 

AR field has been fixed. 

o Monthly View edits in Project Planner not aligning with Forecasting has 

been resolved. 

o Horizontal scroll being missing when expanding the bottom section of 

Project Planner has been fixed. 

• Reports 

o The Reconciliation Summary report could show a duplicate summary 

section which was unnecessary. This is fixed. 

o The Account Reconciliation report now displays a refined 

Finance/Interest/Service Charges section in the Cleared and Uncleared 

Transactions sections along with the Summary section of the report. 

o The Time and Expenses report, Time and Expenses Summarized report, 

and Time and Expenses Detailed report now include Purchase Tax amounts 

correctly in the calculations for Entry Amount, Bill Amount, and Cost 

Amount. We also resolved an issue where Entry Amounts and Bill Amounts 

may have been displayed as $0 when the Cost Rate was set to $0. 



o The Time Details report now includes a display option to switch between 

Entry and Bill Amount. Entry Amount = Actual Hours × Bill Rate, while Bill 

Amount = Client Hours × Bill Rate × WUD%. Proper labels have been 

added to distinguish between Actual Hours and Client Hours for better 

clarity in reporting and calculations. 

o The Transaction Detail report and Trial Balance Accrual report (drill 

through) were displaying discrepancies if zero-dollar cost rates were used. 

This is fixed. 

• Time & Expense 

o An issue with reimbursable expenses on the Bill Payment screen in some 

scenarios has been fixed. 

o An issue where allocated hours summary was not populating on the time 

entry screen has been fixed. 

o Not being able to update expense entries as Paid from T&E Reviewer 

using batch update has been fixed. 

o An issue where clicking the Save button on the Time Entry screen would 

throw an error has been fixed. 

o An issue where the Expense Entry page would appear blank in some 

scenarios involving custom fields has been resolved. 

 

 

VERSION 2025.04.1.0 RELEASED ON APRIL 16, 2025 
 

Spotlight:  

We’ve made a number of improvements to Cloud Feeds and Accounting Reconciliations 

to make reconciling your bank transactions faster! 

• Payments & deposits automation – introducing a new rule to auto-create 

payments & deposits when a CORE invoice matches the incoming bank feeds. 

• Simplified rules administration – you can now create a single rule for multiple 

connected accounts with assigned employees. Transactions will inherit the 

Employee ID from the incoming transaction’s Employee Field. This means fewer 

rules are required and more consistent data linking. 

• New option for Description field to pull from the Activity or Expense item 

description instead of the incoming transaction description. Select your option 

from Cloud Feeds rules. 

• New option to use the Payee value from the incoming transaction to populate 

Credit Card/Check and Time/Expense/Account Line items memo fields.  



• Memos entered against card/check transactions and Bill Payment line items now 

appear in a single Reconciliation Memo field so you can see the whole story and 

reconcile quickly! 

 

Thanks to the customers who submitted these requests via CORE-ideas@bqe.com!  

 

 

Product Enhancements  

Project KPIs enhancements 

We have released a series of customer requested updates to the project KPIs after they 

were introduced last month: 

• Data refresh – We’ve added a refresh button in the top right of the Project pages 

so you view real-time values on those pages. The page also displays the last 

updated time for the project values. 

• Structure tab 

o Contract Remaining and Budget Remaining values were added to the 

Structure tab. 

o The Percent Complete column will display an orange alert if the Budget 

Spent % exceeds the Percent Complete. This helps call attention to times 

when your spending is ahead of your billing for a project or phase. 

o New view option under More menu to Show full Project Hierarchy when 

viewing a phase. With the setting disabled, you will continue to see just that 

phase and it’s descendants. 

• Projects list 

o We’ve made the quick search faster by splitting the search into Project 

Information, Client, and Address fields.  

o New filters to allow you to quickly find projects based on financial 

performance by Billed Margin %, Billed Margin All Cost %, Billed + Unbilled 

Margin %, Direct Labor Multiplier, and Realization Rate.  

 

Project Planning improvements in legacy and Project Planner  

We’re excited to deliver a series of features based on customer feedback following the 

February updates to allocation & forecasting and the Project Planner: 

• Allocations & Forecasting are now kept in sync 

o This restores behavior that was changed in February 2025.  

o Editing the hours of an allocation will update the hours & amount on 

Forecasting. Editing the hours or amount on Forecasting will update the 

hours on Allocation. 

mailto:CORE-ideas@bqe.com


o Existing data where the Allocations and Forecasting data was out of sync 

was migrated to apply the Forecasting data to the Allocations. 

• Project Planner 

o The Gantt bars in the top section now fill up based on the % complete. 

o The Resource Schedules (bottom) of the project planner has two new 

subtotals under each resource: 

▪ Other allocations – allows project managers to see the total value 

of allocations not displayed to them due to permissions or filters. This 

helps prevent over- or under-loading resources. 

▪ Other time entries – allows you to view when time is being spent on 

activities not displayed in the allocations. 

• Batch update on Resource Allocations now includes the Resource Group and Units 

fields. 

 

Preview and edit invoices from Invoice Batch 

Draft and Final invoices in a batch can now be previewed and edited without leaving your 

batch! The links appear at the far right when you process an invoice. 

 

Simplified attachments to Time & Expense entries 

You can now attach documents from the table view in Time Entry, Expense Entry, and Time 

& Expense Reviewer, eliminating the need to open individual records. Previously, 

attachments could only be added when creating the entry or from the Details page. 

 

Consistent “Show Retainer Summary on Invoice” behavior  

We’ve made the display of the retainer summary on Phased and Joint Invoice Templates 

more consistent with other settings. Invoices will now follow the "Show Retainer Summary 

on Invoice" rule at the Project/Phase-level, instead of relying on the global setting. The 

global setting will serve as the default value for new projects. 

 

Batch update of collections notes 

Keeping up to date on Invoice Collections status is now easier with the ability to batch 

update the collections note on multiple invoices at once. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Billing 



o An issue when utilizing split billing causing uneven expense distributions 

and markup fluctuations has been resolved. 

o An issue where the discount was being populated against the wrong 

project in a specific scenario has been resolved. 

o A spacing issue in the Company Details section of Statements has been 

resolved. 

o Contract Amount logic not being handled correctly for certain split billing 

scenarios has been fixed. 

o The prompt to save changes not being automatically closed in the invoice 

editor has been fixed. 

• Dashboards 

o The Project Manager filter not collecting both parent and child Project 

data when child project’s manager is selected has been fixed. 

o The project status widget not displaying contract totals correctly in a 

certain scenario has been resolved. 

• HR 

o Incorrect rollover of certain allocations for employees has been resolved. 

o A display issue in the Employee Details of the HR module has been 

resolved. 

• Integrations 

o A formatting issue with the connection to Cloud Feeds causing some data 

not to be transferred successfully has been resolved. 

o A display issue in Cloud Feeds related to the status icon has been fixed. 

o An issue with ePayments values being represented incorrectly in a specific 

scenario has been resolved. 

o A formatting issue in the API causing incorrect project codes to be 

returned has been resolved. 

o A formatting issue causing an invalid character to be displayed on email 

payment receipts has been fixed. 

o Three issues related to QuickBooks Data integration including some 

performance issues have been resolved. 

o The public API has had the following updates made: 

▪ Allocation endpoint: resourceGroup, resourceGroupID 

▪ Attachments endpoint: new endpoint /document/downloadlink/{id} 

that allows for export of attachments to cloud storage providers 

▪ Company endpoint: new companyId field 

▪ customFieldValue endpoint: now supports POST and DELETE 

methods 

▪ Project object: new sendInvoiceToContact property 

▪ Project Rules fields now support PATCH methods 



▪ resourceSchedule endpoint: new endpoint supporting GET requests 

for data on the Forecasting tab; new Week endpoint supporting the 

resourceSchedule 

• Mobile 

o An issue causing login problems for some customers on the mobile 

application has been resolved. 

o Minor UI issue related to attachment icons requiring a refresh to display 

has been fixed. 

o The project performance tab not showing data in the new UI has been 

fixed. 

o An issue causing duplicated navigation bars in the Employee Details 

section has been resolved. 

o Push notifications not directing users to properly filtered records has been 

resolved. 

o An issue causing discrepancy between Search and Folder counts has been 

resolved. 

• Project 

o An issue where Project Assignment and Resource Allocation notifications 

were being received even if the notification was turned off has been 

resolved.  

o When updating the contract amount on the parent project from Structure 

tab you will now be asked to update the child phase contract amounts based 

on the % of project value. 

o 50 projects per page being displayed in the Project List screen has been 

restored. 

o The date field being cut off for some users when viewing vendors inside of 

the Projects module has been resolved. 

o An issue causing a NaN Error in the manual Forecasting screen has been 

resolved. 

o An issue causing forecasting of prior or future periods to be broken has 

been resolved. 

o A problem with the project performance tab not showing data in the new 

UI has been resolved. 

o A UI issue where the Unbilled column would be greyed out in dark theme 

has been fixed. 

o An issue where the incorrect value was displayed for a level 3 project has 

been resolved. 

o An issue with Project Planner not updating Last Updated or Last Updated 

By has been resolved. 



o Inability to edit Resource Schedules in Project Planner due to time zone 

conflict has been resolved. 

o Two access permissions issues were resolved related to Project Planner for 

Show Amount and Allow Update. 

• Reports 

o The Project Time and Expenses report has been updated to use the 

standard KPIs released last month.  

o We have fixed the CSV format for the Project Time and Expenses and Time 

Details reports. 

o The Top N Clients report now has multiple “Sort By” options. Sort by 

Payments (default), Gross Billed, or Net Billed under Display Options. The 

Amount column on the report updates dynamically based on the selection, 

and drilldowns follow the chosen criteria. 

o The Configure Reports page in Report Center now allows you to leave 

either the From or To dates of a filter blank.  

o The issue with Reconciliation Details & Summary Reports including 

transactions that should be excluded from “Uncleared” has been resolved. 

o A formatting issue with Payment Receipts has been resolved. 

o An issue with alignment on the Time and Expense report has been 

resolved. 

o The Contract Analysis Report not showing “Main” projects in a certain 

scenario has been resolved. 

o An alignment issue on the Project T&E report has been resolved. 

o Group By not working properly in the Allocation Weekly Manual View 

Report has been resolved. 

• Time & Expense 

o A minor UI distorion impacting time card periods has been resolved. 

o An issue where the attachment icon would not display until the page was 

refreshed has been resolved. 

o An issue causing the checkboxes in Time Card to be misaligned has been 

resolved. 

o Two issues related to security bits for Project Planner have been resolved. 

 

 

VERSION 2025.03.1.0 RELEASED ON MARCH 14, 2025 

 
 

Spotlight: Project KPI Power-Up 



We’ve refined and expanded the terminology and key metrics you have available for 

measuring your projects. This update offers standardized project metrics, improved 

visibility with project health indicators, and enhanced insights for better decision-

making.   

 

We also have enhanced the Projects list view, Overview tab, and Structure tab with 

customer-requested features and new controls, making it easier to access all your project 

information. With this update, we’re providing improved and additional KPIs across CORE 

screens, dashboards and reports to:   

• ensure consistency in labels and numbers everywhere  

• provide expanded analytical options  

• increase access to project metrics on the Projects and other key screens  

 

We are also publishing a new, standard Glossary of Terms that is applicable across CORE 

screens, mobile apps, dashboards, and reports. The glossary allows your teams to align 

on the updated terms and calculations. Find out more and get access to live training in 

the announcement! 

 

 

Product Enhancements  

Project Planner – improvements & now available for more customers  

The new Project Planner aims to provide a unified view of your project allocations and 

make it easy to schedule resources. We are expanding customer access to our Project 

Planner to include group 2 customers! All customers will have access from the April 

feature release, planned for 10 Apr 2025.  

 

Key project planning improvements in this release: 

• On Resource Allocation, separate columns for Resource Group and Resource allow 

you to better manage your “bench” for a given activity or activity group. With 

Resource Group applied to every row, you can quickly move between resources in 

the case of conflict. 

• Activity Groups now roll up the used hours across all activities within the group on 

legacy and new pages. 

• Project Planner loads one year of data, rather than being limited to only 15 weeks 

of data. 

• Gantt bars in the Project Planner now show the project % complete and the activity 

% used for easier analysis of progress of project versus allocations. 

 

https://corehelpcenter.bqe.com/hc/en-us/articles/27789219147287-Glossary-of-Terms
https://corehelpcenter.bqe.com/hc/en-us/community/posts/30423095536407-Project-KPIs-Power-Up-Coming-Soon
https://corehelpcenter.bqe.com/hc/en-us/community/posts/30423095536407-Project-KPIs-Power-Up-Coming-Soon


We will continue to add functionality to the Project Planner in the coming weeks and 

months. We recommend reviewing the recent announcement in the CORE Community for 

the most up to date information. 

 

Mobile – optimized Report Center 

The new Report Center feature in the mobile app allows you to view all your saved reports 

from the web in the Saved tab, with the ability to apply custom sort orders through the 

new overflow menu. Additionally, you can access all existing standard reports from the 

Templates tab for easy reference. 

 

Invoice Collections – filtering by Last Email Date 

The Invoice Collection screen now includes a "Last Email Date" filter, allowing users to 

track invoices based on the date of the last email sent 

 

Cloud Feeds optimization 

We have made it easier to manage large numbers of accounts and transactions in Cloud 

Feeds. Cloud Feeds rules can now be based on either the CORE account or institution 

amount, giving you more options to automate processing. Further, we have revamped 

the loading and batch select behavior in Cloud Feeds, enabling you to process up to 100 

transaction in one go. 

 

Streamlined QuickBooks Destop Utility 

We’ve made three key improvements to the QuickBooks Desktop Utility:  

• deep error logging feature in QuickBooks Desktop utility for advanced debugging, 

accessible through a special shortcut (ALT+Z) from Settings menu. 

• enhanced the Mapped/Unmapped toggle experience to maintain the selected 

module when switching views, improving navigation efficiency for users. 

• you will now receive a notification in the QuickBooks Desktop Utility whenever a 

new update is available for QuickBooks Desktop. 

 

Chart of Accounts enhancements 

Inactive accounts in the Chart of Accounts can now be managed more easily. Inactive 

accounts will have a visual indicator of their status and you can now filter by the status of 

accounts as well to tailor your view of the page. 

 

 

Application Stability 

https://corehelpcenter.bqe.com/hc/en-us/community/posts/29786408248855-New-Project-Planner-Coming-Soon


This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Billing 

o An issue where the Summary screen was showing the incorrect phase and 

contract amounts has been resolved. 

o An issue with the invoice display on the Add Payment screen has been 

resolved. 

• Integrations 

o We've enhanced the CORE Public API by extending the PATCH operation 

to support updates for Address and Communications fields. This allows for 

more flexible and efficient modifications without requiring a full record 

update. 

o An issue where calendar events were not being properly updated in CORE 

has been resolved. 

o An issue with SSO where the company authentication screen was not 

being displayed has been resolved. 

o An issue related to security profiles for Outlook email in company settings 

has been resolved. 

o An issue with the public API where clients were receiving an “invalid_client” 

error has been resolved. 

o An issue where webhooks were not being triggered if a project was being 

created through copy and paste has been resolved. 

o An issue where time entry dates were not being properly represented 

when being sent to Quickbooks has been resolved. 

• Project 

o An issue with the sub-main percentage complete being incorrect has been 

fixed. 

o A problem with sorting by project due date has been resolved. 

o A problem where projects were showing up with the wrong filters has 

been resolved. 

o An issue with the Unbilled Time and Unbilled Expenses display in Project 

Overview showing non-billable time and expenses has been resolved. 

o A problem with the Contract Billed amounts not showing unless the user is 

only viewing a single phase has been fixed. 

o A problem where the Activity Group % Used was not visible in the Gantt 

chart in Project Planner has been fixed. 

• Reports 

o The Reconciliation Details Report now includes a list of transactions that 

were uncleared as of the end of the statement date. 



o We have updated the Summary Section of the Reconciliation Details & 

Summary Reports to incorporate uncleared transactions and allow users to 

reconcile the statement ending balance to the relevant cash balance. 

o An issue with the Allocation Weekly Manual View Report has been 

resolved. 

• Time & Expense 

o Incorrect used hours populating when two benefits were assigned in a 

single year for an employee has been fixed. 

o A rounding issue with the Billable Amount of T&E in T&E Reviewer has 

been resolved. 

o A problem where time entries were incorrectly being locked for recurring 

projects has been fixed. 

o A problem where users were unable to resize the Client and Actual Hours 

fields in T&E Reviewer has been resolved. 

 

 

 

VERSION 2025.02.2.0 RELEASED ON FEBRUARY 27, 2025 

 
 

Spotlight: Project Planner now available for Group 1 customers 

We’re excited to announce the first access to our Project Planner! The new Project 

Planner aims to provide a unified view of your project allocations and make it easy to 

schedule resources.  

• Project Planner will allow you to view resource allocations across all your projects; 

previously your view was limited to a single project hierarchy only.   

• Project Planner will give you a split screen view where you can see the tasks 

allocated to the project and schedule resources for those tasks on a weekly or 

monthly basis; previously you had to switch between tabs to visualize both.   

We will continue to add functionality to the Project Planner in the coming weeks and 

months. We recommend reviewing the recent announcement in the CORE Community, 

which includes further details and links too trainings about these enhancements.  

 

Product Enhancements  

New Chart of Accounts controls 

https://corehelpcenter.bqe.com/hc/en-us/community/posts/29786408248855-New-Project-Planner-Coming-Soon


You now have more control over your Chart of Accounts with the ability to restrict direct 

posting to parent-level accounts. Disabling posting ensures the parent accounts are used 

for organization only. 

 

Invoice Collections filtering 

You can now filter by invoice number, client group, and custom field on the Invoice 

Collections page. Custom fields can also be added as a column in the grid. 

 

Set default payment method for ePayments 

Admin users can now set Credit Card or ACH as the default option when clients view the 

Payments page. 

 

Project Overview – updated time and expense report options 

You can now access unfiltered reports which show all project time or expenses from the 

Unbilled Time and Unbilled Expense widgets. This allows you quick access to these views. 

 

Android – pull down refresh of notifications 

We have introduced "pull down to refresh" feature on the Notifications tab of the New 

Look, making it easy for you to refresh notifications. This ensures you can quickly access 

the most up-to-date notifications without needing to manually navigate or reload the 

app. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Accounting 

o A mismatch between expense accounts when batch updating expense 

entries has been fixed. 

o An issue where NSF Payments and original payments were not showing on 

bank reconciliation has been fixed. 

o An issue causing a discrepancy in accrual based accounting reports has 

been fixed. 

• Billing 

o Invoices incorrectly assigning negative markup percentages to expense 

entries in a particular scenario has been resolved. 



o Utilizing the TAB key in pop-up windows will now cycle only between Yes 

and No options instead of navigating away from the window within 

Invoice Batches. 

o A scenario causing the due date displayed on an invoice to be incorrect 

when e-payments are enabled has been resolved. 

o Client and Manager filters have been restored to the Invoices page 

through a new quick filtering design pattern aimed at improving 

performance. 

o An issue where previewing many phased invoices at once displayed 

incorrect page numbers has been fixed. 

o An issue where the entire amount in the extra section was not being 

displayed on invoices has been resolved.  

• CRM 

o The inability to save or add .msg file types to Client documents has been 

resolved. 

o Notifications from opportunities will now redirect to the specific 

opportunity instead of the list screen. 

o An issue where opportunity values were not populating into KPI’s for a 

client has been fixed. 

• Integrations 

o An issue where time entries were not syncing to MYOB depending on 

certain payroll categories being specified has been resolved. 

o We've extended the lifespan of public API refresh tokens from 15 to 30 

days. This means that as long as the token is used at least once every 30 

days, it will stay active.  

o We’ve improved logging in the Xero payment module. 

o Users can now view Office 365 group calendars directly in BQE Core, 

making it easier to manage schedules and collaborate with your team. 

• Project 

o As issue where incorrect notes being logged in the project stages.  

o An issue where a sub-phase of a main project’s completion percentage 

was being calculated incorrectly has been resolved. 

o An issue with repositioning phases within the project structure has been 

resolved. 

• Reports 

o An issue with the Missing 1099 report has been fixed. 

o Financial budgets reports are now available under the Budgets tag. 

• Time & Expense 

o An issue with the Employee Time Card Summary Report displaying dates 

in the wrong format has been resolved. 



 

 

 

VERSION 2025.02.1.0 RELEASED ON FEBRUARY 19, 2025 

 
 

Spotlight: Project planning enhancements 

We’re excited to announce additional project planning enhancements with this release: 

• We’ve updated the rules and behaviors for editing resource allocations to reduce 

data entry and noise in the planning process. Now, resource allocations can be a 

wider umbrella over resource schedule, which is easier to read and use.  

• We’re also starting a phased rollout of the new Project Planner. Project Planner 

provides a unified view to simplify allocations and resource scheduling. 

We recommend reviewing the recent announcement in the CORE Community, which 

includes further details and links to live trainings about these enhancements. We have 

further improvements planned over the coming months, so watch this space!  

 

Product Enhancements  

Mobile – upgraded navigation experience 

For both iOS and Android apps, the new mobile app navigation is your personalized hub: 

guiding you to what needs your attention, tracking items in progress, and enabling quick 

actions with customizable focus areas and universal add capabilities—all designed to 

streamline workflows for architectural, engineering, and consulting professionals. 

 

To enable it, open the Menu in the BQE CORE app, select the Settings gear icon, and 

enable "Try New Look". 

 

Other enhancements 

• Billing Schedules – memos can now be viewed, added, or edited directly from the 

Billing Schedules table. Enable the Memo column from the "More" menu. 

• Calendar integrations – you can now view Google group calendars directly in BQE 

CORE, making it easier to manage schedules and collaborate with your team. 

• CRM – a new Resources column in the Proposals section makes it easier to see 

what resources are included the quotes attached to proposals. 

https://corehelpcenter.bqe.com/hc/en-us/community/posts/29786408248855-New-Project-Planner-Coming-Soon


• Notifications – Quickly clear notifications with the new "Mark all as read" button. 

This feature lets you mark all notifications as read in one click, without leaving the 

notification dropdown. 

• Record History– click the Reference Number/ID for a row in Record History to 

navigate straight to the record in question. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Accounting 

o A scenario causing users to be unable to add a Bill Payment has been 

resolved. 

o Isolated issues modifying accounts from within the Chart of Accounts 

screen have been fixed. 

o An issue with checks duplicating when using “Save and Add Another” has 

been fixed. 

o An issue causing check number to be set to “To Be Printed” when batch 

updating “To Be Printed” has been resolved. 

o An issue with Record History’s date filter was resolved. 

o Filters were added to the Background Processes page to make finding 

records easier. 

• Billing 

o An issue where the online e-payment account was not being automatically 

selected when requesting a client or project retainer has been fixed. 

o A problem where finalizing draft invoices would not impact the Last 

Updated field has been fixed. 

o An issue where memos would duplicate on an invoice when time was 

moved from one phase to another has been fixed. 

• CRM 

o An issue when creating a quote and the incorrect rate being pulled for a 

service item has been fixed. 

o Issue with smart fields in CRM emails impacting the recipient has been 

fixed. 

• Dashboards 

o An issue with the “Due Date” filter of the Task Allocation widget has been 

fixed. 

• HR 

o An issue causing incorrect Roll Over/Available Sick values was resolved. 

• Integrations 



o A scenario causing calendar events to change from the PM to the AM after 

being edited has been fixed. 

o An issue where QBO syncing would not properly respect Project Group 

Account assignments was fixed. 

o We have improved error logging and handling in the Xero integration for 

expense entries and vendor bills data. 

o We have added a new API endpoint for our public APIs for event 

management. 

• Project 

o An issue where updating the Billing Contact of a project was not working 

as expected has been fixed. 

o An issue when cloning a project the Created By would be set to the 

original project creator instead of the cloner has been fixed. 

o An issue pulling the tax-exempt status of a client incorrectly has been 

resolved. 

• Reports 

o Scheduled reports could be received at the wrong time for users at firms 

operating in multiple time zones. This is fixed. 

o The performance of the General Ledger Extended report has been 

enhanced to ensure fewer failures to generate the report occur. 

o Net Income incorrectly showing as 0 when it is negative when certain 

filters are applied has been resolved on the ‘Statement of Cash Flows’ 

report. 

o An issue where the Account Reconciliation Report would display voided 

checks with the incorrect date has been fixed. 

o An issue with Allocated vs Earned Revenue values in the Forecast report 

has been resolved. 

• Time & Expense 

o A scenario which would cause a time entry to be duplicated during the 

creation of a time entry has been resolved. 

o The Activity and Expense items screens have had the More button added 

to ensure all items are easily accessible. 

o An issue where memos were not being imported with line breaks when 

using CSV import has been resolved. 

 

 

 

 

 



VERSION 2025.01.2.0 RELEASED ON JANUARY 23, 2025 
 

Product Enhancements  

CRM: new fields in Quotes  

Quotes has introduced two new fields to make it easier to customize quotes for your 

clients, giving you greater control and precision in aligning costs and services with their 

needs: 

• Bill Amount: This field automatically calculates the billable amount for services 

based on hours multiplied by the Bill Rate. For added flexibility, you can now 

manually adjust the Bill Amount, and the system will recalculate the hours based 

on the Bill Rate. 

• Cost Amount: Similarly, this new field calculates the expense amount based on 

units multiplied by the Cost Rate. You can also edit the Cost Amount directly, and 

the system will adjust the units accordingly. 

 

Faster project selection in Outlook Add-in  

The Outlook Add-in now features a recently used projects option and auto-fill feature for 

project selection, saving you time selecting projects. 

 

Continued 1099 tracking improvements 

Based on customer feedback, we’ve enabled editing of system accounts in the Chart of 

Accounts to support your 1099 process. You can now set the 1099 category as well as edit 

fields like Cost Pool. We have also further streamlined the 1099/1096 preparation report. 

Be sure to review the new 1099 process for 2025 here. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Billing 

o Sorting Time and Expense data connected to Draft or Unprocessed 

invoices has been added to streamline users experience handling the data 

in both locations. 

o The ability to batch update Custom Fields in the Invoices screen has been 

added. 

o Statements lacking their file extension when being emailed and 

subsequently causing attachment issues have been fixed. 

https://corehelpcenter.bqe.com/hc/en-us/articles/28755480859927-Running-IRS-forms-1099-1096-reports-in-BQE-CORE


o An issue related to displaying PO# when an invoice was combined and 

then separated during creation of an invoice batch has been resolved. 

• Dashboards 

o The Income v Expenses widget could mishandle totals with cash based 

accounting when certain filters were applied. This is fixed. 

• Integrations 

o Outlook 365 will request a smaller set of permissions when integrating 

with CORE. 

o We have improved error logging and handling in the Xero integration for 

class and employee data. 

o Custom fields can now be filtered by Label in the public API. 

o Invoices and payments could fail when being sent to QuickBooks Online in 

a particular scenario. This is fixed. 

• Project 

o In a certain scenario not all Project Groups were being displayed in the 

Project > Settings page. This has been fixed. 

• Time & Expense 

o Projects and Activities had an issue displaying in Timers under certain 

circumstances which have now been fixed. 

o T&E Reviewer has been updated to properly format the text wrapping of 

memos in alignment with the Time Entries page. 

o Time card monitoring could fail to send proper notifications in a given 

scenario. This is fixed. 

• Reports 

o We’ve continued to addressed issues with headers and duplicate data 

when reports were exported to CSV format. Improved reports this release 

include the AR Aging, Trial Balance Accrual Basis, and Group Assignment 

reports. 

o The process time for any scheduled report now reflects correctly on the 

report description in the scheduling module. 

o Mismatches between the Project Time & Expense and Time & Expense 

Summarized reports have been resolved. 

o The Write Up/Write Down report had an issue categorizing invoices under 

the proper project. This has been fixed. 

 

 

 

VERSION 2025.01.1.0 RELEASED ON JANUARY 9, 2025 
 



Spotlight: Record history for Accounting subscribers 

Record History enables company administrators to see details about every change done 

to a record, providing clear visibility into your firm's data to ensure its integrity. Creation, 

update, void, and deletion actions against Invoices, Payments, Time Entries, and Expense 

Entries will be recorded including who, what, and when. 

 

Open Record History from Settings > Record History page or launch from a specific record 

from the Row Actions menu or Detail page. 

Note: Record History will be turned on for Accounting customers in a gradual manner. 

The first customers have access immediately from 9 Jan 2025 with the balance of 

Accounting customers gaining access over the course of January 2025. You’ll receive an 

in-app notification when the feature is available to your firm. 

 

Product Enhancements  

New IRS Form 1099/1096 preparation report 

The 1099/1096 preparation report allows you to validate vendor 1099 amounts in a single 

report. This makes it easier to correct any issues before generating your 1099-NEC and 

1099-MISC forms from CORE. Be sure to review the new 1099 process for 2025 here. 

 

Enhanced outside consultant tracking 

The Outside Consultant Summary report lets you compare the cost of outside consultants 

company against the amount charged to clients. By collating amounts across project-

related budgets, vendor bills, purchase orders, and outside consultant billing, the report 

helps ensure positive cash flow and profitability on consultant work. 

 

CRM: Improved Opportunity address management 

You can now input address or location details on Opportunities which will automatically 

transfer to the Project Address when an Opportunity is won, eliminating manual entry. 

The address fields are also available as Smart Fields in the Proposal Builder and Proposal 

Email screens, streamlining workflows and ensuring data consistency. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Billing 

https://corehelpcenter.bqe.com/hc/en-us/articles/28755480859927-Running-IRS-forms-1099-1096-reports-in-BQE-CORE


o In a certain scenario, Write Up/Down (WUD) was not being spread evenly 

when writing up from the Invoice Batch page. This is fixed. 

o The time an invoice batch will now appear in your local time zone.  

o The percent complete column on invoice batches was not being updated 

when combining invoices. This is fixed. 

o An error would occur when using both the Class and Project Group filters. 

This is fixed. 

o Two issues with the Retainer Summary have been fixed with the Hourly 

Invoice Template. Credit memo amounts are no longer included in the 

received column. Additionally, the template is now adding the Client 

Retainer Received and the Client Retainer Balance correctly as part of the 

Client Retainer Summary. 

• CRM 

o The KPIs and the table totals on the Opportunities list could be misaligned 

in certain scenarios. This is fixed. 

• Dashboard 

o The percentages in the Time Performance widget would not always add up 

to 100%. This is fixed. 

o The PTO & Comp Time widget was mishandling individual employee 

filters. This is fixed. 

• General 

o We have upgraded the Help module in CORE with more relevant and 

contextual help articles.  

• HR 

o Benefits earning rules and accruals will now round to the number of digits 

specified with the Number of Digits after Decimal for Benefits setting on 

Settings > Display & Formatting > Number Formatting. 

• Integrations 

o We have improved error logging and handling in the Xero integration for 

projects, clients, invoices, vendors, activity, expense and chart of accounts 

screens. 

o Memos were not being inherited from the activity when creating a time 

entry via Outlook add-in. This is fixed. 

o QuickBooks Desktop customer could encounter an error in a particular 

scenario when importing payments. This is fixed. 

• Project 

o We have improved performance of one of the project look ups by 32%. 

o Customers in Columbia were encountering incorrect values when editing 

the percentage of project value on the Structure tab. This is fixed. 

• Public API 



o Paid Time Off (PTO) requests are now available through the public API via 

a new endpoint. 

• Reports 

o We’ve addressed a series of issues with headers and duplicate data when 

reports were exported to CSV format. Improved reports include: Client List, 

Contacts, Expense Details, Invoice Reconciliation, Invoice Register, Payroll, 

Project List, Project Profitability, Unpaid Vendor Bills. 

o Top N Client report was not including retainer payments correctly. This is 

fixed. 

o Activity by Project report was not correctly restricting access to the 

Amount column. 

o Time and Expenses Detailed report was not correctly restricting access to 

Bill Rates. 

o Time & Expenses report was failing to generate when a custom label was 

used the employee field in CORE. 

• Time & Expense 

o Customers in Trinidad and Tobago could encounter errors creating time or 

expense entries. This is fixed. 

 

 

 

VERSION 2024.12.2.0 RELEASED ON DECEMBER 26, 2024  
 

Spotlight: Enhanced IRS form 1096 and 1099 forms 

We’ve upgraded the process and output for preparing your IRS 1096 and 1099 forms for 

your vendors from CORE!  

• From the Chart of Accounts, edit an account to set the IRS Form 1099 category.  

• CORE will automatically populate the 1099-MISC, 1099-NEC, and 1096 based on 

the which category spend occurred in for a given vendor. 

• We revamped the report layouts to be compatible with standard printable 

1099/1096 forms. This includes support for 2-up printing for 1099-MISC forms and 

3-up printing for 1099-NEC forms. 

 

 

Product Enhancements  

Reporting – improved filtering for Balance Sheets 

We’ve enhanced the Balance Sheet reports by improving the "As of Date" filter, allowing 

you to use dynamic date options. The new date options include As of Today (default), Last 



Month, Last Year, Yesterday, and Last Quarter making it easier to schedule and run these 

reports. 

 

CRM – map resources to Quotes 

You can now identify individual resources when building a quote in CRM. When a project 

is created from the quote, the resources will be carried over to the project and budget 

along with their associated activities and expenses. These improvements provide more 

accurate quotes and save time when creating project budgets. 

 

Adjustable columns on Cloud Feeds page 

The column widths on the Cloud Feeds page can now be adjusted on a per user basis. 

Your changes will be persisted between visits. 

 

QuickBooks Desktop – resend deleted records  

QuickBooks Desktop customers can now easily resend records from CORE which had been 

deleted in QuickBooks. Use the “Send deleted records to QuickBooks” option under sync 

settings. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Accounting 

o In certain cases, clicking an account in the Chart of Accounts could take 

you to a different account than the one you clicked on. This is fixed. 

o Batch transactions from the Cloud Feeds page could fail to create the 

proper type of transaction. This is fixed. 

• Billing 

o A project would not display on Invoice Batch page in a specific scenario. 

This is fixed. 

o Retainers created automatically in the case of overpayment would not 

copy the memo from the original transaction. This is fixed – the memo will 

be copied onto the retainer. 

• CRM 

o Campaign emails could fail to be delivered when sending to multiple 

people at once. This is fixed. 

• General 



o Saved filters which filtered by custom fields could be lost on screens and 

reports. This is fixed. 

• Integrations 

o We’ve improved the performance of the lookups which power the 

QuickBooks Desktop integration. 

o The project webhook will now trigger when the status of a project 

changes.  

o Syncing clients to QuickBooks Desktop would not respect filters on the 

client list. This is fixed. 

• Mobile 

o Some iOS users could not enter negative expenses. This is fixed. 

o Multiple timers could be started by iOS users even though the allow 

multiple timers setting was disabled. This is fixed. 

o Active timers were not displaying in the Timer widget in iOS. This is fixed. 

o Mobile users could experience slowness using global search. This is fixed. 

• Project 

o When adding a new line to a project budget, the End Date field would not 

get saved properly. This is fixed. 

o The budget fee schedule was not being updated for projects where a 

budget hadn’t been initiated. This is fixed. 

o The Billability widget on the Overview tab of the project was mishandling 

entries marked billed but not associated with an invoice. This is fixed. 

o The Forecasting page could show incorrect contract values for projects 

using split contract amounts. This is fixed. 

o Non-Active projects were not appearing as expected on the Resource 

Allocation page. This is fixed. 

• Reports 

o The Time and Expenses report could include unnecessary columns when 

exporting to CSV. This is fixed. 

o The Project List report would show the incorrect Contract Amount when 

“Hide phases” is enabled. This is fixed. 

• Time & Expense 

o Markup values could be stored incorrectly when changing the “Number of 

digits after decimal for rate” setting before creating the entry. This is fixed. 

 

 

 

VERSION 2024.12.1.0 RELEASED ON DECEMBER 12, 2024  
 



Product Enhancements  

 

Budget Improvements – easier budget template creation and memos 

Creating budget templates just got easier! We have streamlined the experience to more 

easily pick or search from an existing budget template or project budget and you can also 

copy custom fields for service and expense line items. In addition, budget templates and 

project budgets now offer a memo so that you can record information against your 

templates for use in the future. 

 

Report Scheduling – edit and delete schedules 

We are excited to announce that Company Owners and Administrators will now be able 

to edit and delete report schedules created by others. This added flexibility will ensure 

better control and management of scheduled reports across your organization. 

 

Closing Time & Expenses – enhanced bi-weekly handling 

To more adequately handle bi-weekly closing of time and expense entries we have 

updated the existing Company > Work Time setting for the first day of the bi-weekly 

period to now be “First Date of the Bi-Weekly Period”. Setting this date will allow for full 

control over bi-weekly periods that can now be utilized in Closing T&E settings with a 

newly added explicit option for “Bi-Weekly” under the “On a rolling basis” option.  

 

CORE Outlook Add-In – additional enhancements 

The CORE Outlook Add-In now supports displaying custom labels configured in the CORE 

WebApp as well as the status and additional details of time entries linked to Outlook 

emails and calendar events already added to CORE. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Accounting 

o An issue related to tax adjustments in the general journal not inheriting 

their class properly has been fixed. 

• Billing 

o An issue where net bill was being incorrectly updated when invoicing a 

billing schedule line item after excluding time entries has been fixed. 

o The invoice editing screen has been updated to ensure the activity 

dropdowns will populate properly for more than the first 25 time entries. 



o An issue related to memos not being saved correctly for Draft invoices has 

been fixed. 

• ePayments 

o An issue where ePayments were not being enabled for invoices when 

parent entries had ePayments enabled has been fixed. 

• Project 

o The Last Updated Date was being displayed instead of the Invoice Paid 

Date in the Project Overview screen which has now been fixed. 

o An issue where the “Yes” button on a Project Assignments prompt was not 

working properly has been fixed. 

• Reports 

o An issue with the Retainer Details by Project report not showing 

transferred retainers has been fixed. 

• T&E 

o An issue with Closing Time & Expenses “Prior to” option incorrectly 

including the specified date has been fixed. 

o In T&E Reviewer users had reported the vendor filter disappearing 

intermittently which has been fixed. 

o A misalignment of the WUD value between CORE WEB App and the CSV 

export data in T&E Reviewer has been resolved. 

• General 

o An issue related to custom fields not populating correctly and requiring a 

refresh in order to display properly has been fixed. 

o An issue where notifications were showing as blank has been fixed. 
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Product Enhancements  
* denotes enhancement request received via CORE-ideas@bqe.com 

 

Improved Benefit Accrual Calculations 

We’ve updated our HR system to make benefit accruals more precise. Accruals will now 

start on the later of the employee’s hire date or the benefit start date, and the hire date 

will always be used to determine the applicable rule for benefits. These improvements 

ensure a more realistic and consistent calculation of employee benefits. 

 

Enhanced Usability on Project Budget Page * 

mailto:CORE-ideas@bqe.com


The Project Budget page has been improved to enhance usability. Service and expense 

records now save without refreshing the entire page, eliminating the need to re-expand 

the hierarchy and locate the relevant phase, ensuring a smoother workflow. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Resolved an issue where entering general journal entries with decimal 

values triggered an exception on the register screen.  

o Performance improvements were done to the deposits screen to load the 

deposit line items faster. 

• Billing 

o A display issue prevented certain time entries to show up in the batch 

billing screen. This was fixed. 

o Projects with an hourly contract type would, in some cases, appear on the 

batch billing screen when billing by % complete. This was fixed. 

o The currency multiplier would not take effect on the generated bill in some 

cases. This was fixed. 

• Cloud Feeds: 

o Some of the users had trouble connecting to Yodlee or refresh their cloud 

feeds. This was fixed. 

• Financial Budgets: 

o A UI glitch that resulted in incorrect column headers being displayed in 

the table was fixed.  

• Integrations 

o In some cases, invoices were not being synced to MYOB. This was fixed 

o While trying to send vendor bills to XERO, an error would occur in some 

cases. This was fixed. 

• Mobile 

o In some cases, on the android app, an error occurred when entering 

expenses in the new UI. This was fixed 

o Weekly timecard updates now reflect instantly on home feed without app 

restart on android devices 

o IOS: Removed white pointer from pop-up menus for improved UI. 

o IOS: Resolved issue where keypad blocked the FAB button in the Notes 

screen. 

• Open APIs 



o Webhook support has been expanded to include additional modules, 

enabling users to trigger webhooks for a broader set of actions- To-Dos, 

Notes, General Journal, Bill Payment, Vendor Bills, Deposits, Documents. 

o Additional entities (e.g. communication type, credit card transaction, credit 

memo etc.) have included in the "Deleted History" endpoint to provide 

enhanced data transparency and enable more comprehensive audits of 

deleted records.  

o Expense API now accepts code field to filter the expenses. 

o We’ve enhanced the Opportunity API endpoint by adding the projectId 

field. This field can also be used for filtering opportunities linked to 

specific projects. 

o The Contact List API now supports filtering by EntityType, making it easier 

to retrieve specific types of contacts. 

• Project  

o The display of the KPI bar on the Project List screen is now governed by 

the security setting "Show Billing & Contract Amounts." This setting will 

determine whether the KPIs at the top of the screen are visible to a user. 

o Removing project rules for all projects using batch update did not work as 

expected in some cases. This was fixed. 

• Reports 

o Grand totals are now available in the Account Transactions report to 

provide a more comprehensive view of financial data with further 

breakdowns by client, project, and invoices. 

o Time and Expense reports will now honor their respective security settings 

when displaying time or expense data. 

o Exporting AR Aging report to csv would not display column headers. This 

was fixed. 

o Unnecessary validation in some cases prevented users from scheduling 

their reports. This was fixed. 

o Uncleared transactions on the reconciliation report run from the screen 

will now be based on the statement date making it consistent with the 

reconciliation report, as run from the report center. 

o Users with role-based subscriptions found certain time and expense 

reports missing in the Time entry screen. These reports were restored. 

• Resource Allocation & Forecasting 

o A new Project Status filter has been added to the Resource Allocations 

screen. 

o While calculating the end date, CORE incorrectly included weekends, 

leading to incorrect allocation. This was fixed.  

• T&E 



o A new draft filter has been added to the T&E Reviewer screen, enabling 

you to quickly filter and view entries associated with draft invoices. 

o Batch update would error out in T&E Reviewer screen when applying All 

employee filter. This was fixed.  

o In Timecard screen, some of the submitted entries would show up as 

approved. This was fixed. 

 

 

VERSION 1.1.231 RELEASED ON NOVEMBER 14, 2024  
 

Product Enhancements  
* denotes enhancement request received via CORE-ideas@bqe.com 
 

Balance Sheet year over year comparison * 

We’ve streamlined your year-over-year balance sheet analysis with new comparison 

reports for both accrual and cash basis. Define the date and the report compares the 

current year with the prior year to that date. These reports are drill-down enabled. 

 

Fee Schedules – improved copying from budget * 

It is now easier to create a fee schedule from a project budget or budget template! We 

streamlined the search process so you can now quickly find the right budget to copy from. 

 

CORE Outlook Add-In – additional enhancements 

The CORE Outlook Add-In now supports recording time entry from the edit email or edit 

appointment windows. We’ve also added protections to avoid duplicate entries.  

 

Public API – access deleted history 

You can now track which records have been deleted using the new endpoint 

DeletedHistory. DeletedHistory is designed to support incremental refresh scenarios, 

where understanding deleted data is crucial for maintaining data integrity. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Reconciliations could generate an incorrect starting balance in one 

scenario. This is fixed. 



• Billing 

o PDF Invoice attachments emailed from CORE could be corrupted in a 

specific scenario. This is fixed. 

o Emailing dozens of invoices in bulk from the Invoices tab was failing. This 

is fixed – you can now email at least 80 invoices at one time. 

o One customer was unable to create invoice batches. This is fixed. 

o Excluding expenses from an invoice could perform poorly. This is fixed. 

o Batch updating an invoice memo would apply capitalization incorrectly. 

This is fixed. 

o Exporting the invoices table to CSV would omit created by and last 

updated by data. This is fixed. 

o Memos could not be added to root projects or to inactive phases that 

appeared on the invoice. This is fixed. 

o The formatting toolbar was missing when adding a memo on Edit Invoice 

page. 

• Dashboards 

o The Employee Allocation widget could display incorrect data when 

activities overlapped. This is fixed. 

• ePayments 

o ePayments were not be recorded against an invoice in a specific scenario. 

This is fixed. 

• Integrations 

o Markup for expense entries was being sent to QuickBooks Online in 

violation of a setting meant to prevent that. This is fixed. 

• Login 

o We’ve removed the create trial company option from our login page due 

to low adoption. 

• Mobile 

o The action button could be unresponsive on the Client Detail page for 

Android. This is fixed. 

• Project 

o Auto-numbering the project ID could be disabled accidentally. This is 

fixed. 

o We’ve improved the messaging when editing custom fields on a parent 

project to ensure updates aren’t applied to child projects unexpectedly. 

o When creating a project from a template or cloning it, we added a control 

to determine if budget item rates should be updated based on the project 

fee schedule. 

o The prompt to confirm changes to the project fee schedule could result in 

changes being saved unexpectedly. This is fixed. 



o The cursor wouldn’t appear in the first column by default on the 

Allocations page, leading to an extra click. This is fixed. 

o Sorting the project budget table was not being persisted. This is fixed. 

o The % of project column was not updating correctly when a phase was 

added or edited. This is fixed. 

o Project budgets were dependent on a user having a security bit Project > 

Allow update rather than on Budget > Allow update. This is fixed. 

o Project budget KPIs could display in contradiction to the security settings. 

This is fixed. 

o Activity Items listed in Project > Settings > Assignments could be 

displayed incorrectly. This is fixed. 

o The columns on the Forecasting page were too small for the numbers they 

displayed and cut off the text. This is fixed.  

• Reports 

o The Time Verification and Time Verification with Memos reports were not 

grouping data properly when custom labels were used. This is fixed. 

o The Employee Expense report was not respecting all permissions when run 

from the Expense screen. This is fixed. 

o Scheduled reports could result in a blank output in a specific scenario. This 

is fixed. 

o Filters were not applying consistently on the Expenses by Vendor report. 

This is fixed. 

• T&E 

o The record counts on T&E Reviewer could be unclear in a particular 

scenario. This is fixed. 

o Batch update on T&E Reviewer could incorrectly state no records were 

updated. This is fixed. 

o Memos could have incorrect formatting applies when copying & pasting 

within CORE. This is fixed. 

o The Close Time or Expense settings could misstate how many users had 

exceptions to the rule. This is fixed.  

o Checkboxes would not work correctly on T&E screens when using Firefox 

or Safari browsers. This is fixed. 

o Editing description in Time Entry page could cause the changes to be lost. 

This is fixed. 

 

 

 

VERSION 1.1.230 RELEASED ON NOVEMBER 4, 2024  



 
Spotlight: Overbilling protections on Invoice Batch 

You now have better protections in place to avoid overbilling your contract on Invoice 

Batch! We have added warning indicators and conditional formatting to relevant fields 

and rows which call out where overbilling is occurring to make it easier identify and 

avoid these scenarios.  

 

There are 6 new fields on the Invoice Batch detail screen which give you key information 

about billings against your contract: Contract Billed to Date, Extra Billed to Date, 

Contract Billed Previously, Contract Billed this Invoice, and Contract Remaining. 

 

 

Product Enhancements  
* denotes enhancement request received via CORE-ideas@bqe.com 

 

Vendor Bills – upgraded list view* 

We have added 8 new fields to the Vendor Bills list view and updated the default column 

order to make it easier to understand the data. Many of the new fields are filterable and 

sortable. 

 

Project budget – edit the Charge Amount directly* 

The Charge Amount column can now be edited directly in your project budget. Modifying 

the charge amount will automatically update the Hours/Units Budget column to tie out 

the charge amount.  

 

CORE Outlook Add-In – additional enhancements* 

We’ve added a new Save & Submit feature in CORE Outlook Add-In where users can now 

save and submit their time entries to CORE in a single step. The Outlook Add-In now pre-

fills the Employee dropdown with the logged-in user upon login. 

 

Summarized option on Balance Sheet reports* 

Standard Balance Sheet reports now have an option to be summarized by Assets, Liability, 

and Equity. This improvement applies to the Accrual by Project, by Class Accrual Basis, 

and by Class Cash Basis balance sheet reports. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  



• Accounting 

o The Register screen was not displaying the last viewed account when the 

page was refreshed. This is fixed. 

o The Purchase Order screen was showing an incorrect created by user. This 

is fixed. 

• Billing 

o Non-billable entries were being counted in the "Amount on Invoice" 

column of T&E Details on the Invoice Batch page. These non-billable 

entries now show an amount of $0. 

o Invoice batch notifications will now be deleted automatically when a batch 

is completed, reducing clutter in your notifications tray. 

o The View Details link could be missing from Invoice Collection page. 

o The unapproved time alert on Invoice Batch could show incorrectly in one 

scenario. This is fixed. 

o Making modifications in the invoice editor could trigger incorrect markups 

on expense entries. This is fixed. 

o Invoice collections could show a negative retainer available. This is fixed. 

o Joint invoices will now use the parent project’s invoice number rather than 

the root project number. This is fixed. 

o The statement file name could be printed outside the margin. This is fixed. 

• Integrations 

o Some customers could not connect to Outlook Add-In. This is fixed. 

• Mobile 

o In iOS, the preview of a report was not showing valid data, 

• Project 

o Batch Update was not working when filtering projects by Project Group. 

This is fixed. 

o Billing Schedules tab was not showing list of more than 25 records 

correctly. This is fixed. 

o Project budgets were hidden from the create budget from existing budget 

workflow. This is fixed. 

o The setting “Restrict the contract amount of phases within that of main 

project” was not turning off for certain contract types as expected. This is 

fixed. 

o Entries in the project list could be repeated incorrectly when the address 

fields were used in a certain way. This is fixed. 

o T&E attached to Draft invoices were in being included in the Billability 

widget on the Overview tab within a project. This is fixed. 

• Reporting 



o The 'Expense Entries' report run from the Expense Entry screen now 

includes memos by default. A memo-free version can be run from the 

Report Center. 

o The “All Employees” and “All Vendors” filters were not returning proper 

data on T&E reports. This is fixed. 

o The Paid Time Off and Comp Hours Dashboard widget, PTO reports, and 

Benefit Usage Report would show an incorrect available balance. This is 

fixed. 

o P&L reports were not persisting the state of checkboxes required for the 

reports. This is fixed. 

o The Client Retainer Summary report was showing an incorrect Total 

Retainer Balance total. This is fixed. 

o The Preview Gross Margin report could misstate invoice totals. This is 

fixed. 

o Emailed retainer invoices were not displaying memos consistently. This is 

fixed. 

o The Time & Expense Details report was not respecting the “All Employees” 

filter. This is fixed. 

o The Employee Bi-Weekly Time Card report could incorrectly set the start & 

end date of the report. This is fixed. 

• System 

o Invited CORE users could encounter an error if they previously had an 

account that was deactivated. This is fixed. 

• Time & Expense 

o Time Card could find a different bill rate to Time Entries. This has been 

fixed. 

o Submitting a time card on behalf of another employee would set the 

approver to the submitter’s manager, not the manager of the employee 

whose time card is in view. This is fixed. 

o Time card was not showing allocated hours in some cases. This is fixed. 

o Entries were not immediately showing as approved on Time Card if auto-

approval was enabled. This is fixed. 

o The Un-submitted time entries reminder was not counting the un-

submitted entries properly. This is fixed. 

o T&E Reviewer could get backed up when a large number of records was 

exported. This is fixed. 

 

 

VERSION 1.1.229 RELEASED ON OCTOBER 17, 2024  



 
Spotlight: Expanded options to close time & expense entries to edits 

We are thrilled to announce expanded controls for time & expense entries! This was one 

of the most popular CORE-ideas@bqe.com submissions and will allow your firm to 

enforce alignment of time & expense entry with your billing and payroll processes. 

 

You can now prevent creating, editing, or deleting entries: 

• On a rolling basis – e.g. close time entries to modification every week on a certain 

day and time. Or monthly on the 5th day of the following month. 

• Prior to a date – e.g. close time entries to modification prior to 30 Sep 2024. 

• Older than a number of days – e.g. close time entries to modification if the entry 

date is more than 7 days ago. This was an existing option. 

 

We recognize there are occasions where entries need to be modified after the close 

date. To support that, you can add exceptions to the restrictions for individual users – 

set which users at your firm can create, update, or delete entries outside the standard 

policy. Define your policies from Settings > Time & Expense. Time and expense controls 

are configured separately. 

 

 

Product Enhancements  

Expanded Resource Allocations filtering controls 

We’ve reduced the number of clicks and time it takes to find and track allocations. You 

can now: 

• Multi-select Resources from the Show: Resource menu lets you compare workloads 

between resources. 

• Select Resource Group and see all activities assigned to the group and all resources 

in that group. This makes it easier to re-assign tasks between members of the same 

group. 

• Select root projects to quickly see activities across phases rather than one phase at 

a time. 

 

Forecasting – enhanced column configuration and options 

It is now easier to forecast your work thanks to new columns and controls on the 

Forecasting page. New columns for phase start date, end date, and contract amounts help 

you ensure your forecast is mapped to your project amount and timeline. 
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Previously, the Forecast tab would only sum the columns visible in the page. New columns 

allow you to see used and scheduled amounts for the whole project duration including 

sub-totals for past and future periods giving you better context for your forecast. 

 

CORE Outlook Add-In – additional enhancements 

The BQE CORE Outlook Add-In now includes Project Assignments, making it easier to 

manage time and track projects directly within Outlook. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o The last check number field could be reset incorrectly in a particular 

scenario. This is fixed. 

• Billing 

o Resizing columns in Invoice Details modal of Invoice Batch would cause 

them to sort. This is fixed. 

o Invoice batches could fail unexpectedly in a particular scenario. This is 

fixed. 

o An unexpected error could occur when adding a memo in Invoice Batch. 

This is fixed. 

• Calendar 

o Errors would appear when creating calendar events in a particular 

situation. This is fixed. 

• ePayments 

o URLs pasted as part of the Message on Invoice would get shown in plain 

text and be unclickable. This is fixed. 

• Integrations 

o Emails would be sent from CORE’s default mailbox rather than from 

Outlook 365 if there was an error processing them. This is fixed. 

o The CORE Outlook Add-In could become unstable when using Outlook 

classic. This is fixed. 

• Mobile 

o The Android app could crash on opening an HR benefit. This is fixed. 

o The Android app could crash when viewing documents attached to a 

payment. 

• Payments 



o Overpayments recorded as retainer payments were not being linked to the 

original invoice payment. This is fixed. 

• Project 

o The Budget Template screen could miscount the number of records in 

view. This is fixed. 

o The project display name could be incorrect in one situation. This is fixed. 

• Reports 

o The Benefit Usage Report and PTO widget could round hours incorrectly. 

This is fixed. 

o The Statement of Cash Flow report could misstate the ending balance of 

the account. This is fixed. 

o Cost amounts were being cut off on the Time and Expenses Detailed 

report. This is fixed. 

• Time & Expense 

o Amounts could be incorrect when importing expense entries in certain 

regions. This is fixed. 

 

 

 

VERSION 1.1.228 RELEASED ON OCTOBER 4, 2024  
 

Product Enhancements  

Invoice Batch – improved WUD tracking on time entries 

You can now see how write-up/write-down (WUD) impacts time entries with new Hours 

on Invoice and Amount on Invoice columns. These optional columns eliminate the need 

to manually calculate WUD’s affect on the entries.  

 

Mark retainers as a bounced check 

We’ve automated the process of handling returned retainers! From the Payments page, 

use the row action menu to mark a retainer payment as a bounced check and the retainer 

balance will be updated automatically and an accounting entry will be created. This will 

also be reflected on reports.  

 

Public API – simplified custom fields access 

We’ve made it easier to retrieve and update custom fields using CORE’s public API. You 

can now interact with custom field data directly, rather than having to use the Expand 

attribute. API performance has also been improved. 

 



QuickBooks Online integrations – streamlined error tracking 

You can identify and resolve integration errors more quickly with an improved error 

banner for the BQE CORE to QuickBooks Online integration. Click the link in the error 

banner to go directly to the relevant sync logs, saving clicks and time! 

 

CORE Outlook Add-In – additional enhancements 

In the Activity dropdown, the CORE Outlook Add-In now shows both the activity code and 

sub-code to make it easier to distinguish between your activities.  

 

New Extra filter on T&E Reviewer 

As requested via CORE-ideas@bqe.com, there is now an Extra filter on T&E Reviewer.  

 

CRM – streamlined proposal builder 

We are excited to introduce a streamlined process for creating Proposal Templates. You 

can now start a Proposal Template directly from Global Settings or the Proposal Templates 

section in CRM, significantly reducing the number of steps required. Previously, you had 

to create a proposal first before you could save it as a template. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Expense entries would be assigned the wrong Income Account when Cost 

Rate was $0. This is fixed. 

• Billing 

o Invoices could be emailed twice if they weren’t previewed before sending 

in a particular scenario. This is fixed. 

o Split bills could round values inconsistently. This is fixed. 

o Filters could be incorrect when generating invoice batches that used both 

the Project Manager and Project Group fields. This is fixed. 

o The invoice templates list would hide rows in a particular scenario. This is 

fixed. 

o The Last Emailed On field would be cleared when an invoice attachment 

was unlinked from an email. This is fixed. 

o The Payments page could freeze when updating the payment amount 

multiple times. This is fixed. 

• CRM 
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o In the Proposal Builder non-phased quotes were incorrectly displaying 

detailed breakdowns when the summary view was selected. This is fixed. 

o Errors could occur when using group assignments and opportunities 

together. This is fixed. 

o When creating a prospect, one of the field labels was unclear. This is fixed. 

o The description column in follow ups was using title case, rather than 

showing the capitalization entered by the user. This is fixed. 

• Dashboards 

o The Project Allocation widget could display phases out of order and not 

group them properly under the root project. 

o Filtering on the To-Dos widget could be incorrect. This is fixed. 

o The Project Schedule by Allocation widget was showing a partial project 

display name. This is fixed. 

o Filters on the Income vs Expenses widget would not work properly for cash 

accounting. 

• ePayments 

o The ePayment setting on an invoice was being lost when toggling from Draft 

to Final. This is fixed. 

• HR 

o Hours would accrue incorrectly for benefits where the benefit period was 

Bi-Weekly. This is fixed. 

• Integrations 

o Microsoft 365 calendar all-day events would show the incorrect date in 

CORE. This is fixed. 

o For customers using Outlook integration, emails would not be recorded in 

Outlook if the “To” field was not populated on the email. 

o CORE’s connection to OneDrive could drop unexpectedly. This is fixed. 

o Customers integrating with QuickBooks Online can now control if markup 

values are sent to QuickBooks.  

o Mapping records sent from CORE to Xero could result in an invalid error. 

This is fixed. 

• Mobile 

o The Android app could crash after adding a check and returning to the 

Checks module. This is fixed. 

o The Android app was incorrectly writing up mileage when an entry was 

edited. This is fixed. 

o The iOS app was missing validation errors on the user profile. This is fixed. 

• Projects 



o When cloning a phased project the fee schedule was not being populated 

automatically. This is fixed.  

o Under Budget > Expenses, the spent columns were mislabeled. This is 

fixed. 

o When changing the billing contact on a project, there was no prompt to 

apply the change to all phases. This is fixed. 

o When editing contract amount and other fields on the project at the same 

time and saving, edits to the other fields would not be saved. This is fixed. 

o A refresh error could appear when changing project status from Draft to 

Active. This is fixed. 

o Changes to the Completed On date could be lost if a project was marked 

active, then completed again. This is fixed. 

o Column sorting was not working on the Transactions tab in certain 

instances. This is fixed. 

o Showing project transactions by PO could result in incorrect totals on the 

page. This is fixed. 

• Public API 

o We have improved support for extracting List type custom fields from the 

API. 

o We improved webhook delivery reliability. Now, if an error occurs during 

the initial push, the webhook payload will be stored and periodically 

retried until delivery is successful. 

• Reports 

o The width of the Saved Reports section of the Report Center can now be 

modified to your preference.  

o Expense permissions were applying to Time only reports, making some 

reports too restrictive for users. This is fixed. 

o The Employee Project Utilization report was not filtering by master project. 

This is fixed. 

o The Retainer Details by Project report could showing incorrect values in one 

scenario. This is fixed. 

o The Project Expenses report was not grouping by project. This is fixed. 

o Special characters in the project name (e.g. &) were being mishandling in 

the Group Assignments report. This is fixed. 

• Time & Expense 

o The Income Account column could be blank when exporting expenses to 

CSV. This is fixed. 

o When entering a time entry, the Overtime Multiplier was not getting fetched 

from the fee schedule in one scenario. This is fixed. 

 



 

 

 

 

VERSION 1.1.227 RELEASED ON SEPTEMBER 19, 2024  
 
   

Release Spotlight 

We are thrilled to release a streamlined process for managing budget templates and 

project budget. These changes make it easier to create a project budget, give more 

control over how you build it, and improve the data coming out of the project budget.  

 

With this update, you will: 

• Be able to build project budgets in a fraction of the time with revamped budget 

templates. Plus, project budgeting is now better integrated with project templates 

and fee schedules.  

• Save time when managing fee schedules with a new option to automatically 

recalculate project budget items using the new fees. Plus, a new Rate Source 

column shows how a given budget rate was derived. 

• Have better visibility to their margin goals with a new Budgeted Margin KPI. Plus, 

simplified comparison of the project budget versus contract amounts. 

 

Find out more about the feature including customer trainings and a video walkthrough 

from the CORE Community announcement here.  

 

 

Product Enhancements  

CORE Outlook Add-In – additional enhancements 

The CORE Outlook Add-In now includes custom fields for time entries making it easier to 

populate these fields without having to leave Outlook! We also added dark mode and 

made the Create Time Entry easier to find. 

 

Quick add button for Payments & Retainers 

A quick add + Button has been added to the Billing menu options for both Payments 

and Retainers making it easier to add records. 

 

CRM – more Quote options in the Proposal Builder 

The Proposal Builder’s Quotes section now includes the ability to customize summarized 
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quotes, providing greater flexibility and control with the ability to toggle Units and 

Hours columns. The Discount row will also only display when a discount is in use. 

 

Mobile – workflow status filter on T&E Reviewer 

You can now quickly filter by workflow status of an entry allowing you to quickly find the 

entries you are looking for. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o The Vendor Bill page would incorrectly error when creating a vendor bill 

from existing time entries. This is fixed. 

o The Vendor Bill page could display column headings incorrectly. This is 

fixed. 

o The KPI totals in Purchase Orders page was not populating data correctly. 

This is fixed. 

• Billing 

o The Billing Contact was not being populated correctly when emailing 

retention invoices. This is fixed. 

o The Billable Services and Expenses would not tie out to the Net Bill value in 

a particular scenario. This is fixed. 

o Searching for a name with an apostrophe on the Invoices page or 

Payments page would cause an error. This is fixed. 

o Saved filters were not working on Invoices page. This is fixed. 

o The Income Account could not be changed on a manual invoice without 

line items. This is fixed. 

• CRM 

o Multiple emails were being sent when multiple recipients were in the CC or 

BCC fields. This is fixed. 

• Dashboard 

o The Project Schedule by Due Date widget would duplicate phase data. This 

is fixed. 

o The Staff Utilization widget could incorrectly sort the records. This is fixed. 

o The Profit and Loss Comparative widget could misstate the income in one 

scenario. This is fixed. 

• HR 

o The Assigned Benefits screen was missing the rolled over hours indicator 

on the totals incorrectly overstating the benefits accrued. This is fixed. 

• Integrations 



o Emails would still be sent from the CORE mailbox for customers who had 

selected to use Office 365 emailing. This is fixed. 

o We improved the reliability of syncing clients, invoices, and projects with 

QuickBooks Desktop. 

• Mobile 

o The markup field could have a discrepancy when creating an expense from 

OCR. This is fixed on Android and iOS. 

• Project 

o Users were being prompted to refresh the project page inadvertently. This 

is fixed.  

o Team member assignments could show as duplicated in certain conditions. 

This is fixed. 

o The Resource Allocation page wouldn’t reload correctly when removing a 

user. This is fixed. 

• Public API 

o Filtering Vendor Bills by number would cause an error. This is fixed. 

o Filtering Group Details would cause an error. This is fixed. 

• Reports 

o The Time Verification report was not respecting user permissions the right 

way. This is fixed. 

o We released a few performance enhancements focused on customers with 

large databases. 

o The Billing Details report could misstate the totals. This is fixed. 

o The Configure Reports page would incorrectly modify the Date From in a 

certain scenario. This is fixed. 

o The calendar picker in the Project Accounting report was broken. This is 

fixed. 

o The Employee Paid Time Off report could omit data. This is fixed. 

o The Project Profitability report was not subtracting discounts from 

Invoiced Revenue columns. This is fixed. 

o Date-type custom fields were not working in the Opportunities report. This 

is fixed. 

o The Project Time Entries report printed names without a space between 

the names. This is fixed. 

o The Work in Hand report could omit projects when using the Transaction 

Date filter. This is fixed. 

• Settings 

o Inviting users who had accounts previously could cause an error. This is 

fixed. 

• Time & Expense 



o When searching in the Column Settings modal in T&E Reviewer, the 

section headings for frozen and standard columns now display. 

o The Batch Update modal on T&E Reviewer was undersized. This is fixed. 

o The memo on Time Card – Day View could become unresponsive. This is 

fixed. 

 

 

 

 

VERSION 1.1.226 RELEASED ON SEPTEMBER 5, 2024  
 
   

Release Spotlight 

We are excited to release a series of improvements to the CORE Outlook Add-In. The Add-

In allows you to create time entries without leaving Outlook! Find out more about the 

Add-In. 

 

Improvements in this release as submitted by customers via CORE-ideas@bqe.com:  

• New search functionality for Projects, Employees, and Activities for faster input of 

your entries. 

• New ability to modify the Time Entry date directly within the Add-In. 

• New Start and Stop time fields allow you to easily record the duration of your 

activities and appointments when creating time entries. These fields can be 

disabled from Settings. 

• Improved interaction when using Projects, Employees, and Activities lists. You can 

now close lists easily by clicking outside the dropdown or hit the Escape key, Plus, 

we’ve made scrolling smoother. 

• Auto-populate the email message content into the Time Entry Memo field when 

creating a time entry from an email, eliminating the need to copy and paste. This 

option can be disabled from Settings. 

 

To take advantage of these great features, enable the CORE Outlook Add-In today by 

selecting Manage Add-in and searching BQE CORE from Outlook desktop or web. 

 

 

Product Enhancements  

Terminology standardization – root projects 

https://corehelpcenter.bqe.com/hc/en-us/articles/4407738548759-CORE-Outlook-Add-in
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We have standardized the terminology in many places in CORE to refer to root project 

instead of master project for the topmost project in a hierarchy. Most instances are 

updated in this release and Report filters will be updated soon. 

 

 

Report Center – simplified buttons 

Based on customer feedback, we replaced the 'Save and Close' button with a 'Save' button 

while configuring a report. This allows you to make changes to the page without having 

to reopen the report after each save. 

 

Project Center – Billed Profitability toggle 

You can now view profitability based on billed, rather than billable values, from the 

Profitability widget on Project Overview. Toggle your preference from the … menu and 

the change will apply across your projects. 

• Billable profitability – profit potential of a project – calculate revenue and cost 

based on all billable time and expenses on the project. 

• Billed profitability – profit recognized on finalized invoices on a project – calculate 

revenue and cost based on all billed time and expenses on the project. 

 

CRM – Proposal Builder 

We’ve added margin visibility to the proposal builder, allowing you to see in the editor 

how the proposal will appear in the final PDF or print version.  

 

To compliment this and other formatting improvements, we have introduced Orientation, 

Layout, and Margin dropdowns to allow you control the look of your proposal. 

Additionally, the Proposal Builder now displays horizontal formatting constraints, allowing 

for a simplified, "what you see is what you get” editing process. 

 

Login page update 

The login page has been updated with a two-step process for entering your username 

and password in anticipation of federated single sign-on being added to CORE. You can 

access sample companies from the user menu in the top right once you are logged in to 

CORE. If you are interested in being added to the waitlist for single sign-on, please email 

CORE-ideas@bqe.com.  

 

 

Application Stability 
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This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o The ‘pay when paid’ prompt to pay Vendor Bills when applying a Payment 

to an Invoice was missing. This is fixed. 

o When using Invoice Batch, the Invoice Date value will default to today’s 

date each time you log in. If you set the value and revisit the page, the 

value you set will remain until you log in again. 

o The Project Number would not display correctly in emails if multiple 

invoices for the same project were sent from the Collections screen. This is 

fixed. 

o The color-coded statuses on the Invoices screen now include tooltips as 

requested by customers.  

o Project Group filters were not returning accurate data on Invoices list. This 

is fixed. 

o Sending an invoice you had previewed as a PDF could trigger an invalid 

error. This is fixed. 

o The ‘As of Last Month’ filter was not working correcting for Manual 

Invoices. This is fixed. 

o Recurring bills were not being scheduled correctly in a particular case. This 

is fixed. 

o Invoice Batch could incorrectly display the Available Retainer. This is fixed.  

o Changing the memo on a Draft Invoice would incorrectly update Write Up 

/ Down. This is fixed. 

• Contacts 

o Converting an Employee into a Vendor would clear the custom field 

associated with the Employee. This is fixed. 

• Dashboards  

o The Due Project widget would sort parent and child phases incorrectly. 

This is fixed. 

o The Project Allocation widget could misstate allocations when filtering a 

particular way. This is fixed. 

o The To-Dos widget would not reflect the user who reassigned a To-Do 

correctly. This is fixed. 

• ePayments 

o The link to ‘View Invoice’ was not working correctly when a retainer 

request was sent. This is fixed. 

• Integrations 

o QuickBooks Online – You can now use Select All/Unselect All options for 

Activity or Expense in the Get Sync Settings. 



o QuickBooks Online – A permission error could block sending Projects to 

QuickBooks in a specific scenario. This is fixed. 

o QuickBooks Desktop – links between data in CORE and QuickBooks could 

be broken when the project name was changed. This was fixed. 

o OneDrive – PDFs uploaded from OneDrive could not be previewed in 

CORE. This is fixed. 

• Mobile 

o Expenses could not be toggled to reimbursable in some scenarios. This is 

fixed for Android and iOS. 

• Projects 

o Batch update fails when updating custom fields that use the dd/mm/yyyy 

format (e.g. 31/12/2024). 

o Project Monitoring emails could go un-sent in a particular scenario. This is 

fixed. 

o The % of Project column was incorrectly truncating decimal points and 

triggering recalculations of certain contract amounts. This is fixed. 

o It was difficult to identify the hierarchy on the phase switcher on the 

projects page. This has been fixed by adding indentation. 

• Reports 

o Filters for budget reports on Configure report were incorrectly labelled 

'Budget'. They have been corrected to 'Budget Template'. 

o Net Income could be inconsistent between the P&L Cash Basis and 

Balance Sheet Cash Basis reports. This is fixed. 

o The Notes report was not handling date filters correctly. This is fixed.  

o The Percentage Billed report could omit projects incorrectly. This is fixed. 

o The Budget Comparison by Employee report wasn’t respecting all relevant 

permissions. This is fixed. 

o The Payment Date filter was not being respected on the Retainer Details 

By Project report. This is fixed. 

o The Monthly Client Statement report could mismatch the totals. This is 

fixed. 

o Drilldowns could break on the Profit & Loss Cash Basis report. This is fixed. 

o The scheduled version of the Contract Analysis and Project List reports 

could differ from the manually run report in one situation. This is fixed.  

o The Project Account Summary report didn’t reflect Write Offs properly. 

This is fixed. 

o The Gross Margin Report would not correctly group by Class. This is fixed. 

o The Retainer Reconciliation report was incorrect when a single payment 

was used against 2 project retainers. This is fixed.  

• Time & Expense 



o The number of records in view on Time & Expense Reviewer was 

inadvertently removed. It has bene restored. 

o Exporting to CSV from Time & Expense Reviewer could result in a blank 

file in a particular scenario. This is fixed. 

o Opening a memo in Time & Expense Reviewer could cause the Totals line 

to obscure the Memo dropdown. This is fixed. 

 

 

VERSION 1.1.225 RELEASED ON AUGUST 22, 2024  
 
   

Release Spotlight 

You can now customize your view in T&E Reviewer with column ordering and column 

freezing! These controls make it easier to track the information you care about most and 

make the page easier to use. Use the Column Settings under the More menu to drag 

and drop your columns into order and to set up to four frozen columns for easy scrolling! 

 

 

Product Enhancements  

Enhancements to Report Center 

You can now configure multiple owners when saving a report. You can grant colleagues 

the ability to edit your report which makes it easier for your organization to keep reports 

up to date when the report creator is out of the office. 

 

We’ve made it easier to find the most used reports across all CORE users with a new 

Popular filter tag when selecting a report template. As a reminder, filter tags can be used 

in combination, e.g. enable Popular and Project to find reports that match both tags. 

 

Streamlined Invoice Batches 

We’ve removed a click when creating invoice batches. If your batch finishes generating 

when you are on the Active Invoice Batches page, you will automatically be redirected to 

your batch. 

 

Improved Settings for BQE CORE Outlook Add-in 

Further to the improvements in the last release, you now have more controls and 

customization of the Add-In from a new settings page.  

 



Time Performance Widget now includes Contract Employees 

You can now track the utilization for Contract Employees using the updated Resource 

filter on the Time Performance Widget. Previously, only Employees could be selected. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o The Billing Schedule page was not dynamically updating as changes were 

made, it would have to be refreshed. This is fixed. 

o Split billing was not being applied correctly between phases in a particular 

scenario. This is fixed. 

o Customers encountered errors when updating the workflow status for a 

large number of invoices at once. This is fixed. 

o Occasionally splitting and re-combining invoices would group the invoice 

by Client instead of root project. This is fixed. 

o Invoice Due Dates were not being displayed correctly on the Invoice page 

in a certain case, but the dates were correct on the invoice PDF. This is 

fixed. 

o Statements could show incorrect Street Address 2 data. This is fixed. 

• Contacts 

o Exporting the Employee list to CSV was not returning all columns. This is 

fixed. 

• ePayments 

o An error could occur if the account set to receive payment was deactivated 

in a certain way. This is fixed. 

• Help Center 

o Customers were having to log in to CORE again in order to access our 

Help Center. This is fixed. 

• Mobile 

o Marking expenses reimbursable could cause an error. This is fixed for both 

Android and iOS. 

o In iOS, there could be a discrepancy in the markup field when creating an 

expense from OCR. This is fixed. 

• Payments 

o Adding a retainer request was not completing properly in Safari browser. 

This is fixed. 

• Project 



o Overdue invoices would not show in red color on the Project Overview in 

certain cases. This is fixed. 

o The “Show Cost Amount” security bit wasn’t being respected in a particular 

case. This is fixed. 

o Recent Projects would not show properly if there were special characters in 

the project name. This is fixed.  

• Public API 

o The Title field could not be fetched for Prospects via API. This is fixed.  

• Reports 

o If an employee has multiple email addresses, reports were not being sent 

to the same address consistently. Reports will now send to the first email 

listed on the employee profile. 

o The Employee Allocation Weekly Distributive report was not sorting 

projects correctly. This is fixed. 

o The Contract Analysis report could show an incorrect billed amount in a 

given situation. This is fixed. 

o The Employee Time Detail report would return an error when special 

characters were in the Employee’s title. This is fixed. 

o The Profit and Loss reports were not showing sub-accounts in the proper 

order. 

o The Project Time & Expense report was not showing items in order when 

grouped by month. This is fixed. 

• Settings 

o Some customers were encountering errors when creating custom fields. 

This is fixed. 

o Filtering custom fields by range was not returning correct results. This is 

fixed. 

• Time & Expense 

o The filter on the Activity Items and Expense Items settings pages was 

being cleared unexpectedly when returning from the Item details page. 

This is fixed. 

o When adding a row to the Time Card, you could not resize the columns in 

the Project selector. This is fixed. 

 

 

 

VERSION 1.1.224 RELEASED ON AUGUST 8, 2024  
 
   

Release Spotlight 



We have sunset the classic Reports screen. All CORE users have been moved to the new 

Report Center and won’t be able to access the old Reports screen. Retiring the old page 

allows us to focus on building new features requested by customers.  

With this release, we have upgraded the Scheduling Reports to give you more control of 

when reports will be delivered. You can now have reports delivered on a particular day of 

the month or day of the week. For example, send reports on the 15th of every month, or 

on the Last Friday of the month! This works weekly too (e.g., send a report every 2 weeks 

on Wednesday).  

 

Product Enhancements  

Editing of Forecast amounts 

To make your Forecasting process faster, the Manual View of the Forecast now includes 

the ability to edit the Amount field, alongside the existing functionality of editing the 

Hour. Changes to the amounts field will now retrospectively adjust the hours, just as 

changes in hours calculate the amount today. 

 

Improvements to BQE CORE Outlook Add-in 

You now have more options to interact with CORE right from Outlook! We’ve added the 

following improvements to the add-in: 

• We added a direct ‘Launch BQE CORE’ link within CORE Outlook Add-in, letting 

you jump right into CORE with a click.  

• You can save on data entry with an option to pre-populate the Description with 

the Activity Description.  

• We upgraded the display of your Company and User information, the CORE 

Outlook Add-in version number, and the Sign Out and Help buttons to make the 

add-in easier to use. 

 

More control of QuickBooks integration 

We’ve added a new Invoice sync setting which allows you to not send $0 invoices to 

QuickBooks. 

 

When mapping payments between CORE and QuickBooks Online, you can now see the 

Invoice Number in CORE, making it easier to understand which invoices were paid.  

 

CRM enhancements 

We continue to upgrade our CRM to make it more powerful and easy to use: 



• Opportunities: You can now filter Opportunities based on Assigned To from the 

Opportunities list. As well, you can add a Group while creating an Opportunity. 

• Proposal Builder: We’ve added Aptos, Calibri, Georgia, and Segoe UI as fonts to 

the Proposal Builder as requested by customers.  

• Proposal Templates: You can now access your Proposal Templates from Settings 

> CRM to align with other areas of CORE. 

 

Support for custom budgets in Public API  

The public API for budgets (api/budget) has been enhanced to support fetching custom 

budgets in addition to the regular budget templates. A new property, IsCustomBudget, 

has been introduced to indicate whether a budget is custom, and it is filterable for more 

refined queries. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o In Bill Payments, ZIP / Post Code formatting was incorrect in certain cases. 

This is fixed. 

o A Custom Field was missing from the Purchase Order page. This is fixed. 

• Allocation & Forecasting 

o The Forecast > Distributive View was omitting hours in certain scenarios. 

This is fixed. 

• Budget 

o Service items were not sorting correctly in Budget Templates. This is fixed. 

• CRM 

o Prospects screen could appear blank when sorting in a particular situation. 

This is fixed. 

o There were formatting issues in the Proposals screen in certain cases. This 

is fixed. 

o Custom label changes were not working for Prospects. This is fixed. 

• Integrations 

o Retainer payments were being sent to QuickBooks Online with the invoice 

date, not the payment date. This is fixed. 

o Time Entries sent from the Time Entry page to QuickBooks would omit the 

memo. This is fixed. 

o Certain file names were being rejected when using OneDrive as cloud 

storage. This is fixed. 

• Project 



o The Parent Project Name Smart Field was not populating properly. This is 

fixed. 

o A few customers were encountering errors setting up Project Monitoring. 

This is fixed. 

o We improved the performance and reliability of clearing notifications. 

• Reports 

o Filters on the Project Profitability report were not persisted to the next 

time the report was run. This is fixed. 

o The cursor could jump from the From Date to the To Date fields 

incorrectly. This is fixed. 

o We implemented a performance improvement to the Accounts Receivable 

Register report. 

• Time & Expense 

o Users could encounter an error while tabbing on Time Card very rapidly. 

This is fixed. 

o Exporting data from Time Entries to CSV would have blank Created by and 

Updated by fields. This is fixed. 

• User Interface / User Experience 

o Links from a detail page, e.g. Time Entry, to source data like Activity Item 

were not working. This is fixed. 

o We’ve made the side panel less sensitive as some customers found it 

opened and closed inadvertently. 

 

 

 

VERSION 1.1.223 RELEASED ON JULY 25, 2024  
 
   

Release Spotlight 

The legacy Reports screen will permanently retire in two weeks on August 8, 2024.  

 

Today, we are moving users still on the classic Reports screen to the new Report Center 

so you can familiarize with the change. We have made many improvements to the Report 

Center based on your feedback.  

 

If you haven’t already, please explore the new Report Center and familiarize yourself with 

it by selecting Help > Walkthrough Guides from the Reports screen. 

 

 

Product Enhancements  



Export Budgets to Estimate PDF Templates:  

You can now download or email budget details on the Estimate PDF template, rather than 

the Budget report. The Estimate PDF includes your company logo and more polished 

formatting. Look for the updated "Email" and "Download PDF" options under the Budget 

list row-action menu and from the Budgets detail view > Actions menu. 

 

Expanded properties in Power BI Connector 

We have enhanced our Microsoft Power BI connector with more properties to provide 

improved reporting and analysis. This update includes: 

• Custom fields property is now available across many Accounting models 

• In Project model: budgetName, estimateId, estimateName, expenseContract, and 

serviceContract properties  

• Many more properties across the Invoice, Payment, Vendor, and Time Entry 

models. 

 

Find out more about our Power BI Connector, giving you out-of-the-box access to most 

of your CORE data. 

 

CRM – Proposal Builder upgrades 

We continue to enhance the Proposals portion of CRM to help you issue beautiful 

proposals to your clients and win more work! This update improves:  

• Proposal Templates – you have better access to view & edit these from a new tab 

in the Proposal Builder. Changes to a template will be reflected in new Proposals 

created from the template. 

• Indentation, tabbing, and spacing between paragraphs 

• Customization options for the Proposal PDF, setting page size, setting margins, 

and providing the option to use the date format as per the requirements.  

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o We addressed a number of small issues tied to the Invoice Batch release. 

o We’ve reduced the time it takes to generate Statements. 

o Statements would not properly show the Client name in a certain situation. 

This is fixed. 

• CRM 

https://corehelpcenter.bqe.com/hc/en-us/articles/360061565354-CORE-Microsoft-Power-BI-integration


o The Opportunity Forecast amount was not reflecting the Opportunity 

Value multiplied by the Probability %. This is fixed. 

• ePayments  

o An error could occur when processing payments in one scenario. This is 

fixed. 

• Mobile 

o In Time Card, weekdays have been adjusted in a single line now. We’ve 

also addressed other display issues in Time Card and Time Entries. 

• Project 

o We’ve improved performance of saving changes to the order of phases by 

90% on the largest projects. 

o The performance of cloning projects has also been improved. 

o Contract amounts could be adjusted incorrectly by a few pennies in a 

certain scenario. This is fixed. 

• Reporting 

o The P&L Accrual by Project and P&L YTD Comparison Cash Basis reports 

now include % of Income and % of Expense columns. Now all reports have 

these columns as requested by our customers! These columns can be 

enabled under Set Display Options for a report. 

o The totals could be incorrect in the Monthly P&L reports for Accrual and 

Cash for certain customers. This is fixed. 

o Time entries could inaccurately be shown as Billed on reports like Contract 

Analysis if the entries were included in an Invoice Batch. This is fixed. 

• Time & Expense 

o When exporting to CSV, the column headings could show erroneous text. 

This is fixed. 

 

VERSION 1.1.222 RELEASED ON JULY 11, 2024  
 
   

Release Spotlight 

We’ve made generating invoices in batches more powerful and faster! We have 

redesigned the process so you have less waiting times and so you don’t have to start over 

(refresh) the batch as often. Key improvements: 

 

• Added flexibility with saved batches – Invoice batches are saved for 24 hours, 

and you can leave the screen without losing all your progress. 

• No more clicking More button to see your invoices – CORE loads all your 

invoices upfront, so you need to wait less during invoicing. 



• Include new T&E entries without refreshing the batch – improved 

include/exclude process to reduce time to get the right entries on your invoice. 

 

Find out more and sign up for a training on our help site! 

 

Product Enhancements  

New Report Center – expanded administrator controls for saved reports 

Administrator users now have access to edit or remove any saved reports that are 

shared with your company. The new access allows your firm to self-service report 

changes if the report owner is unavailable. This feature is available in the Report Center 

only, not the legacy reports page. 

 

Legacy Reports page retirements 8 August 2024 – the legacy Reports page will be 

retired next month. If you haven’t already, please familiarize yourself with the new 

Report Center by selecting Help > Walkthrough Guides from the Reports page. 

 

CRM – improved Client & Opportunity syncing 

We’ve made it significantly easier to manage Opportunities for existing Clients! From the 

Client page, you can now add or review Opportunities from a new Opportunities tab! 

Similarly, when adding an Opportunity, you can map it to an existing Client from the 

Opportunity page. These changes will reduce clicks for CRM customers and give you a 

more holistic picture of the Client relationship. 

 

QuickBooks Online integration – enhanced Expense Entry export 

The Expense Entry sync now has more controls to streamline your integration 

experience: 

• Additional filters for Employee Group, Project, Resource, and Vendor Group allow 

you to better control the sync and save time during your post-sync reconciliation 

activities. 

• You can now control whether to sync Purchase Tax and Markup separately from 

Sync Settings. Previously, the settings were lumped together. 

 

Project Center – improved handling of partial payments 

The Invoices widget now displays partial payments differently to billed but unpaid 

invoices. Partially paid invoices have a striped green box instead of a solid one. The 

totals in the widget have also been updated to clarify that invoices in green are paid in 

full.  

 

https://corehelpcenter.bqe.com/hc/en-us/community/posts/24599288135191-Enhanced-Invoice-Batches-are-Coming-Soon


Simplified PTO request navigation in mobile 

We’ve made it easier to action PTO requests for mobile users! You now have one-tap 

access to approve or reject PTO requests. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Journal entries could be created against a non-posting account when 

importing from CSV. This is fixed. 

• Billing 

o Users couldn’t mark time as Billed from Create Batch Invoice Screen. This is 

fixed with the Invoice Batch updates. 

o Filtering could exclude certain projects when filtering by Individual Items. 

This is fixed. 

o An error would occur when processing many, multi-page invoices. This is 

fixed with the Invoice Batch updates. 

• CRM 

o Cloning an Opportunity would not copy Notes or Documents. This is fixed. 

o There were cases where the Prospective Client could have overlapping 

data. To avoid these scenarios, we removed from Prospective Client the 

ability to edit the Client Name and the “Add Opportunity” button. 

• Dashboards 

o The Employee Allocation widget was missing a Resource filter. This has 

been added. 

• ePayments 

o Clients could encounter errors when processing payments in certain 

scenarios. This is fixed. 

• HR 

o Benefits with reset date = Hire Date would not always reset properly. This 

is fixed. 

• Mobile 

o We’ve addressed display issues on the Time Card and Time Entries page to 

make it easier to navigate on the go! 

• Notifications 

o Loading all notifications could be slow. We’ve improved performance by 

up to 80% for certain customers. 

• Project 



o Cloning a project with 120+ phases would cause a timeout. We’ve 

improved the performance of the cloning action so projects with 300+ 

phases can be cloned. 

o Pressing the Enter key from Project Settings would exit the project and 

return you to the Project list. This is fixed. 

o The Work in Hand value would show incorrectly if no billed T&E was 

entered. This is fixed. 

o Project Assignment > Expenses would not load more than 25 items. This is 

fixed. 

o We’ve improved performance for Project Center by 10-20% in this release. 

• Reporting 

o The CORE P&L YTD Comparison Accrual Basis report now includes % of 

Income and % of Expense columns. We continue to add these columns to 

all P&L reports. These columns can be enabled under Set Display Options 

for a report. 

• Time & Expense 

o The Request PTO page could show the wrong As of hours when employee 

permissible hours were used. This is fixed. 

o Custom labels for Comp Time were not applying on Time Card. This is 

fixed.  

o Changes to some custom fields were not saved on the Expense Entry page. 

This is fixed. 

o Allocation data wouldn’t appear on Time Entries in a certain case due to a 

permission error. This is fixed. 

• User Interface 

o An update to Chrome and Edge browsers caused icon and font colors to 

be lost in CORE. This is fixed. 

 

 

 

VERSION 1.1.221 RELEASED ON JUNE 27, 2024  
 
   

Release Spotlight 

We continue to deliver improvements to Project Center based your feedback to CORE-

ideas@bqe.com. Thank you for your feedback! 

 

Project Center – enhanced filtering experience 

When drilling into a datapoint from the Project Overview tab, e.g. viewing Unbilled Time 

Entries from T&E Reviewer, you can now view and edit the specific filters which apply. 

mailto:CORE-ideas@bqe.com
mailto:CORE-ideas@bqe.com


Previously, CORE would show System Filters in the page. This saves you time if you 

need to tweak a filter to get the precise data you need! 

 

Project Center – faster drill downs 

The Unbilled Time, Unbilled Expenses, and Invoice widgets now all feature clickable 

subtotals, allowing you to drill down to a more focused view in a single click! 

 

We have more improvements in store in the coming releases! 

 

 

Product Enhancements  

Invoice Details – improved clarity to write up/write down (WUD) 

The Time Entry Details on the Invoice Details page now reflects post-WUD amounts, 

rather than pre-WUD amounts. This aligns the Invoice Details page with the invoice 

template to make it easier to review. 

 

The column names and ordering have been updated to reflect the new values, including 

the WUD Applied, Hours on Invoice, and Amount on Invoice columns. 

 

QuickBooks Online integration – new Sync Settings controls 

You can now filter by Project Manager and Invoice Number from Sync 

settings>Send>Invoice. These options allow you to better control what data is sent to 

QuickBooks, when. 

 

CRM – new Smart Fields for your Leads! 

You can now use more Smart Fields to dynamically populate key Lead information from 

the Lead Email or Campaign Email functions! These Smart Fields will save you time and 

ensure your proposal has a personal touch. Fields include Lead: status, type, cost, industry, 

assigned to, created on, created by, and contact information. 

 

Mobile – Universal Search has arrived! 

Mobile users will now be able to save time using the universal search! Find anything within 

CORE from a single location. This feature will be available in Android v1.85.0 and iOS 

v3.21.0. 

 

 

Application Stability 



This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o When printing checks, the wrong account could be used and the last 

check number was not shown properly. This is fixed. 

• Billing 

o When a Billing Schedule was configured, the Batch Invoice page would 

mishandle using time entries or using the schedule based on billing date. 

This is fixed and the label of the setting on Create Batch Invoice has been 

updated to be more clear.  

o On a project with a Billing Schedule, changing the Contract Amount on the 

project would hold constant the % Complete, changing the Revenue of all 

the Billing Schedule entries. Now, the Revenue will be held constant and 

the % complete will change. This makes it easier to add scope to the 

project without having to make updates to the schedule each time. 

o Editing an Expense on a draft invoice would delete the Service amount 

from the Billing Schedule. This is fixed. 

o Custom Invoice numbering would drop leading zeros from the invoice 

number (e.g. CORE would follow INV-01 with INV-2). This is fixed (e.g. INV-

02 would be the second invoice number). 

o Emailing invoices to the same client with different billing contacts would 

send all invoices to each billing contact. This is fixed. 

o For Recurring Invoices, the Next Bill Date column in was showing the 

wrong date when frequency was set to Annually, Quarterly, Monthly, or 

Semi-Monthly. This is fixed. 

o Statements could fail to load for clients with large numbers of invoices. 

We’ve enhanced the performance of the report. 

• Company 

o During set up, customers in the UK would be ask to enter a phone number 

in US format. This is fixed. 

• CRM 

o Creating a new project from an Opportunity would not always link the 

Client correctly via the Prospect. This is fixed. 

o You now have the ability to customize the page setup of the Proposal PDF 

when using the eSign workflow.  

o Smart Fields would not work when sending an email using the "Include in 

email message" option for a Proposal. This is fixed. 

o Emailing a Proposal and selecting "Attach as PDF file" would actually send 

a ZIP file. This is fixed. 



o Users could encounter a display issue when trying to Preview a Proposal 

from the Proposal list. This is fixed. 

• ePayments 

o Multiple payments could be applied to the same invoice from different 

statements. This is fixed. 

• Integrations 

o A new version of the BQE CORE Add-In has been released. Enable the 

CORE Outlook Add-In today by selecting Manage Add-in and searching 

BQE CORE from Outlook desktop or web and start automating your time 

entry process! Find out more. 

• Mobile – iOS  

o We’ve made filters easier to use across Expense Entry, and Productivity 

Tools. 

o Documents were not always opening on the first click. This is fixed. 

o Reports were not being emailed to Gmail addresses. This is fixed. 

o Opening CRM Opportunities would cause the app to crash. This is fixed. 

o The menu in T&E Reviewer wasn’t accessible from the Entry Detail screen. 

This is fixed. 

o Time Card would not save the entry details in a specific scenario. This is 

fixed. 

• Project 

o Errors when creating a project using an existing Project ID were appearing 

as system errors instead of validations causing confusion. This is fixed. 

o Errors would occur when importing Hourly Not To Exceed (HTNE) projects. 

This is fixed. 

o An error would appear when editing a $0 contract project. This is fixed. 

• Public API 

o The Billing Contact has been added to the Project API. 

• Reporting 

o The CORE P&L Cash report now includes % of Income and % of Expense 

columns. We continue to add these columns to all P&L reports. These 

columns can be enabled under Set Display Options for a report. 

o The Accounts Receivable Register report was displaying an inaccurate due 

date. This is fixed.  

o The Allocation Weekly Manual View report was not sorting phases 

properly. This is fixed. 

• Time & Expense 

o Expense Entries were not properly rounded to 2 decimal places in certain 

scenarios. This has been fixed. 

https://corehelpcenter.bqe.com/hc/en-us/articles/4407738548759-CORE-Outlook-Add-in


o In a specific scenario, Activity Groups could show activities inconsistently. 

This is fixed. 

o Rows on Time Card could be duplicated after changing the Activity 

description. Duplicate rows could not be removed. This is fixed. 

o The Description column in Time Card would disappear when resizing the 

browser in a certain way. This is fixed. 

• User Interface 

o Users in Dark Mode would see a white page when saving changes to 

Project Settings. This is fixed so there is no white page in dark mode when 

saving Projects. 

 

 

 

VERSION 1.1.220 RELEASED ON JUNE 13, 2024  
 
   

Product Enhancements  

Project Center – Improved phase search from projects and faster load time 

We’ve upgraded the phase switcher within a project to be faster and easier to use. Loading 

the Project Center is up to 70% faster! Plus, you can now quickly find the phase you want 

to switch to rather than having to scroll the list.  

 

Enhanced Outlook Add-in 

You can now more easily create time entries from within Outlook thanks to a series of 

improvements to the CORE Outlook Add-In. The upgrade applies automatically to your 

Add-In and improves filtering, active record display, and addresses bugs.  

 

Enable the CORE Outlook Add-In today by selecting Manage Add-in and searching BQE 

CORE from Outlook desktop or web and start automating your time entry process! Find 

out more. 

 

CRM – 11 new Smart Fields for your Opportunities! 

You can now use more Smart Fields to dynamically populate key Opportunity information 

in the Proposal Editor and your Proposal email screen in CORE CRM! These Smart Fields 

will save you time and ensure your proposal has a personal touch. Fields include 

Opportunity: type, value, stage, status, target date, expiration date, forecast primary 

contact name, and project. 

 

https://corehelpcenter.bqe.com/hc/en-us/articles/4407738548759-CORE-Outlook-Add-in
https://corehelpcenter.bqe.com/hc/en-us/articles/4407738548759-CORE-Outlook-Add-in


 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o When editing a paid vendor bill, uneditable fields were displaying as 

editable which caused confusion. This is fixed. 

o A rounding issue could cause manual checks to have a check amount not 

match the check details. This is fixed. 

• Billing 

o We improved the performance of the Invoices page when performing a 

search. Some customers will experience up to a 75% performance 

improvement. 

o Opening the time details on a manual invoice could show time entries that 

were supposed to be removed from the invoice. This is fixed. 

o Certain text formatting options were not functioning when adding a 

message to a Statement. This is fixed. 

• CRM 

o You now have the ability to customize the page setup of the Proposal PDF 

before emailing the proposal.  

o Merging activity items in a quote could leave an empty field that caused 

integrity issues. This is fixed. 

o Sending a Proposal with eSignature enabled would cause an error in a 

specific scenario. This is fixed. 

• Integrations 

o The record count could be misstated when importing payment records 

from QuickBooks. This is fixed. 

o The Unmapped records section of Integrations > Record Mapping could 

show a partial list of records. This is fixed. 

• Project 

o The Documents modal has been enlarged to better preview PDF 

attachments. Before, these attachments required scrolling & zooming to 

see the detail.  

o The Billing Schedule and Project Assignment List could display only partial 

data in a certain scenario. This is fixed. 

o Projects could not be re-assigned to a project group after removing them 

in a specific scenario. This is fixed.  

• Reporting 

o We’ve improved handling of long running report jobs to reduce the 

chance that large jobs will end in an error. 



o The CORE P&L Accrual report now includes a % of Expense column. We 

will be adding the % of Income and % of Expense to all P&L reports over 

the coming months. These columns can be enabled under Set Display 

Options for a report. 

o Reports could generate with invalid date ranges for customers in certain 

time zones. This is fixed. 

• Time & Expense 

o Totals would be hidden on T&E Reviewer when using search and the 

income or expense accounts were enabled on the page. This is fixed. 

o A date formatting error would show if certain countries were selected in 

the User Settings. This is fixed. 

o Projects using the rule “Use rates by classification” were encountering 

slowness loading time card and performing other actions. This is fixed. 

 

 

 

VERSION 1.1.219 RELEASED ON MAY 29, 2024  
  
  

Release Spotlight 

We continue to deliver improvements to Project Center and Report Center based your 

feedback to CORE-ideas@bqe.com. Thank you for your feedback! 

 

Updates to Project Center: 

• The Progress section of Analysis will now show for users without access to Cost 

information. Cost information will be hidden from those users. 

• The Timeline will be hidden if your project doesn’t have any child phases. 

• Invoices fully paid with a retainer will now show as Paid instead of Submitted. 

• The tab title in your browser will now show what project tab and project is in view 

making it easier to navigate when you have multiple CORE tabs open (e.g. 

Overview – 24-013 My Project Name). 

 

Updates to Report Center: 

• Save time and find your report more quickly by searching both Saved Reports and 

Report Templates from the search box on My Reports. 

• Improved stability and performance for editing scheduled reports. 

• Reduced clicks with search-as-you-type on the Select Template page. 

 

We have more improvements in store in the coming releases! 

 

mailto:CORE-ideas@bqe.com


 

Product Enhancements  

Automated returns and refunded BQE ePayments 

We’ve automated the process for handling failed (returned) ePayments and user-initiated 

refunds from the BQE ePayments portal! When an ePayment fails or is refunded, CORE 

will mark the payment as a bounced check, automatically unblock the affected invoices, 

and generate a notification indicating a refund or return, complete with a link to view the 

affected payment. The invoice will then be available for repayment.  

 

CRM – 13 new Smart Fields for your Prospects! 

You can now use more Smart Fields to dynamically populate Prospect name and contact 

information across CORE CRM! Whether drafting a campaign email or crafting a 

proposal, these Smart Fields will save you time and ensure your communication is 

personalized to your prospect. Over the coming months we’ll be adding more 

Opportunity, Proposal, Quote, and Lead Smart Fields too! 

 

Product Updates 

Public API test environment decommissioning 

We are decommissioning the public API test environment (https://uat.bqecore.com/) 

effective 31 May 2024 due to limited use. Customers who have used this environment 

recently have been notified directly. If you have questions about the public API or Power 

BI Connector for CORE, please contact COREdeveloper@bqe.com.  

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Vendor bill and bill payment records could get duplicated in certain 

scenarios. This is fixed. 

• Allocation & Forecasting 

o The Resource Allocation and Forecasting pages were not properly sorting 

second tier records. This is fixed. 

o The Forecasting page was not taking into account the Bill Rate Multiplier 

or Pay Rate Multiplier when fee schedule has no bill rate. This is fixed. 

• Billing 

o Retainer balances could be misstated after refunding a retainer payment 

and changing the client on a project. This is fixed. 

https://uat.bqecore.com/
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o The phased invoice template could mis-total the invoice amounts in a 

particular scenario. This is fixed. 

o The ParentProjectID Smart Field would blank when emailing joint invoices. 

This is fixed. 

• CRM 

o Creating a project from an Opportunity would not copy the budget from 

the Opportunity to the project. This is fixed. 

• ePayments 

o Clients could encounter an error paying invoices that were part of a 

statement in a specific scenario. This is fixed. 

o Load performance of the ePayments settings page has been improved. 

o Errors could arise when special characters were used in certain fields. This 

is fixed. 

• Project 

o Project Structure tab would not roll up the Spent Hours from the child 

phases properly. This is fixed. 

o Batch updating projects would fail if filtering on custom fields. This is fixed. 

o Manage Priority page of fee schedules would not load records in a 

particular scenario. This is fixed. 

o The employee list when configuring Project Monitoring would not handle 

lists with hundreds of employees properly. This is fixed. 

o The Estimates table could appear blank when sorting on the Due Date 

column. This is fixed. 

o When setting the Completed on date while marking a master project 

completed, and child phases with existing Completed on dates would be 

overwritten with the new date. This is fixed. 

• Reporting 

o The Balance Sheet by Class Accrual report could misstate the AP Balance in 

specific scenarios involving a vendor credit and bill payment credit. This is 

fixed. 

o The General Ledger report could mis-categorize journal entries in a 

particular case. This is fixed. 

• Settings 

o A custom label could not be set for specific company types. This is fixed. 

• Subscription 

o Certain customers could get an error when adding licenses to a 

subscription with autorenewal. This is fixed. 

• Time and Expense 

o Expense entries imported from CSV could have the Reimbursable state 

mis-stated. This is fixed. 



o Batch updating the Activity would overwrite a modified description with 

the Activity description. Now the modified description will be preserved. 

o The Time Card would not allow different Descriptions for the same Activity 

on a project. This is fixed. 

o The project rule to require memos for Expense entries would not be 

enforced when updating a vendor bill. This is fixed. 

 

 

 

 

VERSION 1.1.218 RELEASED ON MAY 16, 2024  
  
  

Release Spotlight 

We’re excited to release a number of improvements to Project Center and Report Center 

based your feedback to CORE-ideas@bqe.com. You can expect to see more 

improvements in the coming releases.  

 

Updates to Project Center: 

• Unbilled Time widget now displays the currency value in addition to the number 

of hours. 

• Improved navigation to phases – click a phase from the Phases widget to open it 

in a new tab.  

• The phase amounts in the Timeline widget now displays cumulative amounts. 

• Coming soon – improved Billability widget, add billed margin and WIP widgets, 

hide Timeline widget if no phases exist, and more! 

 

Updates to Report Center: 

• Updated labels to make it more clear how you start a new report or filter your 

report templates using tags. 

• Initiate eSignature for your saved reports from the row action menu. This requires 

a DocuSign subscription. 

• We added the Security Details and Security Summary reports to the Report Center. 

Previously, these could only be run from Settings. 

• Coming soon – new controls for managing report ownership, report schedules, and 

options for scheduling reports. 

 

 

Product Enhancements  
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CRM – improved export of Proposal to PDF  

The visual appearance of your proposals is important, so we’ve made it easier to 

manage formatting and alignment in Proposals. Use the print options from the Proposal 

Build or the Proposal list under Actions to export to PDF with optimized formatting. 

You’ll be able to set the margin, orientation, and paper size as you would with any other 

PDF. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Invoices could be duplicated on Profit & Loss reports due to redundant 

entries in accounting tables. This is fixed. 

• Billing 

o Invoice emails were not being sent to Client Contact if you did not preview 

the email. This is fixed. 

o Multiplier and exchange rate invoice settings were being reset when CORE 

updates occurred. This is fixed. 

• CRM 

o Images uploaded from Dropbox cloud storage were not being loaded 

properly in the Resource Library and Proposal Builder. This is fixed. 

o Margins could be incorrectly applied when exporting proposals to PDF. 

This is fixed. 

• ePayments 

o ePayments deposits were not getting created properly in a specific 

scenario. This is fixed. 

o Clients could double pay invoices if they initiated the payment at almost 

the same time from different computers. This is fixed. 

• Project 

o Projects created from a template could cause an error due to project IDs 

which were too long. This is fixed. 

• Reports 

o Report schedules could become corrupted if the update schedule button 

was clicked multiple times in succession. This is fixed. 

o Hourly Invoice by Employee report would not show data if label of 

Employee was changed to Associate or other. This is fixed. 

o Opening a report you didn’t have access to would show an exception, 

rather than a clear error message. This is fixed. 

o The Unpaid Vendor Bills report would cause an error when it was 

scheduled using certain filter criteria. This is fixed. 



o Column selection on the Project List report could become corrupted for 

certain firms. This is fixed.  

o The Billing Forecast and Yearly Billing Cross Tab reports would not group 

by Project Manager correctly. This is fixed. 

o The Employee Allocation report would show an incomplete employee list 

on the document map. This is fixed. 

o Sorting on the Budget Comparison report did not match the pages. This is 

fixed. 

• To-Dos 

o The text contrast when pasting a To-Do memo made it difficult to read. 

This is fixed. 

 

 

 

 

VERSION 1.1.217 RELEASED ON MAY 2, 2024  
  
  

Release Spotlight 

Welcome to CORE: the Project Center! This 6-minute video walks you through it all.  

 

Here are the key elements of the page: 

 

• Unbilled time & expense – track the project’s work in progress and drill into the 

entries themselves. 

• Invoices – see your project invoice and payment history at a glance! 

• Phase timeline – visualize phase dates and monitor spend against budget. 

• Analysis section – we’ve migrated the legacy Performance tab under Analysis, 

improved calculations and made it easier to use. 

• Plus, team, client and contract information at your fingertips! 

 

We’ve also introduced a new Project permission Show Cost Amounts which allows 

administrators to hide Earned Value, Profitability, and other sensitive data in the page.  

 

Finally, we’ve updated the project navigation: 

• Structure tab (previously under General) promoted to top row 

• General tab relabeled to Settings; Settings moved to last position 

• Billing Schedule tab now under Settings 

• Performance tab absorbed into Overview 

https://bqecore.wistia.com/medias/ntnrt52dtp


 

We’d love to hear what you think – please submit feedback to CORE-ideas@bqe.com. 

 

 

Product Enhancements  

ePayments – fewer fees, improved reconciliation 

We’ve removed the $0.25 transaction fee from credit card payments received through 

BQE ePayments. In addition to saving our customers money, removing the fees 

simplifies the reconciliation process for customers as it eliminates the potential for a 

penny rounding issue when fees are passed through to the client. 

 

Simplified partial payment tracking 

The Edit Payment page has been updated with easier to understand columns, 

particularly in the case of partial payments. The key columns are now: 

• Invoice Total: the total of the original invoice. 

• Paid to Date: the value of previously made payments against this invoice. 

• This Payment: the amount as entered by the user. 

• Current Balance: invoice total less paid to date, less this payment. 

 

Reports & Report Center enhancements 

• You can now modify the owner of a report from the Configuration page in the 

Report Center. This makes it easier to share report management responsibilities. 

In an upcoming release, we’ll add the ability to have multiple report owners on a 

single report. 

• Also on the Configuration page, you can reset report filters to the defaults to 

save clicks. 

• The P&L Accrual report can now display the percent of income for each account 

listed in the report. Use the display option toggle to add this summary 

information to your report.  

• The Time & Expense Detailed report now has columns for Client Hours via the 

column selector and a new Memo toggle. 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o Unexpected characters could appear in the message body when an invoice 

was emailed. This is fixed. 
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• Dashboard 

o The Retainer Balances widget filtered by Project Manager would misstate 

retainer balances if a retainer was transferred. This is fixed. 

• ePayments 

o After manually recording an ePayment invoice as paid, the ePayments link 

in the invoice itself would encounter an error when clicked. This is fixed. 

• Project 

o From Project List, filtering by Project Manager and then attempting to 

batch update Project Manager would result in an error. This is fixed. 

o On Project List, sorting could be broken when filtering by Client. This is 

fixed. 

o Project Monitoring could send duplicate emails in a certain scenario. This 

is fixed. 

o Copying and pasting text encoded with HTML into Project or Client notes 

displayed unexpected characters after being saved. This is fixed. 

• Reports 

o Scheduling a report with multiple email addresses would show an 

erroneous formatting error. This is fixed. 

o The Project List report could misstate contract amounts when phases were 

hidden. This is fixed. 

o The WIP Details report could misstate the retainer amounts if a retainer 

was transferred. This is fixed. 

o The Client List report displays the Zip Code in the wrong format. This is 

fixed. 

• Subscriptions 

o Premium Support subscriptions could be double charged when renewing. 

This is fixed. 

• Time & Expense 

o The Expense Entries page could throw an invalid “refresh this page” error 

after updating many expense entries. This is fixed. 

 

 

 

VERSION 1.1.216 RELEASED ON APRIL 18, 2024  
  
  

Release Spotlight 

This release includes the next milestone on the transition to the new Report Center: all 

customers have been set to use the Report Center! You will continue to have access to 

the legacy Reports page until May 16, 2024, when we retire it for all users. 



 

We’ve made the following improvements to the Report Center based on your feedback: 

• Filters and display options persist between report runs,  

• “By project” reports can now be filtered by Project Group, 

• Project Profitability report can now be grouped by Client Group,  

• plus recently released output format configurations and simplified filter options. 

 

Stay tuned for more of your requested improvements in the coming weeks! Please submit 

additional feedback to CORE-ideas@bqe.com. 

 

 

Product Enhancements  

Improved reconciliation tracking 

When starting a reconciliation, if there is a discrepancy in your beginning balance, you’ll 

now see the amount of the discrepancy and a link to the Reconciliation Discrepancy 

report. Discrepancies most frequently occur when reconciled entries are deleted. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o The alignment of fields for check printing was not being saved properly. 

This is fixed. 

• Budget 

o The Create Purchase Order option from the Budget Templates screen was 

not working. This is fixed. 

• CRM 

o There was no indicator when attachments were being added in the Email 

module. Now you will see a progress indicator to ensure your attachments 

send successfully. 

o Inserting a Quote into a Proposal could cause phases in the Quote to be 

missorted. This is fixed. 

o Emails sent through Proposals were not being recorded in the email 

history in certain cases. This is fixed. 

o When previewing a Proposal email, not all smart fields would preview 

correctly. This is fixed. 

• ePayments 

o Removing the attachment from an invoice email would also remove the 

ePayment link in the email body. This is fixed. 
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o Customers reviewing the ePayments portal could see duplicated first 

names in the Payment History page. This is fixed. 

• HR 

o From Manage PTO the “This Year to Date” filter would return entries from 

prior to this year. This is fixed. 

• Projects 

o Not all Groups would load when opening Manage Groups from the project 

assignment page. This is fixed. 

o The Project List would not sort properly on PO# when a Client filter was 

used. This is fixed. 

o Expanding and collapsing project groups on the Project List would cause 

the page to flicker in certain scenarios. This is fixed. 

o When creating a new phased project by cloning, the parent project would 

not be marked as Active properly. This is fixed. 

o Phases could get out of order on Structure when making a project with 

phases the child of another project with phases and then reordering. This 

is fixed. 

o Project Monitoring would not send notifications to Employee Groups 

properly. This is fixed. 

o The Item Status filter was not applying on Allocation page. This is fixed. 

o When opening Fee Schedule from within a project, Activities could show 

as blank even though they were saved. This is fixed. 

• Reports 

o The Reports tab was not showing recently run reports from the Report 

Center. This is fixed. 

o Toggling between the Individual Items and Range filters could leave 

options selected, resulting in extra clicks for the user. This is fixed. 

o Saved versions of the Project List report could fail to generate in the 

Report Center. This is fixed. 

o The Project List report could show incorrect values when applying group 

by and multiple filters. This is fixed. 

o The Reconciliation Discrepancies report was not correctly separating debits 

and credits. This is fixed. 

o The Expense Details report was including vendor expenses incorrectly 

when filtering on All Employees. This is fixed. 

o The Expenses by Vendor report was not respecting the Account filter in 

certain scenarios. This is fixed. 

• Subscriptions 

o Some customers using autorenewal were not having all their licenses 

created properly. This is fixed. 



• Time & Expense 

o Performance on the Time Entries page would degrade after editing more 

than a dozen time entries and their memos. This is fixed. 

o The Overtime checkbox could not be edited by managers with the Allow 

mark Time Entry as overtime. This is fixed. 

o The Time Entry screen was incorrectly blocking selection of projects for 

users with a specific permission and subscription combination. This is 

fixed. 

o Time Card could incorrectly show removed entries in a certain scenario. 

This is fixed. 

• User Experience 

o The left menu could become mismatched with the page content in view in 

a particular scenario. This is fixed. 

 

 

 

VERSION 1.1.215 RELEASED ON APRIL 4, 2024  
  
  

Release Spotlight 

We are updating the new Report Center based on your feedback to the new page released 

in February. Updates in this release: 

• Save output format configuration – set whether you want your saved report in PDF, 

Excel, Word, or the default Viewer format whether than report is generated from 

CORE or scheduled!  

• Streamlined filter options – we’ve removed clutter and unnecessary controls on the 

Configuration page so you can quickly set your filters and run your report! We’ve 

also moved grouping and other controls under Display Options for better visibility. 

 

We have a number of other improvements in store in the coming months. As a reminder, 

we will be retiring the legacy Reports page in May, so try the new Report Center today! 

 

 

Product Enhancements  

Fewer clicks when navigating 

The left menu in CORE now opens when you hover, rather than requiring you to click! 

You’ll see the same for  help icons throughout CORE. 

 

New reports filters 



We’ve added filter controls requested by you via CORE-ideas@bqe.com:  

• The Cash Receipts report now includes a Retainers Received filter so you can find 

transactions with a certain amount of retainer received. 

• All Time reports now have filters for Extra and Comp Time hours making it easier 

to analyze your employee hours. 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o The income account was not getting set correctly after changing the 

project income account in a specific scenario. This is fixed. 

o On Accounting > Retainers, filtering by All Dates would not show all 

retainer invoices. This is fixed. 

• API & Power BI 

o Power BI requests could fail but show a success status when large amounts 

of data were requested. This would result in partial pipeline refreshes. This 

is fixed. 

o We've improved webhook delivery by adding retry behavior and improved 

error handling. 

• Billing 

o On Invoices, the Project Manager filter was not displaying all invoices in 

some cases. This is fixed. 

o If phases on the same master project have different Project Managers 

(PM), the invoice could display any one of the PMs on the rolled-up master 

project line. This is fixed so the master project PM displays. 

o When issuing a joint invoice for two phases on the same project, the 

invoice number format and Last Invoice Number would be used or 

updated on a phase and not the master project. This is fixed. If two phases 

from different projects are joined, CORE’s default invoice number format 

will apply. 

o On Project Transactions tab, the totals would disappear when refreshing 

the page. This is fixed. 

o On Batch Invoice, the Net Bill column was not updating correctly on 

projects with Contract Type = Percentage in certain cases. This is fixed. 

o When creating a manual invoice, there were two Exclude options which 

were causing confusion. We've simplified the page so you can exclude 

linked time and expense entries to make sure they are not linked to the 
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invoice. To remove a line item from the invoice, use the delete line item 

option. 

o Memo fonts were displaying inconsistently on invoices when copying and 

pasting them to time entries. This is fixed. 

o When editing an invoice, time entries could erroneously appear under the 

expenses section. This is fixed. 

o When a credit was applied to an invoice, CORE would email the Cash 

Receipts report instead of the Credit Memo report. This is fixed. 

• Company Settings 

o The currency symbol for Guernsey was incorrect. This is fixed. 

o Smart Fields defined in Settings > Email Settings for Purchase Orders were 

not displaying properly. This is fixed. 

• CRM 

o Adding a custom field to Opportunities would cause an error in certain 

cases. This is fixed. 

o From CRM Proposal module, emails were not sending in certain cases if an 

attachment was present. This is fixed. 

o The CRM Proposal editor toolbar would get moved out of view in certain 

cases. This is fixed. 

• ePayments 

o We've clarified the message when a client goes to pay a statement that is 

fully paid or deleted. The prior message was causing confusion. 

• HR 

o Under Employee, benefit hours would be rolled over incorrectly in certain 

cases. This is fixed. 

o Under Employee, available benefit hours would be misstated when using 

certain realization date configurations. This is fixed. 

• Integrations 

o Some QuickBooks Online customers were encountering errors when 

sending invoices to QuickBooks. This is fixed. 

• Projects 

o From Project > Billing Options, not all contacts would be fetched when 

there were hundreds of contacts. This is fixed. 

o From Project > Assignment, inactive Activity Items would appear for 

selection incorrectly. Further, Activity Items saved to the project would not 

always appear on the page. Both are fixed. 

o When creating a project from a template, the Main Service Tax (MST) 

setting was not being set properly. This is fixed. 

o From Project > Budget, sorting was not working correctly when resource 

groups were used. This is fixed. 



• Reports 

o The Work in Hand report would cause an error when emailing as a PDF. 

This is fixed. 

o The AR Aging reports would show phone numbers incorrectly. This is fixed. 

o The Client filter on certain reports could incorrectly unselect all entries. 

This is fixed. 

o The Employee Daily Time Card report would fail to run if project start date 

or completed on date filters were used. This is fixed. 

o The Employee Weekly Time Card (Week View) report had a formatting 

issue where not all columns displayed in the preview. This is fixed. 

o The Cash Flow Vs Revenue report would fail to run in certain scenarios. 

This is fixed. 

o The Gross Margin report would not respect all the filters provided. This is 

fixed. 

o The Time & Expenses report could fail to run with an error in certain cases. 

This is fixed. 

o The Project Performance report showed an incorrect symbol next to a 

percentage. This is fixed. 

o Emailed reports were not respecting the filter criteria set when the report 

was saved using certain criteria. This is fixed. 

o Tabbing on the Configure Report page would move to fields in the wrong 

order. This is fixed. 

o The Payment Details report was not respecting the Use Retainer filter. This 

is fixed. 

 

 

 

VERSION 1.1.214 RELEASED ON MARCH 21, 2024  
  
  

Release Spotlight 

The new Product Updates page in CORE Help Center is your one-stop-shop for keeping 

up on the latest with CORE. Find information on major features released in the last few 

months, access release notes, and sign up for our CORE-terly product webinars. 

 

Our next webinar is Thursday, March 21st. Sign up here to view live or watch the recording. 

 

 

Product Enhancements  

https://corehelpcenter.bqe.com/hc/en-us/articles/21575836349847-Product-Updates
https://info.bqe.com/core-connect-bqes-innovations-improvements-20240321


New Report Center improvements 

Based on customer feedback, we’ve added two features to the new Report Center: 

1. A new quick add (+ button) on the Reports menu takes you directly to the Add 

Report page, reducing the number of clicks to create a new report. 

2. You can now hide reports shared with you by colleagues using a filter on the 

Report Center. 

 

Improved memo formatting  

You can quickly reformat a memo copied from another application right from CORE. 

We’ve added the clear formatting option to: 

• Time Entries  

• Expense Entries 

• T&E Reviewer 

• Create Batch Invoice > Time & Expense Details 

• Edit Invoice > Time & Expense Details  

• Project memo 

 

 

Application Stability 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o The Balance Sheet Cash Basis incorrectly displayed a zero balance for fully 

utilized Vendor Credits. This is fixed. 

• Billing 

o When creating a batch invoice filtered by Master Project, the link to view 

unapproved time entries wasn’t loading properly. This is fixed.  

o Editing a draft invoice with a memo could cause the memo to be lost. This 

is fixed. 

o When emailing a statement from CORE, only one BCC recipient would be 

copied from the settings even if multiple were defined. This is fixed. 

• Budget 

o In certain cases, the Budget would not pull the correct bill rate from a fee 

schedule in a particular scenario. This is fixed.  

• Dashboard 

o The Hours widget on the Dashboard was not including billable hours on 

weekends. This is fixed. 

• ePayments 



o We’ve made ePayments statements easier to understand with more clear 

labels for the Statement Total and Statement Balance. 

o Some clients were receiving errors when trying to pay statements in 

certain scenarios. This is fixed. 

• HR 

o The PTO request screen was missing the As Of view. This has been added. 

o Data would not display on the PTO request screen for employees with no 

time entries. This is fixed. 

o The Benefits screen now shows rolled over hours when using the As Of 

view.  

• Integration 

o Some customers were encountering an error when sending invoices to 

QuickBooks Online. This is fixed. 

• Project 

o The search on Estimates page was not working properly. This is fixed. 

o The Fee Schedules table was not sorting properly. This is fixed. 

o Phases would become out of order on Structure tab if a project was 

moved under another project by using the Parent Project field. This is 

fixed. 

o On very large projects, saving a single phase on the Structure tab could 

cause an intermittent error. This is fixed.  

• Reports 

o The Budget Details report was not displaying custom budgets. This is fixed. 

o The AR Aging with Credits report was mis-classifying refunded retainers. 

This is fixed.  

o The Billing Details report would show the wrong currency symbol for UK 

customers. This is fixed. 

o The Check Details report displayed an incorrect status for voided checks. 

This is fixed. 

o The To Do Tasks report was not ordering projects correctly. This is fixed. 

o The Employee Time Card Summary and Employee Time Detail reports were 

showing vendor data when filtered on Employees only. This is fixed. 

• Time & Expense 

o Changing the value in the Classification column for an existing entry could 

clear the hours from the entry. This is fixed. 

 

 

 

VERSION 1.1.213 RELEASED ON MARCH 8, 2024  



  
  

Release Spotlight 

We’ve made it easier to add and manage recent activities to your Time Card! There are 

two new controls: 

• Load more recent activities button makes it fast to find the activity you need. 

Clicking the button adds 10 activities which most recently had time entered on 

them.  

• Hide empty rows toggle makes it easy to see the activities which have time 

entries in the period. 

This feature was built based on customer feedback on the recent activities changes we 

made in November. We welcome your comments at CORE-ideas@bqe.com. 

 

Product Enhancements  

Improved filtering on Opportunities 

CRM Customers can better track Opportunities with new Closed on and Created on Date 

filters from the top of the Opportunities list.  

 

Enhanced To-Do widget on Dashboards 

We’ve made it easier to find your To-Dos and access key information in the To-Do 

widget with three key changes: 

1. Improved filters – new Project filter; % Complete filter now supports a range filter; 

and Any Date is now available on the Due Date filter. 

2. Added links directly to the object the To-Do is related to (e.g. Project). 

3. Overdue To-Dos are highlighted in red. 

 

Employee List report enhancement 

The Employee List report now has a Release Date column which allows you to track 

when an employee left your firm. 

Invoice template configuration 

We’ve added a new Sort By invoice template configuration for the Hourly Invoice by 

Title template. You can now choose to sort by Title or Bill Rate. 

 

New setting for handling reimbursable expenses 

Customers with Accounting subscriptions can now opt to mark reimbursable expenses 

as paid without a bill payment using a new setting. Find the setting under Settings > 

Time & Expense > Expense Entry. 
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Improved reconciliation when a transaction is deleted 

The Beginning Balance of a reconciliation now reflects transactions that were deleted 

after they were reconciled. Previously these transactions were not handled properly, 

causing extra steps to re-balance prior reconciliations. 

 

 

Application Stability:  

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Some customers were encountering an incorrect “page refreshed” error 

when completing reconciliations. This is fixed. 

o The font used when printing checks was too light, making it hard to read 

on the page. The font is now heavier. 

o A rounding issue could cause a reconciliation to show as out of balance 

when it was not. This is fixed. 

• Billing 

o In certain scenarios, custom invoice templates could become unassigned. 

This is fixed. 

o When emailing retainer invoices, invoice number and invoice date smart 

fields were being ignored. This is fixed. 

o We added a validation to require Manual Invoices to have a From and To 

date to avoid unexpected time entries from appearing on the invoice. 

o The Invoice Item Tax accounts settings were being ignored. This is fixed. 

• Contacts 

o Converting a Vendor to an Employee could fail for customers with very 

large data sets. This is fixed. 

• CRM 

o Filters on the Opportunities list page would be lost when returning to the 

list from an Opportunity. This is fixed. 

• ePayments 

o Canadian postal codes were not being handled properly in a specific 

instance on the Pay Now page. This is fixed. 

o The payment method options could appear twice in certain scenarios. This 

is fixed. 

o The list of other invoices to pay could show a client a list of invoices that 

were already paid. This is fixed. 

o Some fields in the ePayment Merchant Sign Up form were not being 

captured correctly. This is fixed. 



• Integrations 

o Outlook 365 integration was being reset incorrectly after a period of days 

or weeks. This is fixed. 

• Project 

o The alert which checks for unbilled time when setting project status to 

Completed now ignores non-billable time.  

o Activity or Expense Groups could not be assigned to Project Templates. 

This is fixed. 

o Forecast values were not editable in the Amounts view. This is fixed. 

o The project and activity values could show as undefined when a conflicting 

resource allocation was made. This is fixed. 

o The Budget page would fail to load if the project name or ID contained 

special characters. This is fixed. 

o Estimates could display incomplete information if sorting was applied in a 

certain way. This is fixed. 

o Users would encounter an error if cloning multiple Budget templates one 

right after the other. This is fixed. 

o Projects created from a template would display the wrong Created by user. 

This is fixed. 

• Reports 

o The Master Project filter was not working properly on the Refund Retainer 

Receipt report. This is fixed. 

• System 

o Customers could get a Bad Request pop up when logging in. This is fixed. 

 

 

 

 

 

 

VERSION 1.1.212 RELEASED ON FEBRUARY 22, 2024  
  
  

Release Spotlight 

Welcome to the new Report Center! We’ve made it easier to find, configure, and run 

reports. Highlights: 

• Find the report your need, fast with template previews, enhanced search, and a 

consolidated report template list 



• Simplified configuration with an easier to use page, cloning reports, and a 

simple saving process. 

• Fewer clicks to run with your saved reports front & center and one click 

rerunning reports. 

Your existing memorized and favorite reports have been migrated to the Report Center 

automatically. We expect to retire the legacy report experience in April.  

 

Product Enhancements  

Upgraded Proposal Builder in CRM 

Our latest update to the Proposal Builder is designed with your feedback in mind. We've 

revamped the formatting toolbar for easier text formatting, clarified subpoints and 

bullet points, and improved image manipulation.  

 

New features include font highlighting, upper and lower case formatting, a clear 

formatting option, and heading formats. Additionally, you have more control over 

placement of Smart Fields, Quotes, and Images through a new copy/paste process. 

These enhancements aim to make your proposal-building experience smoother and 

more intuitive. 

 

2023 updates to 1099 / 1096 tax forms 

We’ve updated the formatting of the 1099 and 1096 tax forms to align with the 2023 tax 

year standards. This applies to all versions of the form. 

 

 

Application Stability:  

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o Editing % Complete in Draft Invoice could cause Net Bill to be 

miscalculated. This is fixed. 

• CRM 

o All Leads were not showing correcting in certain scenarios. This is fixed. 

o Multiple issues with Proposal Builder were fixed with the upgrade this 

release related to spacing, indentation, text alignment, and inserting 

Quotes. 

• Dashboards 



o The Time Performance widget now has a filter on Employee Status to 

better align with the Employee Performance report. 

o The Current Opportunities widget could throw an error when a certain 

number of rows were displayed. This is fixed. 

• Employee 

o Employee rates could not be updated in one scenario. This is fixed. 

• Project 

o Updates to the contract amount of a master project were not being 

applied to phases based on the % of Project value. This is fixed. 

o The contract amount of a phase could get updated incorrectly when using 

3rd tier phases. This is fixed. 

o Taxes were not being pulled from the Client record when creating a new 

project. This is fixed. 

• Public API 

o We released an improvement to our proactive logging of Public API 

transactions to help our teams troubleshoot issues. 

• Reports 

o Payment Details report would return incorrect data if the Client filter was 

not applied. This is fixed. 

o 1099 reports could display an error instead of the vendor tax ID. This is 

fixed. 

o Vendor Bills were included on the Time and Expense Details report 

ignoring the Vendor Bills filter being set to no. This is fixed. 

o A performance improvement was made to the Deposit report. The report 

will now return 20,000+ rows without returning an error. 

• Time & Expense 

o Removing rows from Time Card could cause an error. This is fixed. 

o Adding row to the Time Card for a project would not work if that project 

was at the bottom of the list. This is fixed. 

o Time Card monitoring reminders could not be hidden once triggered. Now 

when a user meets their hours, the reminder will disappear on their next 

log in. 

o The record saved confirmation would not appear in certain scenarios. This 

is fixed. 

• To-Dos 

o The “Back to To-Dos” link would not return the user to the To-Do List. This 

is fixed. 

 

 

 



 

VERSION 1.1.211 RELEASED ON FEBRUARY 8, 2024  
  
  

Release Spotlight 

Coming Soon – new Report Center!  

We’re excited to announce the upcoming release of our new Report Center! On 

February 22nd, we’ll be upgrading your reports experience to make it easier to find, 

configure, and run reports. Highlights: 

• Find the report your need, fast with template previews, enhanced search, and a 

consolidated report template list 

• Simplified configuration with an easier to use page, cloning reports, and a 

simple saving process. 

• Fewer clicks to run with your saved reports front & center and one click 

rerunning reports. 

Your existing memorized and favorite reports will be migrated to the Report Center 

automatically. You’ll have access to the legacy report pages for a few weeks following 

the release.  

 

Product Enhancements  

Unbilled T&E alert when marking a project Completed 

When changing the status of a project or phase to Completed, CORE will alert you to 

any unbilled time or expense on the project. This helps avoid missing unbilled entries on 

Completed phases. 

 

Improved Bill Payments detail view 

We’ve enhanced the view details modal in Bill Payments by showing more relevant data 

and improved subtotals. This makes reviewing Bill Payments faster. 

 

Performance improvement on Invoices page 

We’ve improved the performance of the Invoices page by up to 60%. 

 

Enhanced hierarchy handling with QuickBooks Online integration 

You can now seamlessly process payments to QuickBooks Online using the "Send Joint 

Invoices as Single Invoice" and "Join at Parent Job" options together. The previous 



limitation was removed and payments will be directed to the parent project, ensuring an 

error-free and streamlined payment process. 

 

Application Stability:  

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Using the Check Date filter on the Checks page could cause the totals to 

be incorrect. This is fixed. 

o Errors could occur if Vendor Bill numbers exceeded a certain length. CORE 

will now prevent overly long numbers from being saved. 

o Long project names were not clearly shown on the Vendor Bills pages. This 

is fixed and the project name column is resizable.  

o The create Purchase Order modal has been simplified to remove 

redundant fields.  

• Billing 

o Certain billing parameters could cause an invalid error to appear on Batch 

Invoice. This is fixed. 

o The Client name smart field would not display on Statements and Invoices 

for Client’s with an apostrophe in their name. This is fixed. 

o File size limits when emailing invoice attachments was not considering the 

zipped size of the attachments. This is fixed. 

o The Tax Accounts defined on Settings > Accounting > Tax Accounts were 

not being used when creating invoices. This is fixed.  

o Time entries could display against the wrong project on Batch Invoice in 

one case. This is fixed. 

• CRM 

o Opening an Opportunity from a Prospect would open the wrong tab on 

the Opportunity. This is fixed. 

o The Value of Won Opportunities KPI could show an incorrect currency 

symbol. This is fixed. 

• Employees 

o Batch updating a custom date field in Employees could result in an error. 

This is fixed. 

• ePayments 

o Moving an invoice from Draft to Finalized would clear the ePayments 

setting on the invoice. This is fixed. 

o Filters applied before sending a Statement to a client were not being 

applied in the ePayments portal. This is fixed. 



o Customers using ePayments via Stripe could encounter an error with 

partial payments. This is fixed. 

• HR 

o Benefits could be incorrectly accrued due to rounding. This is fixed so 

accruals are accurate. 

o Cloning Review Templates could cause the wrong template to be 

duplicated. This is fixed. 

o Review Templates page could freeze when editing the Question Type. This 

is fixed. 

• Project 

o In some cases, Budget Templates would not show all activities included in 

the template. This is fixed. 

o Saving the Allocation & Forecasting pages as Favorites in CORE was not 

working properly. This is fixed. 

o Project IDs were being set inconsistently when creating projects from a 

template. This is fixed.  

• Reports 

o Balance Sheet by Class Accrual report could show a mismatch between 

Total Assets and Total Liabilities and Equity. This is fixed. 

o AR Aging with Credit Payments report would not deduct retainer refunds 

from the Total Unused Credit amount when filtered by Project Manager. 

This is fixed. 

o AP Aging with Credit report could be missing certain General Journal 

entries linked to the AP account. This is fixed. 

o The Last Fiscal Year filter on various reports was not applying the correct 

dates. This is fixed. 

• Settings 

o Fee Schedule details could disappear in one scenario. This is fixed. 

o Subscription expiration renewal notifications could show the wrong 

number of days remaining. This is fixed. 

o The Default CORE View user setting would work inconsistently when set to 

open to the last screen visited. This is fixed. 

• Time & Expense 

o Time Card would not auto-create “Tasks allocated to me” in certain cases. 

This is fixed. 

• To-Dos 

o The End Date could not be set for users in certain countries. This is fixed. 
 
 

 



VERSION 1.1.210 RELEASED ON JANUARY 24, 2024  
  
  

Product Enhancements  

 

Easy to access subscription expiration reminders 

It’s now easier to avoid disruptions to your company thanks to improved subscription 

alerts in CORE. As your subscription approaches expiration, Owners and Administrators 

on your account will be notified of expiration via a banner at the top of their CORE page. 

Click to Renew to quickly see the state of your subscription or dismiss the banner to be 

reminded later.  

 

Improved memo formatting on invoices 

Invoice memos now have a clear formatting option. This allows you to quickly reformat 

an invoice memo copied from another application right from CORE.  

 

Enhanced Time Entry workflow 

You can now reject time card entries with fewer steps! Previously, entries in Approved or 

Un-Approved status had to be marked Submitted before they were rejected. Now these 

entries can be marked Rejected in one click.  

 

Separately, you can now control whether to use separate approval workflows for Billing 

and Payroll using a new global setting. Most customers use a single Billing workflow, so 

by default the setting is off. Existing customers who use the Payroll workflow extensively 

have had the setting enabled with the release. You can find the setting under Settings > 

Time & Expenses > General. 

 

 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Some customers could only print 3-5 checks at once without encountering 

an error where the print window would not appear. This is fixed. 

• Billing 

o Using the Project Due Date and other filters on the Invoices and Invoice 

Collections screens could result in incorrect results. This is fixed.  



o Some users could encounter an error finalizing invoices from the Batch 

Invoice or Edit Invoice pages. These are fixed. 

o Recurring projects with frequency Half Yearly would not generate invoices 

correctly. This is fixed. 

o The Retainers page would return no results if the “All Dates” filter was 

used. This is fixed. 

o The batch invoice parameters page would not load if an unrelated error 

occurred. This is fixed. 

o Draft manual invoices could not be opened from a project. This is fixed. 

• Company 

o The permission required to create an additional company has been made 

more restrictive. It was also renamed to “Allow create and update” to be 

more clear. 

• Documents 

o The Documents page now enforces permissions from the record type. For 

example, a user with access to Documents and Projects can no longer see 

Expense Entry documents. 

• Employees 

o There was slowness when saving changes to employee records. This is 

fixed. 

• ePayments 

o ePayments could get stuck in an incorrect status due to an error. This is 

fixed. 

• HR 

o PTO earned could show the wrong value because PTO benefits would not 

respect the tiers of Benefit Earning Rules. This is fixed.  

o The Period filter would not persist the user’s selection on the Human 

Resources tab of the Employee profile. This is fixed. 

• Integrations 

o Customers with a company set to CAD and a project in USD could 

encounter an error integrating with QuickBooks Online. This is fixed. 

• Project 

o Project Template > Assignment > Activity Items would not display all 

records in some cases. This is fixed. 

• Public API 

o Customers using webhooks could encounter delayed or missing 

webhooks. We have released a performance improvement and webhooks 

are 85% faster. 

• Reports 



o The Project List report would incorrectly state the contract balance and 

percent complete for main projects. This is fixed. 

o In one scenario, the Project Information report would omit budget 

information. This is fixed. 

o The Billable Work History report would omit the project name and only 

show the project ID. This is fixed. 

o The Work in Progress Details report was including a late fee in the 

Contract Balance field. This was inconsistent with other reports. This is 

fixed.  

o The Project List report would display incorrect start date when grouping by 

master project and hiding phases. This is fixed. 

o The Project Allocation Units report could misstate the Actual Client Hours 

when overlapping employee groups were used. This is fixed. 

o The Aged WIP with AR report now has a Hide Phases parameter to give 

you control of what to show on the report. 

o The Security Template report had inconsistencies in displaying modules 

and in the security bits lists. These are fixed. 

• System 

o Newly invited users could get an error upon invitation that “the resource 

was removed”. This is fixed. 

• Time & Expense 

o There were inconsistent permission checks when deleting records between 

Time Card and Time Entry. The checks are now consistent.  

o Updating Client Hours on T&E Reviewer could be slow. This is fixed.  

o CSV exports of T&E Reviewer page could show duplicate records. This is 

fixed. 

o Resizing columns in the Time Card could cause the table to be mis-

formatted. This is fixed. 

 

 

 

 

VERSION 1.1.209 RELEASED ON JANUARY 11, 2024  
  
  

Release Spotlight 

You can now use timers while offline in the BQE CORE mobile app! You can effortlessly 

track your time on the go, even without an internet connection. Create, pause, and 



delete timers seamlessly, ensuring uninterrupted productivity, accurate time tracking, 

and automatic synchronization when back online.  

Take advantage of the new offline timers in the iOS and Android apps as well as the 

Timer Widgets on the mobile home screen. 

 

Product Enhancements  

 

Streamlined set up of Project Monitoring 

Project monitoring now has an option to "roll up" phase and sub-phase amounts into the 

calculation. This makes monitoring easier to set up – most customers want to enable 

tracking of spent versus contract or budget once at the parent project and capture all the 

phase values. 

 

You can still choose to monitor on a phase by phase basis by selecting to exclude child 

phases when configuring monitoring on the parent project. Find project monitoring under 

Project > General > Monitoring.  

 

Auto logout – additional options 

Auto logout now supports more time intervals to give you more flexibility for aligning to 

your security policies. You can now automatically log users out after up to 12 hours from 

Settings > Access & Permissions > Login Security.  

 

Opportunities in CRM – enhanced batch update 

You can now batch update additional Opportunity fields in the CRM module. The new 

fields are: Groups, Competition, and Next Step. 

 

Improved Charge Amount tracking in Vendor Bills 

You can now record the amount your client should pay you for an expense from Vendor 

Bills. The Charge Amount field has been added to the page. The Bill Rate field can still be 

used to enter the amount your client should page for a time entry. 

 

New report – Employee Allocation Weekly Manual View 

You can now access and schedule the Allocation Weekly Manual View report from the 

Report Center. This report was only available previously from the page itself. 

 



The report provides a 10 week forecast of staff workload or revenue, offering insights 

crucial for efficient resource planning. View by Project or Employee and see scheduled 

and actual hours or amounts. 

 

 
 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Cash Basis accounting could become incorrect when reimbursable bills 

were partially paid. This is fixed. 

• Billing 

o Invoices with item tax could display the wrong total due to a rounding 

issue. This is fixed. 

• CRM 

o Certain customers were getting errors loading the Opportunities page. 

This is fixed. 

o Exporting Opportunities to CSV was not respecting the page filters. This is 

fixed. 

o Marking an Opportunity as Won wouldn’t update the page without a 

refresh. This is fixed. 

• Documents 

o Standard filtering is now available on the Documents page in the new UI. 

• ePayments 

o Already paid invoices could appear for clients in the “Ready to submit 

another payment?" section. This is fixed. 

• HR 

o To reduce the number of clicks to configure a benefit, we’ve removed an 

“Show more” option from the Add/Edit Benefit screens. 

• Project 

o Cost rates were visible to some users when they should not have been on 

the Budget page. This is fixed. 

o The available balance could be incorrect on the Structure tab of the 

project in some cases. This is fixed.  

o Users were encountering errors when marking Allocation & Forecasting 

pages as favorites. This is fixed. 

• Reports 

o Employee Utilization report and Staff Utilization widget now work with the 

setting “Utilization Based on” set to “Standard Hours less deductions”. The 



report and widget will use employee weekly hours if populated, or 

employee daily hours. 

o Profit & Loss report was mishandling expense entries when they were 

marked paid. This is fixed. 

o Time Card Week View report would incorrectly group lines that had the 

same project and activity, even if the description was different. This is 

fixed. 

o Profit & Loss Cash Basis report would inconsistently handle a Vendor Bill 

paid with a credit. This is fixed. 

o Project Time & Expense report would not show the correct number of 

decimal places for expense rate. This is fixed. 

o Filters were not being respected when running the Vendor Bill List report 

from the Vendor Bills page. This is fixed. 

• Time & Expense 

o Time Card monitoring was not handling certain time entry statuses 

correctly. This is fixed. 

 

 

 

VERSION 1.1.208 RELEASED ON DECEMBER 26, 2023  
  
  

Release Spotlight 

We've made it easier to get the most out of CORE with new standard, role-based 

Dashboards! 

The dashboards provide insight into key areas of CORE allowing you to efficiently monitor 

your tasks and projects, boosting productivity and profitability. The dashboards cover:  

Area Content includes 

Billing Aged receivables, money owed, cash flow, retainer balances 

CRM Opportunities, prospects, sales funnel, sales performance 

Financials Balance sheet, profit & loss, Income vs expenses, cash flow 

Project Management  Project status, utilization, workflows, to-dos, project allocation 

Timekeeper Time performance, task allocation, PTO & comp hours, to-dos 

These dashboards have been added to your existing dashboards. Dashboards are 

assigned based on user role and subscription, respect individual permission settings, and 

can be configured or customized at any time. 



We hope you enjoy your new dashboards! 

 

Product Enhancements  
 

Streamlined Opportunities in CRM 

We’ve eliminated manual steps converting an Opportunity to a Project and batch 

updating Opportunities. Now, when an Opportunity is marked Won, the documents from 

the Opportunity can now be made available in the new Project.  

 

Additionally, you can now batch update the Custom Fields and Loss columns of 

Opportunities. 

 

Improved Collections report 

We have revamped the Collection report with new features and an improved layout. You 

can now Group by key information like Client, Principal, or Project. Plus, the "Show/Hide 

Details" toggle allows you to further tailor the output to your needs.  

 

Further Accounting Reconciliation improvements 

We've made it even easier to reconcile your accounts by making transaction memos 

available in the Active Reconciliation page. If a memo exists for check or deposit an 

indicator and the text will appear in a new Memo column. This will give you extra context 

about the transaction without having to leave the page. 

It is easier to see when your reconciliation is complete. When the account is out of balance, 

the Difference amount will show in red; the Difference will turn green when in balance. 

Optimized administrator settings 

We've simplified the set up of your Outlook Outbound Email settings. When enabled, your 

clients will receive emails that come from your company email address. We've reduced 

the number of settings that are required and improved labels. Administrators can find this 

option under Settings > Company > Email Settings. 

 

Fee schedules now load 90% faster for our largest customers! Smaller customers will see 

a less dramatic improvement, but the page will be faster across the board. 

Easier to use Memo from Invoices 

We've upgraded the options in the Memo field on the Invoices page to make it easier to 

use and more consistent. We've also added a Clear Formatting option to make it easier 

to copy & paste memos without affecting your invoice formatting. 



New Power BI data fields 

The Employee Birth Date and Target Utilization columns on the Employee table are now 

available for use with PowerBI + CORE. Download the December 2023 Power BI update 

from Microsoft to access. 

 
 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Accounting 

o Total assets were not matching total liability & equity in some cases on the 

Balance Sheet by Class Accrual report. This is fixed. 

o The Balance Sheet by Class Cash Basis report does not match the Trial 

Balance by Cash or Balance Sheet by Cash in some scenarios. This is fixed. 

o A negative AP balance could occur on the Balance Sheet Cash report in 

one case when a vendor bill had a discount. This is fixed. 

o Cloud feeds could show duplicate transactions when sorting was applied. 

This is fixed. 

o CSV import of Cloud feeds could show invalid errors. This is fixed. 

o On Vendor bills, the cost rate of expenses would not get saved properly in 

a certain scenario. This is fixed. 

• Billing 

o The loading indicator on batch invoice would not appear in some cases. 

This is fixed. 

o Zero dollar entries were not marked billed in a certain situation. This is 

fixed. 

• Client 

o Changing the status of a client isn’t saved properly in one scenario. This is 

fixed. 

• Employee 

o Changes to Automatic Overtime setting would not get saved in certain 

scenarios. This is fixed. 

• Integrations 

o Reimbursements imported from QuickBooks Online could be 

miscategorized. This is fixed. 

o Bad data from QuickBooks Online could cause T&E Reviewer to return 

incorrect results. This is fixed. 

• ePayments 



o ACH transactions could show incorrect last name in ePayments portal. This 

is fixed. 

• Login 

o New users will have to set up two-factor authentication (2FA) when they 

create an account rather than on their second login. 

o A user will have to reauthenticate with 2FA before changing the 2FA 

settings on their user profile.  

• Project 

o When creating a phase using project templates, the Project Monitoring 

settings for the main project or phases can now be copied to the new 

phase. This saves time and ensures consistency when creating phases. 

o The Comparison by Budget option from the Structure page would fail to 

load for lower tier phases. This is fixed. 

• Reports 

o Journal report didn’t show how a bill was paid when a vendor credit was 

used. This is fixed. 

o Expenses by Vendor report could display an balance that was off by a 

penny. This is fixed. 

o Invoice reconciliation report could show the incorrect total expenses. This 

is fixed. 

o Transaction details report could miscategorize transactions under No 

Payee. This is fixed.  

o Time and Expense report would incorrectly order field name when using 

multiple Group by functions. 

o Sorting on the Time Verification report was not showing consistently. This 

is fixed. 

o The Activity Group filter was not working on the Project Assignment 

report. This is fixed. 

o Employee Half Monthly Time Card report would show an invalid total. This 

total has been removed. 

• Time & Expense 

o Editing the Expense Code on an Expense Entry would fail in certain 

scenarios. This is fixed. 

o Submitting a Time Card could display invalid approvers. This is fixed. 

o Time Card would prevent deletion of entries in a row when it should have 

been allowed. 

o On Time Entries, when changing the Activity of an entry via Batch Update 

will now change the Description of entry to match the activity. 

 



 

VERSION 1.1.207 RELEASED ON DECEMBER 12, 2023  
  
  

Release Spotlight 

We've upgraded the Reconciliations section of Accounting in CORE to add functionality 

and make it easier to use. The major improvements are: 

Deposits & Credits and Checks & Payments now have separate totals in the active 

reconciliation. Customers requested this to make it easier to find the transactions that are 

not yet balanced. 

Labels. buttons, and navigation have all been refined for consistency and clarity. For 

example, the statement date and account are more clearly identified and you can use the 

new breadcrumb navigation to move between pages more easily. 

We’ve also fixed bugs with the display of records in the page, navigation, and finalizing 

the reconciliation. We hope you enjoy these improvements on your next reconciliation! 

 

Product Enhancements  
 

Enhanced two-factor authentication (2FA) security 

We’ve simplified 2FA set up and made it more secure.  
 

Now administrators can require 2FA based on User Role: enable for Owners, Admins, or 

Regular Users. When users are added to your company, the rules will automatically 

apply to them.  

 

We’ve streamlined the registration process for users. Users can now select from 

authenticator app, text/SMS, or phone call verification methods. Email has been 

removed as an option because it was not secure. Users can still opt-in to 2FA even if 

their company doesn't require it from their User Settings page.  

 

 

New UI enhancements 

We’ve made the following improvements to the new UI to improve your experience: 

• Notifications & Messages menus in the top right now show the unread count. 

We’ve included a 40% performance improvement in looking up this information. 



• The onboarding video shown to new users has been updated to feature the new 

UI to make onboarding new employees easier. 

• When an error banner appears, it no longer hides the save buttons at the bottom 

of the page.  

• We’ve fixed UI bugs with search in Fee Schedules, editing tax from Settings, Recent 

projects, Manage Subscriptions, Budget Templates, and creating manual invoices. 

Project Monitoring 

We’ve made it easier to set up project monitoring and ensure consistency across your 

projects: 

• When cloning a project, the Project Monitoring settings for the main project or 

phases can now be cloned along with the other settings.  

• When defining Project Templates, you can now set phases to include Project 

Monitoring settings of the parent project. Projects created from the template will 

then inherit the Project Monitoring setting. 

 

Time Card subtotals 

The Workflow Subtotals on Time Card have been updated: 

• Forwarded entries now have their own subtotal row, as requested by customers. 

• Rejected entries are now categorized under Unsubmitted. 

• Un-Approved entries are now categorized Submitted. 

 

 
 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o Duplicate invoice numbers could be assigned when multiple users were 

using Create Batch Invoice at the same time. This is fixed. 

o WUD could be changed when a project was billed in certain scenarios. This 

is fixed. 

• CRM 

o The Sales Goal Performance Widget would not show totals if multiple of 

them were added to a Dashboard. This is fixed. 

o When a Lead was assigned, the email would show an incorrect subject line. 

This is fixed. 

• ePayments 

o You’ll now see now more clear error messages if an ePayment cannot be 

made. 



o Previously, changes to ePayments settings could cause payments to get 

out of sync. This is fixed. 

o In certain cases, Statements could be paid twice. This is fixed. 

• Expense 

o The Expense Cost Rate could be deleted if a Vendor Bill was opened, then 

saved with no changes. This is fixed. 

• Project 

o Changing the billing contact on a project could cause an error. This is 

fixed. 

• Reports 

o Check Details report would show an incorrect value for "Type" when 

rerunning the report. This is fixed. 

o We fixed rounding issues on the Quarterly Profit and Loss Accrual Basis 

and Monthly Profit and Loss Accrual/Cash Basis reports. 

o Project Allocation Earned Revenue Distributive Forecast Report could show 

the wrong Amount Spent in certain situations. This is fixed. 

o Security Details report displayed incorrect status for Fee Schedule. This is 

fixed. 

o The Project List report formatted phases differently to other reports. This is 

fixed. 

o Client Transactions report showed an incorrect balance while using 

Payment method filter. This is fixed. 

o The sum function would not work if the P/L Drill Down report was 

exported to Excel. This is fixed. 

• Xero accounting integration 

o Entries could not be exported to Xero for monthly time cards. This is fixed. 

 
 

 

VERSION 1.1.206 RELEASED ON NOVEMBER 28, 2023  
  
  

Release Spotlight 

You can now automatically send employees reminders when their time cards are 

incomplete with CORE Time Card Monitoring! Configure the reminders from the 

Monitoring under Settings menu. 

Time Card monitoring relies on Standard Hours per Week being set for an employee. This 

allows CORE to know what a "complete" time card is for an employee. Use the Employee 



Missing Time Week View report to see which employees don't have Standard Hours per 

Week set and batch update from the Employees page to set the value. 

Time Card reminders are sent weekly. You can set what day of the week and time you 

want the reminder sent based on your company work week start. For example, if your 

work week starts on Sunday, you could set the reminder to Friday at 4pm or the Following 

Monday at 9am. Optionally, you can set follow up reminders every 24, 48, or 72 hours 

later. 

At the time specified, CORE will send an email and mobile app reminder to any 

employee who has not met their Standard Hours or has time entered, but not submitted 

on their time card for the week. 

This compliments the Project Monitoring feature released in September. If you would 

like additional monitors, please send your suggestions to CORE-ideas@bqe.com! 

 

Product Enhancements  
 

Navigation Enhancements 

As we continue to prepare for the retirement of the Classic View on December 5, 2023, 

we’ve made the following improvements to the new UI to make navigation faster: 

• Projects menu – added a link to Project Assignments under the Templates & Tools 

heading. 

• Projects menu – added links to Documents, Notes, and To-Dos pages. This had 

been requested by a number of customers. 

• If you pin the navigation menu open, it will now stay open between logins.  

QuickBooks troubleshooting 

We've added improved logging to our QuickBooks Online integration to make it easier 

for you to identify problems with the integration. CORE will now show a message when 

an invoice can't be sent to QuickBooks Online because it is attached to a tax account or 

if an account has been deleted in QuickBooks Online. Keep an eye out for more 

improvements to our QuickBooks Online integration! 

 

New columns in T&E Reviewer 

We’ve added columns for Comp Time, Income Account, and Expense Account to T&E 

Reviewer as requested by customers. 
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Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o Exporting Invoices page to CSV did not include all columns. This is fixed. 

o The formatting bar for memos and custom fields didn’t work and covered 

the text in some scenarios. This is fixed. 

o There could be a penny difference on Cost Plus invoices. This is fixed. 

o Emailing statements would not respect the filters applied before emailing. 

This is fixed. 

o Invoices could be missed in a statement based on the date filters. This is 

fixed. 

o On Create Batch Invoice, editing WUD for one entry applied the change to 

all entries. This is fixed. 

• Budgets 

o Budget templates could be duplicated in certain scenarios. This is fixed. 

o Users with delete budget items permission could not do so from within a 

project. This is fixed. 

• Client  

o Updates and bulk updates to Clients wouldn’t be saved properly in certain 

cases. This is fixed. 

o There were errors with the search function for Client. This is fixed. 

• Cloud Feeds 

o Selecting “Refresh” could fail to get new transactions. This is fixed. 

• CRM 

o Proposals created from an Opportunity did not inherit name, description, 

and value from Opportunity. This is fixed. 

o The Proposal Builder did not have an option to indicate discount on the 

Quote. This is fixed. 

• Dashboards 

o Employee Allocations widget was not filtering out "Cancelled" projects to 

align with Allocations page. This is fixed. 

o Income vs Expenses widget would show incorrect expenses when using 

class filter. This is fixed. 

o To-Dos widget would not correctly sort by Due Date order or display 

Project & Client names correctly. This is fixed. 

o Time Performance widget could double count entries which can be 

Vacation, Sick, Holiday, or Comp time in Settings. This is fixed. 

• ePayments 



o The pay now screen showed the wrong Due Date for Retainer Invoices. 

This is fixed. 

o ePayment invoices could have broken links or icons when emailed. This is 

fixed. 

• Expenses 

o Custom field data for an Expense Entry was not being saved in certain 

scenarios. This is fixed. 

o The Totals could disappear from the Expense Entries page when the 

Expense Group filter was applied. This is fixed. 

• Fee Schedule 

o Not all the columns would display in the Fee Schedule table for some 

users. This is fixed. 

• HR 

o “Available Hours” could be inconsistent due to rounding differences when 

using different filters. This is fixed. 

o “Available Balance” would be incorrect when two benefits are assigned to 

an employee. This is fixed. 

o Users were unable to Edit Question type in Review Templates from 

Settings. This is fixed. 

• Payments 

o When making a single payment for two retainer invoices on different 

projects, the payment would save under one project only. This is fixed. 

• Projects 

o Created by and Updated by fields could be incorrectly set. This is fixed. 

o On Assignment tab, you were unable to sort on the columns. This is fixed. 

o Searches including 2 digits on the Project list would cause an error. This is 

fixed. 

• Purchase Orders 

o Items in a purchase order could get reordered incorrectly if one of the 

items was deleted. This is fixed. 

• Reports 

o Project List report did not respect the “Hide Phases” display option when 

grouping by Master Project. This is fixed. 

o Updated invoice numbers were not reflected on the GL report. This is 

fixed. 

o Scheduled reports could show Charge Amount to employees who should 

not have had access to it. This is fixed. 

o Balance Sheet Cash Basis report could display an incorrect Total Liabilities. 

This is fixed. 



o The “Unsubmitted” status filter was not working correctly on the Workflow 

Details Report for Time Entries. This is fixed. 

o Aged WIP with AR report could fail to run when a custom field filter was 

applied. This is fixed. 

o AR Aging 8 Steps report showed the wrong time buckets when scheduled 

weekly. This is fixed. 

o Balance Sheet by Class Accrual report could be incorrect in certain 

scenarios. This is fixed. 

o There were errors when exporting Benefit Assignment report to CSV. This 

is fixed. 

• System 

o Customers from Saudi Arabia could get an error when logging in. This is 

fixed. 

• Time  

o Before on Time Card, when opening the memo box the status badge 

would only displayed when Show Status was enabled. This is fixed. 

o The Time Card memo icon before was unclear. Now, when a memo exists a 

solid icon displays. When a memo is missing but can be added a hollow 

icon displays. 

o On Time Card – Day view and Time Entries, users could edit approved 

entries without proper permission. This is fixed. 

• T&E Reviewer 

o On T&E Reviewer, users were unable to view the whole JPEG attachment in 

previewer (can't scroll or zoom). This is fixed. 

o The Employees filters could display bad data on T&E Reviewer. This is 

fixed. 

o The Class column was not exported to CSV. This is fixed. 

• Vendors 

o Previously, you could not void a vendor bill if it had a credit against it. This 

is fixed. 

o When importing Vendors, it was not possible to map the Company name 

field. This is fixed. 

o Custom cost rates of expenses could be lost on Vendor Bills. This is fixed. 

 

 

 

VERSION 1.1.205 RELEASED ON NOVEMBER 14, 2023  
  
  

Release Spotlight 



This release includes the next milestone on the transition to CORE’s new look: all 

customers have been set to use the new look! You will continue to have access to the 

Classic View until December 5, 2023, when we disable it for all users. 

As a reminder, the new look provides clarity in the navigation and helps to improve the 

overall user experience, including new user onboarding. Key changes include: 

• Global Settings Location: We've moved all the global settings to the new Settings 

menu in the bottom left. 

• Productivity Tools Re-organized: You'll find these screens within the projects or 

other global settings. 

• Lists Moved: Lists can be found in the Settings menu at the bottom left in their 

respective category. 

We’ve made the following improvements to the new look based on customer feedback: 

• Added a Templates & Tools section to the Projects menu which makes accessing 

Project Templates, Budget Templates, and Fee Schedules much easier!  

• Simplified the display of the Settings menu. 

• Addressed bugs related to custom labels, invoice filtering, and more. 

Stay tuned for more of your requested improvements in the coming weeks! 

 

Product Enhancements  
 

Batch Invoicing 

We’ve made the Batch Invoicing page much faster! This release reduces time to load 

results on the page by more than 50% for our largest customers. 

 

 

Enhanced Employee Missing Time Week View report  

It's now easier to see how all your employees are performing with the Employee Missing 

Time Week View report. The report now shows all employees and categorizes them by 

employees who haven’t met their standard hours, employees that have met their standard 

hours, and employees who don’t have standard hours defined.  

 

Set Project Monitoring with templates 

Project Monitoring can now be copied to new projects from a project template and to 

new phases from the parent project. Project monitoring sends automated monitors to 

inform you about key Budget or Contract milestones, like when the Approved Spent 



amount exceeds 50% of your Contract. Customize your thresholds and who on your team 

should be notified by selecting Project > General > Monitoring. 

 

Additional filtering on Aged Receivable Dashboard 

The Aged Receivable widget on your Dashboard can now be filtered by either Project 

Status or by Client. 

 
 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

• Billing 

o Late fee invoices were showing a phase name instead of the parent 

project's name. This is fixed. 

• ePayments 

o In a specific scenario, a client was not able to pay an outstanding balance 

on an invoice. This is fixed. 

• Time and Expense 

o Some users were encountering Time Card display issues where the Total 

column was too narrow. This is fixed. 

o We added a copy option to the Time Card memo, which makes it easier to 

copy for users who don't have access to edit the memo. 

o The Time & Expense Reviewer batch workflow indicator could get stuck 

and not update. This is fixed. 

o Sorting by Submit Status on Time Entry page would cause an empty table 

to display. This is fixed. 

• Reports 

o Editing Invoice numbers would not always update across financial reports, 

including P&L Accrual Drill Down. This is fixed. 

o The Project List report could display an incorrect Contract Balance, Spent 

amount, and WIP amount in certain scenarios. This is fixed. 

o The Balance Sheet Cash Basis report would sometimes show an AR or AP 

balance. This is fixed.   

o The dates used by the Semimonthly filter in the month of February were 

incorrect. This is fixed. 

 

 

 

VERSION 1.1.204 RELEASED ON NOVEMBER 2, 2023  



  
  

Release Spotlight 

We're thrilled to announce the transition to CORE’s new look, designed with you in mind! 

The new look provides clarity in the navigation and helps to improve the overall user 

experience, including new user onboarding. Get ready to experience a modern, intuitive, 

and powerful CORE like never before. 

What's New? 

• Sleek New Look: Say hello to a fresh, contemporary design that's not only easy on 

the eyes but also simplifies navigation. 

• Streamlined Features: We've optimized your favorite features, offering more 

intuitive and efficient workflows. 

• Customer-Driven Enhancements: Your feedback has guided us every step of the 

way, resulting in a CORE that truly caters to your needs. 

• No Functionality Left Behind: We've kept all your beloved functionality from the 

classic view, now seamlessly integrated into the new look. 

What's Changed? 

• Global Settings Location: We've moved all the global settings to the new Settings 

menu in the bottom-left. 

• Productivity Tools Re-organized: You'll find these screens within the projects or 

other global settings. 

• Lists Moved: Lists can be found in the Settings menu at the bottom left in their 

respective category. 

Mark Your Calendar 

• November 14, 2023: Get ready as we turn on the new look for all users. 

• December 5, 2023: Say bye to the classic view as we disable it for all users. 

Stay tuned for more updates and get ready to explore the next level of CORE excellence.  

Product Enhancements  
 

Time card improvements:  

• We’ve simplified the "Auto-create Time Card activities" user setting to make it 

easier to use. Entries will auto-create if you’ve recently billed time against them, 

and if you remove a time entry it won't reappear until you add it back to your Time 

Card.  



• You can now clear formatting from memos to help you copy & paste memos from 

another application. Select the text and click the  icon to clear formatting. 

• We’ve made it easier to close the Time Card memo modal. Now you can use the 

Esc key or click away from the modal to close it and see more of the Time Card. 

 

Simplified project navigation: We've relabeled "Manage Projects" to "Projects" and listed 

the recent projects at the top of the menu so the recent projects are easier to find. In 

upcoming releases, we’ll make it easier to access key features like project templates, 

documents, and to-dos. 

 
 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Billing 

o Users in Costa Rica were encountering errors entering values on Batch 

Invoice. This is fixed. 

o The memo field was simplified to make it easier to know when the memo 

is saved. This is fixed. 

• Budget 

o In certain cases, budget line items were not saved. This is fixed. 

o When creating new budget from existing the search function didn’t work 

consistently. This is fixed. 

• ePayments 

o Customers using statements with ePayments could encounter issues with 

partial payments and email notifications. These issues are fixed. 

• Project 

o Phases created from a template could not be reordered in certain cases. 

This is fixed. 

o Late fee invoice amounts were included in the Billed values on the 

Structure tab. This is fixed. 

• Public API 

o Creating checks using the isEFT field was causing an error. This is fixed. 

• Reports 

o The total of the P&L Cash Basis report could differ from the Balance Sheet 

Cash report by a few pennies. This is fixed. 

o Project T&E report would group values incorrectly if a Vendor & an 

Employee shared the same display name. 



o The drill downs didn’t work properly on the Monthly Financial Budget vs 

Actual report. This is fixed. 

o Retainer reconciliation report was missing the ability to sort by date. This is 

fixed. 

• QuickBooks Integration  

o Sending a phase with a billing of zero to QuickBooks would result in an 

error. This is fixed. 

 

 

VERSION 1.1.203 RELEASED ON OCTOBER 17, 2023  
  
  

Product Enhancements  
 

Easier access to T&E entries pending approval during invoicing: From Batch Invoice, you 

can now right click to review T&E entries pending approval to open in a new tab. 

 

Time & Expense improvements: We made the following updates to T&E: 

• Time card font returned to standard size. We had made the font larger in a prior 

release, but customers didn't like it. 

• For both Time and Expense Entries, the security bits are now more consistent and 

clear. Un-submit is now allowed only if you have "Allow edit submitted entry" and 

Un-approve the entries of others is now allowed only if you have "Allow Approve 

entries of others". 

 

Aged WIP with AR report updates: It's now easier to track billing performance on the Aged 

WIP with AR report with the ability to Group By Client, Client Manager, Master Project, 

Project, or PM.  

 

Customize columns on Employee List report: You can now select up to 7 custom columns 

on the Employee List report. Custom columns are also available on the Client List and 

Project List reports. 

 

Vendor Bill API filtering: Finding the right payment is now easier and faster when using 

the Vendor Bill API with filtering by payment status & balance. 

 
 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  



 

• Billing 

o The Billed to Date column on Create Batch Invoice did not include 

Expenses in some cases. This is fixed. 

o When sending invoices, in certain cases you couldn’t select an email to 

add to the CC line. This is fixed. 

o Certain invoice templates were including late fees in the percent complete. 

This is fixed. 

o A retainer memo could appear incorrectly on an invoice if a reference 

number was reused. This is fixed. 

• CRM 

o When using the group by setting, the Contacts report would be blank. This 

is fixed. 

o The Opportunities report would not sort by stage. This is fixed. 

• ePayments 

o In certain scenarios, the credit card fee would be recorded incorrectly on 

the ePayment deposit. This is fixed. 

• Mobile 

o Scrolling was not working when opening an ePayment invoice or 

statement from the mobile app. This is fixed. 

• Project 

o On very large projects, the existing budgets would not load when creating 

a budget from existing budget. This is fixed. 

o In the new UI, creating a PO from the budget section could cause the 

screen to freeze. This is fixed. 

o Batch updating To Dos could cause an error. This is fixed. 

o When creating a project from a template, the status of the project was 

always set to Active instead of the value in the template. This is fixed. 

• Reports 

o Large currency amounts would display incorrectly on the Monthly Financial 

Budget vs Actual report. This is fixed. 

o The AR Aging 8 Steps report could not be exported to PDF. This is fixed. 

• Settings 

o In the new UI, not all Activities would display when merging T&E Activities 

from the Settings page. This is fixed. 

o In the new UI, certain screens would not display under Favorites. This is 

fixed. 

o When using custom labels and a phone number with extension, the 

contact record could get duplicated. This is fixed. 

• Time & Expense 



o Date and currency formatting errors could appear when entering time or 

expenses for customers in certain countries (Costa Rica, Dominican 

Republic, Jamaica, Philippines, South Africa). This is fixed. 

o Time entries were not using the correct Cost Rate when an activity was set 

up in a fee schedule and for an employee. This is fixed. 
 

 

 

VERSION 1.1.202 RELEASED ON SEPTEMBER 29, 2023  
  
  

Release Spotlight   
 

Enhanced status tracking on Time Card  

We’ve made it easier to read and understand your Time Card with subtotaling and 

improved display of statuses in the week view. 

 

You can enable subtotaling by workflow status to see how time is progressing from 

submission through billing. Or quickly toggle to subtotal by entry details – including how 

many hours are marked non-billable, extra, comp, or overtime. Plus, you can filter by any 

of the subtotals to focus on certain entries. 

 

Other improvements made to Time Card: 

• Less chance for error – uneditable entries are clearly identified in gray. 

• Easier to read – larger text size for key information and consistent indicators for 

entry status. 

• Fewer clicks – Comp time can now be set on the memo modal instead of having to 

leave the page. 

• Plus Time Card is faster!!! We’re excited to say we added these new features and 

made Time Card 40% faster! 

 

Soon, we’ll have a more improvements to how removing time entries works on your Time 

Card. 

 
 

Product Enhancements  
 

Faster saved filters: We have improved the performance of saved filters across CORE. 

Customers who use filters regularly will see the biggest improvement, with pages loading 

in half of the time. 

 



Easier error tracking: Errors in CORE will now be accompanied by a unique reference or 

correlation ID. If you encounter an error, include this correlation ID when reporting to 

Support@bqe.com for a faster resolution.  
 

Application Stability:  
 

This update fixes many issues reported by our users. Key fixes are listed below and are 

organized by module:  

 

• Billing 

o Certain recurring projects could be missing on Create Batch Invoice when 

filtering by recurring projects. This is fixed. 

o Invoices attached as .zip files to emails sent via CORE Outlook could be 

corrupted and were unable to be opened. This is fixed. 

o Create Batch Invoice would throw an error in some cases when over 1,000 

projects were loaded. This is fixed. 

o A rounding issue could cause the Invoices screen and the invoice 

document to differ by 0.01. This is fixed. 

• CRM 

o The Opportunities report was not displaying correct records when a filter 

was applied on a custom field. This is fixed.  

o The Leads page could incorrectly display City and State. This is fixed. 

• ePayments 

o ePayment fees were incorrectly displayed on the ePayment Details, 

ePayment Deposits Details, and ePayment Deposits Summary reports. This 

caused totals to display incorrectly. This is fixed. 

o Changing the From or Fee Account for a deposit could affect the deposit 

Amount. This is fixed. 

• Project 

o Customers had to re-enter the quick filter when navigating back to the 

Manage Projects page from within a project. This is fixed. 

o On Main projects, the project contract amount was displayed to users who 

should not have had access to the contract amount. This is fixed. 

o Once an invoice template was assigned to a project template, it could not 

be removed. The invoice template can now be removed. 

o When a quick filter is in use on Manage Projects page and a batch update 

is made, the update would not always take effect. This is resolved. 

• Settings 

o Customers were unable to set their DCAA password. This is fixed. 

• Time & Expense 

o The memo toggle was not working in some situations. This is fixed. 
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o Markup could be stored incorrectly when expenses were added via mobile. 

This is fixed. 

o The link to the T&E Reviewer screen from the email notification would not 

go to the correct page. This is fixed. 

 

 

 

VERSION 1.1.201 RELEASED ON SEPTEMBER 15, 2023  

  
Product Enhancements  

ePayments awaiting payout: When a client has initiated a payment via BQE ePayments, 

and is awaiting payout, you will now see a banner message on the Deposits screen 

informing you of the status. With a single click, you can open the ePayment Details 

report and see which payments are awaiting payout.  
  

Batch Update improvements in T&E Reviewer: You can now more easily track your batch 

updates to T&E and batch invoice entries. Before, when updating hundreds of records, it 

was unclear if the changes had been made or were still in progress. You will now receive 

a notification when the batch update is finished, confirming the number of records 

which were updated and if there were failures.  
  

Reports: We have made several improvements to your reporting experience:   

• The Client List report now supports column customization.  

• The Employee Daily Time Card report is 20% faster and has additional filters.   

• The Billed Time & Expenses report is 50% faster on average.  

  

Application Stability  

This update fixes many issues reported by our users, ranging from minor annoyances to 

critical fixes to our billing, reporting, and other modules.  

• Billing  

o Projects would appear incorrectly when filtering by Master Project and 

combining by Client. This is fixed.  

o Some users were encountering a timeout when generating hundreds of 

invoices at once. This is fixed.  

• CRM  

o Smart fields were not being populated when emailing Prospects or Leads 

from CRM. This is fixed.  

• Emails  



o The configuration to send emails via Office365 would incorrectly reset to 

CORE sending emails. This is fixed.  

• ePayments  

o Clients were encountering issues paying dozens of invoices at once from a 

single statement. This is fixed.  

o Canadian clients using a credit card would encounter an error making a 

payment. This is fixed.  

• Project  

o The Spent Amount wasn’t matching across the project. The Structure tab, 

Performance tab, and project snapshot now align.   

• QuickBooks Integration  

o Some customers were encountering issues connecting with QuickBooks. 

This is fixed.  

o QuickBooks Online invoice payments would be sent to CORE as retainers 

prior to the invoice being synced. This is fixed.  

• Reports  

o There would be a rate mismatch between the screen and Project 

Allocation Earned Revenue Distributive Forecast report. This is fixed.  

o The Unpaid Vendor Bill report date filters were not working in all cases. 

This is fixed.  

o The Trial Balance Accrual Basis report and drill down would be wrong 

when tax was used. This is fixed.  

• Time Card  

o The memo icon was showing even when no time entries were entered if 

you pre-populated the memo from, say, a fee schedule. This is fixed.  

 

 

 

VERSION 1.1.200 RELEASED ON SEPTEMBER 1, 2023  
 

  
Release Spotlight   
 

Automatically track key project milestones with CORE Monitoring   

We’re excited to introduce CORE Monitoring! You can now set automated monitors to 

inform you about key Budget or Contract milestones. Customize your thresholds and who 

on your team should be notified, and CORE will send out in-app or email notifications 

when the Approved Spent reaches the milestone.  
 



Set up your monitors from your project, select General, then Monitoring. We look forward 

to adding additional monitors, so if you have something you’d like to monitor please send 

your request to CORE-ideas@bqe.com.   

 
 

Product Enhancements  
 

Faster, easier to use Time Card and memos: We have made three key improvements to 

Time Card based on customer submissions to CORE-ideas@bqe.com:    

• We’ve simplified the memo entry process on Time Card – Week View. You 

can now use Tab to move between the time entry cell and the memo – no clicks 

required!   

• Memo text which is defined on Activity, Expense, Fee schedule service or 

Fee Schedule will populate right when you open the memo. This applies to all 

the time and expense entry pages.   

• The totals on the Time Card now load 30% faster.  

Keep an eye out for more improvements in upcoming releases that make it easier to 

understand the status of your time entries.  
 

Project navigation breadcrumb: We’ve added the breadcrumb to the project details 

screens to make it easier to see where you are in a project and navigate with fewer clicks. 

Click on any parent phase to jump up the project hierarchy. You can configure what 

project and phase information appears in your breadcrumb from the Project section of 

Settings.  
 

ePayment Deposits Detailed Report: The new ePayment Deposits Detailed Report delivers 

a detailed view of all payments and fees associated with ePayments. Accessible from the 

Payments screen.  
 

Faster Create Batch Billing screen: We have made significant performance improvements 

to Create Batch Billing screen. Customers with large project sets will see the biggest 

improvement, with projects loading in 20% of the time.   
 

  

Application Stability:  
 

This update fixes many long-standing issues reported by our users, ranging from minor 

annoyances to critical fixes to our billing, reporting and other modules.  

• Accounting  

o A performance issue in Chart of Accounts was fixed.  

o Balance Sheet by Class Accrual Report was incorrect after creating a 

check with one or more negative line items. This was fixed.  

mailto:CORE-ideas@bqe.com
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o 1099 Report was not displaying vendor expenses paid by credit 

card. This was fixed.  

• Billing  

o Invoices on cost plus percent projects could have a penny round 

incorrectly. This was fixed.  

o Invoice numbers were not displayed properly when exported to CSV 

from Invoice list and Time and Expense reviewer screens. This was 

fixed.  

o Invoice templates were not displaying certain fields properly when 

Custom Labels were used. This was fixed.  

• ePayments  

o Deposit details could display a penny difference for ePayments. This 

was fixed.  

o Credit Card Passthrough fees were incorrectly labeled as ACH 

Passthrough fees. This was fixed.   

• Reports  

o The Project Time and Expense Report was missing headers when 

exported to CSV. This was fixed.  

o Work In Progress Detail Report displayed cost amount even when 

cost rates were hidden for a user. This was fixed.  

o The summary of the Project Account Details Report did not follow 

the time expense date filter. This was fixed.  

o Project Time and Expenses Report now supports a new filter – 

Invoice number.  

  

 

VERSION 1.1.199 RELEASED ON AUGUST 15, 2023 

 

Product Enhancements: 

Clients ePayments made easier: We have enhanced the Invoice ePayments page to alert 

your clients about any additional unpaid Invoices after they have successfully recorded a 

payment. This will be controlled by setting ePayments > Settings > Ask Customers to pay 

other unpaid Invoices when they pay an Invoice. 

BQE ePayments Fee visibility: You will now be able to click the amount fields under 

Deposits>New Funds section to see the associated Payments and invoices. 



Time and Expense Detailed report: New Time and Expense Detailed report added to the 

report list. The report supports Column selector and multi-Level grouping. 

Easier accessibility to Memos in Timecard: We have renamed the menu item, show entry 

details to Show memo. You will not be able to turn it off if your company level setting, 

Time entry memo required is on. 

Easier accessibility to Timecard Preferences (Classic UI)/ Time Settings (New UI): We have 

swapped the position of Show/ hide status option with Time Settings (New UI) / 

Preferences (Classic UI) to make it easier for you to reach to the preferences that drive 

your timecard. 

Contract amount remaining: You will now see the unallocated contract amount under 

contract amount field in Project Details and in Project>Structure tab. This will help in 

avoiding the overallocation of contract amount to phases of a Main type project. 

 

Application Stability: 

This update fixes many long-standing issues reported by our users, ranging from minor 

annoyances to critical fixes to our billing, reporting and other modules. 

 

• Time and Expenses report now supports new filter – Invoice number. 

• Payroll report now supports new filter - Paid. 

• Application will not allow updating Employees in time or expense sections while 

editing an invoice. 

• Updated column name from Open AR to Open Invoices in Project List report, 

column selection tab. 

• Added dynamic tooltips to Employee and Vendor Utilization Widget to reflect the 

value set in Global settings. 

• The selection of show dropdown under Project > Assignments tab is now 

remembered when you switch between a project to one of its phases. 

• We have added a disclaimer to the Workflow report to make it obvious which 

entries are included in the report. 

• ePayments don't move to success due to "not linked to any employee" error. This 

was fixed. 

• Invoice Screen -> Filtering by Project manager would sometimes throw an error. 

This was fixed. 



• Batch invoice would through an error when project count was more than 1500 

projects. This was fixed. 

• AR Aging' report displayed a strange row with text '330' or -240 on the report. 

This was fixed. 

• Employee Time card summary report displayed approved entries even when Un 

approved was used. This was fixed. 

• Charge column on Project Time and Expenses report displayed amounts with 6 

decimal places. This was fixed. 

• Omani currency was not reflected in the project screen. This was fixed. 

• Expense Group filter was not working in Project Time and Expenses' report. This 

was fixed. 

• Voided Bill Payments showed up on AP Aging report. This was fixed. 

• Negative amounts were not handled properly in Time and Expense report. This 

was fixed. 

• Internal Server error was displayed while running reports in some cases. This was 

fixed. 

• Spent columns in the Budget comparison report displayed unapproved 

time/expense entries. This was fixed. 

• Email notifications were providing incorrect information when invoices on a 

statement were partially paid using cc. This was fixed. 

• Grouping changed in Billed Time and Expense report on memorizing the report. 

This was fixed. 

• The Billable work history report displayed incorrect data in a particular scenario. 

This was fixed. 

• An issue was report in Staff workload widget > used hours. This was fixed. 

• Expenses by vendor report displayed incorrect amount in one of the cases. This 

was fixed. 

• Some Months/ Weeks were ignored in cash flow widget, Money owed widget and 

Retainer balances widget. This was fixed. 

• Penny difference observed in Phased, Cost-plus Invoice Templates. This was fixed. 

• Retainer Available Column was displaying incorrect values in one case. This was 

fixed. 

• While trying to find related vendor bills after paying an invoice, all vendor bills 

were not displayed. This was fixed. 

• Money Owed widget was displaying incorrect Aging. This was fixed. 

• Paid Time off widget, Time Performance Widget and Employee Paid Time Off 

report show incorrect values in one scenario. This was fixed. 

 



_____________ 

 

VERSION 1.1.198 RELEASED ON AUGUST 04, 2023 

 

Product Enhancements: 

Time and Expense Summarized report: New Time and Expense Summarized report added 

to the report list. The report supports Column selector and multi-Level grouping. 

Enhanced dropdowns in Report center: Dropdowns in report center are now consistent 

with rest of the application. These dropdowns will entertain the text entered to filter 

dropdown lists.  

 

Application Stability: 

This update fixes many long-standing issues reported by our users, ranging from minor 

annoyances to critical fixes to our billing, reporting modules and other modules. 

• Create batch Invoice > Processing large set of Invoices would error out. This was 

fixed. 

• BQE ePayments > Accounts were sometimes flagged as inactive. This was fixed. 

• Invoice Emails > Using Outlook provider, Invoices were sent out to unintended 

customers in a scenario. This was fixed. 

• ClientPay > Pass through Fee calculation for ClientPay was charged. Restored the 

legacy calculations. 

• Invoice screen > Manage documents was not showing full list of expense 

attachments. This was fixed. 

• New UI > New row was not getting added in split billing On Billing Options in the 

Edit project screen. This was fixed. 

• Opportunity > Budget attributes were associated to parent project instead of the 

phases when creating a project from an opportunity. This was fixed. 

• Opportunity > While converting an opportunity to a project. The associated Fee 

schedule was not copied. This was fixed. 



• Project screen > Made the toggle state of show/ hide phases intuitive and easier 

to understand. 

• Timecard > Managers were not able to create/ update memos of employee even 

when security setting, allow access to employee I manage was set to true for 

them. This was fixed. 

• Project Screen> Creating a client contact from billing contact dropdown > quick 

create would create a contact with inactive status. This was fixed. 

• Timecard > Allocation summary in Timecard would show double used hours in 

some cases. This was fixed. 

• Financial Budgets > Updating Memos was updating the Fiscal year field. This was 

fixed. 

• QuickBooks Online Sync > Invoice send would not respect start date filter if end 

date was left empty. This was fixed. 

• Timecard > Timecard would not reflect the extra flag when an activity marked 

extra was used. This was fixed. 

• Create batch Invoice-> Actual contract type of main project was not displayed 

when projects with multiple parent – child hierarchy was used. This was fixed. 

• Allocation screen > Performance issue was observed while copying a large dataset 

of allocation from a project. This was fixed. 

• Retainer screen > Incorrect balance in total Received column was displayed while 

processing a large set of retainer payments for a project. This was fixed. 

• Productivity Tools > All groups were shown to users with limited security. This was 

fixed. 

• Invoice screen > Voiding current Late fee invoices and regenerating those would 

result in duplicate invoice number associations. This was fixed. 

• Credit Memo > While downloading the pdf of a particular entry. All credit memos 

were displayed on the pdf. This was fixed.  

• Create batch Invoice > Glitch related to net bill being incorrectly calculated while 

unchecking the “Use billing schedule reminder date” was fixed. 

• Recurring Invoice > Wrong “next bill date” was being displayed in a scenario. This 

was fixed. 

• Timecard > Users from "RWANDA" were not able to view their timecards. This was 

fixed. 

• Manual Invoices > For Projects without any time or expense, Income account was 

not inherited from the Project. This was fixed. 

• HR Benefits > Benefits were incorrectly calculated in certain scenarios. This was 

fixed. 



• Retainer payment > Retainer payment date was not updated to the invoice when 

applied in the invoice screen. This was fixed. 

• Reports > Retained Earnings Account was not following display settings on any 

financial reports. This was fixed. 

• Reports > Newly added Project List report was throwing exception in a certain 

combination of columns. This was fixed. 

• Scheduling > In a certain scenario, scheduled reports were not updating if they 

were created from a memorized report. This was fixed. 

• Reports: AP Aging Credit report was fixed to show a certain type of General 

Journal entries. 

• Reports > Benefit Usage report was showing up blank in a particular scenario from 

report center. This was fixed. 

• Reports > Financial Budget Vs Actual report was not grouping sub accounts 

properly. This was fixed. 

• Reports > Email Body was showing up on Statement report itself if the email was 

sent without preview. This was fixed. 

• Reports > Project Account Details report was not supporting the Document Map. 

This was implemented. 

• Reports > Activity Items report was not respecting the Group Filter. This was fixed. 

• Invoices: Joint and Phased Invoices did not include Retainer Payments in Account 

Summary's BTD and PTD fields. 

• Report Center: For certain users, Custom reports tab was showing unused 

categories. Tab was handled to show only Active categories. 

• Reports > Project Allocation Units Report fails to show data under other tasks. 

This was fixed. 

• Reports > Client Performance Report had inconsistency with regards to Retainer 

Balance. This was fixed. 

• Invoice Collections > Screen would show Paid invoices if, user navigates from 

Money Owed Widget on Dashboard. This was handled to show only Open 

invoices. 

• Dashboard > Workflow widget: Purchase Order takes user to T&E Reviewer 

instead of Purchase Order screen. This was handled to open Purchase order 

screen. 

• Dashboard > For Canadian users, Allocation widget would not show details. This 

was fixed. 

• Invoice Collections > Notes on Invoice Collection screen and Collection Notes 

with Aging report would show inconsistent dates. This was fixed. 

• Reports > Balance of individual Accounts on Quarterly Financial Budget Vs Actual 

report would not tally with Total Income. This was handled on Report template. 



• Reports > AP Aging report would show employees upon filter by Vendor Group. 

This was fixed. 

• Dashboard > Project Schedule by Allocation widget does not display chart for 

client. This was fixed. 

• Scheduling > In certain cases Run Schedule would not work if we kept the email 

recipient as Employee Manager. 

• Reports > Filters would repeat on Cash Flow Monthly Statement. This was fixed. 

• Reports > Client Group filter was broken on Client Performance Report. This was 

fixed. 

 

 

_____________ 

 

VERSION 1.1.197 RELEASED ON JULY 21, 2023 

 

Application Stability: 

This update fixes many long-standing issues reported by our users, ranging from minor 

annoyances to critical fixes to our billing, reporting modules and other modules. 

• Account List> Not all accounts were loaded when sorting by account number. This 

was fixed. 

• Activity > Sort column is not remembered when a new activity is added. This was 

fixed. 

• Allocations> Uses had reported issue with Projects/Resources duplicating in 

Forecasting Manual view. This was fixed. 

• Expense Entry >Check Number column not displaying data after applying a Bill 

Payment. This was fixed. 

• Create Batch Invoice > An issue with the billing screen would prevent any projects 

from loading when Invoicing using Project range filter. This was fixed. 

• Create Batch Invoice > Users would see a blank dropdown for Master Project if 

manager is selected as the primary column sort under Invoice Option screen. This 

was fixed. 



• Create Batch Invoice > Few users had reported issues with the exclude time and 

expense feature that prevented them from processing Invoices. This was fixed. 

• Credit Memos > The system would restrict the Project list to the ones that the 

user has been assigned as a project member. This was fixed. 

• CRM > When we win an opportunity and create a project using project template, 

the SFS and Project Assignments are not copied to the new project. This was 

corrected. 

• Dashboard > Hours widget on dashboard was not showing the correct details 

when the widget is used multiple time on the dashboard. This was fixed. 

• Dashboard > If we apply 'Assigned By' filter in the To-Dos widget, it does not 

display any data. This was corrected. 

• Dashboard > In certain scenarios, Money Owed widget would show Wrong Aging. 

This was fixed. 

• Dashboard > Project allocation widget does not show data against phased project 

when using resource filter. This was fixed. 

• Dashboard > Round off issue on PTO & Comp Hours widget. This was fixed. 

• Dashboard> Drilling down on Time related submissions in in the workflow widget 

would include expense entries in the reviewer screen. This was fixed. 

• Dashboard> Fixed an issue that would cause ToDos' to be repeated in the widget 

as many times as there are employees in the group. 

• Expense Entry > Fee Schedule rates were not being respected on updating an 

Expense entry. This was fixed. 

• Expense Entry > Fixed an issue with the tab key to move between various fields. 

• Expense Entry > Users had reported issues with the Batch update function for Paid 

flag. This was fixed. 

• HR Benefits > There was an incorrect roll over of balance hours when using reset 

of January 1. This was fixed. 

• Invoice Templates > 'Manual Invoice with Contract summary' invoice was showing 

tax part of contract. This was fixed. 

• Invoice Templates > There was an Issue Previewing Split Billing Invoice. This was 

fixed. 

• Invoice Templates> 'Manual Invoice Custom Ordering' Invoice template not 

showing in correct order. This was fixed. 

• Invoice Templates> There was an Issue with the Pay Now button link when 

previewing ePayments enabled Invoices together with an Invoice(s) that did not 

have ePayment option enabled. This was fixed. 

• Invoices > Invoice template preview makes CORE becomes unresponsive (if you 

click before the template preview loads). This was fixed. 

• Invoices > There was an issue with Custom Date filter on Invoices screen for 

Australian companies. This was fixed. 



• Invoices > When viewing the detail of a Phased Invoice, Phase ID would be shown 

instead of the Parent Project. This was fixed. 

• Manual Invoices > Fixed an issue with the "Approved Time and Expense" option 

skipping hours in the processed Invoice. 

• Payments > When receiving retainer jointly for 2 phases, it would show up under a 

single phase. This was fixed. 

• Project > Cloning a project with "Hold" creates the new Project in Active status. 

This was fixed.. 

• Project > Project Tabs would collapse on all screen resolutions. This was fixed. 

• Project > There was an issue with Project group and Project manager filter, when 

used in combination. This was fixed. 

• Projects > There was an issue when issuing batch update when filtering the list by 

Project status. This was fixed. 

• Reports > An issue was causing total income to double on monthly financial 

budget vs actual report. This was fixed. 

• Reports > 'As of filter' broken in monthly P&L accrual basis report. This was fixed. 

• Reports > Budget comparison summary report shows zero spent hours for many 

projects when Status filter is applied. This was fixed. 

• Reports > Cost and Bill Rate Security was not being followed on few reports. This 

was fixed. 

• Reports > Expenses by Vendor report filter was broken. This was fixed. 

• Reports > Fixed a display issue with Check Details report. 

• Reports > Fixed an Issue with custom fields AND filter in Employee Daily Time 

Card report. 

• Reports > Fixed an issue with Unpaid Vendor Bills report that prevented random 

unpaid bills from appearing on the report. 

• Reports > Quarterly Financial Budget vs Actual shows double filters. This was 

fixed. 

• Reports > Retained Earning Account does not obey the Display as Settings on 

Accounting Reports. This was fixed. 

• Reports > Updated Client Contact does not show up on Credit memo Receipt 

report. This was fixed. 

• Reports> Fixed an error when using preview format as Excel in AR Aging/AR 

Aging 5 Steps reports/Monthly Profit and Loss reports. 

• Reports> There was a typo in Standard Reconciliation Reports. It was fixed. 

• Reports> There was an issue in Project filter when saved as favorite/memorized 

report. This was fixed. 

• Reports> We have fixed an Issue with the 'Billable work history' report. 

• Security > There was an issue with Project security bits 'Allow set Billing 

Information' and 'Show billing options'. It was fixed. 



• Time Card >If the user sets country as OMAN in user profile, then Time card does 

not load. This was fixed. 

• Time Entry > Activity from Inactive group assigned to Project shows up in the 

Activity List Dropdown. This was fixed. 

• User Prefs> When saving default view to "Last Screen Visited", upon refresh it is 

set back to "Dashboard". This was fixed. 

• Vendor Bills > Link time expense->Time or Expense views>sort by date in AUS 

format is not correct. This was fixed. 

• Vendors > "Import from CSV" did not have a mapping option for the last name. 

This was corrected. 

 

 

_____________ 

 

VERSION 1.1.196 RELEASED ON JULY 07, 2023 

 

Product Enhancements: 

BQE ePayments Payout Reconciliation: Accounting users can benefit from real time 

syncing of bank payouts with CORE deposits. Each deposit will provide details on the 

enclosed payments as well as any transaction or non-transaction fee that was incurred as 

part of the payout. Additionally, in-app notifications will keep you informed about 

successful bank payouts. 

Invoice emailing with Outlook 365: Admin users can now connect firm’s Outlook 365 

account to CORE and designate it as the preferred email service for outbound Invoice 

emails. 

Project Contract Amount with Percent of Project: Now you can enforce project contract 

amount discipline across phases by turning on this new setting. Once turned on, the 

Project and their phases will not allow Project contract amounts to exceed the Parent 

project contract amount during set up. 

Processing Fee visibility: The Payment details screen now includes a breakdown of the 

processing fee associated with BQE ePayments. Additionally, you will find details about 

the processing fee on the ePayments page and in the payment confirmation emails. 



EPayment Deposits Reporting: The new ePayment Deposits report offers a concise 

overview of deposits associated with ePayments. This report presents key details such as 

the number of payments, fees, total payment amount, and total fee amount, providing a 

comprehensive snapshot of deposit information. Accessible from the Payments screen, 

this report delivers a summarized view that facilitates quick analysis and understanding. 

Enhanced Invoice Register Report: The Invoice Register report has been enhanced to 

allow up to three levels of grouping. The enhanced grouping options will be available on 

any standard instance of the Invoice Register report including Standard, Memorized, 

Favorite or Scheduled tabs. The re-organized records will allow you to review data more 

efficiently. 

Application Stability: 

• Invoice > Manual invoices were ignoring hours in one scenario. This was fixed. 

• Time Entry > Batch update of custom fields not working in a one scenario. This 

was fixed. 

• Time and Expense Reviewer > Actual hours can now be exported to csv. 

• Invoices > Vendor name was not displaying in case of joint invoices on one 

template. This was fixed. 

• Invoices > Memo not displayed in some scenarios in case of split invoices. 

• Fee schedule > Batch update of pay rate multiplier was not working. This was 

fixed. 

• Custom Fields > Custom fields related to Budget service and expense can now be 

created in the settings.  

• Sales Forecast > Sales forecast screen was displaying duplicate opportunity in one 

case. This was fixed. 

• Prospects > Importing prospect was failing in some cases. This was fixed. 

• New UI > Scrolling issue fixed in Fee schedule, security, and couple of other 

screens in settings area. 

• Projects > Table header position fixed in Budget tab. 

• Reports > Mismatch between HR Screen, PTO Widget and HR reports was 

reported in certain cases. This was fixed. 

• Reports > Realization Rate amount was added to Employee Time Detail Report. 

• Reports > "This Biweekly" filter would display incorrect results in certain cases. 

This was fixed. 

• Reports > Error was observed in Time and Expense Details Report in T&E Reviewer 

screen while Paid Date filter set. This was fixed. 

• Reports > Billed Time and Expense Report was incorrectly following alpha numeric 

sort. This was fixed. 



• Reports > Billing Analysis, Time and Expense, Payment Details, Percentage Billed, 

Client Transaction, AR Aging, Work in Hand Report, excel export was displaying 

#Value in place of blank cells and in certain cases Numbers were stored in text 

format. This was fixed. 

• Reports > Employee Time Card Summary Report was failing to export in certain 

cases. This was fixed. 

• Reports > Project Time and Expense Report was fixed for Penny difference with 

T&E Reviewer. This was fixed. 

• Reports > Purchase Order Invoice Report was not following Zip code masking. 

This was fixed. 

• Reports > Statement was missing invoices in Mountain Time Zone, if invoices are 

created and previewed on the last day of the month. This was fixed. 

• Reports > Workflow status filter was broken in Employee Time Details Report. This 

was fixed. 

• Reports > Invoice Register Report was not following Display Project set in Global 

Settings. This was fixed. 

• Reports > Work in Progress Details Report was showing Phase Name instead of 

Master Project Name in account summary if grouped by Master Project. This was 

fixed. 

• Reports > Billing Analysis Report was not leaving any space between Project 

Managers First and Last name. This was fixed. 

• Reports > Vendor Group filter was broken in Time Card Cross Tab report. This was 

fixed. 

• Reports > Project Account Details Report shows Paid Invoices as Open in Payment 

method was set as Credit. This was fixed. 

• Invoice template > Vendor name was not displayed in certain cases on Joint 

Invoice template. This was fixed. 

• Reports > Opportunity Report would repeat opportunities as number of times as 

tags linked to the prospect. This was fixed. 

• Reports > Transaction Date filter was broken in certain scenarios for Work In Hand 

report. This was fixed. 

• Reports > Open Purchase Order report would show extra page at the end. This 

was fixed. 

• Reports > Top N Clients report would show totals irrespective of filters assigned 

to it. This was fixed. 

• Dashboard > Workflow widget not directing to correct screen upon clicking 

Invoices or Vendor Bills. This was fixed. 

• Dashboard > Project Status Widget, would display Non-PM employees. This was 

fixed. 

 



 

_________________ 

 

 

VERSION 1.1.195 RELEASED ON JUNE 24, 2023 

 

Product Enhancements: 

Define Employee Utilization basis: On top of the default calculation that uses actual 

hours, we now offer the option to use standard hours or standard hours less deductions 

(include sick, vacation and holiday) as basis for calculating Employee Utilization, 

empowering Owners/admins to better understand how employees are truly utilizing their 

time against active, billable work and non-billable work. 

BQE ePayments updates:  

Updated ePayment Details report: We had added the “Net ePayments Amount” column to 

this report to help users understand the net payment amount. 

ePayments onboarding improvements: New users that sign up for BQE ePayments are 

now made aware of the mandatory 10 day hold for payouts as soon as they complete 

merchant onboarding. 

Manage ePayment profiles: This update adds the ability to delete ePayment profiles even 

though they are in use. This neat housekeeping feature will allow existing and new 

ePayment customers to consolidate their ePayment set up and manage a smaller list. 

Edit Deposits: Feel free to edit bank deposits that are tied to ePayments to make any 

adjustments, allowing for more accurate reconciliation with bank statements. 

Performance Optimizations:  

Add payments experience has been optimized to handle large number of Invoices (~300) 

in single payment. Similarly, we have optimized the Invoice number update to handle 

projects that have large number of phases (~350). 



 

Application Stability: 

• Account Reconciliations > Few accounts types like “Other Current Assets”, “Other 

Current Liabilities” were being ignore from the list of account that can be 

reconciled. This was fixed. 

• Projects > We have fixed an issue with documents security that would make 

project documents accessible even though the logged user was restricted to 

documents that they had created. 

• Projects > There was a UI distortion issue when switching projects in the Budget 

view. This was fixed. 

• Projects > Total project count would not show the correct number when 

automatic page scrolling for new records in collapses mode. This was fixed. 

• Invoices > Time/expense entry was being set as “billed” after excluding/deleting 

when creating a Manual Invoice. This was fixed 

• Messages > Optimized the list view to handle large number of messages 

(~1000’s) and also respond to sort actions. 

• Notes > We had fixed an issue that was preventing any formats to notes to be 

saved. 

 

_________________ 

 

 

VERSION 1.1.194 RELEASED ON JUNE 10, 2023 

 

Product Enhancements: 

Projects List Column Selector: The Projects List report has been improved to include 

more columns on the column selector. Companies can now mix and match more project 

data to view at once and improve their efficiency. 

Project Snapshot contextual reporting: The Billing Analysis report can now be launched 

from within the Project Snapshot to allow for quicker review of key project data. Users 

can click on the Usage section title to launch the contextual report from within the 

Project Snapshot. 



Improved pass through set up for BQE ePayments: Set up your pass-through preferences 

with confidence as we have optimized Credit card and ACH fees pass through. No more 

guessing as we will pre-fill the recommended values to achieve 100% pass through. A 

safety check was added to prevent admins from accidently setting up pass through that 

exceed your processing fees. 

Quickly access Payments: Payments tied to a deposit can now be opened in a separate 

tab by clicking on the amount field, thus giving users an easy way to access payment 

details. 

ePayments page and email enhancements: We have made updates to the ePayments 

page to help end clients with payment method and processing fees options. Also, added 

message footer text in the payment page and ePayments email, to highlight the top tier 

security promise that comes with BQE ePayments to help drive more ePayments. 

 

Application Stability: 

• Projects > An issue in the budget tab would prevent users from updating hours 

field for the parent project. This was fixed. 

• Projects > We have rectified an issue that prevented specific projects from 

appearing when active filter was applied. 

• Budget > There was in issue with pulling the correct rates when a fee schedule 

was associated to a budget. This was fixed. 

• Time and Expense > There was an issue with workflow filters when “approved” 

was excluded after select all checkbox was clicked in the filter dropdown. This was 

fixed 

• Time and Expense > Several non-US customers had reported an issue in the “As 

Of” date filter option. This was fixed. 

• Invoices > We were using the wrong label for ePayments section on this screen. 

This was corrected. 

• Invoices > The previously billed column under Invoice details was including MST 

amount and MET amount as well. This was fixed. 

• Save filters > The save filters pop up now allows users to type in the filter name 

directly without the need to click in the filter name text box. 

• Reports > The Project Cost Multiplier report was showing Cost Amount even 

when cost rates were hidden for a user. This was fixed. 

• Reports > The AR Reconciliation report was not showing Account Receivable 

Payments when applying the Invoice number filter. This was fixed. 



• Reports > Custom label global setting changes were not being properly reflected 

on reports. This was fixed. 

• Reports > The Work in Progress Details report was not properly loading when a 

custom field filter was applied in combination with a start date filter. This was 

fixed. 

• New UI > Settings > Project Templates > Assignments view was restricting the 

number of records to 25. This was fixed. 

• New UI > Settings > Project Templates >Duplicate action was not working. This 

was fixed. 

• New UI > There was an issue in saving changes for proposal builder. This was 

fixed 

• New UI > The filter panel would disappear after filters were applied in CRM Follow 

up. This was fixed. 

• Auto Logout > In a multi-tab situation, this feature will not perform as expected. 

This was fixed. 

 

 

 

_________________ 

VERSION 1.1.193 RELEASED ON MAY 27, 2023 

 

Product Enhancements: 

Save and Update named filters across CORE: Now, you can use this powerful feature to 

quickly review your list view data across more pages: Payment list, Vendor Bills, 

Statements, Invoice Collections, Vendor Bills, Purchase Orders, Credit Cards, Checks and 

PTO list. We have also added the ability update existing named filters to optimize your 

previous searches. 

“Yesterday” as a date shortcut option: Data throughout the application can now be date 

filtered for Yesterday. This enhancement will allow you quickly review recent records in-

app and in the reporting center.  

Clients ePayments made easier: We have enhanced the Invoice ePayments page to alert 

your clients about any additional unpaid Invoices after they have successfully recorded a 

payment. 



Application Stability: 

• Time Entries > Fixed an issue that would cause the Fee Schedule OT multiplier to 

be used for Cost rates. 

• Time Entries > Import CSV now auto populates client hours if they are missing in 

the CSV 

• Time Card > Navigating from Day view to Week View would cause a UI distortion. 

This was fixed. 

• Reviewer > There was issue with the totals for numeric and currency columns 

when filtering for employee and vendor groups. This was fixed. 

• Create Batch Invoice > An issue in code prevented split billing projects from 

showing up on some occasions. This was fixed. 

• API > We have updated Credit Card API to support date filters. 

• OT Calculator > Progressive scroll was not working in Overtime calculator view. 

This was fixed. 

• Reports > The Work in Progress Details was not properly loading when applying a 

specific date filter. This was fixed.  

• Reports > The Employee Time Card Summary report was not properly exporting 

to PDF when certain filters were set. This was fixed. 

• Reports > Two Profit and Loss Comparison reports were not properly handling 

Vendor Bills. This was fixed. 

• Reports > When the Contract Analysis report was launched from the Project list, 

the report was displaying the wrong project dates. This was fixed. 

• ePayments > We have updated email and in-app notifications to help customers 

onboard effectively when signing up for BQE ePayments. 

• ePayments > Payment summary page and in-app notification would exclude the 

pass-through fees that was paid by the client. This was fixed. 

• Onboarding > Help and documentation links to the latest links. 

• Email > Address book drop down would associate unwanted text to Category 

labels. This was fixed. 

• Invoices >Draft as prefix to invoice number is displayed on invoices migrated from 

BQ. It was fixed. 

• New UI > Page is not redirecting to last visited page when click on the Cancel 

button in User Settings. It was fixed. 

• New UI > Scroll was not working in Term List. It was fixed. 

• New UI > Persist Search was not working In GS>Activity/Expense. It was fixed. 

• New UI >Settings > There was an issue when updating the Accounts Receivable 

account. This was fixed 

 



_____________________ 

 

VERSION 1.1.192 RELEASED ON MAY 10, 2023 

 

Product Enhancements: 

Column selector on Project List report: We are excited to introduce the first step in providing 

users greater control over their reports. The columns displayed on the Projects List report can 

now be selected and re-ordered to fit your various office needs. Be on the lookout as we 

continue to roll this out for additional reports 

Filter Time Details by Invoice: The Time Details report can now be filtered by Invoice 

Number. This will give users another dimension to slice up their time records by for 

easier review. 

Save your filters across CORE: Now, you can use this powerful feature to quickly review 

your list view data across more pages: Invoice list, Time and Expense entry list, Client list, 

Employee list and Vendor list views 

Application Stability: 

• ePayments >We have updated BQE ePayments onboarding process to minimize 

creating clones of existing ePayment profiles unless deemed necessary. 

• ePayments > The payment page would not clearly show any retainers that might 

have been applied prior to the Invoice. This was fixed. 

• ePayments > We have handled several scenarios (missing accounts, profile 

settings turned off etc.) that can potentially lead to payment recording failures in 

the app. 

• ePayments > Several customers had been impacted from the missing Expense 

account for legacy profiles migrated to BQE ePayments. This was fixed. 

• Invoices > The Invoice number filter would show an incorrect value when setting 

up a range filter. This was fixed. 

• Reports > If a check record had time and expense associated to multiple projects, 

the Check Details report was not properly grouping check entries which led to 

incorrect grouped sub-totals. This was fixed. 

• Reports > Group By option labels were cleaned up for consistency across all 

reports. 



• Reports > The General Ledger report was not populating report data if the Show 

Memo option was enabled. This was fixed. 

• Reports > The Project Time Entries report was not properly grouping by Activity 

Items when that option was selected. This was fixed. 

• Reports > The Time Details report was incorrectly pulling the Description of the 

Activity Code instead of the Activity ID. This was fixed. 

• Reports > The Work in Progress Details Report was incorrectly showing Cost 

Amount in the summary section for users that had this data permission disabled. 

This was fixed.  

• Reports > When an existing Memorized report was edited and re-saved, CORE 

was incorrectly routing to Scheduled Reports. This was fixed. 

• Time Card> We noticed an issue with the recently added re-sizing feature. This 

was fixed. 

• New UI >Activity Items header would scroll away. This was fixed. 

• New UI > Wrong message is shown when we duplicate project template. This was 

fixed. 

• New UI > When copying security profiles, users were were navigated to the wrong 

section of the Security screen. This was fixed. 

• New UI> ePayments column does not show up correctly in Projects. This was 

fixed. 

• New UI > Top Navigation to indicate time/ counter of other users timers as well 

• New UI > We had added “View All” Documents links under Projects>documents 

list view. 

• New UI > Account payable does not default to the global defined when creating a 

new vendor bill. This was fixed. 

• New UI > On unselecting "All checkbox" security permission screen freezes. This 

was fixed. 

• Invoices > Invoice number values would not show up correctly when applied as a 

filter to the list view. This was fixed. 

• Projects > We have fixed an issue with updating bill rates in Projects> Budget 

view. 

• Projects > There was an issue adding new line item or updating existing item for 

phase level budget. This was fixed. 

___________ 

 

 

VERSION 1.1.191 RELEASED ON APRIL 26, 2023 



 

Product Enhancements: 

Project List Analytics Drawer: This enhancement will streamline a project manager’s 

ability to review important project-specific information directly from the context of their 

report list without having to navigate to the reporting center or drill into each project. 

This enhancement is aimed at reducing context switching and improving a project 

manager’s efficiency and productivity in CORE. 

Edit Invoice by removing Time and Expense: Billing users can now quickly make updates 

to existing Invoices by removing time and expense entries within the comfort of the 

Invoice editor. This enhancement will significantly cut down on the turnaround time for 

sharing updated invoices with clients. 

Save and name T&E Reviewer filters: Now, users can save their preferred filters on the 

T&E Reviewer easily. This will allow them to apply saved filters with one click to make 

workflow and other updates for entries narrowed down to their criteria. 

Expense entry just got faster: Project and expense dropdowns load faster, allowing users 

to create expense entries faster than before. 

Client Payments made easier: We have enhanced our ePayments page to alert your 

clients about any unpaid Invoices that have ePayments turned on. 

Friendly, contextual Integration sync log: QuickBooks Online integration has been 

updated to 

provide users with easy-to-understand error/validation sync log while syncing payments. 

Extended Project Accounting: No need to update late fees invoices accounting to reflect 

the income account added at the Project level, as we have updated the implementation 

to use the project income account automatically.  

Time Card resizing: We have fixed the position of the done button to make it easy to 

record entries when the browser is resized. Users can now take full advantage of high-res 

monitors as Time card now adapts to any browser dimensions. 

Application Stability: 

• Reports > Report filters were not properly being applied when 50 or more 

individual records were selected and was affecting reports including Time Details 

and Contract Analysis. This was fixed. 



• Reports > The Employee Time Details report incorrectly displayed the $ symbol on 

hour specific KPIs in the summary section. This was fixed. 

• Time entries > We have rectified an issue with “Comp Time” flagging when it was 

being earned and used in the same earning period. 

• Time entries > The system would incorrectly use the Fee Schedule > Overtime 

multiplier to populate the cost rate of a time entry when a match was found. This 

was corrected. 

• New UI >All the items in Side Panel now support opening in new tab. 

• NEW UI: Can't add dropdown in Custom Form Fields Screen 

• New UI >Project Templates missing Structure information. This was fixed. 

• New UI: Unable to perform progressive scrolling for Employee/ Vendor in 'Security 

Permissions '. This was fixed. 

• New UI > Adding a new phase in Project Structure will lead to an incorrect error 

message. This was fixed. 

• New UI > Batch updating Fee Schedule > Services/Expenses error was being 

thrown. This was fixed 

• New UI > There was an error when updating start date in 'Recurring Checks'. This 

was fixed. 

• New UI > Budgets > Services/Expense -> Cost Amount and Charge Amount fields 

are not auto filled when we focus out of the rate and units’ columns while making 

the entry. This was fixed. 

• New UI > Resolved an issue with Proposal builder being used in dark theme 

setting. 

• New UI > Creating a new project with same display name and phase description 

would throw an error. This was fixed. 

• Time Card > There was a crash issue introduced for Project filter. This was fixed. 

• CRM Campaigns > We have resolved an issue with sending out Campaign emails 

with “Prospect Company” smart field.  

• Documents > Several users had complained about Google drive integration 

requiring them to repeatedly reconnect to attach documents. This was fixed. 

• ePayments > We have fixed an issue with ePayments message settings that did 

not allow users to turn off the stock message.  

 

 

__________ 

 

 



VERSION 1.1.190 RELEASED ON APRIL 12, 2023 

 

Product Enhancements: 

Actionable notifications for un-approved Time and Expenses : Users can now review, with 

one click, all un-approved time and expense entries while creating batch invoices, 

allowing them to complete their billing cycle faster. 

Save time by naming your Project filters: Now, users can save their preferred filters on the 

project list. Easily apply saved filters with one click to help find the projects users care 

about quickly. 

Create your timers faster: Project and activity dropdowns load faster, allowing users to 

create timers faster  

Faster data entry using Import CSV: Get started with CORE by importing Activity items, 

Expense items and Payments directly from a CSV source. This functionality is available 

under “More” menu in respective list view. 

Sort Time and Expense: Draft invoices will now allow users to sort their time and 

expenses in Invoice Editor. This change will be reflected in “Hourly Invoice Custom 

Ordering” Invoice template as well. 

Enter time directly for selected project: Time Card grouping by Project now allows user to 

add a new row directly in the project group, allowing users to enter time faster as they 

do not to find and select the project. 

ePayments with Pay when Paid: Receive instant alerts to pay vendor payables when 

receiving ePayment for Invoices that have vendor bill line items. 

Friendlier, contextual Integration sync log: QuickBooks Online Invoice integration has 

been updated to provide users with easy-to-understand error/validation sync log with 

project/client/invoice number information added in all scenarios for full context of the 

underlying reason for sync failures. 

Quicker review of Time and Expense memos: The Time and Expenses Detail report 

generated from the Time and Expenses Reviewer now contains Memos for each record 

that has one. 



Other standard report enhancements to improve data review efficiency and allow more 

customization: 

• The Billing Details report can now be filtered by Billable status, so users can now 

review their billing information with more refined control 

• The WIP Reconciliation report can now be Grouped By either Client, Master 

Project or Project 

 

Application Stability: 

• ePayments > Added checks to prevent duplicate submission of BQE ePayments 

merchant application. 

• ePayments > ePayments page has been updated to allow end clients to pick 

Country and State from respective drop downs instead of manually entering these 

values. 

• ePayments > Few users had complained that they are receiving duplicate emails 

after an Invoice was paid by the Client using the ACH method. This was fixed. 

• ePayments > We have resolved issues with ACH status being stuck in “Pending” in 

scenarios when the user turns off pass through charges after the payment had 

been initiated. 

• Expense Entry > Decimal places specified for rate and amounts were not being 

applied in this view. This was fixed. 

• Import CSV > Cloud Feeds import CSV would not notify users of missing values 

and instead rely on users to click on the notification. This was fixed. 

• Invoice Editor >Remediated issue related to single invoice to allow editing of time 

or expense entry without changing it to a joint invoice. 

• Invoices > Users can now paste memo text copied from word documents without 

any garbled text being introduced. 

• Invoices > We have added the “draft” indicator label next to the Invoice number in 

all table views and drop-downs that show the Invoice number. 

• New UI > Compose email tab is not automatically closed once an email is sent. 

This was fixed. 

• New UI > Fee schedules that have created recently did not appear in the list view. 

This was fixed. 

• New UI > Fixed text display issues for: Notes Widgets, Global settings, Email, and 

memo notes, in Dark mode for New UI. Initially users were not able to view the 

texts clearly due to color contrast issues 

• New UI > On trying to assign a project to fee schedule , the page freezes. 

• New UI > The fee schedule list disappears on applying filters. 



• New UI > Update New UI to close the side panel as it was not closing when users 

click anywhere else on the screen 

• New UI > User is not navigated to Create Fee Schedule screen when clicks on 

"Save & Add another" button. This was fixed. 

• New UI >Access & Permission: Security Permission: "Back To Security" link 

navigates user to blank page. 

• New UI: Fee Schedules: When user selects and un-selects the "Check all" 

checkbox, The screen freezes. 

• New UI: Indicators of Application suggested Timers is missing. This was fixed. 

• NEW UI: The proposal builder in the CRM stays dark and the text does not flip to a 

lighter color on the builder. 

• New UI: We are not able to favorite the Project Assignments screen. This was 

fixed. 

• Projects > Updated project status change notification link CTA to open the project 

in a new tab. 

• Security > Few users complained that after clicking “Back to Security“, Security 

Permissions screen wasn’t navigating back to Security Permission list view and a 

blank page was getting displayed 

• Security > Fixed security permissions issues to allow user to edit Project Note's tab 

under a Project’s page. 

 

____________________________ 

 

VERSION 1.1.186 RELEASED ON FEBRUARY 17, 2023 

 

Product Enhancements: 

New UI 

• Navigation items now have labels visible at all times to help users find the correct 

module faster  

• Increased the number of allowed favorites from 10 to 18; users can now favorite 

more of the things they access most frequent organized in one area for quick 

access 

Project Improvements  



• A new project status "Draft" has been added; users can now create projects that 

are in the early planning stages and are not yet active, without impact on 

invoicing, T&E, reports workflows  

• The project status is now available on the Project List as well as on the Project 

page; users can now make changes to the project status quickly and easily 

• Users can now select to assign a budget template to their project or start a new 

budget from scratch 

Report Enhancements: 

• Reports > Access powerful context driven reports by using the newly added "View 

Reports" function added to Project row caret menu. 

• Reports > Drill down for "Monthly Profit and Loss Accrual" and "Balance Sheet 

Cash Basis" reports have been enhanced to include Project, Vendor and Payer 

columns. 

• Reports > We have added enhanced filtering and grouping by City and State to 

the "Tax Tracking" report 

 

Billing and ePayment Enhancements: 

• ePayments > Based on customer feedback, we have made changes to the 

payment summary section of the ePayments page to better highlight the amount 

to be paid. 

Other Enhancements: 

• Import CSV > We have updated the error handing and validation in "Cloud Feeds" 

to be more intuitive and consistent with others areas of the application. 

 

Application Stability: 

• Create Batch Invoice > Late fee invoices are considered to be part of contract amount 

when billing is done using percent complete in contract analysis widget of project. This 

was fixed. 

• ePayments > An issue with our help system had caused the "Learn More about BQE 

ePayments" link to break. This was fixed. 

• ePayments > Few users had complained that payment notifications were not being 

delivered in case of Statement payments. This was fixed. 



• ePayments > We have fixed an issue related to the partial payments setting in ePayments 

profile being modified after ePayments was scheduled. 

• ePayments > We have fixed few issues with editing of scheduled payments. 

Help > We have fixed an issue with the help links that are accessible from the help menu 

pop up. 

• New UI > Resolved the issue to view Expense Entry screen under favorite after the page 

is added to favorites 

• New UI > Resolved the issues with closing the side panel when user clicks anywhere on 

the page. 

• New UI >Resolved issues that prevented users from making the main Notes and To-dos 

screen as favorites. 

• New UI >Resolved the issue related to adding a new line item under fee schedule 

• New UI >Resolved the Object Reference errors when finalizing any draft invoice 

• Notifications > Updated the text for Notifications 

• Power BI Connector > Fixed an issue with the "Contact" table. 

• Reports > "Work In Hand" report would crash upon multiple drill down actions. This was 

fixed. 

• Reports > Fixed an issue with abbreviated footnote for "Contract Analysis" report. 

• Reports > Fixed an issue with the hours column displaying as currency in "Project 

Performance" report. 

• Timecard > Reverting the change related to auto save new row of Timecard 

____________________________ 

 

VERSION 1.1.185 RELEASED ON FEBRUARY 01, 2023 

 

Product Enhancements: 

• Auto Logout >Admin users can now set up automatic logout based on logged 

users (in)activity monitoring. 

• Import CSV >Vendor records can now be bulk imported to CORE by uploading a 

.csv file. 

• Public API > We have added webhooks support for Time entry workflow changes. 

 

Application Stability: 



• Data export > CSV files from the Time and Expense Reviewer, Invoices, and 

Vendor Bills screens were not properly exporting if the Approved By field has a 

comma punctuation. This was fixed. 

• ePayments > Recent change in payment notifications had introduced an issue that 

would lead to blank notifications when receiving ePayments. This was fixed, 

• ePayments > We have fixed an issue with partial payment of Statements. 

• Login > We have fixed an issue with incomplete 2FA set up. 

• New UI > There was an issue related to "Groups" security in the new UI. This was 

fixed. 

• New UI > Add On global settings would show up even if there were items under 

it. This was fixed. 

Projects > The drill down Contract Analysis report was not properly displaying 

report information for Main projects. This was fixed. 

• Reports > The 1099-MISC report was displaying error codes in some scenarios. 

This was fixed. 

 

____________________________ 

 

VERSION 1.1.184 RELEASED ON JANUARY 21, 2023 

 

 

Product Enhancements: 

Edit finalized Invoices: 

• Users can now edit finalized Invoices using the Invoice editor interface. This new 

capability will allow billing users to change Invoice attributes like Terms, Billing 

address, Discounts etc. or make changes to the associated Time and Expense 

entries without the need to recreate the Invoice again from scratch.  

Import Phased Projects in bulk 

• We have made it easy to import Projects and associated Phases at the same time 

using our Project CSV import feature. 

Analytics enhancements: 



• The most used report in CORE, the Time and Expenses report, has been enhanced 

to allow up to three levels of grouping. The enhanced grouping options will be 

available on any standard instance of the Time and Expenses report including 

Standard, Memorized, Favorite or Scheduled tabs. The re-organized records will 

allow users to review their data more efficiently. 

• “Tax registry” and “Taxes” reports were both enhanced to for more robust filtering 

and grouping options. 

• Additional information has been added to the Transaction Details report including 

the Project, Vendor and Payer details. 

Integrations: 

• Updates to QuickBooks Desktop Sync Utility 

 

Performance Optimizations: 

• Back end improvements for faster processing 

  

Application Stability: 

• Create Batch Invoice > An issue in the Create new Manual Invoice from Approved T&E 

would bring in entries outside the dates provided by the user. This was fixed. 

• CRM Proposals > We have fixed an issue with the Proposal view that would cause it to 

lose some changes after saving. 

• ePayments >The system would not allow partial payment of ePayments enabled 

Statements in some cases, This was fixed. 

• New UI > Timer totals were not updating if there were one more timers running. This was 

fixed. 

• New UI > We have fixed an issue with create batch Invoice screen sub totals. 

• New UI > We have restored access to view all notes setting that was missing in the new 

interface. 

• New UI> We have fixed an issue in Settings page that had made the LEDES setting 

inaccessible. 

• T&E Reviewer >an issue in T& E reviewer would prevent cause the “Mark Billed” action to 

update the first 75 records only. This was fixed. 

 



 

____________________________ 

 

VERSION 1.1.183 RELEASED ON JANUARY 04, 2023 

 

Product Enhancements: 

New UI: 

• Users can now add shortcuts for their favorite settings by marking them as 

“Favorites”.  

• We have made it easier for Foundation, Billing and Accounting subscription users 

to access Purchase Order and Vendor Bill modules. These are now conveniently 

located under Accounting->Payables menu. 

 

 

Time Card Improvements: 

• We have updated the add new row experience to be consistent with our other areas of 

the application. Users will be presented with a DONE button to complete adding a new 

time card row. 

 

Data Onboarding: 

• Employee records can now be bulk imported to CORE by uploading a .csv file. 

• Enhanced error handling for Prospect and Leads CSV import 

Reporting improvements: 

• Reports > When drilling into the details of a Profit and Loss Cash Basis report, the 

underlying report will now include the Project, Vendor and Payer details as well. 

ePayments: 

• Updates to BQE ePayments- Automatic deposit recording w/ settled fees. (limited 

release) 



• ePayment email notifications will now include Invoice, Project and Client 

information. 

Budget improvements: 

• Users can now turn on custom fields for Budgets list view. 

Integrations: 

• Updates to QuickBooks Desktop Sync Utility 

 

Performance Optimizations: 

• Back end improvements for faster processing 

 

Application Stability: 

• A&F > We have fixed an issue that would prevent time entry hours that do not 

any corresponding allocation from appearing under "Other Tasks". 

• Expense Entry > There was an issue with the total record count if expense entries 

had more than one custom fields specified. 

• Integration > Many users had complained about their Google Calendar 

appointments not appearing after setting up the integration. This was fixed. 

• Invoice Editor > There was an issue with Net Bill calculation not being updated 

when modifying time entries. This was fixed. 

• Invoice Editor > Unsaved changes would be lost when including approved time 

entries. This was fixed. 

• Invoices > Users were not able to update Invoice Numbers for finalized Invoices. 

This was fixed. 

• Invoices > We have fixed an issue with email attachments for One Drive/DropBox 

documents. 

• Leads > There was an issue with import sample CSV for leads. This was fixed. 

• New UI > There was an issue with custom fields list view when deleting existing 

records. This was fixed. 

• New UI > There was an issue with the Class list view display. This was fixed. 

• New UI > We have enhanced the hover and active states for left nav. menu items. 

• Projects > All tabs in Project details section are misaligned if the Project name was 

over a certain length. This was fixed. 

• Time Card > The Day view interface would not reveal the full contents of the 

memo when clicking on the memo box. This was fixed 



 

____________________________ 

 

 

 

VERSION 1.1.182 RELEASED ON DECEMBER 22, 2022 

 

Product Enhancements: 

• Time and Expense entry Improvements: 

o Within the Time Card week view, there is now a button that will allow you 

to submit all time entries for the current period. 

o When you submit your time card, CORE will now remember the previous 

settings that you used. 

o Time Card has been updated to show the time stamp of the last update to 

the Time Card view. 

o Time Entries page has been updated to sort by custom fields. 

• New UI 

o User profiles now allow for adding a profile picture. 

o We have added contextual help links for Global and User settings pages. 

• Subscription Management  

o Premium Yearly Support Plan can be added as Company level subscription. 

o We are rolling out updated pricing for Foundation package. 

• Reporting Improvements: 

o When drilling into the details of a Balance Sheet Accrual Basis report, the 

underlying report will now include the Project, Vendor and Payer details as 

well. 

o New filters have been added to the Personal Time Off Usage report, 

including: Employee, Vendor, and Vendor Group. 

 

Application Stability: 

• New UI > Fixed security access issue with Company> Documents tab. 



• New UI > The first record would get un-selected after all records were selected 

and then the user clicked on the description field of any record in the T&E 

reviewer 

• New UI > There was an issue with remembering filters for Time entries view. This 

was fixed. 

• New UI > There was an issue with scrolling after the user responded to the 

unsaved changes prompt. This was fixed. 

• New UI> Project Assignments would stop at 25 records. This was fixed. 

• OT Calculator > The system would keep reverting Regular and OT hour settings 

entered by the user. This was fixed. 

• Time Card >Fixed a bug where the time card view switches from the week view to 

the day view automatically. 

• Time Entries > When creating an Employee from the Add New button in the Time 

Entry screen, the Auto Approve Time for Employees Global Setting is not 

respected. This was fixed. 

 

____________________________ 

 

VERSION 1.1.181 RELEASED ON DECEMBER 8, 2022 

 

Product Enhancements: 

• Import CSV > We have optimized data validation and error/success messages 

when importing Projects, Time and Expense entry and General Journals. 

• Invoices > We have added the ability to launch statements directly from the 

Invoice record. 

• Projects > Users can now launch the Contract Analysis report for a project from 

the Projects list screen by clicking on a project's Contract Amount. 

• Reports > When drilling into the numbers on the Profit and Loss Accrual Basis, the 

underlying Transaction Details report will now display the Project, Vendor and 

Payer details as well. 

• Reports Center > The reporting center search bar has been enhanced to display 

suggestions across all report tabs. 

• Subscription Management > Added the ability to renew Foundation subscriptions. 

• Time Card > New users will have the approval status flags turned on by default. 



 

Application Stability: 

• Import CSV > There was an issue with importing contacts for Client, Vendor and 

Employees. This was fixed. 

• Import CSV > There was an issue with importing start and stop time for time 

entries. This was fixed. 

• Invoices > Processing late fees in bulk would complete for the first 75 selected 

Invoices only. This was fixed. 

• Invoices > Updating memo or description for entries tied to a draft Invoice would 

reset the WUD factor. This was fixed. 

• New UI > Fixed an issue with select all checkboxes in Currency Manager. 

• New UI > Invoice number under recent Invoices was not getting updated to 

modified Invoice number. This was fixed. 

• New UI > Invoices that had been deleted would still hold a reference under the 

"Recent Invoices". This was fixed. 

• New UI > There was an issue in Project Groups> Assign Project. This was fixed. 

• New UI > There was an issue with QuickBooks Online Sync> Record mapping 

when loading more records. This was fixed. 

• New UI > There was an issue with showing existing data for Notes categories, 

classes and contact methods. This was fixed. 

• New UI > There was issue with saving Accounting settings from the Settings area. 

This was fixed. 

• New UI > We have relocated "Auto Approve" settings under Project. 

• New UI > We have restored access for Project assignments by adding "View 

Assignments" action under Project details>More. 

• New UI > We have restored access to OT Calculator from Time entries and Time 

Card views. 

• OT Calculator > The system would not take the "Excluded Activities" setting into 

consideration when processing over time for the selected employees and time 

period. This was fixed. 

• OT Calculator> The Select All feature would select the visible rows only. This was 

fixed and made consistent with other list views. 

• Projects > Emailing budgets directly from the Budgets tab would attach an empty 

PDF. This was fixed. 

• Reports > In some cases, when the Employee Expenses report was exported as a 

CSV, some row data was not exported correctly. This was fixed. 



• Time Entries > There was an issue with showing more than one custom field of the 

same type. This was fixed. 

 

____________________________ 

 

VERSION 1.1.180 RELEASED ON NOVEMBER 23, 2022 

 

Product Enhancements: 

• App Navigation and UI Update (Open Beta): This update adds several 

enhancements like Dark mode support and fixes numerous known issues. 

• Reports > Several new filter options were added to the Employee Time Card 

Summary report including Project Status, Project Type and Project Contract Type. 

• Dashboard > Clicking into PTO records from the Workflow dashboard widget will 

now re-direct users to the PTO screen. 

• Report Center > Search bar in the report center has been enhanced with 

autocomplete suggestions to make finding your data faster and easier. 

• Security Optimizations > This update further improves the security posture of the 

Application. 

 

Application Stability: 

• Integrations > QuickBooks Online sync would throw an error if the logged user was 

missing the custom label security permission. This was fixed. 

• Integrations > There was an issue with selecting all Calendars created in Office 

365. This was fixed. 

• Invoice Templates > Sample Invoice previews were not properly generating. This 

was fixed. 

• Invoices > Draft Invoice Editor UI would show draft invoice number instead of 

actual invoice number. This was fixed. 

• Projects > The Budget ID field would be left empty when custom budget was 

being used for the project. This was fixed. 

• Reports > The Historic Billing report was not properly honoring Fiscal Year date 

filters when the default fiscal year did not coincide with calendar year end. This 

was fixed. 



• Time entries > When creating a time entry from a timer, the 'amount' field would 

not show the correct amount unless updated from the Time entries view. This was 

fixed. 

 

____________________________ 

 

VERSION 1.1.179 RELEASED ON NOVEMBER 10, 2022 

 

Product Enhancements: 

• App Navigation and UI Update (Beta): This update adds several enhancements 

and UI fixes for many known issues. 

• Client records can now be bulk imported to CORE by uploading a .csv file. 

• BQE ePayments onboarding has been enhanced to allow users to turn on 

ePayments links for all open and draft state invoices at the time of Merchant Sign 

up. 

• Time and Expense Entries >We are now saving column width for the 'Best Fit' 

option. 

Application Stability: 

• Billing > There was an issue in the late fee calculation for specific month ending 

scenarios. This was fixed. 

• Dashboards > The HR benefits calculations have been updated for the Paid Time 

Off and Comp Hours widget and Benefits Usage report, so the values match. 

• Expense Entries > Users were not able to attach documents when creating new 

entries if the auto approve Expense rule was turned on. This was fixed. 

• Projects > Handled crash error in Expense list of Budgets tab when 'Include 

Phases' was turned on. 

• Reports > In certain scenarios, created vendor bills would create an imbalance on 

the Balance Sheet Cash Basis report. This was fixed. 

• Reports > In certain scenarios, joint invoice payment breakdown were not 

matching on the Payment Details report. This was fixed. 

• Reports > The Parent Project name was not being properly displayed when date 

filters were being applied to the Time and Expenses by Parent Project report. This 

was fixed. 



• Time and Expense Reviewer > Applying filters and sorting the reviewer list would 

sometimes result in incorrect number of records to be exported to CSV format. 

This was fixed. 

• Time Entry > It would require several tries to update the memo field for an 

existing entry. This was fixed. 

 

____________________________ 

 

VERSION 1.1.178 RELEASED ON OCTOBER 25, 2022 

 

Product Enhancements: 

• App Navigation and UI Update (Beta): This release rolls out navigation and UI 

changes to select beta customers. 

Application Stability: 

• Dashboard > Employee filter in the 'HOURS' widget was not showing Vendors 

even if the setting 'Include vendors in the employee drop-downs' was checked in 

the User Preferences. This was fixed. 

• Dashboard > HOURS widgets was including weekend hours. This was fixed. 

• Invoice Templates > Manual Invoice templates were not using the correct rate 

multiplier when previewing Invoices created for a Project with non-US currency. 

This was fixed. 

_______________ 

 

VERSION 1.1.177 RELEASED ON OCTOBER 12, 2022 

 

Product Enhancements: 

• Invoices > Parent Retainer Available information has been added to Phased 

Invoices Retainer Summaries. 



• Reports > The Employee Expenses report has been updated to improve 

readability and it was optimized for better performance. The report can now be 

grouped by Expense Item. 

• Reports > The Percentage Billed report can now be grouped by Project Manager. 

 

Application Stability: 

• Budgets > Users with read only permission were not able to add new line items. 

This fixed. 

• Budgets > We have fixed a UI issue that would distort the table if all columns were 

made visible. 

• Integrations > There was an issue with Office 365 integration that would prevent 

Outlook events Calendar to show up in full calendar view. This was fixed. 

• Payments > An isolated issue with payments screen would prevent loading of 

more than 75 records. This was fixed. 

• Scheduled reports > Time verification scheduled reports were not being sent out 

properly if their schedule was modified. This was fixed. 

 

_________________ 

 

VERSION 1.1.176 RELEASED ON SEPTEMBER 28, 2022 

 

Product Enhancements: 

• Projects can now be bulk imported to CORE by uploading a .csv file.  

• Pricing Update> This update rolls out new pricing for CORE subscriptions effective 

immediately. 

• Reports > More filters, including Project Status and Principal, have been added to 

the Cash Receipts report. The report has also been optimized for improved 

performance and readability. 

• Reports > More filters, including Project Status and Principal, have been added to 

the Employee Paid Time Off Hours report. The report has also been optimized for 

improved performance and readability. 

• Reports > The Client Transactions report can now be grouped by Master Project. 

• Reports > The Time Details report can now be grouped by Project Manager. 

• Integrations> “Connect” buttons have been refreshed for new styling. 



• Security Optimizations > This update further improves the security posture of the 

application. 

 

 

 

Application Stability: 

• Batch Invoice > There was an issue with retainer amount calculated for the Invoice 

when one or more entries were excluded from the Invoice. This was fixed. 

• Batch Invoice > Users had reported issues processing Invoices using Project Filter 

Option in combination with Percentage based billing. This was fixed. 

• Expense Entry > Time and Expense subscription users were not able to use the 

Credit Card field when creating a new Expense entry. This was fixed. 

• General Journals > An issue with the Import CSV was preventing users to import 

entries from CSV source. This was fixed. 

• Subscription Management > Some users would not get subscription renewal 

notifications while logging in during the grace period. This was fixed. 

• TE Reviewer > The system was not updating "Paid Date" when paid flag was 

removed. This was fixed. 

• Vendor Bills > There was an issue with the Batch update feature when used in 

conjunction with quick list view search. This was fixed. 

• Reports > The Project Time Entries was not properly honoring security bits for 

subtotal amounts. This was fixed. 

 

____________________ 

 

VERSION 1.1.175 RELEASED ON SEPTEMBER 14, 2022 

 

Product Enhancements: 

• Time Card > Time Card interface has been enhanced to allow users to group their 

time entries by Project. 



• BQE ePayments > Automatic bank deposits have been reworked to match the 

real-world bank transfer events. This feature will be made available to selected 

customers for testing before full roll out. 

• Invoice Editor > Labels in the Invoice Editor screen have been updated to properly 

refer to Phase or Project sections. 

 

Application Stability: 

• Expenses > Creating a copy of an expense entry was not retaining the correct 

charge amount. This was fixed. 

• Integrations > An issue with AccountRight integration was preventing users from 

syncing Projects/Invoices along with the sync settings page being not accessible 

This was fixed. 

• Integrations > Dropbox storage users were unable to upload documents to 

Projects or Vendor Bills. This was fixed. 

• Invoice Editor > The call-to-action buttons disappeared from the invoice editor 

screen when we DELETE, SEND TO and PRINT actions were used from Action 

menu. This was fixed. 

• Invoices > The View Transactions link in a finalized invoice details screen was 

linking to a blank Payments list. This was fixed. 

• Reports > CORE Express Plus users were not able to see all financial reports. This 

was fixed. 

• Reports > The Report Center was not properly displaying all reports under some 

categories. This was fixed. 

• Scheduled Reports > Several users had complained about reports being emailed 

even after their CORE subscription had expired. This was fixed. 

 

VERSION 1.1.174 RELEASED ON AUGUST 31, 2022 

 

Product Enhancements: 

• Invoice Editor > Newly approved time and expense records can now be added 

to draft invoices using the Invoice Editor. 

• Time Card > The Time Card activity drop down has been optimized for better 

performance. 

• Reports > The "Write Up Write Down" report has been optimized for better 

performance. 



• Reports > The "Trial Balance Cash YTD" report has been optimized for better 

performance. 

• Reports > The "Trial Balance Accrual YTD" report has been optimized for better 

performance. 

• Reports > More filter options have been added to the "Employee Project 

Utilization" report and its readability has been improved. 

• Reports > More filter options have been added to the "Account Reconciliation" 

report and its readability has been improved. 

• Invoices > The user experience for re-directing to the Payments screen from 

Invoices has been enhanced to avoid loading a blank screen if no payments 

have been made. 

 

 

Application Stability: 

• Batch Update > Batch updating projects from a filtered list would result in all 

project records being incorrectly updated. This was fixed. 

• Dashboard > A security bug was not allowing the proper data to load in the 

"Paid Time Off and Comp Hours" widget. This was fixed. 

• Global Search > The global search box was not properly displaying recent 

searches. This was fixed. 

• Integrations > Certain users were unable to send Invoices to Xero. This was 

fixed. 

• Invoice Editor > Edits made to an Expense’s Extra attribute were not being 

properly saved. This was fixed. 

• Invoice Editor > Split Draft Invoices were not properly loading in the Invoice 

Editor. This was fixed. 

• Invoice Templates > Users were incorrectly given permission to delete Custom 

Invoice Templates from Global Settings. This was fixed. 

• Manual Invoices > Manual Invoices could not be created for Projects with 

certain rules set. This was fixed. 

• Reports > On drill down, the "Account Reconciliation" report uncleared totals 

did not match. This was fixed. 

• Reports > The "Time and Expense" report was incorrectly calculating the Grand 

Total Billable Service / Expense by including non-billable amounts. This was 

fixed. 

• Reports > The summary section of 'Monthly Financial Budget vs Actual' report 

was not formatted correctly. This was fixed. 

 

________________ 



 

VERSION 1.1.173 RELEASED ON AUGUST 17, 2022 

 

Product Enhancements: 

• Reports > “General Ledger Cash Basis” report has been optimized for better 

performance. 

• Reports > “Payment Details” report has been enhanced to improve readability 

and new filter options have been added. 

 

Application Stability: 

• Dashboard > The Paid Time Off dashboard widget was displaying the wrong 

Used values. This was fixed. 

• Global Settings > Changes to tax rates in global settings were not being 

properly updated throughout the application. This was fixed. 

• Integrations > Invoiced were not properly syncing from CORE to MYOB. This 

was fixed. 

• Integrations > When syncing invoices to QuickBooks, the Net Terms were 

being incorrectly set at the Client level instead of the Project level. This was 

fixed. 

• Invoices > Invoices were not sending to Client Contacts without viewing a 

Preview of the Invoice. This was fixed. 

• Reports > “Profit and Loss by Class Cash Basis” report numbers were not 

matching the drill down report when applying a Transaction date filter. This 

was fixed. 

• Reports > “AR Aging 8 steps” report was failing to preview and email for large 

data sets. This was fixed. 

• Reports > “Time Details and Contract Analysis” reports could not be opened 

from email attachments when a scheduled report was run to deliver them. This 

was fixed. 

• Reports > “Work In Progress Detail” report was duplicating entries if more than 

one Project Group was assigned to a Project. This was fixed. 

• Security > Users that had a custom security profile assigned were able to run 

assigned reports, but the reports would not display any data. This was fixed. 

• Time & Expense > The Time Entry, Expense Log and Reviewer screens were not 

properly applying the un-approved filter. This was fixed. 



• Time Card > The Overtime splitting feature in the Time Card was not properly 

splitting Overtime entries for billable work. This was fixed. 

• Time Entries > Billed Time Entries were not correctly enforcing restrictions that 

prevented updates. This was fixed. 

• Vendor Bills > Time Entries on paid Vendor Bills could incorrectly be updated 

which would result in incorrect cost amounts. This was fixed. 

• Vendor Bills > Updating units on a saved Vendor Bill was not properly 

updating client hours in the Time Entry record. This was fixed. 

• Vendor Bills > When a Vendor Bill is created using existing Time Entry records 

with custom memos, the custom memos are not properly imported. This was 

fixed. 

• Time Card > Clicking tab after entering a time entry was not properly saving 

the entry. This was fixed. 

 

 

 

 

VERSION 1.1.172 RELEASED ON AUGUST 3, 2022 

 

Product Enhancements: 

• Invoice Editor > The Invoice Editor experience has been enhanced by enabling 

the editing of linked Expense Entries on a Draft Invoice. 

• Invoice Editor > The Invoice Editor user experience has been simplified. 

• Invoices > Phased Invoice templates have been updated to include a Retainer 

Summary if the option is enabled. 

• Time Card > The Project dropdowns in the Time Card have been optimized for 

better performance. 

• Bill Payments > Bill Payment details view has been updated to accommodate 

longer Reference Number values.  

• Reports > The Budget Comparison report has been optimized for better 

performance. 

• Reports > The Cost Analysis report has been optimized for better 

performance. 

• Reports > The Monthly Billing Statement report has been optimized for better 

performance. 



• Reports > The Project List report has been optimized for better performance. 

• Reports > The Project Performance report has been optimized for better 

performance. 

• Reports > The Project Profitability report has been optimized for better 

performance. 

• Reports > The Trial Balance Cash Basis report has been optimized for better 

performance. 

 

Application Stability: 

• Bill Payments > When creating a Bill Payment by Saving and Adding Another, 

the Payee filter was not being honored and the list would display all Vendors. 

This was fixed. 

• General > "This Bi-Weekly" date period was inconsistently referred to 

throughout screens and reports. This was fixed. 

• Invoices > Hours on the cover page were incorrectly multiplied by the number 

of payments received for the Invoice. This was fixed. 

• Invoices > Late fees were incorrectly being considered part of the contract 

amount when using percent complete billing. This was fixed. 

• Projects > When a Project filter was applied to the Projects list, then the list 

was sorted by Project, some Projects were incorrectly listed as duplicates in the 

list. This was fixed. 

• QuickBooks > In some instances, Invoice Class was not properly syncing to 

QuickBooks. This was fixed. 

• QuickBooks > Invoices created from Billable expenses that were tied to 

accounts in QuickBooks Online were not transferred to CORE. This was fixed. 

• QuickBooks > Searching keywords against Unmapped Payments in 

QuickBooks was not yielding the correct results. This was fixed. 

• Reports > Column headers were missing from Page 2 of the Employee 

Profitability Report. This was fixed. 

• Reports > Deposits made through New Funds were not properly reflected on 

any AR Aging reports when the General Journal option is turned on. This was 

fixed. 

• Reports > The Vendor Bills Paid report was incorrectly including records for 

Unpaid Vendor Bills. This was fixed. 

• Reports > When exporting the Expenses by Vendor report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 



• Reports > When exporting the Journal report as an Excel file, calculations 

could not be run on certain number fields due to their format type. This was 

fixed. 

• Reports > When exporting the Project List report as an Excel file, calculations 

could not be run on certain number fields due to their format type. This was 

fixed. 

• Reports > When exporting the Unpaid Vendor Bills report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Time Card > Clicking tab after entering a time entry was not properly saving 

the entry. This was fixed. 

 

 

 

 

VERSION 1.1.171 RELEASED ON JULY 20, 2022 

 

Product Enhancements: 

• Invoice Editor > Expense Entry details can now be updated directly from the 

• Invoice Editor. 

• Invoices > Users can now filter the list by Invoice Created On date. 

• Reports > “General Ledger” and "General Ledger Extended" reports have been 

optimized for better performance. 

• Dashboard > "Paid Time Off and Comp Hours" widget has been updated to 

handle the advanced benefit rules. 

 

 

Application Stability: 

• Account Management > An issue with the reset password mechanism would 

lock out few users after they had changed their password. This was fixed. 

• Checks > The screen would become unresponsive when associating existing 

expenses for the selected Payee. This was fixed. 

• Dashboard > Vacation and Sick time were not reflecting in Paid Time Off and 

Comp Hours widget. This was fixed. 



• ePayments > An issue with phone number formatting was preventing few 

users from completing the Merchant Sign up in one go. This was fixed. 

• ePayments > ePayment status for Partial Payments would still refer to the 

payment method used in the first transaction. This was fixed. 

• Integrations > Users would lose search results when matching records in the 

record mappings for QuickBooks Online . This was fixed. 

• Invoice Editor > Updates to custom fields linked to T&E items were not being 

saved. This was fixed. 

• Reports > "Tax Registry" report would show incorrect tax amounts in case of 

Joint Invoices. This was fixed. 

• Reports > An issue with the "Hide Phases" option would cause the report to 

not calculate client hours and other fields correctly. This was fixed. 

• Reports > When exporting the Aged WIP with AR report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed.  

• Reports > When exporting the Check Details report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed.  

• Reports > When exporting the Employee Allocation Units report as an Excel 

file calculation could not be run on certain number fields due to their format 

• type. This was fixed.  

• Reports > When exporting the Employee Half Monthly Time Card report as an 

Excel file, calculations could not be run on certain number fields due to their 

format type. This was fixed.  

• Reports > When exporting the Statement by Client (Accountant) report as an 

Excel file, calculations could not be run on certain number fields due to their 

format type. This was fixed.  

• Security > Several fixes were added to harden the security profile of the 

application. 

 

 

 

VERSION 1.1.170 RELEASED ON JULY 06, 2022 

 

Product Enhancements: 



• BQE ePayments is now available for US companies that subscribe to our billing 

module. Users can now sign up for this service using in-app Merchant 

onboarding and start accepting payments immediately after getting approved. 

• Invoice Editor > Time Entry details can now be updated directly from the 

Invoice Editor. 

• Invoice Templates > Retainer summaries have been added to Joint Invoice 

Templates. 

• Reports > New filter options have been added to the Project Time Entries 

report and it has been optimized for better performance. 

• Reports > The Time Details report has been optimized for better performance. 

• Reports > The Trial Balance Accrual report's UI has been updated to improve 

readability and its performance has been optimized. 

• Time Card > The Description column was made to be an optional column that 

is displayed by default. 

• Time Card > The Time Card has been optimized for better performance. 

• Time Entries > The memo for an entry displayed in the Time Entries screen was 

updated to fill out the Memo column depending on how wide or narrow the 

column gets expanded. 

 

Application Stability: 

• ePayments > Partial ACH payments made on an invoice would restrict future 

partial payments to be made only in ACH and not credit cards. This was fixed. 

• ePayments > Phone number formatting was not properly reflected when 

emailing ePayment invoice. 

• ePayments > Cash Receipt has been restored as default template for 

attachments on ePayment emails. 

• Integrations > Taxes were not syncing to the proper accounts when 

connecting to QuickBooks. This was fixed. 

• Invoice Editor > Custom field updates were not saving for Time Entry details 

from the Invoice Editor. This was fixed. 

• Project Templates > The Start and End dates in Project Templates were not 

properly following the defined pattern when creating a new Project. This was 

fixed. 

• Reports > Penny issue discrepancy between P&L and General Ledger Accrual 

reports has been fixed. 

• Reports > When exporting the Activity by Project report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 



• Reports > When exporting the Billable Work History report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Reports > When exporting the Budget Comparison report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Reports > When exporting the Employee Paid Time Off Comparison report as 

an Excel file, calculations could not be run on certain number fields due to 

their format type. This was fixed. 

• Reports > When exporting the Employee Performance report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Reports > When exporting the General Ledger Extended report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Reports > When exporting the Invoice Register report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Reports > When exporting the Top N Clients report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Reports > When exporting the Transaction Details report as an Excel file, 

calculations could not be run on certain number fields due to their format 

type. This was fixed. 

• Security > 2FA verifications were being sent to the wrong company emails. 

This was fixed. 

• Time Entries > Rates by Classification were not properly honored when 

entering time. This was fixed. 

 

VERSION 1.1.169 RELEASED ON JUNE 22, 2022 

 

Product Enhancements: 

 

• T&E Reviewer > Users can now instantly see subtotals for selected records in 

the T&E Reviewer screen. 

• Batch Invoices > We have updated the way the invoice date is interpreted for 

recurring type projects. The new approach will allow users to include approved 

time and expenses, independent of the invoice date. 



• BQE ePayments beta: This update adds the ability to schedule invoice and 

statement payments. 

• Reports > We have optimized the "Time Verification" report for faster load 

times. 

 

Application Stability: 

 

• Billing Schedule > Scheduled Amount was being reset to $0 when a project’s 

Contract Type field was updated. This was fixed. 

• BQE ePayments beta: We have fixed an issue with ACH transfers that would 

cause the Invoice to be flagged as ACH Success on payment capture. 

• BQE ePayments beta: We have fixed an issue with ePayment methods not 

being automatically associated with new and draft invoices. 

• BQE ePayments beta: We have updated the message included in emails sent to 

merchants during the onboarding process. 

• Dashboard > An issue in the "Staff Workload" widget was causing a mismatch 

between this widget and the associated report. This was fixed. 

• Integrations > The Project Group filter was not working when sending over 

invoices to QuickBooks Online . This was fixed. 

• Invoice > Duplicate emails were being sent for the same invoice. This was 

fixed. 

• Project Template > To-do dates were incorrect when project was created from 

a template with existing To-dos. This was fixed. 

• Reports > The Account Reconciliation' report was not showing subtotals and 

drill down for uncleared transactions. This was fixed. 

• Time Card > There was a UI issue when pre-filling more than 45 

Project/Activity combinations. This was fixed. 

• Time Card > Time Card row suggestions were not showing when tasks were 

allocated to an employee group. This was fixed. 

• Time Entries > The "Memo Flag" column was not showing the correct status 

when a memo was present for an entry. This was fixed. 

 

 

VERSION 1.1.168 RELEASED ON JUNE 8, 2022 

 

Product Enhancements: 



• BQE ePayments > Enhancements have been added to the BQE ePayments beta 

including a more integrated merchant sign-up experience and a few other 

important fixes. 

• ePayments > The Stripe and AffiniPay on-boarding experiences have been 

enhanced to match the newly updated flow. 

• Projects > When navigating to a different phase within a project's details, the 

user is now dropped into the same tab they are already on instead of always 

returning them to the Details tab. 

• Reports > The Invoice Register report has been optimized for better 

performance and new filters have been added. 

• Reports > The Project Time and Expense report has been optimized for better 

performance and new filters have been added. 

• Reports > The Time and Expenses by Parent Project report has been optimized 

for better performance and new filters have been added. 

• Time Card > Suggested Time Card rows based on allocated projects/tasks 

were not always displayed in the Time Card if the allocation dates only lasted 

for a portion of a week. This was fixed. 

 

Application Stability: 

 

• Cloud Feeds > Cloud Feeds was incorrectly noting that entries had already 

been matched when trying to “Find Match” for multiple transactions. This was 

fixed. 

• ePayments > The ePayments Details report was not accurately displaying 

payment statuses for payments that were previously deleted then repaid. This 

was fixed. 

• Integrations > Projects were incorrectly being created in CORE when syncing 

payment data from QuickBooks Online. This was fixed. 

• Integrations > Trying to send invoices to QuickBooks in a batch was not 

properly sending all invoices. This was fixed. 

• Projects > Users were incorrectly getting a permissions error when trying to 

view Project details for certain records. This was fixed. 

• Reports > The ePayment Details report was incorrectly displaying Payment 

type when paying with credit card. This was fixed. 

• Reports > When exporting the Balance Sheet Accrual report as an Excel file, 

numbers were exported as text and not number format. This was fixed. 

• Reports > When exporting the Balance Sheet Cash report as an Excel file, 

numbers were exported as text instead of number format. This was fixed. 

• Reports > When exporting the Billing Analysis report as an Excel file, numbers 

were exported as text instead of number format. This was fixed. 



• Reports > When exporting the Billing Details report as an Excel file, numbers 

were exported as text instead of number format. This was fixed. 

• Reports > When exporting the Employee Paid Time Off Hours report as an 

Excel file, numbers were exported as text instead of number format. This was 

fixed. 

• Reports > When exporting the Employee Utilization report as an Excel file, 

numbers were exported as text instead of number format. This was fixed. 

• Reports > When exporting the General Ledger Cash report as an Excel file, 

numbers were exported as text instead of number format. This was fixed. 

• Reports > When exporting the General Ledger report as an Excel file, numbers 

were exported as text instead of number format. This was fixed. 

• Reports > When exporting the Personal Time Off Usage report as an Excel file, 

numbers were exported as text instead of number format. This was fixed. 

• Reports > When exporting the Project Account Details report as an Excel file, 

numbers were exported as text instead of number format. This was fixed. 

• Reports > When exporting the Project Performance report as an Excel file, 

numbers were exported as text instead of number format. This was fixed. 

• Reports > When exporting the Work in Hand report as an Excel file, numbers 

were exported as text instead of number format. This was fixed. 

• Reports > When exporting the Work in Progress report as an Excel file, 

numbers were exported as text instead of number format. This was fixed. 

• Scheduled Reports > Scheduled reports that had a custom field filter applied 

and were updated failed to send. This was fixed. 

 

 

 

 

VERSION 1.1.167 RELEASED ON MAY 25, 2022 

 

Product Enhancements: 

 

• BQE ePayments: This update adds the beta version of our enhanced 

ePayments processing capabilities. The current release will be available to 

select few users. 

• UI improvements in ePayments Set up and Profile Management. 



• Dashboard > The Due Projects widget has been updated to sort by “Due 

Date”. 

• Reports > The Employee Time Details report was optimized to load faster and 

not freeze when applying filters. 

• Reports > The Monthly Profit and Loss Accrual Basis report Excel export has 

been updated so numerical values export in number format instead of text 

format. 

• Reports > The Trial Balance Accrual Basis report Excel export has been updated 

so numerical values export in number format instead of text format. 

• Reports > The Account Transactions report Excel export has been updated so 

numerical values export in number format instead of text format. 

• Reports > The Employee Time Detail report Excel export has been updated so 

numerical values export in number format instead of text format. 

• Reports > The Time Card Week View report Excel export has been updated so 

numerical values export in number format instead of text format. 

• Reports > The Time Card Week View report has been optimized for better 

performance. 

• Reports > The Employee Time Card Summary report has been optimized for 

better performance. 

• Reports > The AR Reconciliation report was optimized to include missing filters 

options and load faster when applying filters. 

Application Stability: 

 

• Batch Billing > During the batch billing process, the Time and Expenses report 

was not properly generated to reflect unapproved entries. This was fixed. 

 

• Batch Billing > In some instances, there were duplicate invoices being created 

when using the batch billing process. This was fixed. 

• Integrations > Projects were not properly syncing to MYOB. This was fixed. 

• Cloud Feeds > In certain scenarios, cloud feeds pulled from third party sources 

were being duplicated. This was fixed. 

 

 

 

 

VERSION 1.1.166 RELEASED ON MAY 11, 2022 

 

Product Enhancements: 



 

• Invoices > The Invoices list screen can now be sorted using the Created-On 

column. 

• Reports > The Contract Analysis report has been optimized for better 

performance. 

• Reports > The Gross Margin Real Time report has been updated to include 

additional information. 

• Reports > The Work in Hand report layout has been updated to improve 

readability and the performance has been optimized. 

 

Application Stability: 

 

• Batch Invoice > Available Project Retainers were not being displayed correctly 

during the Create Batch Invoice process when there was no Project filter 

specified. This was fixed. 

• Reports > The Time Details Report was not calculating amount/hours correctly 

when filtering by multiple client groups. This was fixed. 

• Outlook integration > Some users were unable to sync all their Outlook events 

to CORE. This was fixed. 

• Employees > Payroll related actions were incorrectly showing up in employee 

screen action menus. This was fixed. 

• ePayments > Previewing the "Statement" report from the Payment portal, the 

system would not consider the filters that were associated with the Statement 

report that shared with the Client. This was corrected. 

 

 

VERSION 1.1.165 RELEASED ON APRIL 27, 2022 

 

Product Enhancements: 

• ePayments > The Invoice totals on the Client Payment Portal have been 

updated to reflect any discounts or retainers applied. 

• Cloud Feeds > Cloud Feeds have been enhanced to show check numbers for 

transactions involving checks. 

• QuickBooks integration > Users now have the ability to exclude non-

reimbursable expenses when sending expenses from CORE to QuickBooks. 



• Fee Schedules > Batch Update capabilities have been added to Fee Schedule 

Services and Expenses. 

• Budgets > Batch Update capabilities have been added to Project Budget 

Services and Expenses. 

• Activities > "Extra" attribute has been added to the Activities lists. 

• Activities > Description column has been added to all Activity filter drop 

downs throughout CORE. 

• Batch Invoicing > Users can now update the percent complete of a Project 

from the Batch Invoice screen without it affecting their Net Bill. 

• Reports > The Gross Margin report’s layout has been updated for easier 

scanning and its performance has been optimized. 

• Reports > The Time and Expenses report’s layout has been updated for easier 

scanning and its performance has been optimized. 

• Reports > The Expense Details report performance has been optimized. 

 

Application Stability: 

 

• Batch Invoicing > Projects were not showing up when using the Project 

Manager filter in the Create Batch Invoice screen. This was fixed. 

• Batch Invoicing > Time Entries were being excluded when Auto Apply Retainer 

was selected on the Batch Invoice flow. This was fixed. 

• Dashboard > The Project Status widget was showing incorrect contract 

amounts for Standard type parent projects. This was fixed. 

• ePayments > Invoice amounts on outgoing ePayment emails were not 

accounting for discounts or retainers. This was fixed. 

• ePayments > One of the CORE help links on the Global Settings ePayments 

screen was broken. This was fixed. 

• Invoice Templates > Project phases were shown out of order on joint invoices. 

This was fixed. 

• Invoices > Creating a batch invoice using the setting to 'generate an invoice 

amount based on % complete values' was not loading all the correct projects. 

This was fixed. 

• Outlook integration > Some users were unable to sync all their Outlook events 

to CORE. This was fixed. 

• Payments > There was an issue with displaying the client's projects in the 

modal window after saving and adding another Payment for a different Client. 

This was fixed. 



• Projects > Batch updating custom fields was incorrectly updating all records 

when using search text to filter records. This was fixed. 

• QuickBooks integration > Syncing joint invoices to QuickBooks Online was 

creating duplicates. This was fixed. 

• Reports > Running the Project List report using certain filters would cause 

master projects to not display in the report. This was fixed.   

• Reports > The Employee Performance report can now be filtered by Project. 

• Reports > The Profit and Loss reports had issues when drilling into figures in 

the report. This was fixed. 

• Reports > The Project Performance report was not properly displaying the 

Earned Value %. This was fixed. 

• Reports > The Statements report has been updated to reset the page number 

totals for each Client. 

• Reports > The Tax Registry report was showing incorrect grand totals. This was 

fixed. 

• Time Card > When using a multi-week Time Card option, the user was not 

brought to Week 1 when moving between different periods. This was fixed. 

• Time Entries > Exporting Time Entries to CSV was not honoring Cost and Bill 

rate security settings. This was fixed. 

• Time Entries > Time Entry descriptions were incorrectly being reset if the 

Project of the saved entry was edited. This was fixed. 

 

 

VERSION 1.1.164 RELEASED ON APRIL 15, 2022 

 

Product Enhancements: 

 

• ePayments > The ePayments portal has been enhanced to enable Clients to 

choose which Invoices to pay on a Statement. 

• Invoice Templates > Invoice Template sections and appearance can now be batch 

updated from the Global Settings page.  

• Projects > Users can now batch update Accounts from within the Projects list 

screen. 

• Reports > Multiple group filters have been added to CRM reports. 

• Reports > The Client List report layout format has been updated to improve 

readability. 



• CRM > Group filters have been added to the Leads, Prospects, Opportunities, 

Quotes and Proposals list screens. 

 

Application Stability: 

 

• Cloud Feeds > Projects were not loading in the Project Drop Down when adding a 

new transaction of type "ITEM", if the project has Rule "Prevent Time Entry." This 

was fixed. 

• Create Batch Invoice > Using the Project manager filter in combination with the 

"Generate invoice based on % Complete" rule caused certain projects to not show 

up. This was fixed. 

• CRM > Client Contacts were not getting copied over as Prospect Contacts. This 

was fixed. 

• CRM Opportunities > When applying a group filter on the Opportunity list screen, 

the top level KPIs would disappear. This was fixed. 

• General > Projects were not being displayed using the correct sorting order in 

various screens like the Projects list screen and Create Batch Invoice for some 

users. This was fixed. 

• General > Whenever the “All Dates” date filter was applied, the list screen would 

reset to This Year on the next refresh. This was fixed. 

• Invoice Templates > The Hourly by Title invoice template was not displaying 

correct bill rates. This was fixed. 

• Payables > The Vendor Bills and Purchase Order list screens had issues when 

applying the All-Dates filter. This was fixed. 

• Projects > Recurring project types had issues with doubled amounts. This was 

fixed. 

• Reconciliations > Duplicate transactions were unintentionally being created when 

double clicking the Clear checkbox really fast, making it impossible to balance 

properly. This was fixed. 

• Reports > The Proposal Documents report had the wrong report label. This was 

fixed. 

• Reports > The Contract Analysis report was not correctly honoring new report 

parameters. This was fixed. 

• Reports > The Contract Analysis report was not displaying all projects if contract 

amount was not specified at the project level. This was fixed. 

• Reports > The Expense Details report was incorrectly displaying Vendor records 

when Employee filters were applied. This was fixed. 

• Reports > The Proposal Documents report was incorrectly displaying all 

Document records. This was fixed. 



• Reports > Running or memorizing a Time Details report grouped by project or 

employee instead generates a report grouped by activity. This was fixed. 

• Scheduled reports > Scheduled reports were not processed for instances with 

more than 13 email recipients. This was fixed. 

 

Performance Fixes: 

 

• Several areas of the application including API requests, list and detail views, 

reports and widgets have been optimized for better performance. 

• Reports > The Billing Analysis report has been optimized for better performance. 

• Reports > The General Ledger Cash report has been optimized for better 

performance. 

• Reports > The Check Details report has been optimized for better performance. 

• Reports > The Vendor Bills report format has been updated and the performance 

has been optimized. 

• Reports > The Groups Assignment report was optimized for performance. 

 

 

VERSION 1.1.163 RELEASED ON FEBRUARY 10, 2022 

 

Enhancements:  

 

• Allocation-Event Sync: When created from an allocation, any changes made to a 

calendar event will now auto update the corresponding allocation also.  

• eSignature support for CRM Proposals: Proposals can now be emailed for digital 

signatures using DocuSign.  

• Contract Amount and Taxes: Global Settings to select different contract tax 

configuration have been updated to help users distinguish between the three 

varied tax options CORE supports.  

• QuickBooks Online Sync: A Linked column has been added to list views that 

support QuickBooks integration to help denote if a record has been synced or not.  

• Pricing Update: CORE's role-based and Express package pricing has been updated.  

 

Performance Fixes:  

 

• The General Ledger Extended report has been optimized for better performance.  



• The performance of the Time Entries, Expense Entries, and T&E Reviewer screens 

has been improved by limiting the use of the ‘All Dates’ period filter. ‘This Year’ 

will now be used as the default period for these screens and ‘All Dates’ can no 

longer be persisted as a saved option.  

• The performance of the Employee Allocation, Task Allocation, Project Allocation 

and Staff Workload widgets has been improved by limiting the use of the ‘As of’, 

‘As of Today’, and ‘Custom’ period filters and removing totals.  

• User notifications polling has been optimized for performance.  

• Project, Client and Invoice summaries have been optimized for better 

performance.  

 

Application Stability:  

 

• Updating the hours of an allocation line item did not properly save. This was fixed.  

 

• The Follow-Ups dashboard widget would incorrectly continue to display follow-

ups that were marked complete. This was fixed.  

• Payees were experiencing issues in the payment portal when processing a 

payment was attempted and the required fields were not filled correctly. This was 

fixed.  

• Setting a negative rate for an activity/expense line item was incorrectly saving as 

$0 instead of keeping the negative rate. This was fixed.  

• Any custom label set for the Net Bill value in Global Settings was not being used 

in the Project Performance tab. This was fixed.  

• When Google Drive was set as the default storage destination in Global Settings, 

previewing a file attached to an expense entry did not successfully display the file. 

This was fixed.  

• Updating the Start and End Dates for a task allocation line item would not 

properly work. This was fixed.  

• Payments that were recorded against a Client in QuickBooks were not properly 

syncing to CORE. This was fixed.   

• The Vendor Performance report displayed an incorrect vendor credit balance 

when multiple bills were paid using vendor credits. This was fixed.  

• If a Vendor did not have a first and last name, the Time Details report would 

display a blank space when grouping the report by Employee. This was fixed.  

• Switching between two companies in one CORE account would cause issues when 

applying filters in Dashboard widgets. This was fixed.  

• The Work in Progress Details report showed the incorrect discount amount in 

some instances. This was fixed.  



• The Allocation vs. Earned Revenue with Forecast report was incorrectly calculating 

the total using the employee's bill rate instead of the rate taken from the assigned 

fee schedule. This was fixed.  

• The Staff Workload widget did not include hours for allocations that did not have 

an end date causing an inconsistency with the hours displayed in the Employee 

Allocation Units report. This was fixed.  

• When a Vendor's Tax ID Number was saved and the setting to track payments for 

1099 was turned on, the TAX ID number displayed an error in all 1099 reports. This 

was fixed.  

• Exporting the line items when batch invoicing creates a blank file. This was fixed.  

• When viewing the Project Status widget by Budgeted Amount, the Open A/R 

column displayed the incorrect amount for phases. This was fixed.   

• When matching CORE transactions, the auto-filled memos were incorrectly 

deleted after selecting the corresponding Project and Item. This was fixed  

 

• Payments transferred to CORE as retainer are not successfully being used to pay 

an invoice. This was fixed.  

• CORE expense sync to QuickBooks was creating multiple bills instead of a single 

bill. This was fixed.  

• Joint invoices linked to one Project did not have the correct mappings even 

though the invoices were successfully syncing with QuickBooks Online. This was 

fixed.  

 

 

 

 

 

 

Payroll Beta Updates:  

 

• Users can now save historical employee payroll information to help with accurate 

YTD reporting.  

• Entries that were approved in a previous period are now successfully maintaining 

the updated approval status.  

• UI updates in Payroll Reviewer and Payroll Taxes report  

• General Fixes 

 

VERSION 1.1.162 RELEASED ON JANUARY 6, 2022 

 



Application Stability: 

• The Projects list view was not displaying any projects if the ‘Date’ type custom 

field was configured to display in the list view for one user. This was fixed.  

• When filtering for an individual project or a range of all projects in the Forecasting 

Manual View tab, the results listed are duplicated. This was fixed. 

• Error messages in CORE have been updated to provide a better description of the 

error that occurred. 

• Time Entries created using a device set to Central Time (US & Canada) were 

displaying tomorrow’s date for the Created on and Last Updated fields instead of 

today’s date. This was fixed. 

• Only leads with a 'Pending' status were displayed in the Leads list view by default, 

but the default display should have also included leads with a 'New' or 'Contacted' 

status. This was fixed. 

• Vendor bills that had time and expense synced to QuickBooks Online were not 

syncing. This was corrected. 

• Updating Start and End dates of dependent tasks in Gantt Chart would not update 

the underlying record for these date fields. This was fixed. 

• When filtering the Allocated Hours report by a client group, data for the wrong 

client group is displayed in the report. This was fixed. 

• CRM Proposal preview would not work if primary contact of a Prospect was added 

as one of the recipients. This was fixed. 

• When pasting text from a Word document into the Proposal Builder editor, all 

indentations are lost. This was fixed. 

 

Performance Fixes: 

• The Time Details report was optimized for better performance 

 

General Fixes: 

• Descriptions were updated for each package in the Manage Subscriptions screen. 

• The Managed By field on a standard Hourly invoice included an extra space 

between the first and last name. This was fixed. 

 

Payroll beta user feedback: 

• 'Net Pay x Percentage' was added as a calculation option for employee 

withholdings and company matching. 

• A row for totals was added for each employee or vendor in the Employee Pay 

Items report. 

• Bug fixes 

 

 



VERSION 1.1.161 RELEASED ON DECEMBER 16, 2021 

Performance Fixes: 

• Default date filters have been updated throughout CORE to improve performance. 

• List views that displayed KPIs at the top were improved to improve page load 

times. 

• Batch Update operations in Cloud feed have been optimized for improved 

performance. 

• Project update involving Phase hierarchy was optimized for performance. 

• General Ledger and Time Details report performance optimizations  

  

General Fixes: 

• Decimals were added back to the Billed, Paid, and Balance metrics displayed at the 

top of the Invoices list. 

• Cumulative Project Custom budgets experience was optimized to allow users to 

add line items for phases w/o turning on custom budget flags for each phase. 

• Monthly P&L report was updated to handle large numeric data w/o introducing 

overflow. 

• Project list report had an issue with rolling up Contract amounts when the “hide 

phases” option was used. This was fixed. 
  

Payroll beta user feedback: 

• Added the ability to save historical employee payroll information 

• Default filters applied to the Payroll Reviewer for faster access to relevant data 

• Bug fixes 

 

 

VERSION 1.1.160 RELEASED ON NOVEMBER 29, 2021 

 

Subscription Pricing Update: 

• BQE is introducing a new pricing structure to better package the most popular 

modules: Time & Expense, Project Management, and Billing. The new pricing 

model offers Accounting, CRM and HRM as add-on packages at the Company 

level. The new pricing changes will only apply to new CORE customers and will not 

affect existing users until a later date. 

 

Application Stability: 



• Users who had custom security profiles assigned were not able to load reports in 

the report center. This was fixed. 

• The Vendor Bill report was crashing when the Vendor Bill Status filter was applied. 

This was fixed. 

• Exporting a large number of records from the Create Batch Invoice screen would 

result in faulty exported files. This was fixed. 

• Entering a memo in the Project details would cause CORE to be unresponsive in 

the Chrome browser. This was fixed. 

 

Performance Fixes: 

• Follow up list view was optimized for performance. 

• The General Ledger report was optimized for performance. 

 

Payroll beta user feedback: 

• Improved review and approval experience in the Reviewer 

• Bug fixes 

 

General Fixes: 

• Updates to task start and end dates were not syncing within the Allocation & 

Forecasting screens. This was fixed. 

• The Retainer Reconciliation report was not applying the date filter correctly. This 

was fixed. 

• Time details Report shows project manager instead of employee/activity at the 

top when group by employee or activity. 

• Payment type updates were not properly syncing throughout CORE. This was 

fixed. 

• When updating the description of a Time Entry, the memo would be deleted. This 

was fixed. 

• Payment Receipts were being sent even with Global Setting turned off. This was 

fixed. 

• The Client Transactions report has been updated to improve readability. New filter 

parameters have been added as well. 

 

VERSION 1.1.159 RELEASED ON NOVEMBER 10, 2021 

 

Application Stability: 

• Fixed an issue that was preventing some two-factor authentication users from 

logging in. 



• Fixed an issue that was not properly enforcing cost amount access on the Budget 

screen.  

• Fixed an issue with date filters in the Time Card view for New Zealand users. 

• Added several security related fixes. 

 

Performance Fixes: 

• Budget creation from existing budgets that had a large number of items was 

optimized for faster performance. 

• List view KPI metrics were optimized for performance improvements when 

reporting for companies with large data. 

• Performance optimizations were implemented for several reports that either failed 

to preview or would take a long time to preview. 

 

General Fixes: 

• The Time Details report has been improved for readability and now offers more 

filters.  

• QuickBooks credit payments are now transferred as Client retainers instead of 

Project retainers. 

• Added support for less popular international currencies for cloud feeds. 

 

Payroll beta user feedback: 

• Improved Employee Payroll Defaults UI. 

• Updated several reports with default filters. 

• Updated labels and captions. 

• Bug fixing. 

 

 

VERSION 1.1.158 RELEASED ON OCTOBER 25, 2021 

 

General Application Stability 

Several issues affecting existing features have been fixed throughout the application. 

• ePayments > When returning to the ePayments portal to edit an existing payment, 

the incorrect deposit account details were being displayed. This was fixed. 

• Projects > The Project list screen was not properly displaying search results when 

two or more Custom Field filters were applied. This was fixed. 

• Bill Payments > ABA Files that were generated from the Bill Payments screen were 

incorrectly rounding amounts. This was fixed. 



• Cloud Feeds > When matching transactions in Cloud Feeds, the Payee drop down 

menu was not displaying all records. This was fixed. 

• Invoice Collections > Invoice Collection notes that were added to past or future 

dates were reverting to an incorrect date. This was fixed. 

• Payments > The Invoices list in the Add Payment screen was not sorting dates 

correctly. This was fixed. 

• Integrations > The eSign option was appearing for proposals after connecting a 

DocuSign account, but that feature is not yet available. This was fixed. 

• Payments > The credit and debit amounts were not displaying the same amount 

when creating an ABA file from the Payments screen. This was fixed. 

• Deposits > Users with Deposit records that were migrated to CORE were 

experiencing issues when saving Text Custom Fields. This was fixed. 

• ePayments > The branding update from DesignPay to ClientPay was not applied in 

some parts of CORE. This was fixed. 

• Updated help and other documentation.  

• Other minor level fixes. 

 

 

 

VERSION 1.1.156 RELEASED ON OCTOBER 9, 2021 

 

What’s new in this version?  

 

Two-Factor Authentication app support 

CORE has further enhanced its two-factor authentication security by now offering the 

ability to connect with popular authenticator apps. The implementation will support 

popular authenticator applications like Google Authenticator, Microsoft Authenticator, 

Twilio Authy among others. 

 

Draft Invoice Editing 

A highly requested feature enhancement to CORE’s popular Billing module is finally here. 

Draft Invoices can now be edited directly in the Invoices screen. Relevant Invoice details 

ranging from Contact Information to discount and retainers can be updated from one clean 

interface. 

 



Extend eSignature support to more modules 

The ability to send documents out for collecting eSignatures directly from CORE has been 

expanded to other modules. Document eSignatures have been expanded to include 

Invoices, Purchase Orders, and Vendor Bills. When a document is sent for eSignatures, the 

eSignature status will be tracked and automatically updated in the respective Documents 

tab of the specified record.  

 

CORE Payroll – Beta 

Significant progress has been made on the upcoming CORE Payroll feature being 

introduced to round out CORE's overall offering including the ability to configure company 

and employee payroll defaults, approve entries to include in payroll, and process payroll 

for employees and agencies that follow multiple differing payroll frequencies. This module 

is currently in closed beta. 

Cloud Feed Enhancements 

Several enhancements have been made to the Cloud Feed module to improve the overall 

user experience. These include search and filter function, column resizing among other 

improvements.  

 

Integrations Enhancements 

Improvements have been made to strengthen the data synchronization with third party 

accounting software solutions. 

 

Other Improvements: 

• Assignments > A new option has been added to the Assignments tab of a Project’s 

detail page so users can update phase assignments when changes are made at the 

Parent level. 

• Batch Invoicing > Pre-Tax Net Bill has been added as a column to the Create Batch 

Invoice list screen. 

• Benefits > Managers can set a benefit to have a maximum carry over amount 

calculated based on a multiplier of the previous year's remaining balance.  

• Cloud Feeds > A filter panel and Search box has been added to all three transaction 

list views in Cloud Feeds. 

• Cloud Feeds > Cloud Feeds rules can now be reviewed and edited from within the 

Transactions lists accessible from the More drop-down menu. 

• Cloud Feeds > Column resizing has been added throughout the Cloud Feeds 

module. 



• Cloud Feeds > Payee and Account have been added CORE transactions details in the 

Pending list in Cloud Feed. 

• Cloud Feeds > The Cloud Feeds matching experience has been updated to avoid list 

refreshes after an entry is matched. 

• Dashboard > The dates on the x-axis for the newly-added Project Schedule widgets 

have been moved to the top of the chart. 

• Dashboard > The Retainer Balances widget has been updated to exclude Clients 

with a zero-retainer balance. 

• ePayments > CORE has been updated to work smoothly with DesignPay’s brand 

name transition to ClientPay. 

• General > When merging entities, the confirmation dialog now displays the exact 

names of the entities being merged to make the process more transparent. 

• Global Search > Users now search for Cost Amount along with other currency fields 

like Cost and Bill rates. 

• HR Reviews> Questions on Employee Reviews can now be assigned specifically to 

the Reviewee, Reviewer or Both. 

• Integrations > A column for Invoice number has been added to the QuickBooks 

Unmapped records screen on the CORE side. 

• Integrations > Credit Payments can now be synced from QuickBooks to CORE as 

Retainer Payments. 

• Invoice Templates > Invoice Templates can now be configured to allow eSignatures. 

• Invoices > A project rule has been added to include retainer summaries on invoices. 

• Leads and Prospects > Added City and State as filter options in their respective list 

view screens. 

• Performance > CORE data queries have been optimized to improve widget and 

report performance. 

• Project Templates > In the To-dos tab of a Project Template, the Duration column 

label was changed to "Duration (Days)" to better describe the information displayed 

in the column. 

• Reports > A Resource filter option has been added to the Time Card Cross Tab 

report. 

• Reports > An Employee Group filter has been added to the Employee Utilization 

report. 

• Reports > An option to show Start and Stop times has been to the Time Verification 

and Time Detail reports. 

• Reports > Options have been added to the AP Aging with Credits report to 

Show/Hide details and to Show orphaned General Journal entries. 

• Reports > Resource and Vendor filter options have been added to the Time 

Verification report. 

• Reports > The Class filter has been added to the following reports: AR Aging, AR 

Aging 5 Steps, AR Aging 8 Steps, AR Aging with Retainage. 

• Reports > The Expense Details report has been updated for improved readability. 



• Reports > The Notes column in the Employee Notes by Category report has been 

expanded to take full advantage of the page width. 

• Reports > The Payment Refunds report has been updated for improved readability. 

• Reports > The Time and Expense by Parent Project report has been updated for 

improved readability. 

• Reports > The Time and Expense report has been updated to improve its readability 

and offer more filter parameters. 

• Reports > The Time Card Cross Tab report has been updated to improve its 

readability and offer more filter parameters. 

• Reports > Several reports had issues with the drill down feature and this update 

remedies that. 

• Retainers > An option to modify the memo text for ePayments-enabled Retainer 

Invoices has been added to the ePayments Settings section. 

• Split Bills > We have enhanced this function to allow users to configure 0% billing 

splits. 

• Subscriptions > We have bumped up free storage allowance from 2 GB to 5 GB limit 

per Company. 

• Time & Expense > If a Project has the “Auto-approve Time/Expense” rule checked, 

CORE will allow its entries to be updated irrespective of the "Allow Edit of Approved 

Entry" security permission.  

• Time & Expense Reviewer > When opening the Time & Expense Reviewer screen, the 

search box of the list was updated to be the initial focus upon page load. 

• User Preferences > Users now have the option to turn off the recent suggestions 

feature on CORE drop-down lists. 

• Vendor Bills > Duplicate Vendor Bill restrictions have been enhanced to allow the 

use of the same bill number for different Vendors. 

• Vendor Bills > eSignature capabilities have been added to Vendor Bills. 

• Vendor Bills > Time and Expense entry attachments will be automatically added to a 

corresponding Vendor Bill and all attachments cannot be accessed in the 

Documents tab of the Vendor Bill details. 

• Vendor Bills > Workflow options have been added to the Actions menu in the 

Vendor Bill details. 

 

Other Fixes: 

• Accounting > The General Ledger Extended report was not showing memos entered 

at the expenses item level on invoices. This was fixed. 

• Bill Payments > The Amount field on the Bill Payment list screen was incorrectly 

including the Vendor Credits applied. This was fixed. 

• Bill Payments > The NACHA file generated from the Bill Payments screen for 

Australian companies was causing errors when uploaded to Commonwealth Bank 

to initiate a batch payment. This was fixed. 

• Calendar > The Sync Date on the CORE Calendar was not reflecting the correct local 

time. This was fixed. 



• Create Batch Invoice > When batch updating a list of Project billings, the system 

would allow the user to specify a discount amount and then apply it as is without 

checking the net bill amount for that Project. This was fixed. 

• Dashboard > On the Due Projects widget, filtering the list for projects with a 

‘Canceled’ Project Status was not working. This was fixed. 

• Dashboard > The Cash Flow widget was not properly displaying Invoice payments 

made via one Payment. This was fixed. 

• Dashboard > The Payment Date filter in the Retainer Balances widget was not 

properly transferring retainers. This was fixed. 

• Documents > In the Documents list screen, clicking on a disabled eSign action would 

open the detail view of that document record. This was fixed. 

• ePayments > A third party scenario was causing the ACH Transaction Status to not 

update to Completed. This was fixed. 

• Estimates > The Documents tab of an Estimate's detail page displayed the row 

actions menu outside of the table when the eSign Status column was not turned on. 

This was fixed. 

• Expense Entry> An update to the billable flag would reset the charge amount if the 

user had not entered a Cost rate. This was fixed. 

• HR > Users that had the CORE Express and CORE Express HR subscription added to 

a company file were unable to preview any of the on-screen Reports for the HR 

modules. This was fixed. 

• Integrations > Payments were not syncing over to Xero from CORE if the Bank 

account under sync setting was set to the Bank account created in the Xero. This 

was fixed. 

• Lists > The height of the error message displayed in CRM lists when deleting an item 

that is in use was cutting off the message. This was fixed. 

• Opportunities > New contacts could not be created from an existing CRM 

Opportunity. This was fixed. 

• Project Budgets > For Budgets with many budgeted items, the Unbudgeted Items 

row would duplicate itself at the end of the list. This was fixed. 

• Project Templates > In the To-dos tab of a Project Template, the "Create Time Entry" 

action for a to-do item does not open the modal to create a time entry and causes 

an error. This was fixed. 

• Project Templates > The ability to add an attachment when creating a time entry 

from a project template's to-do item was not working. This was fixed.  

• Projects > Few users had reported that the Percent Complete value was not rolling 

up to the Parent Project in the Structure tab interface. This was fixed. 

• Projects > Rearranging the phases in a project's Structure tab was not properly 

saving the correct order. This was fixed.  

• Projects > The Projects list view column sort was not correctly sorting for several 

columns. This was fixed. 

• Projects > The relocated dropdown for all the phases in a project's detail view was 

missing the ability to scroll through a longer list of phases. This was fixed. 



• Projects > When adding a Team Member under the Assignments tab in Project 

details, sorting the list of Team Members in the dialog would cause the entire list to 

vanish. This was fixed. 

• Projects > When navigating to a different phase from the Project details, the tab 

location was not persisted. This was fixed. 

• Projects > When searching for team members to assign in a project detail's 

Assignment tab, the modal's search box was only searching for entries that were 

initially loaded and displayed instead of searching the whole list. This was fixed. 

• Projects > When using the Expand Sub-phases action in the Projects list screen, 

some projects were being duplicated and an incorrect view count was being 

displayed. This was fixed. 

• Proposal Builder > When trying to preview a Proposal that had a Quote in the 

Compose Email module, the preview window had overflowing tables. This was fixed. 

• Reports > New Zealand based customers could not preview the WIP Reconciliation 

Report. This was fixed. 

• Reports > Profitability percentage was being calculated incorrectly when the Invoice 

amount was $0. This was fixed. 

• Reports > Purchase Order History report had an issue when grouped by Vendor. 

This was fixed. 

• Reports > Several users had complained that they would get a blank page inserted 

at the end of the report when previewing or printing the report. This was corrected. 

• Reports > Several users had complained that a few of the standard reports had 

stopped working if the logged user had a custom defined security profile. This was 

fixed. 

• Reports > Some Equity accounts were not being displayed in Viewer format for the 

Balance Sheet Cash Basis report. This was fixed. 

• Reports > Some Financial Reports were producing an extra blank page at the end of 

the report. This was fixed. 

• Reports > The Activity by Project report was not properly supporting the drill down 

feature. This was fixed. 

• Reports > The Balance Sheet by Class Accrual Basis report threw a system error 

when drilling down into the number details. This was fixed. 

• Reports > The Documents report was not displaying the payroll labels properly. This 

was fixed. 

• Reports > The Employee Daily Time Card and Time Verification on-screen reports 

were not reflecting the same date range as the Time Card screen. This was fixed. 

• Reports > The Employee Expense report total numbers were not trying out. This was 

fixed. 

• Reports > The Missing Classification category was not being displayed in certain 

scenarios across the AR Aging reports. This was fixed. 

• Reports > The Paid filter was not being correctly applied when running on-screen 

reports from the Payments screen. This was fixed. 



• Reports > The Project Time Entries report was not respecting the cost security when 

a scheduled report was delivered. This was fixed. 

• Reports > The Top N Expenses report was not properly supporting the drill down 

feature. This was fixed. 

• Reports > The Workflow Details report could not be filtered by Vendors. This was 

fixed. 

• Scheduled Reports > Reports could not be scheduled for more than 15 emails. This 

was fixed. 

• To-dos > The list of To-do items would disappear whenever creating a new To-do for 

an Opportunity in the main To-dos list screen. This was fixed. 

• To-dos > To-do reports were not available to generate from the To-dos list screen 

for Invoices and Project templates. This was fixed. 

• To-dos > When creating a Time Entry from a To-do, attachments couldn't be added 

from the Resource Library option. This was fixed. 

• Vendor Bills > When creating a new vendor bill, time entries that have already been 

marked as paid using batch update in the Time Entries screen were incorrectly 

being listed in the time entries CORE suggests to include in the vendor bill. This was 

fixed. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes. 

 

 

VERSION 1.1.155 RELEASED ON AUGUST 21, 2021 

 

What’s new in this version?  

 

Project Schedule Dashboard Widgets 

Two new dashboard widgets have been added to CORE to help users better visualize their 

project schedules and allocations. The “Project Schedule by Due Date” widget displays 

projects in a Gantt chart using each project’s start and due dates. The “Project Schedule by 

Allocation” widget also displays projects in a Gantt chart, but is driven by Project allocation 

dates. 

 

Enhanced Project Templates 

Project Templates have been further enhanced to streamline the project creation process 

and eliminate manual data entry. Additional phases can now be added to existing project 



templates. When setting up a project template, project managers can also elect to 

designate a standard set of To-dos to that template that can be cloned when setting up a 

new project. 

 

Allocate from Events 

CORE Calendar Events have been enhanced to further integrate with the Allocations 

module. New and existing events can now be used to create Allocations. Event details will 

be used to pre-fill the Allocation information and reduce the need for duplicating data 

entry.  

 

 

Other Improvements: 

• Activity Items > The "Purchase Tax" column label has been updated to match the 

label used in Expense Items. 

• Calendar > Calendar events that have been used to create a Time Entry will now be 

marked with an icon to signify that a Time Entry record exists. 

• Checks, Deposits > An anchored totals row has been added to the Checks and 

Deposits list screens. 

• CRM Email Templates > Custom fields can now be used as Smart Fields when setting 

up a CRM Email Template. 

• Dashboard > The Priority column was added to the To-dos widget. 

• Dashboard > The Project Status Widget was missing the Marketing option for the 

Project Contract Type filter. This was added. 

• ePayments > ePayment invoice emails have been updated to accommodate multiple 

invoices being sent out at once. 

• eSignatures > A new status column has been added to the Documents list view that 

will display the Document's eSignature status. 

• Employees > The Employee Account number field has been expanded to accept up 

to 16 digits. 

• Expenses > The cost amounts for approved expense entries have been added to the 

automated email notifications. 

• Follow-Ups > Users can now issue a quick search for matching follow-ups based on 

Assigned to and Follow-up type values. 

• Integrations > CORE Joint invoices that are synced to QuickBooks will now remain as 

one invoice rather than being split into multiple Invoices in QuickBooks. Users can 

also retain to use the old option. 

• Integrations > The date time stamps in the Sync history have been updated to 

reflect the logged in user's time zone. 

• Invoice Templates > The Joint Invoice Templates have been updated to improve 

readability. 



• Invoices > Manual invoices can now be created from an existing Custom Budget. 

• Projects > Project detail hierarchy navigation has been expanded to include all tabs 

in a Project's details. 

• Projects > The tooltip for the Spent column in a Project detail page's Structure tab 

was updated to more accurately describe that column's information.  

• Reports > The Time Entry Delay report has been added to the Report Center. 

• Reports > All Financial Budget reports will now include Income and Expense 

accounts even if they have not been assigned a budget but have a balance in the 

specific period. 

• Reports > The Billable Work History report has been re-designed to improve 

readability. 

• Reports > The Cash Flow vs Revenue report has been re-designed to improve 

readability and offer new filter options. 

• Reports > The Project Group filter has been added to the WIP Reconciliation and 

Employee Utilization reports. 

• Reports > The Retainage Summary by Client report has been re-designed to improve 

readability. 

• Reports > The Taxes report has been re-designed to improve readability. 

• Reports > The Top Ten in Revenue report has been re-designed to improve 

readability and offer new filter options. 

• Reports > The Void Invoices report has been re-designed to improve readability and 

offer new filter options. 

• Retainers > Project Retainers can now be transferred between different clients. 

• Security > A new security option has been added to control the "Update Rates" 

feature in Time Entry. 

• Security > A new security option has been added to show or hide bill rates on 

reports. 

• Submit Workflow > The messaging for notifications and workflow emails have been 

updated for submissions that are forwarded to another manager for approval. 

• Time & Expense Reviewer > Taxes (including Purchase Tax) can now be added to the 

Time & Expense Reviewer list view as optional columns. 

• Vendor Bills > Users can now enter Purchase Tax as an amount by prefixing the 

number with a "$" symbol. 

 
 

Other Fixes: 

• Bill Payments > Bill Payments could not be saved for users that switched their 

country to UAE in the company profile. This was fixed. 

• Budgets > Selecting all records on the Budgets list view and then scrolling to expose 

more records in the list would cause Batch Updates to affect an incorrect number of 

records. This was fixed. 



• Create Batch Invoice > In certain scenarios involving a large number of Phases per 

Project, the Percent Complete option would not display all the phases that were due 

for billing. This was fixed. 

• Credit Cards > An issue in code was preventing updates to the class associated with 

a line item. This was corrected. 

• CRM > Custom fields were incorrectly overlapping between filters for all CRM 

modules (Leads, Prospects, Opportunities). This was fixed. 

• Dashboard > The Submittal and RFI widgets would disappear from an existing 

dashboard and could not be added back when a new subscription was assigned to a 

logged in user. This was fixed. 

• Estimates > When downloading an Estimate from the Estimates list view, the PDF 

would contain extra pages. This was fixed. 

• Forecasting > The forecasting algorithm was not able to distribute a 1-unit 

allocation. This was fixed. 

• General > Drop down items displayed under the recent section were not appearing 

in their usual position in the broader list. This was fixed. 

• General > Filtering a list view by a text box type of custom field and then editing that 

field for a record would cause the entire list of records to disappear. This was fixed. 

• General > Logos were not being uploaded with the correct dimensions in Company 

Profile. This was fixed. 

• Integrations > Project costs were not being tracked appropriately using the 

QuickBooks sync. This was fixed. 

• Integrations > Invoice sync was not working if the CORE project for the invoice had 

the automatic email on processing turned on. This was fixed. 

• Invoices > The "Last Emailed On" column was not correctly adjusting the date time 

field to the user's time zone. This was fixed. 

• Invoices > The Project Manager filter would cause some of the paid invoices to show 

up as Open. This was fixed. 

• Leads, Prospects > The autocomplete feature was not working properly for the Tag 

filter on the Leads and Prospects list views. This was fixed. 

• Manual Invoices > When creating a manual invoice, the date format was not 

following the local settings set for Australian users. This was fixed. 

• Messages > Opening an attachment from the Message details screen would cause a 

screen error. This was fixed. 

• Projects > Quick search would limit the list view to 25 records if the user had chosen 

to display a custom field in the list view. This was fixed. 

• Proposals > The placeholder text in the search box of the Add Quote modal was 

incorrectly labeled. This was fixed. 

• Prospects > The file name of the selected file when uploading a document in the 

note details of a Prospect's contact was not displaying in the modal. This was fixed. 

• Prospects > When importing contacts via csv files into a Prospect record, saved 

mappings were not showing up on subsequent imports. This was fixed. 



• Reports > An issue with the Open Purchase Orders report was preventing open 

Purchase Orders from showing up if they had a line item with a negative number of 

units. This was fixed. 

• Reports > The Project Groups report was un-necessarily including the "All' group. 

This was fixed. 

• Reports > The "Project Time and Expenses" report was not including the extra billed 

expenses in the Account Summary. This was fixed. 

• Reports > The Budget Comparison by Employee report was not displaying the 

correct sums under the Spent Amount column in some cases. This was fixed. 

• Reports > The Employee Missing Time Week View report was not showing 

Employees who had missing time, if a Vendor with the same name existed. This was 

fixed. 

• Reports > The Notes report was not displaying all relevant records when applying a 

date filter. This was fixed. 

• Reports > The Project List report had issues when applying certain logical filters. This 

was fixed. 

• Reports > The WIP Reconciliation report has been optimized for performance. 

• Time & Expense Reviewer > When the Select All checkbox was used for Workflow 

Status filter, the list view would not display all records as it should have. This was 

fixed. 

• Time Card > The Bi-week period used on employee time cards and the Employee Bi-

weekly Time Card report were not referencing the same period. This was fixed. 

• Time Card > When a time entry was submitted to My Manager as Payroll type only, 

the submit status icon would not show up on the Time Card. This was fixed. 

• Time Entries > The newly added import CSV feature was not including the Class 

column when imported from a CSV file. This was fixed. 

• To-dos > To-dos that were batch updated to an inactive status were still showing up 

on the list view. This was fixed. 

• To-dos > To-dos were not properly sorted by their priority. This was fixed. 

• Vendor Bills > non-reimbursable expense entries were being marked as 

reimbursable when their associated Vendor Bill was paid via Credit Card or Checks. 

This was fixed. 

• Vendor Credits > In the Vendor Credits Create New and Details screens, the 

Accounts Payable field did not have a red asterisk to indicate that it is a required 

field. This was fixed. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes. 
 

 

 



VERSION 1.1.154 RELEASED ON JULY 3, 2021 

 

What’s new in this version?  

 

CORE eSignatures with DocuSign 

This update adds the hugely requested feature of electronic signing for CORE reports and 

documents. We have added this feature by partnering with DocuSign, the world leader in 

digital signing allowing CORE users to send documents and reports for eSignature to any 

external or internal contact. The fully embedded eSignature experience has also been 

added as an option in Budgets, Estimates, Time Card, Time Entry and Expense entry 

screens and allows users to send reports for electronic signing with or without preview. 

 

Time & Expense Import 

Time and Expense Entries can now be bulk imported to CORE by uploading a .csv file. The 

import wizard can be accessed from the More option of the list views. CORE also has the 

ability to memorize the column mapping from your designated file to streamline future 

imports.  

BAS Statement  

Australia-based companies can now generate a Business Activity Statement from CORE 

using their existing company data. The Business Activity Statement module will allow users 

to review and make edits to the required input fields. Each BAS can be saved for future 

reference and a neat report can be shared with internal or external parties. 

ABA File Export 

Australian and New Zealand users can export their Bill Payments to an .aba file format file. 

ABA is a preferred file format for all the major banks in the Australia and NZ to automate 

Bill Payments. 

Pre-fill Time Card from Allocated Tasks 

Time Card suggestions have been enhanced to now suggest time card rows based on 

allocated tasks. Each user will now have the option to have their Time Card suggestions 

based on recent time entries, allocated tasks for a given period, or a combination of both. 

 

 

Other Improvements: 



• Accounting > Multiple Accounts Receivable and Accounts Payable accounts can now 

be used when creating a Journal entry. 

• Activities > Purchase Tax Rate has been added as a Batch Update option in the 

Activities list view screen. 

• Batch Invoices > When launching the Billing Details report from the Create Batch 

Invoice list screen, it will now include the Billing Through dates. 

• Billing > Upon billing 100%, Projects will now be marked complete based on the 

Global Setting rule, regardless of Project Contract type. 

• Budgets > Cumulative Budget list view scrolling has been improved. 

• Budgets > The Project Budgets UI has been updated for improved readability. A new 

subtotal row has also been added to report the unbudgeted units that have been 

incurred on that specific project or phase. 

• Clients > The Clients list screen now supports searching by Address. 

• Clients > The Company column was made to be an optional column in the Clients list 

view. 

• Clients, Employees, Vendors, and Projects > State and City were added as optional 

columns for the Clients, Employees, Vendors, and Project’s list screens. 

• Custom Fields > Custom fields can now be batch updated from all existing modules 

that support them. 

• Dashboard > Additional filters have been added to Dashboard widgets for Principal 

and Originator. 

• Dashboard > The Last Week period filter option has been added to the Time 

Performance widget. 

• Dashboard > The number format on Dashboard widgets have been updated to 

include commas. 

• Employees > Employee Groups can now be batch updated and assigned from the 

Employee list screen. 

• ePayments > ePayments users can now set default ePayment profiles for each 

payment type (ACH and Credit Cards) at the global level. Previously, users could only 

set one default profile, regardless of type. 

• Forecasting > The Activity grouping for Other Tasks can now be expanded from the 

Forecasting list screen. 

• General > Additional optional columns have been added to the following list 

screens: Employees, Clients, Vendors, Projects, Invoices, Payments, Time Entries and 

Expense Entries. 

• General Journal > A totals row has been added to the review step while importing 

entries via CSV to the General Journal. 

• Global Settings > Administrators can now set up a separate default Account for Late 

Fees in Global Settings. 

• Invoice Collections > A Notes count has been added to the Invoice Collections 

screen. 

• Invoices > Draft Invoices can now be Approved and Finalized from the Invoices list 

view screen. 



• Invoices > Time and Expense entries on Draft Invoices will now be included in Work 

in Progress calculations for reports and widgets. 

• Leads and Prospects > A Job Title attribute has been added to CRM Leads and 

Prospects. 

• Lists > Default Note Categories can now be edited or deleted from the Note 

Categories list. 

• Notes > The ability to add notes for secondary level contacts was added in the 

Contacts tab of a Client, Employee, and Vendor. 

• Opportunities > A Created-On column has been added to the CRM Opportunities list 

screen. 

• Opportunities > Custom fields have been added to CRM Opportunity records. 

• Opportunities > New CRM Opportunities can now be created for existing Contacts 

(Clients, Vendors, Employees) using a row action from the corresponding list 

screens. 

• Opportunities > Notifications will now be sent to a user when they are assigned to 

an Opportunity. 

• Opportunities > Sales Commissions were not being processed if the Quote Amount 

or Proposal Amount were chosen as the final amount when marking an Opportunity 

as Won. This was fixed. 

• Overtime Calculator > The Overtime Calculator has been enhanced to support 

Employee Weekly Standard Hours. Also, Overtime rules can now be set on a weekly 

or daily basis. 

• Project Templates > Custom Fields have been added to Project Templates. 

• Projects > The Originator field for a Project will be automatically set as the user 

creating the Project. 

• Projects > When cloning an existing Project, Custom Fields can now be included as 

part of this process. 

• Reports > An option to Include Write ups and Write Downs has been added to the 

Billing Details report. 

• Reports > The Custom Retainer Invoice report now supports the ePayments Pay 

Now button. 

• Reports > New filter options have been added to the Monthly Billing Statement 

report and the report layout has been updated to improve readability. 

• Reports > New filter options have been added to the Percentage Billed report and 

the report layout has been updated to improve readability. 

• Reports > New filter options have been added to the Tax Tracking report and the 

report layout has been updated to improve readability. 

• Reports > The Cloud Feeds report can now be filtered to show All, Pending, Ignored 

or Included in CORE records. 

• Reports > The Originator and Principal filters have been added to the following 

Aging reports: AR Aging, AR Aging 5 Steps, AR Aging 8 Steps, AR Aging with Credit 

Payments, and AR Aging with Retainage. 



• Reports > The Originator and Principal filters have been added to the following 

financial reports: Balance Sheet Accrual by Project and Profit and Loss Accrual by 

Project. 

• Reports > The Originator, Principal and Project Manager filters have been added to 

the following Analysis reports: Actual and Billing Comparison, Cost Analysis, Earned 

Value and Employee Realization Rate. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following accounting reports: Vendor Bills by Project, Open Purchase Orders, 

Purchase Order History, Purchase Order Invoice, Purchase Order Received Item, 

Purchase Order Time & Expense, and Purchase Orders. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Activity/Expense reports: Activity by Project, Top N Activities, and Top 

AND Expenses. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Billing reports: Account Transactions, AR Reconciliation, Billed Time 

and Expenses, Billable Work History, Cash Flow vs. Revenue, Invoice Register, 

Payment Refunds, Retainage Summary by Client, Statement, Taxes, Statement by 

Client (Accountant), Top Ten in Revenue, Void Invoices, Work In Progress, and Write 

Up Write Down. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Client reports: Client Retainer Summary, Client Transactions, Tax 

Registry, and Top N Clients. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Company reports: Collection Calls, Conditional Lien Release, Contacts, 

Employee Profitability, Employee Project Utilization, Firm Reconciliation, Group 

Assignments, Mailing Labels, Monthly Revenue by Project, Notes, Payroll, To-do 

Tasks, WIP Reconciliation. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Employee reports: Employee Allocation Units, Employee Control, 

Employee Daily Time Card, Employee Expenses, Employee Half Monthly Time Card, 

Employee Paid Time Off Comparison, Employee Time Card Summary, Employee 

Time Detail, Personal Time Off Usage, and Staff Workload. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Payment reports: Cash Flow Monthly Statement, Cash Receipt YTD 

Comparison, Cash Receipts, Cash Receipts Journal, Collections, Credit Memo 

Receipt, Credit Memos, Credit Payment Receipt, ePayment Details, Paid Time and 

Expense Disbursements, Paid Time and Expenses, Payment Details, Payment 

Receipt, Payments Synced with QuickBooks, Refund Retainer Receipt, Retainer 

Details by Project, Retainer Invoice, and Void Payments. 

• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Project reports: Submittals, Drawings, and Allocated vs. Earned 

Revenue with Forecast. 



• Reports > The Originator, Principal, and Project Manager filters have been added to 

the following Time and Expense reports: Expense Details, Allocated Hours, Time 

Verification, Time Card Crosstab, Time Card Week View, Time and Expenses, and 

Time Details. 

• Reports > The preview option label was changed to "Preview Format" to better 

describe the associated action. 

• Reports > Principal and Originator filters have been added to the following 

accounting reports: Vendor Bills, Vendor Bill Status, Trust Fund Account Activity. 

• Reports > The Project Profitability report now has the option to calculate Profit with 

or without Work in Progress. 

• Reports > The Sales Forecast Distributed and Sales Forecast Summarized reports 

can now be drilled down on for more granular details. 

• Reports > The Sales Forecast Summarized report can now be filtered by Category. 

• Reports > The Time Verification report now has the option to group by week. 

• Reports > Newly added reports and custom reports are now made available to users 

with full reports access only. 

• Reports > The Accounts Receivable report’s calculation performance has been 

optimized to handle large amounts of data. 

• Sales Forecasting > Additional security has been added to the Sales Forecasting 

module in CRM to limit access to certain users. 

• Subscriptions > CORE has added Express subscriptions for CRM and HR Packages. 

• Task Allocations > Memos can now be batch updated from the Task Allocations list 

screen. 

• Time and Expense Reviewer > The Reviewer list screen can now be filtered for 

Reimbursable entries. 

• Time Entries > The Purchase Tax Rate field has been added to the detail view of 

Time Entries and Activities. 

• Time Entries > The Time Entry description field has been expanded to accept up to 

200 characters. 

• To-Dos > Batch Update functionality has been added to the To-Dos list view screen. 
 

Other fixes: 

• Activities > Batch Updating the description field from the Activities list screen to use 

more than 200 characters would result in a system error. This was fixed. 

• Calendar > Some synced calendars from Office 365 were displaying the wrong name 

in the CORE Calendar view. This was fixed. 

• Credit Cards > A system issue would prevent updating the class field of a charge. 

This was fixed. 

• Custom Fields > Custom fields used for either Leads, Prospects or Opportunities 

that exceeded the character limit were showing up as saved when there was no 

record found. This was fixed. 



• Dashboard > The YTD date filter was not working properly for the PTO widget. This 

was fixed. 

• Dashboard > The Project Status Widget would remove existing filters if the View By 

option was changed from Budget to Contract Amount. This was fixed. 

• Dashboard > The Staff Utilization widget would ignore Contract Employee type 

vendors. This was fixed. 

• General > The 'Accounting' main navigation link was not highlighted while on the 

Reconciliations page. This was fixed. 

• Global Search > In some instances, the "Recent Activities" results were displaying 

duplicates. This was fixed. 

• Manage Users > CORE allowed the deletion of employees with entries submitted to 

them. This was fixed.  

• Opportunities > Creating a Project from an Opportunity using a Project Template 

would result in a system error. This was fixed. 

• Overtime Calculator > Overtime entries created by the OT Calculator did not inherit 

the memo of the original entry. This was fixed. 

• Projects > Project Name and Contract Amount columns were not properly being 

exported in CSV files from the Projects list view. This was fixed. 

• Projects > The Projects list view row count was not properly updating when phased 

projects were expanded and then collapsed. This was fixed. 

• Proposals > When deleting a Proposal that had a Note with an attachment, the 

associated Note was getting deleted but the attachment was not. This was fixed. 

• Proposals, Opportunities > The ability to quickly add a new opportunity from the 

Create Proposal screen was not successfully creating the new Opportunity. This was 

fixed. 

• Prospects > The tooltip was not working properly on the mapping step of importing 

Prospects via CSV. This was fixed. 

• Prospects > When adding or editing a note for a Prospect's contact, the Created By 

column was incorrectly allowing users to specify the note's creator from a wrong list 

of options. This was fixed. 

• PTO > Updating an existing paid time off request would incorrectly update the 

"Requested on" date to the current date. This was fixed. 

• Purchase Orders > Purchase Orders created from Budgets would use the Bill rate of 

service items and not the Cost rate. This was fixed. 

• Recurring Bills, Invoices > The system was not able to create new bills and Invoices if 

one or more of the recurring schedules were assigned to a Project or used line 

items of a Project that had been marked as Completed. This was fixed. 

• Reports > The Employee Realization Rate report drill down feature would crash 

when any filter was applied. This was fixed. 

• Reports > The "Contract Analysis" report would not show the Project ID and not 

follow the Project Display As global setting. This was fixed. 

• Reports > The Employee Performance report was not reflecting the entries that are 

marked directly as billed in the realization rate column. This was fixed. 



• Vendor Bills > Custom fields that are configured to show up in the Bills list view were 

not showing up. This was fixed. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

 

 

 

 

 

VERSION 1.1.153 RELEASED ON MAY 1, 2021 

 

What’s new in this version?  

 

Google Calendar Integration 

CORE is proud to announce an integration with Google Calendar. Users will be able to pick 

and choose which Google Calendars to sync with CORE’s calendar module. Users will be 

able to add, edit and delete Google Calendar events directly from the Calendar interface. 

Additionally, users can create Time Entries from Google Calendar events directly from the 

Calendar view. 

 

 

Enhanced Global Search 

CORE’s Global Search feature has been enhanced to improve the overall performance and 

result quality. Users now have the option to also search for keywords in Notes, Memos and 

also include Custom Fields in the search. The search engine has been improved to also list 

the recent activities performed within CORE. 

 

Sales Forecasting 

CORE has added a new Sales Forecasting module as part of the CRM subscription. Users 

will now be able to track their forecasted sales in a monthly, quarterly or yearly view. 

Forecasted sales figures can be grouped by either Resource or Prospect and can be pivoted 

to show a distributed or summarized list. 

 



Advanced CSV Import 

This update adds the CSV Import feature to General Journals. We have also made powerful 

additions to the import experience like allowing users to save field mappings and to upload 

Contacts during Lead or Prospect imports. Additionally, users will have the option to 

upload Contact records directly from the Prospect Contacts tab.  

 

 

Purchase Tax for Services 

This update adds the Purchase Tax attribute to Vendor Bill service line items to ensure 

proper accounting for all Purchase taxes paid for vendor services. 

 

 

Other Improvements: 

• Allocation & Forecasting > The Manual View in the Forecasting module has been 

optimized for improved performance. 

• Benefits > Benefit label was changed to "Benefit Period Units" to better describe the 

purpose of the field. 

• Bill Payments > When creating a new Bill Payment, users now have the option to 

select an individual Payee or a range of Payees. 

• CRM > The list of the navigation items under Sales Tools have been reordered. 

• Dashboard > The Project Manager filter was added for the Employee Allocation, 

Project Allocation, Project Allocation by Activity, and Task Allocation widgets. 

• Dashboard > The Principal and Originator filters have been added to Project 

Widgets. 

• ePayments > The labels in the Statement Payment page have been updated to 

better suit the purpose of the link. 

• Projects > A tooltip was added to the Use Custom Budget checkbox in the Project 

details screen to better explain what this setting is and how this setting works. 

• Projects > Project Name was added as a separate optional column in the Projects list 

view. 

• Projects > Projects can now be created from an existing Budget. This creation can be 

initiated from the Budgets list view row actions menu or from the Budget details 

Actions menu. 

• Projects > The Expand/Collapse Sub-Projects action has been enhanced to work with 

filters also. 

• Projects > When exploring the details of a Phase, users can now navigate to any 

phase in the Project Hierarchy using the drop-down navigation. 

• Projects > When working on a percent complete contract type, users will now be 

prompted if they change the contract amount used to create their Billing Schedule 

to confirm the changes throughout. 

• Projects > CORE has added the ability to batch update Projects for default Invoice 

templates. 



• Prospects > The "Assigned To" smart field has been added to the Prospect email 

screen. 

• Reconciliation > CORE is now hard coding the Check NO/REF No for Check as 

“*SVCCHRG*” that is created against Bank service charges during Account 

Reconciliation. 

• Reconciliations > The 'Cancel' button label in the Reconciliation screen was changed 

to a 'Continue Later' to better clarify that those changes will be saved and users can 

resume where they left off. 

• Reports > A new CRM report has been added to track Distributed Sales Forecast. 

• Reports > A new CRM report has been added to track Summarized Sales Forecast. 

• Reports > More filter options have been added to the Billing Analysis report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Billing Forecast report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Billing Schedules report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Historical Billing report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Invoice Reconciliation report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Overdue Invoices report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Retainer Reconciliation report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the WIP with AR report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Work in Progress Details 

report. Additionally, the report layout has been updated to improve readability. 

• Reports > More filter options have been added to the Yearly Billing Cross Tab report. 

Additionally, the report layout has been updated to improve readability. 

• Reports > The ability to filter by class was added to four balance sheet reports: 

Balance Sheet Accrual Basis, Balance Sheet by Class Accrual Basis, Balance Sheet by 

Class Cash Basis, and Balance Sheet Cash Basis. 

• Reports > The Aged WIP with AR report layout has been updated to improve 

readability. 

• Reports > The Class filter has been added to most of the Profit and Loss reports. 

• Reports > Payee and Transaction Type columns have been added to the Cloud 

Feeds report. 

• Reports > The Principal and Originator filters have been added to Project Reports. 

• Reports > The Project List report can now be grouped by Project Group. 

• Reports > The Project Manager filter has been added to the Time Details report. 

• Reviewer > A new security setting has been added that will allow admin users to 

control user access to filters in Reviewer. 



• Time and Expense > The batch update process in the Time Entries, Expense Entries, 

and Time & Expense Reviewer screens has been optimized to allow updating up to 

5000 records in seconds. Workflow status updates will be processed in background. 

• User Preferences > An option to be notified when a proposal has been submitted 

for approval has been added. 

• Vendor Bills > CORE will now automatically update the time and expense entries to 

match an updated Vendor Bill date if they were assigned the same date earlier. 

 

Other fixes: 

• Batch Invoices > In some scenarios, when batch updating custom fields from the 

Batch Invoicing workflow, CORE would incorrectly reset other custom field values. 

This was fixed. 

• Bill Payments > When clicking "Save & Add Another" after editing a Bill Payment, the 

Payee dropdown in the modal should not allow you to quick add. This was fixed. 

• Billing Schedule > Schedules that were configured as negative service amount would 

cause the Expense portion of the Invoices to be processed as negative. This was 

fixed. 

• Budgets > When filtering the Budgets list for amounts that were equal to a specified 

Budgeted Profit Amount, the filter did not work if a budget only had a miscellaneous 

amount entered or no service amounts entered. This was fixed. 

• Checks > Users were allowed to enter a negative value for Purchase Tax. This was 

fixed. 

• Client > Performance tab charts would take a long time to render in certain 

situations. This was fixed. 

• Client > The Profitability widget in the Performance tab was not including Time and 

Expense entries that had been manually marked as billed. This was corrected. 

• CRM > Emails that were synced from the Outlook integration were not displaying 

correctly when dark mode was turned on. This was fixed. 

• Custom Fields > In some scenarios, when existing Custom Fields were deleted from 

a module, CORE would hide all records from the affected module's list view screen. 

This was fixed. 

• Dashboard> The Gross Margin widget was not including data from Projects whose 

managers were set as inactive. This was corrected. 

• Dashboard > The Gross Margin widget was not including Time and Expense entries 

that had been manually marked as billed. This was corrected. 

•  

• ePayments > Some DesignPay payment platform users had duplicate payment 

records show up in CORE when they received a Credit Card payment. This was fixed. 

• ePayments > Terminated or inactive users received emails and notifications for 

online payments for any invoices they created when they were active. This was 

fixed. 



• ePayments > When composing an ePayments Statement email, the credit card and 

ACH icons were both displayed instead of conditionally being displayed based on 

the type of ePayments account set up. This was fixed. 

• ePayments > An issue with one of BQE’s payment partners was causing the payment 

status to show up as ejected even after the ePayment was processed successfully. 

This was fixed. 

• ePayments > When sending receipt emails for a successful email to the Client, CORE 

would show the other recipients of the emails as well. This was corrected. 

• General > The currency symbol was changed from KSH to S when refreshing the 

pages for Kenya regional settings. This was fixed. 

• General > The incorrect date format was being displayed for Australian regional 

settings. This was fixed. 

• General > When doing a text search in the filter panel, using the Select All checkbox 

option would select all options instead of just selecting the shortened list based on 

the text search. This was fixed. 

• Integrations > Office 365 emails are now automatically synced once every hour 

during active use of the CRM Leads and Prospect screens. 

• Invoice Collections > The note date for an invoice when updated in an Invoice’s 

detail view would not show up correctly in the Collection view. This was fixed. 

• Invoices > When downloading an invoice as a PDF from the row actions menu, the 

Hours column was missing. This was fixed. 

• Payments > CORE would incorrectly display the "Create Payment" option for 

Invoices that had ePayments scheduled. This was corrected. 

• Payments > When creating a new payment for a client then clicking 'Save & Add 

Another', the Add Payment modal allowed you to choose projects that weren’t 

associated with the selected client. This was fixed. 

• Project > Updating ePayment profiles would not update correctly if the batch size 

was more than 300 records. This was fixed. 

• Projects > If a project is assigned to 2 groups and the Projects list filter was set to 

include both of these groups, the project record would display twice in the list. This 

was fixed. 

• Projects > In the Assignments tab of Project details, users were unable to clear the 

search text box in the Add New dialog when trying to add a new contact or team 

member. This was fixed. 

• Projects > When cloning a project, the character limit for the Project ID was not 

enforced in the Clone Project modal. This was fixed. 

• Projects > When selecting a parent project in the Projects list view, not all phases 

would get selected all the time. This was fixed. 

• Projects > When deselecting the 'Use Custom Budget' checkbox in a parent project, 

any regular budget selected for one of that project's phases was being erased. This 

was fixed. 

• Reconciliations > We have streamlined the Resume Reconciliation user experience. 



• Reports > For security purposes, the ePayments report has been removed from the 

Time & Expense and HR administrator subscription packages. 

• Reports > The Billing Details report has been updated to reflect proper calculations. 

Services WIP, Expenses WIP, Proposed Net Bill are now updated to only factor in the 

values of billable entries. Cost, Bill Amount, Services WIP, Expenses WIP, Proposed 

Net Bill are now updated to round each entry to 2 decimals 

• Reports > The Profit and Loss YTD Comparison Accrual Basis report was displaying 

the wrong currency symbol in the Gross Profit and Net Ordinary Income rows. This 

was fixed. 

• Reports > Exporting the Gross Margin Real Time report to CSV would produce 

duplication of records. This was fixed. 

• Reports > Memorized reports would bypass security restrictions if shared with other 

users. This was fixed. 

• Review Templates > Deleting a question type from the Question Types list screen 

and a review template from the Review Templates list screen would cause the 

search box at the top of each list screen to disappear until the tab was opened 

again. This was fixed. 

• Reviewer > Sorting by "Last Action By" would cause unexpected results to show up 

in the Time & Expense Reviewer screen. This was fixed. 

• Security > The column widths of the Security Profile Reports tab table were not 

properly distributed. This was fixed. 

• Time Card > Sorting by the L-Code column in the Time Card would cause all the time 

entries already entered to disappear. This was fixed. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

 

 

 

 

VERSION 1.1.152 RELEASED ON MARCH 6, 2021 

 

What’s new in this version?  

 

This update addressed several issues and added many highly requested features. Most 

notable: 
 

Statement Payments | ePayments 

CORE now allows users to set up electronic payments for Client Statements.  



 

Office 365 Email Integration | CRM  

CORE is extending its Office 365 integration to CRM emails. Users will now be able to sync 

email communications with their CRM contacts directly to CORE and also use their Office 

365 account to send out emails.  
 

Project Budgets Enhancements | Project Management  

Project Budgets have been improved to allow direct access from Project’s detail view. Users 

can now manage Project and phase budgets in one unified interface and also have the 

ability to create custom budgets for Projects or their phases. 
 

HR Benefits with roll over rules | HR  

HR administrators now have more control around how employees can earn benefits. These 

newly added attributes will allow HR administrators to specify a benefit's maximum accrual 

amount, maximum carry amount, reset date, and earning rules. 
 

 In-App Referral Program | Subscriptions 

CORE is proud to introduce a Referral Program for our existing users. Referring colleagues 

can earn them a free demo of CORE so that our team can explain how CORE can be the 

best solution for their business’s needs. Existing users can access their referral link from 

within the web and mobile applications.  
  

 

 

Other Improvements: 

• Assignments > An option was added in the Assignments screen so that users can 

now easily copy assignments from a project's associated budget. 

• Assignments > The experience for copying assignments from parent projects to any 

sub-phase was simplified.  

• Checks > A new template has been added to allow checks to print in the Voucher-

Check- Voucher format. 

• Client Contacts > The Quick Search feature was added to filter a client’s contact list 

based on a search keyword. 

• CRM > Time Entries can now be created directly from CRM To-Dos and Follow-Ups. 

• CRM Email Templates> Browser right click was being prevented. This was fixed. 

• CRM > Added the "Cost Rate" column to the Quote Templates list view screen. 

• Dashboard > The Privacy Options field was renamed as Sharing Options to better 

reflect the changes this setting can make to a dashboard. 



• Emails > The email notifying employees about an upcoming employee review date 

was reformatted. 

• ePayments > A new Global Setting has been added to let administrators control if 

the biller, project manager or administrator should get ePayment notifications. 

• Expense Entries > Expense Entry charge amounts can now be calculated directly 

within the entry cell. In-cell calculations support basic math operations including 

addition, subtraction, multiplication and division. 

• Expense Entries > Paid Date was added as an optional column in the Expense 

Entries screen.  

• Follow-Ups > The CRM Follow-Ups list view screen can now be exported as a CSV file. 

• General > More optional columns have been added to list view screens throughout 

CORE. 

• Global Settings > A User Interface option has been added to hide the Copyright on 

standard Invoices and Reports. 

• Groups > The Quick Search feature was added to the list within the Groups detail 

page. 

• Invoice Templates > Invoice Templates can now be Batch Updated from the Projects 

list view screen. 

• Invoices > Purchase Order Number was added as an optional column in the Invoices 

list view screen. 

• Invoices > The Email Recipients column was added to the Invoice list screen. 

• Leads, Prospects > Name and Company have been added as optional columns to 

the CRM Leads and Prospects list view screens. 

• Leads > In the Emails tab of a Lead's detail page, the email statuses are displayed 

using descriptive icons instead of text.  

• Manual Invoices > Batch action "Delete" was renamed to "Exclude" when the Invoice 

was based on Approved Time and Expense. 

• Opportunities > Project Budgets created from Opportunities marked as Won will 

now add the same Fee Schedule that was attached to the Quote. 

• Project Templates > When creating a new Project using a Project Template, users 

now have the option to copy the Project Groups from the template. 

• Projects > Budget and Contract analysis reports can now be launched from the 

Structure tab of a Project's details. 

• QuickBooks integration > QuickBooks sync logs can now be downloaded as a CSV 

file. 

• Report Center > The Report name column has been expanded to fit all report names 

without truncating. 

• Reports > A Select All option has been added to the filter drop downs in the Report 

Center. 

• Reports > An option has been added to the Unpaid Vendor Bills report to show only 

those records linked to an Invoice. 

• Reports > The Billed Time and Expenses report has been updated to make it easier 

to read and understand. 



• Reports > The Budget Comparison by Phase report has been updated to make it 

easier to read and understand. 

• Reports > The Cash Receipts Journal report has been updated to make it easier to 

read and understand. 

• Reports > The Paid Time and Expenses report has been updated to make it easier to 

read and understand. 

• Reports > The Statement by Client (Accountant) report PDF document map has been 

updated to separate out each Client. 

• Reports > The subtotals on the AR Aging with Retainage report have been updated 

to include more column subtotals. 

• Reports > The Privacy Options field was renamed as Sharing Options to better 

reflect the changes this setting can make to a memorized report. 

• Retainers > When creating a Retainer, Legal users will now be able to denote if the 

Retainer is for a Trust Fund. 

• Time Entry, Expense Entry, Reviewer > Batch Update function updated to process 

Business logic rules and can support batch size of 5,000 entries 

• Time Card > Users can now expand the text box field when adding a memo to a 

time entry from the Time Card. 

• To-dos > When a Project related To-Do is marked complete, users will now have the 

option to disable the dialog that asks if they would like to create a Time Entry for 

that To-Do. This option can be reset from User Preferences. 

 

Other fixes: 

• Budgets, Estimates > The default width of the ID column was very narrow and 

needed to be increased. This was fixed. 

• Clients > The Append Memo to Top or Bottom options were not working in the 

Client list view Batch Actions. This was fixed. 

• Cloud Feeds > Some Cloud Feed transaction records were not downloaded if they 

had long description fields. This was fixed. 

• CRM > The CRM Follow-Up badge count on all CRM list views was incorrectly 

including Inactive, Hold and Complete records. The badge count was fixed to only 

include Active or Incomplete Follow-ups. 

• CRM > When creating a time entry from a to-do item that's marked 100% complete, 

the Employee field is not pre-filled with the Assigned To value in the prompt. This 

was fixed. 

• CRM > No Sales Goal assigned notification was received if a Goal was assigned to an 

Employee Group. This was fixed. 

• Dashboard > The Hours widget was not including data for Vendors. This was fixed. 

• Dashboard > PTO widget had an issue related to "All Dates" filter. This was fixed. 



• Employee Control > Selecting the checkbox next to an employee's name in the Copy 

Assignments pop up of the Employee Control screen would not check the box 

associated with the correct employee. This was fixed.  

• ePayments > When creating a new CORE ePayments profile for a service provider 

that was already connected, users were still being asked to create a new account. 

This was fixed. 

• Forms > The actions menu when viewing a form was hidden behind the file preview. 

This was fixed. 

• Fund Transfers > When a user applied the Account filter to the Fund Transfers list 

view and then launched the Fund Transfers report from this screen, the report did 

not honor the applied filter. This was fixed. 

• General > In some instances throughout CORE, duplicate filters were incorrectly 

being applied to list view screens. This was fixed. 

• General > Some color enhancements have been made to the Dark Mode theme to 

make it easier to view. 

• Forms > HR Forms could not be uploaded to CORE from the Resource Library. This 

was fixed. 

• Integrations > CORE would apply Project MST/MET on Invoices that were imported 

from QuickBooks Online even when they had a Tax line with this amount already 

present. This was fixed. 

• Integrations > Bills created in QuickBooks Online; Ireland region were fetching 

amounts that included VAT. This was fixed. 

• Integrations > Office 365/Outlook Calendar sync would not show for the Time 

Expense subscription users. This was fixed. 

• Payments > UI glitch would sometimes cause users to enter the same payment 

twice. This was fixed. 

• Projects > The Class range filter was not working in the Projects list view. This was 

fixed. 

• Projects > When merging Project records from the Projects list view, the 

confirmation dialog was displaying the incorrect number of records to be merged. 

This was fixed. 

• Projects > Quick search would not work for dropdown type custom fields. This was 

fixed. 

• Purchase Orders > When emailing a Purchase order, the Project smart field was not 

getting filled. This was fixed. 

• Quote Templates > Resizing the newly added Cost Rate column would cause an 

error that prevented users from sorting the list by this column. This was fixed.  

• Recurring Transactions > CORE would incorrectly stop processing recurring 

transactions after the 24th instance. This was fixed. 

• Reports > The Bill Status filter was incorrectly added to the Billing Details report. 

This was fixed. 



• Reports > When users included the main taxes in their Project contract amounts, 

CORE wasn't storing values to calculate the contract balance properly. This was 

fixed. 

• Reports > Trial Balance Cash Basis report would show NSF Payments as positive 

amounts. This was fixed. 

• Reports > The Client List report was not showing the country in the Address column 

if the attribute existed for each record. This was fixed. 

• Time Entries > The Start Time and Stop Time fields on the Time Entry detailed view 

did not show proper time values in their respective drop-down menus. This was 

fixed. 

• Time Entries> When updating a batch of entries for Project, the relevant Class was 

not being inherited. This was fixed. 

• To-Dos > To-Dos associated with deleted Projects were not also being deleted. This 

was updated. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

 

VERSION 1.1.151 RELEASED ON JANUARY 2, 2021 

 

What’s new in this version?  

 

This update addressed several issues and added many highly requested features. Most 

notable: 

 

Dark Mode Theme 

The Dark mode theme is now available from User Preferences. The meticulously designed 

light-on-dark color scheme adds a new refreshing new look to CORE and also helps reduce 

eye strain. 

 

Shared Dashboards 

Dashboards have been enhanced to allow sharing them with groups, individual users or 

both. Users can now also designate an owner for Dashboards.  

 

Shared Memorized Reports 



Memorized Reports have been enhanced to allow sharing them with groups, individual 

users or both. Users can now also designate an owner for each Memorized Report.  

 

Enhanced Project and Account Display options 

We have redesigned the Project and Account display options in Global Settings. The new 

changes include more options for combining individual components and a live preview to 

find the best combination that works for you. 

 

CORE Touch 2 Talk  

The Call Support feature was enhanced with a numeric keypad to allow users to provide 

interactive responses during the call. Other enhancements include enabling users to 

continue using CORE without disconnecting the call and a new button to call BQE Sales. 

 

Administrator Controls for 2-Factor Authentication 

Admin users can now apply a uniform 2FA authentication policy for CORE users at their 

company. Options include enforcing a mandatory opt-in for 2-FA for all or selected users as 

well as staying informed about its compliance. 

 

Project Structure Tab Enhancements 

The Project Structure tab has been improved to display more information about a parent 

project and its phases. Projects can now be seen in comparison with a project's associated 

budget or contract amounts. Additionally, the columns of the project table have been 

categorized into 3 sections to better understand all the information being displayed. 

 

Other Improvements: 

• Allocation & Forecasting > Users with a Time and Expense subscription can now 

update the % Complete value for their allocations. 

• Batch Invoices > Users can now turn on custom field columns when reviewing 

Project time and expense entries. 

• Batch Invoices > Users can now turn on Project and Client Retainer Available 

columns on the batch billing screen. 

• Bill Payments> CORE now remembers the last Bank/Credit Card Account used for 

Bill Payments for both of the supported payment methods. 

• Calendar > Hovering over an event in the calendar now gives users a preview of the 

event's description.  



• Calendar > If you have connected your Office 365 account, you can now create new 

calendar events in CORE and have them instantly sync to your Outlook Calendar. 

• Calendar > CORE now maintains a link between events and time entries created 

from these events to prevent duplicates. 

• Client > Users can now enter longer company names for their clients. 

• Cloud Feeds > The “Included in CORE” list has been updated to include cloud feed 

details, date of matching and important attributes of the matched transaction. 

• Cloud Feeds > Users will now have an option to disconnect an account and not lose 

existing matched transaction mappings if they choose to connect the account again. 

• CRM Emails > Users will now be able to track if an email has been read by the 

recipient(s). 

• CRM Leads, Prospects > The Referred By attribute has been updated to display a 

pre-filled list of existing contacts. 

• CRM Quotes > Cost Rate has been added as an optional column in the Services tab 

of a Quote’s detail page. 

• CRM Quotes > Quote rates have been updated to reflect the rates from Fee 

Schedules. 

• CRM Quotes > Service and Expense line items can now be copied from an existing 

Budget or Estimate. 

• Dashboard > Project and Resource filters have been added to all Allocation widgets. 

• Dashboard > The Project Profitability report is now accessible directly from the 

‘Gross Margin by Project’ Dashboard widget. 

• Emails > CORE email layouts have been updated to provide more useful 

information. 

• Emails > The workflow approval emails sent from CORE have been updated to allow 

more room for Project names. 

• ePayments > Company Owner and Administrator accounts will now be notified via 

email when third party ePayment integrations are enabled. 

• Follow-Ups > The Follow-up list edit experience has been updated to make it 

consistent with the rest of the application. 

• General > A Select/Un-Select All option has been added to all multi-select dropdown 

menus in CORE. 

• General > New optional columns have been added to important screens like Project, 

Client, Timers, Time entry, Expense entry, Expense Items, Project Templates, 

Budgets, Estimates, Bill Payments and Reviewer based on top user requests. 

• Integrations > Specific Project rules have been bypassed while getting transaction 

data like Time and Expense entries and Bills from Xero, QuickBooks Online and 

MYOB to CORE. 

• Notes > The Notes list screen can now be filtered by Status. Additionally, the Status 

column has been added to the Notes associated to other CORE records. 

• Notifications > Users now have the option to be notified when a Project has been 

assigned to them. 



• Projects > A ‘Completed On’ field has been added to Project details. This field will 

only become available when a Project has been marked Complete. 

• Projects > Project Assignments have been made easier with the added ability to add 

assignments to or delete assignments from a parent project and its phases at the 

same time. 

• Reports > Added ‘Unpaid Vendor Bills’: List of unpaid Vendor bills that have received 

AR Payments. New Report   

• Reports > We have added a brand new 1099-NEC report that matches the latest 

guidelines from IRS. 1099 MISC and 1096 MISC have also been updated with new 

changes. New Report   

• Reports > ‘Financial Budgets Comparison by Class’ report has been added to the 

Report Center. New Report   

• Reports > ‘Comp Time’ column has been added to the Employee Utilization report. 

• Reports > ‘Notes Category’ filter has been added to the Notes report. 

• Reports > ‘Reminder Date’ filter has been added to the Billing Schedules report. 

• Reports > ‘Tax Line number’ column has been added to the Chart of Accounts 

report. 

• Reports > An option has been added to the WIP Reconciliation report to view Time 

and Expense separately or combined. 

• Reports > Balance Sheet reports now offer a summarized option for a condensed 

view for Assets, Liabilities and Equity. 

• Reports > Labels have been appended to Retainer Invoice numbers on the 

ePayments report to differentiate between normal and Retainer Invoices. 

• Reports > Memorized reports have been enhanced to include its unique name in the 

footer of the report. 

• Reports > Profit and Loss reports now show a section for 'Net Ordinary Income'. 

• Reports > The Monthly Profit and Loss reports can now be filtered by Class. 

• Reports > The on-screen Reconciliation report has been updated to only show 

transactions that are part of the current reconciliation. 

• Reports > The WIP Reconciliation report has been updated to exclude Projects that 

had zeros across all column values. 

• Reports > Trust Fund has been added as an option for the Transaction Type filter on 

all financial reports. 

• Reports > Users can now limit the 'Employee Missing Time' report to various 

Employee and Vendor types. 

• Security > Administrator users can now set up separate security settings for 

Company and Individual level integrations. 

• Subscriptions > Users can now send requests for subscription to admin accounts 

from any screen that is not included in their CORE subscription. 

• User Preferences > Users now have an option to get reminded daily or weekly about 

missing or incomplete time cards. 

• User Preferences > Users now have the option to turn off the Allocation summary 

feature in the Time Card and Time Entries screen. 



• Vendors > The Vendor Transactions tab can now be filtered by Date period. 

 

Other fixes: 

• Calendar > Time entries created from Calendar events were missing the Start and 

Stop times. This was fixed. 

• Calendar > When creating a time entry from a calendar event, the time entry project 

field was not being pre-filled using the event's project value. This was fixed. 

• Checks > The total record count was displaying 0 records when the Payee Name 

filter was applied even if there were records in the list. This was fixed. 

• Checks > When editing the details of a Bill Payment Check, the “Back to Checks” link 

was incorrectly being changed to “Back to Bill Payments” after clicking the Save & 

Done button. This was fixed. 

• Checks > When trying to void a check used to pay a vendor bill whose bill number 

exceeded 49 characters an error will occur. This was fixed.   

• Credit Cards > The Credit Cards exported file name was incorrectly downloading as 

Credit Card Transactions. This was fixed. 

• CRM > The search bar in the Add & Modify dialog for Follow-Ups was not searching 

against the Follow-up Type and Assigned To attributes of Follow-up records. This 

has been fixed. 

• CRM Leads > If converting a Lead to a Prospect was delayed, the loading message 

was not displaying. This was fixed.  

• CRM Lists > The Leads and Prospects SCORE values were not displayed in the order 

that was configured in the Lists module. This was fixed. 

• CRM Opportunities > Adding a new Quote from the Quotes tab of an Opportunity 

defaulted the quote date value to be blank instead of today's date. This was fixed. 

• CRM Opportunities > Recurring type Projects could not be created from the Create 

Project dialog of the Opportunity screen. This was fixed. 

• CRM Opportunities > When creating a new Project as an Opportunity is marked as 

Won, the contract type field should default to be Hourly. This was fixed.  

• CRM Opportunities > When marking an Opportunity as Won, the Forecast amount 

option in the modal only included the dollar amounts and excluded cent values. This 

was fixed.  

• CRM Proposal Builder > After inserting a Quote and saving a Proposal, the ‘Remove’ 

action on the Quote was not working. This has been fixed. 

• CRM Proposal Builder > Right clicking to paste text into the Proposal Builder was not 

working. This has been fixed. 

• CRM Prospects > When searching for a Prospect using the list view quick search and 

opening the detail screen of a resulting record, returning to the list view by pressing 

"Cancel" should retain the search keyword and results when coming back to the list 

view. This was fixed.  



• CRM Quotes > Filtering the Quotes list view by a specific date included Quotes with 

no quote date value in the resulting list. This was fixed. 

• CRM Resource Library > After a CRM user uploaded a document then modified the 

description on the same file, they were incorrectly blocked from performing this 

action stating the user did not have the right permissions. This was fixed. 

• Dashboard > The To-dos widget in the dashboard was missing the Assigned By filter. 

This was fixed. 

• Dashboard > The To-dos widget was always displaying behavior that should have 

only been shown on hover. This was fixed.  

• Deposits > The total records count was missing on the list view when applying 

filters. This was fixed. 

• Emails > In some instances when users typed alphanumeric values in the To field of 

the Compose Email module, the text was being cleared. This was fixed. 

• Emails > The Address Book in the Compose Email module had some text overflow UI 

problems. These were fixed. 

• Follow-Ups > A red asterisk was missing for two required fields in the Add Follow-Up 

modal. This was fixed. 

• Global Settings > Smart Fields were not being correctly populated in the Default 

Message field within Email Settings. This was fixed. 

• Global Settings > Users were allowed to enter values into greyed out fields that 

should have been disabled. These were fixed. 

• HR Reviews > When a user created a new Review and clicked save, the modal did 

not immediately close which gave the impression the record was not created and 

often led to creating duplicate entries. This was fixed. 

• Integrations > Invoice Amounts would not transfer correctly to QuickBooks Online if 

the invoice was generated using the Net Bill feature of Batch Invoice screen. This 

was fixed. 

• Invoices > Hourly Invoices for Phased Projects weren't handling the Retainer 

Summary correctly. This has been fixed. 

• Invoices > Recurring Retainer Invoices were not inheriting the Online ePayment 

account attribute when creating from an existing Retainer Invoice. This was fixed. 

• Invoices > The 'Last Emailed On' field would not refresh by itself when an Invoice 

was emailed. This was fixed. 

• Invoices > Workflow notes were being truncated when viewed from the Workflow 

History section of an Invoice’s detail page. This was fixed. 

• Opportunities > Batch Update actions performed on Opportunities were creating 

duplicate entries in the record history. This was fixed. 

• Opportunities > Projects that are linked to an existing Opportunity could be deleted. 

This was fixed. 

• Project > Cloning a Project would not copy the allocation dependencies in the source 

Project's allocations. This was fixed. 

• Projects > The Assign Groups modal in a Project's detail page was not properly 

sorting the list of groups that can be selected. This was fixed. 



• Projects > The Assign Groups modal when editing a project's details was not sized 

properly. This was fixed.  

• Projects > When deleting a rule assignment, the wrong text was displaying in the 

fading confirmation message. This was fixed.  

• Prospects > In a Prospect's detail page, the tooltip message was not displaying the 

message for the Display As field. This was fixed.  

• Prospects > In the notes tab of a Prospect's detail page, changing the category in the 

"Show" dropdown would change the time stamp for existing notes. This was fixed. 

• Reports > A few important filters were missing from the ePayment Details report. 

This was fixed. 

• Reports > Custom field filters were not working for CRM reports. This was fixed. 

• Reports > In some cases, Payment Amount was shown in the Processing Charges 

Recovered column on the ePayments report. This was fixed. 

• Reports > New credit card payments were showing a status of none in the 

ePayments report. This was fixed. 

• Reports > The Billing Details report was producing an unnecessary page with no 

information as the last page. This was fixed. 

• Reports > The column headers were only appearing on the first page of the AR 

Aging with Credit Payments report. This has been updated. 

• Reports > The Employee Details report would not show the 2nd address line. This 

was fixed. 

• Reports > The Employee Performance report date was not following regional 

settings. This was fixed. 

• Reports > The Notes report was displaying all dates in the US format instead of 

honoring regional settings. This was fixed. 

• Reports > The Notes report was not properly fetching the date values for system 

generated Notes associated with a Follow-up. This was fixed. 

• Reports > The Percentage Billed report was displaying a $ sign next to the 

percentage values in the % Billed column. This was fixed.  

• Reports > The report column headers were not repeating across all pages for the 

Project Time Entries report. This was fixed. 

• Reports > The Workflow Details report was not labeling the groups of items by the 

type of module. This was fixed. 

• Reports > Various Time Reports were showing duplicate time entries if the Project 

was assigned to multiple Groups. This was fixed. 

• Retainers > IOLTA accounts were not showing up as an option when performing a 

Batch Update on Project Retainer Invoice. This was fixed. 

• Retainers > Some column header alignment issues were fixed on the Retainers 

screen. 

• Review Templates > When adding a question based on an existing question, the 

Question Text column was too narrow to get a good sense of which question was 

being selected. This was fixed.  



• Time & Expense Reviewer > The system filters were not being persisted on the Time 

& Expense Reviewer screen if a user clicked into the details and clicked Back into the 

list view. This was fixed. 

• Vendor Credits > Sorting by the AP Account column in the Vendor Credits list view 

was not working properly. This was fixed.  

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

 

 

VERSION 1.1.150 RELEASED ON NOVEMBER 15, 2020 

 

What’s new in this version?  

 

This update addressed several issues and added many highly requested features. Most 

notable: 

 

AffiniPay ePayment Integration 

CORE now integrates with AffiniPay and its affiliate payment platforms to offer online 

payments for Invoices and Retainers. The industry specific appeal of LawPay, DesignPay 

and CPA Charge make these a natural fit for CORE’s users. Our LawPay integration is 

designed to handle Trust Fund accounting while keeping it compliant with ABA and IOLTA 

guidelines. Our integration will support both Credit Cards and ACH payment methods and 

also allow users to set up scheduled and partial payment as options for their Clients. 

 

 

Office 365 Calendar Integration 

CORE users can now integrate their existing Office 365 calendars to CORE's calendar 

module. Our integration will support any Microsoft Cloud account that connects with the 

Office 365 Calendar. Users get to choose which of their Outlook Calendars will show in 

CORE’s Calendar. Outlook events can be assigned Projects and event attendees in CORE 

and can also be converted to a Time Entry. CORE will always maintain a real time sync to 

avoid any conflicts. 

 

 

Multi-Period Time Card 



CORE's popular Time Card screen has been enhanced to handle multiple time periods 

including Bi-Weekly, Semi-Monthly and Monthly intervals. Time Entry users can now view, 

edit, and submit multiple weeks’ worth of entries directly from the Time Card. Similarly, 

Managers can now approve multiple weeks’ worth of entries. Users will also be allowed to 

use the “Copy To” and “Copy From” feature in the Weekly and Bi-Weekly periods.  

 

 

Automatic Refresh for CORE Cloud Feed Transactions 

CORE Cloud Feeds have been automated to ensure you are up-to-date with all available 

transactions from your connected bank or credit card accounts. Syncing your existing bank 

and credit card transactions to CORE has never been easier! 

Call Support Button 

BQE's customer support department can now be contacted directly from CORE. CORE has 

introduced a new “Call Support” button in the top navigation that works as a direct 

connection to our support department - making it easier than ever to contact us whenever 

you need help navigating through CORE! 

 

 

Other Improvements: 

 

• Budgets > Project details have been added to the Budget details General tab to 

make it easier to track the associated project. 

• Budgets & Estimates > Budgets and Estimates can now be downloaded as a PDF 

directly from their respective list view screens. This option has been added as a row 

action for each record. 

• Budgets & Estimates > The Review/Approve/Reject buttons in Manager workflow 

emails have been expanded to include Budgets and Estimates. 

• Cloud Feeds > CORE Cloud Feed CSV import has been updated to automate the CSV 

column mapping process. CORE will automatically map the required fields with the 

CSV columns in the file based on the columns that had previously been mapped. 

• Cloud Feeds > CORE Cloud Feeds have been enhanced to handle Batch Add for up 

to 100 records at a time. Previously, users were constrained to a 25-record limit for 

Batch Add. 

• Cloud Feeds > CORE Cloud Feeds have been updated to automatically fill the 

transaction memo line when matching records. 

• Credit Memos > Credit Memos can now be emailed directly from their list view. This 

has been added as a row action option for each record. 

• CRM > A column chooser was added to the Follow-Ups modal so that Priority and 

Status can be used as optional columns. 

• Dashboard > A new widget has been added to allow users to track and update the 

status of RFIs directly from their Dashboard. 



• Dashboard > A new widget has been added to allow users to track and update the 

status of Submittals directly from their Dashboard. 

• ePayment > We now allow partial payments for ACH methods. 

• ePayments> Payment portal page has been updated to show payment history of 

previous online payments. 

• ePayments > CORE's existing Stripe ACH integration flows have been updated to 

make the sign-up flow more intuitive. 

• ePayments > The project manager and biller will now receive email notifications 

when a Client's ACH payment has been successfully processed. 

• ePayments > The project manager and biller will now receive email notifications 

when a Client's credit card payment has been successfully initiated. 

• General > All CORE list view screens have been enhanced to show the total number 

of records in the header section. 

• General > CORE drop downs have been updated to automatically select all text to 

make it easier to delete the entire text in case you want to make a different 

selection. 

• General > Custom fields can now be added to CORE list view screens as optional 

columns. Users can elect to add up to three existing custom fields in all the major 

screens including Time and Expense entry screens. 

• General > Progressive scrolling improvements have been implemented in all CORE 

list view screens. 

• HR > Print preview has been added as a row action for Employee Reviews. 

• Invoices, Payments, Retainers, Credit Memos, Invoice Collections, Purchase Orders, 

Vendor Bills > These entities can now be downloaded as a PDF directly from their 

respective list view screens. This option has been added as a row action for each 

record. 

• Leads > A Documents tab has been added to Leads details that will allow uploading 

files to a Lead record. 

• Leads > The Referred By field can now be populated using your existing list of 

Clients, Contacts Employees and Vendors. 

• Leads > When converting a Lead into a Prospect, users will now have the option to 

also include any Documents attached to that Lead record. 

• Opportunities > Priority was added as an optional column to the Opportunities list 

view screen. 

• Opportunities > Projects can now be created for Opportunities that have not been 

marked as Won yet. This will allow users to track Time and Expense against the 

Opportunity-linked Project. 

• Projects > Parent Project Assignments can now be copied to sub-phases from the 

Assignments tab in Project details. 

• Projects > When adding a phase to a Project, the Principal field of the phase is now 

automatically populated using the Principal from the parent project. 



• Proposals > The list of accessible CORE Smart Fields in the Proposal Builder has 

been expanded to include the following: Current Date, Current Time, Current Date 

Time, and Quote ID. 

• Prospects > Prospects and Contacts can now be imported via CSV upload from the 

Prospects list view screen. 

• Prospects & Leads > An Attachments indicator column has been added in the Emails 

tab. 

• Prospects > Users can now search Prospects by their Contacts’ names. 

• Quotes > When creating a Quote, users can now use Activity or Expense Groups 

rather than just individual line items. 

• Reports > A Cleared status filter has been added to the Check Details report. 

• Reports > A Project Manager filter has been added for the Project Allocation Earned 

Revenue Distributed Forecast report. 

• Reports > An ePayments Details report has been added. This report will help outline 

transaction details for companies accepting ePayments. 

• Reports > The Annual, Quarterly and Monthly Financial Budget vs Actual reports can 

now be accessed from the Report Center. 

• Reports > The AR Reconciliation report can now be grouped by Client, Project, 

Master Project, Project Manager, Principal and Contract Type. 

• Reports > The Benefit Assignment report has been updated to include a Value 

column for Fixed type benefits. 

• Reports > The Cash Receipt YTD Comparison report has been updated to allow 

grouping by Client, Project, Master Project, Project Manager, Principal or Contract 

Type. Additionally, this report now has the ability to hide phases. 

• Reports > The Employee Profitability report has been updated to include an option 

to hide Expenses. 

• Reports > The following Budget reports have been re-designed to improve their 

readability: Budget Comparison by Employee, Budget Comparison by Phase, Budget 

Comparison Summary, Budget Comparison and Budget Details. 

• Reports > The following reports have been re-designed to improve their readability: 

Account Transactions, AR Reconciliation, Contract Analysis, Employee Expense, 

Gross Margin, Time Verification, WIP Reconciliation and Work in Hand. 

• Reports > The Invoice Reconciliation report can now be grouped by Master Project 

or Project. 

• Reports > The Percentage Billed report now has the option to hide phases when 

grouping it by Master Project. 

• Reports > The Project Profitability report has been updated to make it easier to read 

and understand.  

• Reports > The Proposals, Quotes, Contacts and Opportunities reports can now be 

filtered using Tags. 

• Reports > The Work In Hand report has been updated to make it easier to read and 

understand.  

• Reports > The Work in Progress report has been updated to increase its readability. 



• Reports> We have extended the address book feature to Report Viewer emails. 

• RFIs, Submittals, Drawings > The ability to batch update records has been added for 

RFIs, Submittals, and Drawings list view screens. 

• Scheduled Reports > Scheduled reports can now be sent in either PDF, CSV, Excel or 

Word format. 

• Settings > An extra time entry security setting was added so that administrators can 

decide which employees are allowed to update actual hours for other employees. 

• Time & Expense Reviewer > Overtime was added as an optional column to let users 

know which time entries were marked as overtime. 

• Time & Expense Reviewer > As part of the Batch Mark Billed process, we have 

updated the information listed in the drop-down menu to include Billing Period. 

• Time Entries & Expense Entries> Users can now select up to 3 custom fields to be 

included in these rapid entry screens. 

• Vendors > The Transactions tab under Vendor details can now be filtered by Credit 

Card transactions. 

• Workflow > Users can perform workflow actions for all selected records by using 

"Select All" in Time entry, Expense Entry and Reviewer. 

• Workflow > CORE will now present users with a summarized view of the entries 

before confirming batch approvals or rejections. 
•  

 

 

 

 

Other Fixes: 

 

• Allocation & Forecasting > Hours were lost in the Forecasting screen Smart View 

when two or more Allocations were made against the same Resource for the same 

time frame as the weekly Forecasting view. This was fixed. 

• Budgets, Estimates > The memo added when a Budget or Estimate is approved was 

not properly displayed in the Workflow History section of the respective details 

screen. This was fixed. 

• Cloud Feeds > After scrolling to the bottom of all Ignored Transactions under a 

Cloud Feed account, clicking on the Select All checkbox would not select records at 

the top of the list. This has been fixed. 

• CRM > When viewing the details of notes accessed from CRM list views, there was an 

alignment issue for the Add Documents link. This was fixed. 

• CRM Lists > Exporting the list of Scores as a CSV file excluded the Active column. This 

was fixed. 

• Documents > Viewing the associated entry for a chart of accounts document from 

the Documents list view resulted in an error. This was fixed. 



• Follow-Ups > The CRM Type dropdown at the top of the Follow-Ups screen did not 

have a label. This was fixed.  

• General > Filter chips on list views were not applying any custom labels defined 

from global settings. This was fixed 

• General Journal > When a new general journal entry was made using an existing 

entry number, the confirmation prompt asking users if they would like to continue 

with this duplicate entry number redirected them to the list view screen instead of 

keeping them on the create screen. This was fixed. 

• HR > The Question Types list view and Add modal displayed alignment issues. This 

was fixed. 

• HR Reviews > The review PDF would not open on its own and needed to be re-

named since it lacked an appropriate file extension. This was fixed. 

• HR Reviews > CORE was incorrectly changing the status of the performance review 

to In Progress when it was saved. This has been fixed. 

• Invoices > After searching for an Invoice using the list view text search, users could 

not apply a Late Fee filter. This was fixed. 

• Messages > When composing a message, the column headers of the recipient field 

dropdown lacked proper spacing. This was fixed. 

• Notifications > Previously, when clicking on Notifications that alerted of a scheduled 

ACH payment, CORE would redirect a user to the Payments screen although the 

payment had not yet been settled. This was fixed. 

• Opportunities > Marking an Opportunity as Won from the Opportunities list view 

didn’t update the Closed Date until the page was refreshed. This was fixed. 

• Opportunities > Mobile and contact hyperlinked numbers were incorrectly 

launching a mail service wizard from within the Opportunities details. This has been 

fixed. 

• Opportunities > The Quotes tab of an opportunity's detail page was missing the 

ability to delete a Quote from the list. This was fixed. 

• Opportunities > When batch updating records from the Opportunities list view, any 

applied filters disappeared after the update was saved. This was fixed.  

• Payments > Creating a Payment for an Invoice that had Online Payments enabled 

and was linked to a Vendor Bill would auto-fill the wrong date when a user was 

redirected to the Create Bill Payments page. This was fixed. 

• Payments > When applying a new Payment in the Payments screen, CORE was 

allowing users to double click the Save & Done buttons and it was incorrectly 

creating duplicate payments. This has been fixed. 

• Project Templates > When assigning Groups to either Team Members, Activity or 

Expense Items, the pop-up modal would only load a maximum list of 25 Groups for 

each category. This was fixed. 

• Projects > Adding a phase whose name includes parentheses caused a capitalization 

error. This was fixed. 



• Proposals > After previewing a Proposal from the Proposals list screen, previewing 

any other Proposal in the same screen would always show that first Proposal 

preview until the page was refreshed. This was fixed. 

• Proposals > The Create from Scratch option only took users to the Create page if 

they clicked on the words directly and did not include the rest of the button space. 

This was fixed. 

• Proposals > When adding a Smart Field in the Proposal Builder, the smart field 

dropdown was incorrectly labeled. This was fixed. 

• Prospects > When sorting the Prospects list view by Prospect Score, an ellipse icon 

was displayed instead of a caret. This was fixed.  

• Quotes > When using the quick search to find a record in the Quotes list view, the 

search was not saved when returning to the list view from a Quote detail page. This 

was fixed. 

• Recurring Transactions > We have added several checks to pre-empt scenarios 

which could lead to issues like duplicate processing of transactions etc. for recurring 

transactions. 

• Reports > Group by Principal / Originator was not working on all AR Aging reports. 

This was fixed. 

• Reports > The Ship To address was not properly formatted in the Purchase Order 

Invoice report. This was fixed. 

• Reports > The Time and Expense report was not correctly filtering specific dates for 

users outside of the U.S. This was fixed. 

• Reports > The Totals line for a project was not properly aligned in the Project Time 

Entries report. This was fixed. 

• Resource Library > When uploading multiple items to the Resource Library, users 

were not getting a Successful Update prompt when the operation was a success. 

This has been fixed. 

• Sales Goals, Dashboard > Sales Goals were incorrectly allowed to have negative goal 

amounts which would display inaccurate graphs on the Sales Goals Performance 

widget. This was fixed. 

• Scheduled Reports > Few users had complained that they were not able to re-use 

group names of Scheduled Reports they had previously deleted. This was fixed. 

• Scheduled Reports > When scheduling a Report using the Choose from Existing 

Group option, the Subject line was not visible. This has been fixed. 

• Scheduled Reports > When updating an existing Scheduled Report, an error alert 

would flash before the success message. This has been fixed. 

• Security > Previously, Time Expense security users could view other users' records 

using the on-screen reports under the More drop-down. This has been fixed. 

• Time Card > When copying a week's worth of Time Card entries to a new week using 

the custom date picker, the date picker would pick the incorrect start and end dates 

for the week of the day that was selected. This was fixed. 

• Vendor Bills > Units were not properly updating when importing a Purchase Order 

into a Vendor Bill. This has been fixed. 



• Vendor Bills > When setting up a daily recurring Vendor Bill with a fixed end date, 

duplicate Vendor Bills were being created for dates outside of the end date. This 

was fixed. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

 

 

 

 

VERSION 1.1.149 RELEASED ON SEPTEMBER 27, 2020 

 

What’s new in this version?  

 

This update addressed several issues and added many highly requested features. Most 

notable: 

 

Stripe ACH Transfers  

The power of ACH Transfers comes to CORE. Stripe ACH Transfer option will allow you to 

confidently share ACH payment enabled Invoices with your clients. Stripe ACH is backed 

with instant bank verification from Plaid.com to ensure a smooth, hassle free money 

transfer. All of this comes to CORE customers at an incredibly low processing fee from 

Stripe. Getting paid on time has never been easier in CORE! 

 

Cloud Feed CSV 

CORE Cloud Feeds have been enhanced to allow importing accounts and records via CSV 

files. Users now have the ability to add new Accounts to CORE without having to link their 

financial institution. Additionally, Bank and Credit Card Transactions can now be imported 

for any account. Our intuitive step-by-step wizard walks you through the import process so 

you can be sure you import the appropriate records to CORE. 

 

Workflow Notification Emails 

Workflow emails sent to Managers for review have been redesigned to increase their 

usability and help streamline daily tasks. This enhancement will help automate how you 



manage your employees’ submitted Time and Expenses, Invoices, Purchase Orders and 

Vendor Bills. Managers can now initiate the approval or rejection of the submitted items 

from the email and be redirected to the appropriate CORE screen for confirmation. 

Managers can also review the details of these entries before deciding to approve or reject 

them. Managing your Company’s various workflows has never been easier in CORE. 

 

Transfer Retainers  

Client and Project Retainers can now be easily transferred between Clients and Projects 

directly from the Retainers screen. All the related adjustment entries will be automatically 

made in the background and show up on retainer reports and screens. Managing your 

Client and Project Retainers is now easier in CORE. 

 

Benefits Summary 

We have introduced helpful controls and settings to allow your employees to better 

understand their benefit summary. Employees can now choose to get a YTD summary of 

their assigned benefits and also switch from Hours to Days view. HR admins can also set up 

a rounding option for benefit calculations. 

 

Custom Fields and Document Uploads for More Modules 

The ability to create and use custom fields have been added for more modules in CORE 

including Purchase Orders, Vendor Bills, Payments, Credit Cards, Credit Memos, and 

Vendor Credits. Create custom fields to track any value that CORE does not already cover 

and is important to keep track of for your business. Additionally, the ability to upload 

documents has been expanded to more modules including Vendor Credits, Credit Memos, 

and the Company Profile. Organize and keep track of all the relevant documents for a 

specific record in one place. 

 

Report Center enhancements 

CORE's Report Center continues to be enhanced in this release. Reports filters can now be 

toggled on and off to easily run a report with no filters without losing your saved 

configuration. Additionally, Scheduled Reports can now be sent in either PDF or Excel 

format. 

 

 

Other Improvements: 

• Benefits > A Global Settings option to configure how Human Resources Benefits 

data is displayed has been added. The number of digits after the decimal point can 

now be set for display whenever Benefits data is shown throughout CORE.  

• Campaigns > An Email column was added for adding individuals in the Add 

Recipients window of a campaign. 



• Cloud Feeds > Quick Refresh has been added as a Batch Action to the Cloud Feeds 

list view. 

• CRM > Files stored in the Resource Library can now be emailed directly from the 

Resource Library screen. Files can be sent individually via row action or as a group 

via batch action. 

• CRM > Follow-Ups have been updated on the CRM master lists to allow review and 

editing of all existing Follow-ups for a particular record. 

• CRM > Leads and Prospects details screens have been enhanced to show a history 

of all changes made to a record. The log has important details like date and time of 

change, who made the change and the value that was changed. 

• CRM > Users who have the right permissions, will now be allowed to delete Email 

history from the CRM module. 

• Dashboard > The Time Performance widget now displays the percentage of the 

selected part of the doughnut chart.  

• Emails > CORE has been enhanced to notify when an outgoing email bounced back. 

The system notifications will alert you with the relevant details of the unsuccessful 

email. 

• ePayments > Users can now quickly access the Payment Portal link that is sent to 

your Clients when ePayments are enabled. This can be accessed from within the 

Invoice details screen. The link to the Payment Portal can also be easily copied from 

the details screen. 

• ePayments> We are now sending email notifications to more internal users, like 

Project Manager and Biller when an ePayment is processed successfully. 

• Expense Entries, Time Entries, Leads > Custom field values can now be displayed as 

optional columns in the list view screens for Expenses, Time Entries, and Leads. 

• Follow-Ups > The Follow-Ups screen can now be quickly filtered to show All Follow-

Ups or just Follow-Ups for My Leads, My Prospects or My Opportunities. 

• Forecasting > All Forecasting screens now have a Project Status filter.  

• Forecasting > Filter options have been expanded in the various tabs to include 

Projects, Item Status and Billable Status. 

• Forecasting> We are now persisting the headers when scrolling the list of 

Allocations. 

• General > Drop-downs with multiple columns are now resizable.  

• Integrations > A default tax code for Vendor Bills in QuickBooks online sync settings 

has been added. 

• Integrations > CORE Expenses can now be synced as Bills to Xero. 

• Integrations > Integrations with third party accounting software have been updated 

to restrict syncing zero ($0) value phased Invoices from CORE. 

• Leads > Lead Score was added as an optional column in the list view.  

• Leads > Leads can now be assigned to a Campaign and the list view screen can now 

be filtered by Lead Source. 

• Opportunities > Users can now specify the Project Template they want to use at the 

Opportunity level. 



• Opportunities > When converting an Opportunity to a Project, CORE gives you the 

option to bring over the project template phase structure as well as service and 

expense line items used in the primary Quote. 

• Projects > Quick search now includes Project name and Phase description when 

returning search results. 

• Proposals > The Proposal templates screen has been simplified to only show Name, 

Description, and Status of each record. 

• Prospects > An Assigned To column was added to the Prospects list view screen so 

users can sort and filter the list by this value. 

• Prospects > Emails sent to a Prospect can now be reviewed from within the Prospect 

details Emails tab. Email attachments can also be reviewed. 

• Prospects > Prospects can now be assigned to Outside Consultants and Contract 

Employees. 

• Prospects > The Lead Source Filter has been added to the Prospects list view. 

• Prospects > When converting a Prospect into a Client, Contacts can now be included 

in the conversion. 

• Reports > A Created By column has been added to the Quotes report. 

• Reports > All Profit and Loss reports have been enhanced to make them easier to 

read. 

• Reports > All Trial Balance reports have been enhanced to make them easier to 

read. 

• Reports > All Balance Sheet reports have been enhanced with an enhanced design 

to improve layout and readability. 

• Reports > AR reports can now optionally display and filter by a project's Principal.  

• Reports > Leads, Prospects and other reports that show Leads and Prospects can 

now be filtered by “Tags." 

• Reports > Saved filters on Reports can now be toggled on and off to easily run a 

report with no filters without having to delete each one at a time. 

• Reports > The Billing Details report has been updated to simplify the header names. 

• Reports > The Budget Comparison report has been re-designed to include Services 

and Expenses Grand Totals. 

• Reports > The Project Account Details report has been added to the Billing package.  

• Reports > The search feature in the Scheduled and Memorized reports tabs has 

been expanded to now include matching results in Group Names. 

• Reports > The Transaction Details report can now be grouped by Payee. 

• Scheduled Reports > Scheduled reports can now be sent in either PDF or Excel 

format. 

• Statements > The Statements list view can now be filtered by Master Project. 

• Subscription> “Paid” watermark has been added to system receipts for CORE 

subscription purchases. 

• Time Entries > For Legal industry users, L-codes can now be batch updated from the 

Time Entries screen. 



• Time Entries > For Legal industry users, L-codes is now included in the exported .csv 

file of time entries. 

• Trust Fund Accounting > CORE has been updated to restrict showing Trust Fund 

transactions for Matters that have Trust Funds assigned to them. 

• Two-Factor Authentication > Answers to the security question were previously case 

sensitive. Case sensitivity has been removed. 

• Two-Factor Authentication > This feature has been restricted to paid users only. 

• Two-Factor Authentication > Two-factor authentication users now have the ability to 

disable their settings without completely clearing them. A separate option to clear 

all settings has been added as well. 

• User Preferences > Users can now customize the number of hours used to consider 

whether a Time Card is incomplete or not. This will trigger a reminder to fill it out. 

 

Other Fixes: 

 

• Account Reconciliations > When switching between Accounts, the wrong Account 

was being displayed in Account Drop Down. This has been fixed.  

• Allocation & Forecasting > Gantt Chart chips moved in the opposite direction when 

using the Project or Employee Task Bars for the first time. This has been fixed. 

• Chart of Accounts > The count of selected Accounts in the disclaimer of the batch 

delete window does not include sub-accounts. This was fixed.  

• Chart of Accounts > The KPIs on the list view screen do not change based on any 

applied filters. This was fixed.  

• Cloud Feeds> A specific scenario would cause feeds to duplicate on scrolling. This 

was fixed. 

• Custom Fields > Custom fields added for Projects from the Custom Fields list screen 

are not displayed in a Project's detail view in the order they were added. This was 

fixed.  

• Dashboard > Some icons in the Add Dashboard Widget modal of the dashboard 

were not showing. This was fixed.  

• Dashboard > The default filter applied for the Hours widget was 12 weeks, but the 

graph only displayed the last 4 months. This was fixed.  

• Dashboard > The Project Allocation widget incorrectly displayed a Project with 

phases when any filter was applied. This was fixed.  

• Dashboard > The Project Status widget was not properly displaying projects with a 

due date in the next month when applying a Due Date filter for next month. This 

was fixed.  

• Documents > The filter panel in the Documents list view did not correctly display the 

applied "Created By" filter value. This was fixed. 

• Email > If an email address was manually typed into the address line and didn’t 

match one of the existing autocomplete options, the email typed was erased. This 

was fixed.  



• Emails > After manually typing out an email address, clicking in the line to focus 

caused the email address to disappear. This was fixed.  

• Emails > The Message label of an email's detail view was not placed in the right 

location. This was fixed. 

• Emails > Using the backspace key to remove an email from the address key did not 

successfully remove the email. This was fixed.  

• Emails > When emailing Statements, the compose email screen was not populating 

pre-set TO, CC or BCC values depending on what action was taken to launch this 

screen. This has been fixed. 

• Financial Budgets > The page tab title did not match the page screen title. This was 

fixed.  

• General > Custom labeling for projects of some industries did not persist in 

dropdowns. This was fixed.  

• General> Users would no longer see the menu items if they clicked on an item they 

were not subscribed to. This was corrected. 

• Global Settings > Custom labeling for vendors was not properly applied in the Edit 

Vendor Credit page tab title. This was fixed.  

• Integrations > CORE Integrations were not syncing correctly for a Standard user with 

any Custom security profile other than the Full Access security profile. This was 

fixed. 

• Integrations > In some cases when manually entering a date into a date field of the 

Sync Settings tab, the date picker functionality would be disabled. This was fixed. 

• Invoice Collections > The Email column in the list view screen was not displaying 

when selected in the optional columns. This was fixed. 

• Invoice Collections > The Invoice Collections list view had issues sorting records by 

the Terms column. This was fixed. 

• Leads > Previewing the attached file when viewing the details of an email sent to 

lead was not working. This was fixed.  

• Leads, Prospects > When changing any field value that was not the Assigned To field, 

the Assigned-On field value was erased. This was fixed. 

• Projects > Changing the default group assigned to a Project did not successfully 

save. This was fixed. 

• Projects > When adding a phase to a multi-phased Project, the percentage complete 

field was being incorrectly auto-filled in some cases. This was fixed. 

• PTO > The “Requested For” label was incorrectly duplicated in the add/edit PTO 

request screen. This was fixed.  

• Reports > The Trust Fund Account Activity report was not displaying all purchase 

order numbers when applying a purchase order number filter. This was fixed. 

• Reports > When a company's currency was set to “Euros”, the Time and Expenses by 

Parent Project report incorrectly displayed amounts using US dollar signs. This was 

fixed.  

• Sales Goals > The page title and tab title did not match. This was fixed. 



• Time & Expense Reviewer > Sorting by the Type column did not sort the list 

correctly. This was fixed. 

• Two-Factor Authentication > Some users were getting an error while sending the 

verification code for two-factor authentication set up. This was fixed. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

 

 

 

 

VERSION 1.1.148 RELEASED ON JULY 25, 2020 

 

What’s new in this version?  

 

This update addressed some critical issues and added a few enhancements. Most notable: 

 

2-Factor Authentication 

We have added an extra layer of security that goes beyond a username and password. 

Users now have an option to turn on 2 FA on their accounts and choose from text, voice 

call or email as authentication options. 

Toggle Filters 

Filters on list view screens can now be toggled on and off. In case you want to review an 

unfiltered list, you can simply disable your applied filters and turn them back on when 

needed. This way, you spend less time constantly clearing then reapplying filters when 

trying to view a list with varying parameters. 

Improved Account Reconciliations  

We have added a "Reconciliations" screen that is accessible from the main navigation to 

simplify the path for reconciling accounts. Other improvements include easy to print 

summarized and detailed reports and an option to print them immediately after finalizing a 

reconciliation. 



Contact look up in Email  

Emailing your clients, vendors or employees from CORE has been made easier with 

automatic contact lookup or select multiple recipients from an address book pop up. Users 

can now look up any specific contact, including groups, using either a name or email. Email 

composition retains the ability to add unlimited email recipients by entering an email 

address directly. 

 

Create Time entries from Events 

Users now have the added ability to create time entries directly from a calendar event. The 

associated project and hourly duration are prefilled to simplify this time entry creation 

process. 

CORE Express Subscription Bundle  

CORE is proud to announce a new discounted pricing bundle for companies with up to 5 

users.  

 

Other improvements:  

• Account Reconciliation > Users will now have an option to generate a summarized 

or detailed report after finalizing an account reconciliation. 

• Account Reconciliations > The account reconciliation experience has been improved 

to better track large checks and deposits that correspond to multiple projects or 

vendor payments. 

• Account Reconciliations > Users can now run Reconciliation reports directly from the 

Reconciliation screen. 

• Allocation & Forecasting > The Allocation & Forecasting view and widgets can now 

be filtered by Principal and Originator. 

• Bill Payments > A column has been added for expense entry date to the details pop 

up of employee reimbursables. 

• Chart of Accounts, Fund Transfers > Users can now upload documents for fund 

transfers and individual accounts in the Chart of Accounts. 

• Chart of Accounts > Parent Account balance amounts now include balances for all of 

its sub-accounts when the accounts are being displayed in a hierarchical manner. 

• Chart of Accounts > The Account type drop down in "Create New Account" now 

conforms to an accountant friendly display order. 

• Checks > Checks can now be batch updated on the Checks list view screen. 

• Checks > The Bill Payment column has been added to the Checks list view to denote 

checks used to pay bills. 



• Clients, Employees, Vendors, Prospects > Individual contacts listed in the Contacts 

tab now have their own active status. 

• Cloud Feeds > We added a "Quick Refresh" action that allows users to refresh their 

account without invoking the refresh UI.  

* This action is available once every 24 hours and cannot be performed for accounts 

that need MFA code or Captcha to perform a refresh. 

• Contacts > Contact Status has been added to the Contacts detail views throughout 

CORE. 

• CRM > Attachments can now be added to Prospects, Opportunities and Quotes from 

their respective list views. 

• CRM > Elaborate tooltips have been added throughout the CRM module. 

• CRM > Grand totals have been added to the Opportunity list view for Closed 

Amounts 

• CRM > Newly added CRM screens were missing record counts on list views. These 

counts have been added. 

• Dashboard > The Staff Utilization widget was updated to display the total utilization 

percentage for all employees. 

• Dashboard > The Staff Work Load widget will now roll up all allocation data to the 

resource level. 

• Dashboard > The To-Do widget can now be filtered by Status. 

• Emails > Users can now specify recipients in the compose email screen using quick 

search or address book pop up. 

• Emails > The file size allowed for email attachments has been increased to 10 MB.  

• Emails > Files can now be dragged and dropped anywhere on the compose Email 

screen to attach the document. 

• Emails > Users will now be prompted when a subject line is not set for any outgoing 

Email. 

• Employee Control > A column has been added to the Employee Control details to 

differentiate Projects from Project Groups. 

• General > Custom fields are now supported for more modules like General Journal, 

Checks, Chart of Accounts, Deposits, and Fund Transfers. 

• General > The link to reorder the menu items of the side navigation was relocated to 

the bottom of the navigation menu. 

• General > The logo by industry feature was further enhanced to provide separate 

logos for Architectural and Engineering industries. 

• General > To improve the column resizing experience in the Time Entry and T&E 

Reviewer screens, a suggested best fit option is provided. 

• Global Settings > 'Invoice Due Date' was added as a smart field option to insert in 

global email settings. 

• Global Settings > Administrators can now configure the custom labels for CRM 

modules including Leads, Prospects, Quotes, Proposals, Campaigns and 

Promotions. 



• Integrations > QuickBooks users can now send multiple CORE employee expenses 

to the same vendor bill in QuickBooks. 

• Integrations > Users can now include purchase tax amount when sending Vendor 

Bills to AccountRight. 

• Invoices > A filter to display invoices with or without a discount has been added to 

the Invoices screen. 

• Invoices > The invoice list view screen can now be filtered by Client Group and 

Project Group. 

• Leads > When converting a lead into a prospect, users are given the option to 

transfer any notes, to-dos, emails, and campaigns during the conversion. 

• Leads > The "Import from CSV" feature now allows users to specify mapping for 

more fields. 

• Legal > "Expenses" will now be custom labeled "Costs" by default when a CORE 

account is created for a Legal industry client. 

• Notifications > Users will now be presented with more context like the name of the 

client etc. when notifying them about successful processing of recurring 

transactions. 

• Opportunities > When creating an opportunity, the Forecast value now 

automatically defaults to any amount already entered for the Opportunity Value. 

• Opportunities > The Quotes tab in an Opportunities detail view now has a field to 

denote if a Quote Template is being used. 

• Projects > The ability to search the list view by Client, Manager, City, State, and 

custom field values has been added. 

• Projects, Clients > Users can now specify the date range to filter transactions in the 

Transactions tab of the detail view. 

• Projects > When creating a Project from a Project template, the Fee Schedule will 

also get cloned to the new Project. 

• Projects > When creating an Invoice from a Project's opening balance, users will now 

be presented with the details on successfully adding the transaction. 

• Proposals > Proposal Builder has been updated to limit inserting new quotes based 

on existing Templates only. 

• Prospects > The email field is displayed by default when adding a new Prospect. 

• Purchase Orders > Users can now send multiple purchase orders as separate 

attachments in one email. 

• Quotes > A Created By filter was added to the Quotes list view screen. 

• Quotes > A "Created By" column was added to the Quotes list view screen. 

• Registers > The register account has been moved to the top of the screen for a 

better user experience and overall consistency. 

• Reports > Project Start Date and Project Due Date filters were added to all Allocation 

& Forecasting reports. 

• Reports > Users can now filter the Workflow Details report by specific employees. 

• Reports > A column with contact number has been added to the Follow-Ups report. 



• Reports > Next Week and Next Month have been added as date options for 

Allocation Start and End Dates. 

• Reports > Security reports were missing the option to choose the output format. 

This was added. 

• Reports > The Retainer Details by Project report now has the option to show or hide 

Zero Balances. 

• Reports > The Sales Goal Performance and Sales Goal by Employee reports were 

updated to handle employee groups. 

• Reports > The Work in Hand report now has the option to include or exclude Work 

in Progress amounts in the contract balances. 

• Retainer Invoices > The retainer invoice message can now be edited or turned off in 

global settings. 

• Scheduled Reports > Users now have the ability to control the subject line in 

scheduled report emails. 

• Search > Global search has been updated to include CRM module results. 

• Security > As added security, users who use the Forgot Password to reset their 

password will receive an email letting them know that the password has been 

updated. 

• Statements > Billing users can narrow down statement generation by using newly 

added filters like Project groups and Client Groups. 

• Subscriptions > When an owner account logs into CORE and the company has 

expired or has subscriptions in grace days, they will be directed to the Manage 

Subscriptions screen. 

• Time and Expense > Time, Expense and Reviewer list views can now be filtered by 

Invoice Number. 

• Time Card > For legal industry users, the L-code column was added as an optional 

column instead of always displaying it. 

• Time Card > Managers now have the ability to approve Time Entries directly from 

the Time Card screen. 

• Time Card > We have enhanced the "Copy From" and "Copy To" functions and 

added the total of logged hours in the destination or source week. 

• Time Entries > If a user had no privilege to approve entries, then these options have 

been removed from the Time and Expense user. 

• User Preferences > Users can now set a reminder to check their incomplete time 

cards from the previous week. 

• User Preferences > Users can now set CRM modules as the default screen when 

logging into CORE. 

• User Preferences > Users can now set HR modules as the default screen when 

logging into CORE. 

• Vendor Bills > The ability to batch update the date, reference number, term, due 

date, and memo of selected vendor bills in batch was added. 

• Vendor Bills > Users can now see and edit the bill rate for each line item when 

creating or editing a vendor bill. 



• Vendor Bills > The Project or Phase on a Vendor Bill can now be changed after it has 

been paid. 

 

Other fixes: 

 

• Campaigns, Leads, Prospects > The date of a note is not consistent in the list view 

and the detail view of a campaign, lead, or prospect. This was fixed. 

• Follow Ups > The batch update feature in the Follow Ups screen does not 

successfully update the follow-up status from Inactive to Active. This was fixed.  

• Follow Ups > When clicking an email address in the hover dialog, the default mail 

application was not opened to send an email. This was fixed.  

• Follow Ups > When moving the cursor to the View Lead Details link of the hover 

state dialog, it disappears before you can click it. This was fixed.  

• Incidents > When creating a new incident, descriptions are cut off if they exceed a 

255-character count instead of saving the entire note. This was fixed. 

• Integrations > When syncing Bills and Purchase Orders from CORE to Xero, the tax 

code specified at the Account level was fetched instead of the one at the item level 

for each transaction. This was fixed. 

• Invoices > Formatted memos on Invoices would display HTML when saved. This was 

fixed. 

• Leads > Any notes, to-dos, or campaigns associated with a lead is not carried over 

when it is cloned. This was fixed.  

• Leads > Batch updating leads from the list view did not successfully update the lead 

cost, country, or memo fields. This was fixed.  

• Leads > When converting a lead into a prospect, the default probability value in the 

modal was not consistently at 25% when converting from the list view and the 

details view. This was fixed.  

• Leads > Notes, to-dos, and tags were not carried over when a Lead is converted into 

a Prospect. This was fixed. 

• Legal > The Project column on the Invoice Collection screen was incorrectly 

displaying the name of the Client instead of the Project when a Split Bill Invoice was 

used. This was fixed. 

• Lists > Attaching files from the Resource Library to certain Expense Item in the Lists 

module would result in an error. This was fixed. 

• Notes > Notes were not automatically created when emailing Proposals and 

Campaigns. This has been updated. 

• Opportunities > Totals were not displaying a correct sum in the list view. This was 

fixed.  

• Opportunities > Not specifying a Closed-on Date when marking an Opportunity as 

Won from the list view screen would result in a system error. This was fixed. 



• Proposals > The template and format of a Quote inserted into a Proposal does not 

match what is displayed in the email sent. This was fixed.  

• Proposals > Too many columns were displayed in the Proposals list view by default 

and a Created by Date, Opportunity, Proposal, Prospect, and description were not 

included in the optional column list. This was fixed.  

• Prospects > In the Opportunities tab of a prospect's detail view, the Forecast field of 

the Add New Opportunity dialog does not pre-fill to display any amount already 

entered in the Opportunity Value field on focus. This was fixed. 

• Prospects > In the Opportunities tab of a Prospect's detail view, the Total 

Opportunity Value KPI on top of the opportunity list was displaying an incorrect 

summed value. This was corrected. 

• Prospects > When creating a new prospect based on an existing record, the list of 

client options disappears when sorting by the Contact column. This was fixed.   

• Prospects > Prospect filter panel was only displaying Active Prospects. This has been 

updated to also show Inactive Prospects. 

• Prospects > The Opportunities tab in Prospect details was missing totals for value 

and closed amount. These have been added. 

• Reports > Applying the "Last Semi Monthly" date filter on reports would result in 

system errors. This was fixed 

• Reports > Leads reports were only accounting for Leads with a Pending status. This 

was fixed. 

• Scheduled Reports > Some scheduled reports with the ‘Last Week’ date filter applied 

were sending incorrect data. This was fixed. 

• Time Card, Reports > The Employee Time Card (Weekly View) report does not 

differentiate time entries by unique description values. This was fixed. 

• Vendor Bills > The vendor bill batch email option has been restricted to 25 records 

at a time. 

• Vendors > Country currency labels change when selecting an option in the Currency 

dropdown of a vendor's detail page. This was fixed.  

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

VERSION 1.1.147 RELEASED ON JUNE 6, 2020 

 

What’s new in this version?  

 

This update addressed some critical issues and added a few enhancements. Most notable: 

 

 



Introducing CORE CRM (Beta) 

• Fully Integrated Client relationship management system. 

• Designed for the Professional services industry. 

• All-in-one CRM solution that compliments existing CORE platform. 

• Centralized system to track your Leads and their progress through your sales 

pipeline. 

• Help manage your Sales/Business development team’s daily tasks and assignments 

using our comprehensive Follow-Up screen. 

• New set of reports specific to CRM metrics such as Campaign Performance, 

Promotion Code Usage and much more. 

• Build, customize and email Quotes and Proposals directly in CORE CRM. 

• Generate Promotions and Campaigns within CORE and track their performance to 

optimize return on investment. 

• Powerful, real-time dashboard widgets to track Sales Goal Performance, Sales 

Velocity and much more. 

• No fees, zero obligation CRM subscription until September 30, 2020. 

 

Copy Time Card 

This much awaited feature will allow users to copy existing Time Cards to any selected 

week. We have added two powerful copy options: “Copy From” and “Copy To” to give our 

users total control over their Time Cards and will allow them to submit in a matter of 

seconds. 

 

Customizable Navigation 

CORE users can now control the order of menu items and keep it unique to their 

preferences. An edit icon placed on the navigation menu leads users to an elaborate UI 

that allows easy menu item re-ordering. 

Update your To-Dos 

All CORE users can now report progress on assigned To-Dos directly from the Dashboard. 

The newly designed To-Do widget allows easy update of percent complete and adds more 

context to the assigned To-dos. 

 

Documents for Check & Credit Cards  

The ability to attach documents to checks and credit cards has been added so that 

necessary documents can be uploaded for these types of transactions. 



 

Other improvements:  

• Bill Payments> Check numbers will now be automatically added into the memo 

when making a Bill Payment with a check or credit card. 

• Cloud Feeds> The search function has been added to Cloud Feeds in the Find Match 

flow. 

• Dashboard> Dashboard Accounting widgets are now reflecting Accrual or Cash basis 

as defined in Global Settings. Users also have the option to choose the accounting 

option in the widget itself. 

• Dashboard> Enhancements have been made to the Project Allocation by Task 

widget to enable filtering by Employee, widening the Project column, and adding 

Resource as a group. 

• Dashboard> The Project Allocation widget was missing a total row. This has been 

added. 

• General> Batch update operations have been limited to 5000 records per batch. 

• Integrations> Split Billing type Invoices are now getting properly synced to XERO and 

AccountRight. 

• Payments> "Type" column was added to the payment disbursement window to 

differentiate services and expenses. 

• Payments> The Payment Disbursement screen can now be sorted by any column. 

• Project Templates> Assignments have been added to Project Templates. 

• Projects> The Project Templates option in the More menu has been separated from 

other options to make it easier to find. 

• Project Templates> Users can now assign Fee Schedules, Budgets, and Estimates to 

Project Templates. 

• Reports> A new report was added to list all Scheduled Report details. 

• Reports> An individual Employee filter was added to the Employee Time Card 

Summary report. 

• Reports> An option to hide phases when running a Project List report has been 

added. 

• Time and Expense> Users can now choose from various write down / mark down 

options when assigning time and expense entries to an invoice directly from the 

Time Entries, Expense Entries and Reviewer screens 

• Time Card> An additional column has been added to Legal industry Time Cards to 

denote L-Code for your activities. 

• Trust Fund Accounting> Trust Fund summaries are now supported on all CORE 

Invoice Templates. 

• Vendor Bills> Payments Status filter has been updated to allow multiple options to 

be applied at once. 

 

Other fixes: 



• Accounting> There were incorrect restrictions for DCAA compliance that were 

preventing a user from entering Vendor Bills that included Time and Expenses. This 

was fixed. 

• Clients> Search capability was not working properly in the City field dropdown. This 

was fixed. 

• Clients> The “All Projects” option disappears in the Performance tab Project 

dropdown after selecting a different project. This was fixed. 

• Credit Cards> Changes to Expense Entries linked with a Credit Card were not 

syncing correctly between both modules. This was fixed. 

• Credit Memos> The class field value was not able to be removed after saving. This 

was fixed.  

• Credit Memos> When saving /updating credit memo without class field, class would 

get displayed as required. This was fixed. 

• Currency Manager> The Currency Manager screen did not allow an assigned 

multiplier value to exceed 7 digits. This was fixed.  

• Currency Manager> The Cayman Islands currency was incorrectly displaying the 

pound symbol instead of the dollar sign. This was fixed.  

• Currency Manager> The search bar on this screen was not successfully returning 

results. This was fixed.  

• Custom labels > Activity and Expense custom labels were not reflecting correctly 

throughout Assignments. This was fixed. 

• Dashboard & Invoices> Time entries recorded against sub-phases were not counted 

in the Totals row. This was fixed. 

• Dashboard. If any Invoices had been created for Inactive or On Hold Projects, the 

Project Gross Margin widget would unnecessarily display 0 values. This was fixed.  

• Dashboard> When filtering the Expense Performance widget to display Invoices for 

all dates, an error would occur when scrolling to the bottom. This was fixed.  

• Dashboard> The PTO widget did not account for negative benefit usage values like 

other HR modules do. This was fixed.  

• Dashboard> The utilization percentage displayed in the Staff Utilization widget did 

not match the same percentage displayed in the Employee Performance screen. 

This was fixed.  

• Documents> Sorting the list of an Invoice’s existing documents would throw an 

exception. This was fixed.  

• ePayments> Due date or Custom date payment options should not have appeared 

once the Payment was overdue. This was fixed.  

• ePayments> Retainer invoices that had ePayments enabled were throwing API 

Errors. This was fixed. 

• Financial Budgets> Allowing users to edit a Financial Budget's time period caused an 

error. This was fixed.  

• Financial Budgets> Budgeted amounts for each interval were not dividing correctly 

when switching between annual, quarterly, and monthly views. This was fixed. 



• Financial Budgets> The “Hide Blank Rows” action would hide account category rows 

when it should have only hidden individual account rows. This was fixed.  

• Gantt Chart> Incorrect start and end dates were being displayed when exporting a 

phased parent project Gantt view as a PDF. This was fixed.  

• General Journal> Clicking either "Save & Done" or "Save & Add Another" when 

creating a General Journal entry redirected the user to the Dashboard instead of the 

correct General Journal screen. This was fixed. 

• Global Settings> Users who enabled DCAA and used a hash "#" in their password 

were unable to disable it afterwards. This was fixed. 

• Groups> When changes were made to security settings and reverted back, access 

was not fully granted back. This was fixed. 

• Integrations> When successfully syncing expenses from QuickBooks Online to 

CORE, CORE would use the same alert that was used to depict a sync failure. This 

has been updated to reflect a successful sync. 

• Integrations> DCAA compliance settings were causing issues with Xero, QuickBooks 

Online and AccountRight. This was fixed. 

• Invoice Collections> Invoice Collections screen was reflecting incorrect Retainer 

Available numbers. This was fixed. 

• Invoice Collections> The Client column was incorrectly labeled as an Invoice column 

when exporting the list as a .CSV. This was fixed.  

• Invoices>When trying to void a manual invoice that had been manually paid, an API 

error was thrown. This was fixed. 

• Invoices> Invoice records on the list view screen would disappear when sorting by 

Class. This was fixed.  

• Invoices> When 2 draft Invoices were finalized at the same time for a Project that 

used custom Invoice numbers, only 1 finalized Invoice reflected the custom Invoice 

number while the other did not. This was fixed.  

• Invoices> When filtering by a Project Manager in the Invoices list view, the selected 

Project Manager name was displayed incorrectly in the filter details section. This 

was fixed.  

• Messages> When searching for a name in the TO field of the Message Composition 

screen, the search did not return proper results. This was fixed.  

 

• Payments> General Journal entries were not being created for credit or write-off 

payment types. This was fixed. 

• Payments> Payments screen allowed multiple clicks on the Pay button which would 

lead to duplicate payments being created. This was fixed. 

•  

• Projects> Column resizing in the list view were not being persisted and applied 

anymore after reloading the page. This was fixed.  

• Projects> Phase order was lost when cloning a project. This was fixed.  



• Projects> Showing duplicate records for vendors when assigning as a team member 

in project details. This was fixed.  

• Projects> Using fractional percentages on split billed projects would round up 

percentage values and could cause totals to go over 100%. This was corrected. 

• PTO> Request Approval email notifications were displaying the date the request was 

made instead of the date requested off. This was fixed.  

• Reports > Document reports were not showing the correct file size Grand Totals. 

This has been corrected. 

• Reports> Incorrect applied filter details were being displayed on the Percentage 

Billed report. This was fixed. 

• Reports> The Balance Sheet Accrual by Project and P&L Accrual by Project reports 

were not applying custom labels correctly. This was fixed.  

• Reports> The Statement report was generating extra blank pages. This was fixed.  

• Reports> Time Details report displayed an incorrect stop time for time entries. This 

was fixed.  

• Search> When applying discrete filters and searching together in a list view, and 

then clearing the applied filters, the value in the search box was also cleared. This 

has been fixed. 

• Time & Expense Reviewer> Changes made to an entry's description field from the 

list view were not being successfully saved after clicking Done even though a 

success message was shown. This was fixed.  

• Time & Expense Reviewer> When specifying a custom date range, the placeholder 

text for the From and To fields was not reflecting the correct date format. This was 

corrected.  

• Time & Expense> When a time entry was entered on behalf of another employee 

and then rejected by a manager, the rejection notice was incorrectly sent to the 

employee who made the time entry instead of the employee whose time was 

rejected. This was fixed.  

• Time & Expense> In the Time and Expense Entry details screens, the Created On 

Date has been moved next to the Entry Date in the General tab. 

• Time Card> The "Remove Blank Rows" action should have removed all blank rows in 

the time card; however, if this action was used with a few rows selected, then only 

the selected blank rows should have been removed. This was fixed. 

• Time Entries> Users could not update the billable status from the Edit Time Entry 

screen for fixed Projects. This was fixed.  

• To-Dos> Some To-Dos that had attachments were not reflecting this information 

correctly from the list view. This was fixed. 

• Vendor Bills> When creating a new Vendor Bill, 

• searching by a Vendor's last name would not display any results. This was fixed. 

• Vendors> An error was thrown when converting a vendor with saved notes into an 

employee. This was fixed.  

• Vendors> When a vendor already has a saved memo, the details tab continued to 

show "Add Memo" instead of "Show memo". This was corrected. 



• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

VERSION 1.1.146 RELEASED ON APRIL 18, 2020 

 

What’s new in this version?  

This update addressed some critical issues and added a few enhancements. Most notable: 

 

Trust Fund Account Management 

We are proud to announce that we have added Trust/IOLTA account management, a very 

popular feature in the Legal industry. This powerful enhancement will allow users to 

manage and report on a client’s funds separately from their firm’s operative bank accounts 

and comes packed with reports and widgets that allow tracking Trust funds by matter and 

3-way account reconciliation that can be run for each statement period. 

 

Guaranteed payments with Scheduled ePayments  

Never miss another ePayment from your Client because the Invoice was not due yet. We 

have enhanced our ePayments feature to allow your Clients to schedule payments on any 

date of their choice. As long as the scheduled payment date falls on or before the Invoice 

due date, your Clients can choose when to pay and also be able to make any changes right 

from the ePayment page for the specific invoice.  

 

Rates by Classification 

This powerful feature that is turned on by a project rule, allows your Fee Schedules to pivot 

on employee classifications. Define specific or general classification rate rules in your Fee 

Schedules and this new feature will auto populate the new rates based on the classification 

selected for the time entry. 

 

 

 



Advanced Report Filters 

Create powerful reports based on advanced filtering that supports And, Or and Not 

combinations. Also, CORE reports now print the applied filters at the top of each report to 

add more context to the report. 

 

Filter preview 

By popular demand, we have added aesthetically designed filters segments that provide a 

sneak preview of the filters applied to any of the CORE list views. Users can click on these 

segments to see the full list of filters and also continue to add or remove the filters from 

the panel view. 

 

‘Mark as Billed’ with Invoice number 

This powerful enhancement in the Time and Expense reviewer allows billing managers to 

associate unbilled entries to previous invoices, and handle it for multiple projects at the 

same time.  

 

Know your allocations 

Added a brand new ‘Task Allocations’ widget that displays assigned tasks with complete 

details including allocated, used and remaining hours and is easily filterable by Project, 

Employee and date ranges. T&E users also have been allowed restricted access to 

Allocations screen to view their tasks in a list view. 

 

 

Other improvements:  

• Allocation & Forecasting> Employee manager filter has been added to allow 

managers to easily view the tasks of all the employees they manage. 

• Allocation & Forecasting> More validation rules have been added in the '+Add' 

window to help users make sure they add allocations correctly. 

• Batch Invoices> A new global setting (Master>Charge Item taxes in addition to 

Contract Amount) now controls if the net bill algorithm should exclude item-level 

taxes when processing an invoice using the percent complete option. 

• Batch Invoices> There have been several important enhancements in this screen 

including automatically combining an unlimited number of phases, performance 



optimization that makes the create batch Invoice process 50% faster and a better 

user experience for Phased, Joint and Split Invoices. 

• Budgets, Estimates> Select multiple records to send together in one email instead of 

individually emailing one at a time. 

• Budgets, Estimates, Fee Schedules, and Financial Budgets> The search bar in the 

'Create from Existing' window was relocated for scalability and clarifying what users 

can search. 

• Cloud Feeds> The account setup experience has been updated to address the issue 

of orphan accounts being created before the process was completed. 

• Cloud Feeds> We now append the institution account number to better identify the 

third-party institution account when adding new accounts to CORE. 

• Currency Manager> Added 'New Taiwan Dollar' as a new currency in CORE. 

• Dashboard> Drill down into the details of the data displayed in the Account 

Balances widget by opening the Account Registers report straight from the widget. 

• Dashboard> Drill down into the details of the data displayed in the Expense 

Performance widget by opening the Billed time & Expenses report straight from the 

widget. 

• Dashboard> As part of the Trust accounting update, a new 'Trust Fund Balances' 

widget has been added to the Dashboard to allow easy read-access to your trust 

fund balances. 

• ePayments> We have added more options to allow users to control the ePayment 

email message including an override for the stock message. 

• ePayments> We have redesigned the 'Pay' button and also listed all supported 

credit cards on the Client payment page. 

• ePayments> We have added a ‘View Invoice’ link on the Payment page to preview 

the original invoice. 

• Expense Entry> A 'Classification' column has been added to the Expense Entry list 

view. 

• Financial Budgets> A tooltip was added to elaborate on the purpose of using a 

reference year when creating a financial budget. 

• Financial Budgets> Easily expand or collapse all rows at once when editing a 

financial budget. 

• Financial Budgets> In the batch update dialog, a field is auto-checked when a value 

is entered. 

• Financial Budgets> The data displayed in the reference column now updates to 

show actual numbers from specific time periods of the selected reference year 

based on the column the user is currently editing. 

• General> CORE has added a second confirmation step before batch actions are 

executed to prevent unwanted changes to large record sets. 

• General> CORE's customer services contact information can now be accessed within 

the application from the Help menu. 



• General> We have made several enhancements to our column resizing feature to 

allow for better user experience. Columns that have been resized already by the 

user are not affected by modifying any of the other columns. 

• Invoice Collections> 'Retainer Available' column has been added to the Invoice 

Collections list view. 

• Invoice Templates> As part of the Trust accounting update, Invoices for matters that 

have an associated trust fund will have the option to select from invoices templates 

that display a Trust Fund Summary. 

• Invoice Templates> We have enhanced our late fee invoice templates to show the 

memos associated with the Invoice. 

• Invoices> We have added the Batch Update menu that allows users to perform 

multiple batch updates at the same time. 

• Manage Subscriptions> Subscriptions that have been purchased together and set to 

auto renew at the same interval, will now also be renewed at the same time and a 

single, consolidated invoice would be generated. 

• Manage Users> The filter panel has been added to better manage your users. 

• Payments> Accounting users can now directly add payments to their bank accounts 

when entering a payment. The newly added 'Deposit Account' field will list all their 

bank accounts as well as the traditional 'Undeposited Funds' account, allowing them 

to issue a direct deposit to the bank. 

• Payments> Expense Account for Credit and Write-Off type payments has been 

renamed as 'Posting Account' to convey the purpose of this field better. 

• Projects> Allow users to choose project attributes to inherit when adding a new 

phase and also remember their choices for the next time. 

• Projects> As part of the Trust accounting update, trust fund activity will now be 

accessible from within the Transactions tab in Matter details. 

• Reconciliations> Bank account reconciliation was further simplified by rolling up bill 

payment checks to a single entry to match how it appears on the bank statement. 

• Registers> See check numbers for a bill payment in the register so you can associate 

it with the bank statement when reconciling. 

• Reports> The Monthly Profit and Loss Accrual and Cash Basis reports now have an 

added column to display a total for every month. 

• Reports> The 'Project List Report' now has the added option of grouping by Master 

Project. 

• Reports> As part of the Trust accounting update, a new 3-way reconciliation report 

has been added to provide information about reconciled bank balance, book 

balance and client trust ledger balance. 

• Reports> As part of the Trust Fund feature, we have added the 'Trust Fund Account 

Activity' report that will track Trust funds by client and matter. 

• Reports> Benefit Usage reports now round to the nearest quarter hour. 



• Reports> 'Client List' report can now be grouped by various options like Client 

Group and Client Manager. 

• Reports> 'Requests for Information' report now allows users to specify if they want 

to see the Contacts or the Creator of the RFI as a report column. 

• Reports> We have extended the drill down feature to all our Financial reports. This 

update adds this functionality to financial reports that are based on Class and 

Project accounting. 

• Reports> We now allow admin users to rename scheduled report group names. 

• Reports> We now print the applied filters on the top of each report but limit the list 

to 10 or less discrete filters. 

• Reviewer> We have added the Hours column to reveal the actual hours associated 

with the Time entry. 

• Security> Access to Performance widget security now also controls access to the List 

view Info bars in the relevant screens. 

• Security> Admin users can now control if Project Managers have access to the 

'Forecasting' view and also a separate security to control access to the amount view 

while forecasting. 

• Statements> The selected template in the Statements screen now defaults to the 

last used template. 

• User Preferences> Users can now configure CORE drop down searches to be based 

on ‘starts with’ or ‘wild card matching’ principle. Wild card matching is the default 

setting. 

 

Other fixes: 

• Activity> Activity screen did not warn against entering a duplicate Activity. This was 

fixed. 

• Bill Payments> After excluding a negative reimbursable amount from the details 

window of a bill payment, the pay amount was not being updated accordingly. This 

was fixed. 

• Checks> After making changes to Alignment, Check Style dropdown selection would 

get refreshed instead of persisting the selected value. This was fixed. 

• Client> Performance tab, Project drop down would only include active projects. This 

was fixed. 

• Cloud Feeds> CORE did not allow split transactions to be entered with a negative 

amount. This was corrected. 

• Cloud Feeds> CORE would allow users to specify multiple payees when adding a 

check feed as check in split mode. This was corrected. 

• Compose email> Configuring global settings to include the client's and the logged in 

user's email addresses in the CC field would automatically add them without 



including a separator and this error would block an invoice email from being sent. 

This was fixed. 

• Dashboard> Employee Allocation & Staff Workload widgets did not work when 

applying a project and employee group filter at the same time. This was fixed. 

• Dashboard> Vendors were included when trying to filter by Employees in the 

Employee Allocation and Staff Workload widgets. This was fixed. 

• Employees> Clicking on the 'Added By' hyperlink in a note's details inconsistently 

directed a user to the Documents tab when it should have directed the user to the 

General tab of that employee. This was fixed. 

• Expenses> Users were unable to delete an Expense entry that was previously linked 

to a Credit Card and then unlinked. This was fixed. 

• Financial Budgets> The % Changed values of the reference column would not 

display for account category rows. This was corrected. 

• Financial Budgets> The amounts budgeted in each cell would split evenly among all 

intervals throughout the entire fiscal year when switching between monthly, 

quarterly, and annual instead of splitting these amounts only within the subsection 

of a fiscal year. This was fixed. 

• Financial Budgets> The current expanded/collapsed view format was not persisting 

when switching the interval view between monthly, quarterly, and annual. This was 

fixed. 

• Financial Budgets> The reference column was not grouping the value and % 

changed columns together so that they could be shown or hidden together. This 

was fixed. 

• Financial Budgets> The Save & Done button did not successfully save a financial 

budget in the create and edit screens. This was fixed. 

• Financial Budgets> Updating the Class and Fiscal Year fields while editing a financial 

budget caused the screen to load the changes indefinitely. This was fixed. 

• Financial Budgets> When switching the view between annual, quarterly, and 

monthly while editing a financial budget, the budgeted amount was lost. This was 

fixed. 

• General> Groups counts have been updated to exclude Inactive Groups. 

• Integrations> Split billed invoices were not being properly synced for QuickBooks 

Online integrations. This was fixed. 

• Invoices> API error occurred when processing multiple phased invoices as final in 

one batch action. This was fixed. 

• Invoices> In a certain scenario, multiple Joint invoices were created when clicking 

the 'More' button that loads more entries instead of only creating one invoice. This 

was fixed. 

• Invoices> The loading spinner would disappear after the unapproved time/expenses 

message appears even though the page was not done loading. This was corrected. 



• Invoices> Quick adding a project, budget, or estimate when creating an invoice 

would open duplicate dialog windows. This was fixed. 

• Invoices> Invoice date sort would not correctly sort the invoices if they were created 

on the same day. This was fixed. 

• Invoices> Email to Client would not default to Project Billing Contact if Client email 

was blank. This was fixed. 

• Payments> When creating a new payment and selecting a Client but not a Project in 

the 'Add Payment' dialog, 'Accept as retainer' would fetch all retainer Invoices, 

including those which did not belong to the selected Client. This was fixed. 

• Payments> Billing users were not able to select 'Completed' projects from the 

Project drop down to record a new payment. This was fixed. 

• Payments> CORE was not handling cash accounting correctly when a deposited 

check was marked as bounced. This was fixed. 

• Projects> Entries disappeared in 'Add Team Member/Expense/Activity' window while 

searching and sorting through the list. This was fixed. 

• Projects> Main project row in split billing section of Billing Options tab did not follow 

the name convention set in global settings for labeling projects. This was fixed. 

• Projects> Running a Project Time & Expense with Accounts report from the Projects 

screen did not apply the filters used in the list view. This was fixed. 

• Projects> Users who did not have access to add a Team Member, Activity, or 

Expense were not prompted with this explanation when attempting to add one to a 

Project. This was corrected. 

• Projects> The structure tab would not gracefully handle a situation when the logged-

in user had no access to the Project contract amount. This was corrected. 

• Projects> CORE would not hide the contract amount and cost rate related widget 

data if the relevant security settings were turned off for the logged-in user. This was 

fixed. 

• QuickBooks Online Integration> Errors were thrown when re-syncing already-synced 

Expenses from CORE to QuickBooks Online. This was fixed. 

• Reports> Account Transactions report was showing Project and Client filters in the 

custom field tab. This was fixed. 

• Reports> Activity Items filter options were not sorted alphabetically. This was 

corrected. 

• Reports> Any filters set when running a Client List report were not being applied. 

This was fixed. 

• Reports> Bounced check transactions caused an error in the Profit and Loss Cash 

Basis report calculations. This was fixed. 

• Reports> Custom Fields filter section header was missing in the customization 

widow. This was corrected. 

• Reports> Filtering the Project Requests for Information report should only allow 

users to select individual records and not a range of statuses. This was corrected. 



• Reports> The Net Billed amount in the summary section of the Account Register 

report was not calculating the correct sum. This was fixed. 

• Reports> The Retainer Invoice report crashed when applying a Reference Num filter. 

This was fixed. 

• Reports> In select scenarios, Statement report displayed an error instead of a date 

when using 'As of' date filter. This was fixed. 

• Statements> Statement reports have been updated to properly apply 'As Of' date 

filters. 

• Subscriptions> The user interface was not responsive on smaller monitors and this 

would cause design overlaps. This was fixed. 

• Time and Expense> When updating the Activity item and Cost rate of the Time 

entries linked to a Vendor bill, the Vendor Bill Accounting details were not getting 

updated accordingly. This was fixed. 

• Time and Expense Reviewer> Applying a single Class filter to the Reviewer list screen 

would always retrieve a blank list. This was fixed. 

• Time Card> Allocated hours were not considered in the allocation summary section 

if a start/end date was not specified in the A&F screen. This was fixed. 

• Time Entries> Time entries linked to Vendor Bills, Checks, and Credit Cards would 

not update when changed for income and expense accounts when using Batch 

update. This was fixed. 

• Time Entries and Vendor Bills> The Project dropdown list becomes empty when 

reopening the dropdown after scrolling through the entire list the first time it was 

opened. This was fixed. 

• Timers> Deleting a hyperlink document attached to a timer entry causes an error 

and does not successfully delete the record. This was fixed. 

• Vendor Bills> The 'Amount' column in the account tab was incorrectly labeled 'Cost 

Amount'. This was fixed. 

• Xero Integration> CORE would throw an error when getting the same name Client or 

Vendor from Xero. This was fixed. 

• Xero Integration> Duplicate records were being created when syncing same name 

Projects from Xero to CORE and vice versa. This was fixed. 

• Updated report templates.   

• Updated help and other documentation.   

• Numerous other medium and minor level fixes 

 

 

 

 



 

 

VERSION 1.1.145 RELEASED ON MARCH 07, 2020 

 

What’s new in this version?  

This update addressed some critical issues and added a few enhancements. Most notable: 

 

 

Financial budgets 

Create financial budgets to define cost and revenue benchmarks your company can follow 

in an upcoming fiscal year. This feature comes with reference and input tools to help you 

make tough budgeting decisions. As the year progresses, run a comparison report to see 

how the company finances are holding up against what you've budgeted. 

 

Split Billing  

The introduction of split billing will allow an invoice to be divided among multiple matters 

(projects). The invoice breakdown can be easily customized using percentages.  

 

Multi-Tier Invoicing 

Joint/Phased Invoices now have the option to roll up to any specified level in the project 

hierarchy, rather than just rolling up to the root or Client level. Combination options 

include roll up at Master Project, Phase, Sub phase or Client.  

 

Automatic General Journals for accurate accounting 

We now create automatic journal entries when an Invoice, Payment or Check is voided and 

also allow users to specify the voided date. Automatic journal entries will now also allow 

billing users to void Invoices, Payments and Checks that fall in previously closed periods 

without any risk of impacting accounting. 

 



Time Card enhancements  

We have introduced Project, Client and Activity filters to the Time Card giving users more 

control when they are entering time. Additionally, users now have the option to turn on 

billed status for their time card entries.  

 

 

Other improvements: 

 

• Budgets, Estimates and Fee Schedules> Added search function to assign projects 

dialog to allow for quick and easy assignment process. Also, Projects that are 

already assigned a budget (or estimate, fee schedule) are grayed out to avoid any 

assignments by mistake. 

• Budgets> We have added batch update action to Budget and Estimate lists to allow 

users to change active status, Fee Schedule and date in one action. 

• Checks>This update allows accounting users to print Checks using custom 

templates developed by BQE Consulting teams. 

• Cloud Feeds> Accounting users can now set connected accounts as inactive. This 

takes away the need to disconnect certain accounts like expired credit cards and 

thus avoid losing matched data. 

• Cloud Feeds>Users can override auto matching for feeds by using the "Find Match" 

option. 

• Dashboard> "Project Allocation" widget now rolls up values to parent project level. 

• Dashboard> Allocation widgets like Employee Allocation, Project Allocation now 

compute spent for all allocation scenarios including Employee Group- Activity and 

Employee Group-Activity Group. 

• Dashboard> Shared dashboard widgets now allow users other than the owner to 

also apply their own filters. 

• Dashboard> We now handle employee and vendor groups in "Staff Work Load" and 

"Employee Allocation Widget". 

• Dashboard>"Project Allocation by Activity" widget was enhanced to show allocation 

start and end dates and also default to show allocations for the logged user only. 

• Expense Entry> We now support credits for reimbursable expenses by allowing 

users to enter negative reimbursable expenses. 

• Fee Schedule> Added the ability to search when viewing the list of existing fee 

schedules in “Create new Fee Schedule from existing” dialog. 

• Fee Schedule> Billing users can now enable the "Minimum Hours" column in 

services tab. 



• HR Benefits> Added the 'Earned Unit' column to benefit list view. 

• HR Review Templates> The list view was further enhanced with new optional 'Status' 

column. Also, added status as a filter. 

• HR Reviewer> We now create a To-do automatically for the reviewer as soon as the 

performance review is set up. 

• Invoices> Automatically email Clients when sending out emails to Client contacts. 

This is controlled by a new setting in Global Settings>Email. 

• Invoices> 'Last Emailed' now shows the time of the day along with date for last 

emailed. 

• Invoices> Phased and Joint Invoices now show up with an expansion caret and show 

phases that were part of the combined invoices as separate rows when the caret is 

expanded. 

• Invoices> Users can re-arrange the line numbers to match the current sort in Time 

and expense entry detail in Invoice detail view. 

• Manage User and Subscriptions> Added Export to CSV action. 

• Notes > Added Quick add option for Client, Employee, Project and Vendor 

dropdowns. 

• Payments> An accounting enhancement now ensures that CORE makes an 

automatic journal entry to adjust tax liability accounts when a Write off or Credit 

payment is entered. 

• Payments> CORE now allows users to pick a contra asset account when entering a 

write-off/credit payment. 

• Payments> Users can now view the deposit that is holding the payment by using the 

'View Deposit' row action. 

• Project Structure> We now leave the hierarchy view expanded (or collapsed) when 

moving phases up or down or when moving them across projects. 

• Project> User can now create a new client when cloning a Project. 

• Reports> 'Billable Work History' report now can be run for billed as well as un-billed 

time and expenses. 

• Reports> Budget reports now allows users to run comparison based on Time and 

Expense Dates. 

• Reports> Employee Missing Time report now uses weekly standard hours if the 

standard day hours for the employee are not set. 

• Security> HR Salary history now allows admin users to control if they want employee 

managers to view salary history of their employees. 

• Security> We have added new security settings called 'Show Performance Widgets' 

in Project, Client, Employee and Vendor to allow an administrative control on who 

has access to this information. 

• Security> We have added new 'Show Billing Options' security to allow admin users 

to control who has access to project billing information. 



• Security> We have added the security profile as a filter option to make it easy for 

CORE admin users to filter for employees that have specific security profiles 

assigned. 

• Statements> Statement generation was simplified by limiting the date range drop-

down to just 'As of' date. 

• Time & Expense Reviewer> Managers can now view the actual hours of the time 

entry by turning on the 'Actual Hours' column in Reviewer screen. 

• Time & Expense Reviewer> Users can locate entries by class by using the optional 

'Class' column. 

 

Other fixes: 

 

• Calendar> Progressive scroll would not work for documents attached to a calendar 

event. This was fixed 

• Checks> A scenario tied to Payee filter would cause the progressive scroll to stop 

working after 25 records. This was fixed. 

• Checks> Class attribute specified for line items was not being automatically set for 

AR side even though there was no default class set at the Project level. This was 

fixed. 

• Cloud Feeds> An issue with the third-party provider, Yodlee was preventing adding 

accounts when the Company owner was missing the last name. This was fixed. 

• Cloud Feeds> Matching feeds to transactions in closed periods was being prevented. 

This was corrected. 

• Cloud Feeds> When associating a new CORE COA to an existing connected bank, 

existing feeds would stop showing in the transaction view. This was fixed. 

• ePayments> ePayments related UI would appear in some instances even if 

ePayments is not turned on for the company. This was corrected. 

• Expense Entry> Batch update to change expense entries for the expense code 

would not automatically update the income and expense accounts to match the 

accounts set at Expense code level. This was corrected. 

• General> Google maps integration for address section was not working. This was 

fixed. 

• Integration> An issue was preventing Vendor sync for QuickBooks Online Australia. 

This was fixed. 

• Integration> QuickBooks Online record synced from CORE would not show the 

correct payment type in certain scenarios. This was fixed. 

• LEDES Export> Classification field was not getting abbreviated. This was fixed. 

• Project Assignment >Progressive scroll would break in a certain scenario. This was 

fixed. 



• Project Assignments> Inactive activity and expense codes would show up when 

searching for items in “Add assignments”. This was fixed. 

• Projects> Changing the class attribute and selecting change all existing records 

would cause discrepancies in class accounting reports. This was fixed. 

• Projects> Users were able to modify existing opening balance entries that had prior 

payment information and this would cause a discrepancy. This was fixed. 

• Projects> Users would always get navigated to the details tab when using Project 

hierarchical drop down to move between phases. This was corrected. 

• PTO> Approving a PTO by navigating from the notification area would cause the 

approver to be not prompted to create a time entry. This was fixed. 

• Reports> "Employee Allocation Units Summary" would fail if "Show Active Only Rule" 

was checked in Allocation and Forecasting. This was fixed. 

• Reports> "General Ledger Cash Basis" would take a long time to process for large 

databases. This was fixed. 

• Reports> "Project Allocation Units" report would fail to process for large data. This 

was fixed. 

• Time and Expense entry>Cash accounting was getting affected when an expense 

entry was made part of an invoice with prior payments. This was fixed. 

• Updated report templates. 

• Updated help and other documentation. 

• Numerous other medium and minor level fixes. 

 

 

VERSION 1.1.144 RELEASED ON JANUARY 18, 2020 

 

What’s new in this version?  

This update addressed some critical issues and added a few enhancements. Most notable: 

 

Due Date Aging 

This update adds a slick new option to base Aging reports off Invoice and Bill due dates.  

 

New Contract Amount Calculator 

We have added a contract amount calculator that allows users to express Project Contract 

as a “Percentage of total amount’ or “Units x Cost Amount”. This cool new feature will 

remember the provided values and allow recalculation at any stage of the project.  



 

Improved, faster CSV Export 

We re-wrote our CSV exporter to allow users to export unlimited records from any of 

CORE’s list views.  

 

In-app Promotions  

This update adds an intelligent, trigger driven in-app promotion messaging system to CORE 

that will allow BQE to engage with our customers more by informing about the new 

features and upcoming BQE events. 

 

Enhanced Xero Integration 

We have added sync support for projects in Xero and CORE. It does not matter where you 

maintain your project list. These new sync improvements have you covered. 

 

Budget Improvements 

We have added Start and end dates to budget line items to allow for easy import to 

Allocations and also improve Budget tracking and comparison. 

 

Other improvements: 

• ePayments> CORE Users can now pass the $.30 fixed processing fee charged by 

Stripe for each transaction on to their Clients. 

• Gantt Chart> Users now copy allocations and create new tasks from the Gantt view 

also. 

• General> We made the column chooser scroll bar wider to make it more visible for 

users. 

• General>Users who open multiple tabs of different CORE companies at the same 

time are now prompted to close the other tabs before switching companies. 

• Integration>Implemented the latest version of authentication protocol for Xero 

integration. 

• Notifications> Certain system generated emails like allocation assignment were 

improved for content. 

• Reports> 1099 Reports now allow users to specify if they want to report on 1099 

vendors only. 



• Reports> Added Project start and due date filters to 'Contract Analysis' report. 

• Reports> All Time and Expense reports were enhanced with an 'Employee Manager' 

filter. 

• Reports> 'Client Transactions' report was further enhanced to report accrual and 

cash-based revenue by Client or Project state. 

• Reports>Added 'Payment Date' filter to 'Taxes' report. 

• Reports>AR Payments of type 'Write-off' were not being reflected in Cash basis 

reports. This was corrected. 

• Security> Admin users can now filter the list for active employees and vendors. 

• Subscriptions>Admin users can now purchase 4- and 5-year subscription plans right 

from the Manage Subscriptions page. 

• Time & Expense Reviewer> Added the 'Paid' filter to this view. 

 

 

 

 

Other fixes: 

• Allocations>Users were unable to copy allocations when the logged user had 

employee control restrictions on allocation screen. This was fixed. 

• Calendar>Creating an event for 'Submittal' review date would cause the event to be 

a day off. This was fixed. 

• Chart of Accounts> Users were not able to an account when 'As of' date was set 

blank. This was fixed. 

• Checks>Users were able to create a recurring check without a payee. This was 

corrected. 

• Deposit Screen>Account drop down did not accept certain uppercase characters. 

This was fixed. 

• Employee & Vendor>Masked fields like SSN, birth dates would show up complete 

value when the page was still loading. This was fixed. 

• General> Users are now warned before navigating them to the detail view if they 

have selected more than one item(s). 

• General>Some new screens were found to have issues with progressive scrolling. 

This was fixed. 

• Integration>Credit and Write off payments would to sync over to QuickBooks Online 

on Australia and Canada region companies when tax code setting was turned on. 

This was fixed. 

• Invoices> Changing invoice date and memo for a paid invoice would cause the cash-

based accounting to be thrown off. This was fixed. 



• Invoices> Users were not able to process late fee invoices for a Joint Invoice which 

had one of the projects with zero-dollar invoices. This was fixed. 

• Payments> A certain scenario could cause the 'Save' buttons to stay enabled even 

when a payment was being applied causing some users to record duplicate 

payments. This was corrected. 

• Projects> When creating a new project structure from a template, the project name 

was being pre-filled from the name of the template and not the underlying parent 

project. This was corrected. 

• Projects>Quick add Project was missing from Projects>Billing Contract drop-down. It 

was added. 

• Reports> Allocation reports would refer to the descriptions of item codes instead of 

the descriptions provided in the allocation entry. This was fixed. 

• Reports>Allocated Hours report did not match Allocation and Forecasting Screen 

when allocation involved groups. This was fixed. 

• Reports>'Project Profitability' report would exclude invoices for main type projects. 

This was fixed. 

• Security> Users with no access to client list would see the client list when hitting 

create new project in project drop-down. This was corrected. 

• Time & Expense Reviewer> Recently added column 'Manager' was renamed 'Project 

Manager' to avoid confusion. 

• Time Entry> Entries marked as non-billable by the system if they were over the 

contract amount would change to billable if the user changed the activity. This was 

corrected. 

• Vendor Credits>Class inheritance would fail when selecting a project with assigned 

class at item level. This was fixed. 

• Updated report templates. 

• Updated help and other documentation. 

• Numerous other medium and minor level fixes. 

 

 

VERSION 1.1.143 RELEASED ON DECEMBER 21, 2019 

 

What’s new in this version?  

This update addressed some critical issues and added a few enhancements. Most notable: 

 

Smart Timers 



New and improved Timers list, auto populated with the most recently used Project and 

Activity combinations, will now allow users to start timers with minimal effort and no input. 

A brand-new user preference allows users to limit the number of predicted entries to suit 

their typical use. 

Column re-sizing across the board 

We have re-engineered the column re-sizing experience and made it available for all 

columns throughout the app. Users also have the option to reset column widths to their 

default values. 

Project assignments made easier 

A brand new ‘Assignments’ tab in Project view will allow users to perform all assignments- 

rules, contacts, team members, activity and expense codes from one convenient location.  

Allocation Status in Time Card 

This update adds the much-requested feature of allocation status in the Time Card and 

Time Entry screens. The system will now highlight allocation status information, if an 

underlying allocation is detected, when entering time and help users to stay within the 

allocated units. 

 Improved, efficient Gantt Charts 

Users can now shift entire project time lines by using the new drag and drop feature for 

Projects and resources. Moving the top-level project or any underlying phases 

automatically adjusts the start and end dates for all underlying tasks. Other neat usability 

improvements include magnifying small interval tasks on mouse hover to for easy linking 

and drag & drop. 

Copy allocations  

Allocating employees and Projects just got easier with the new copy and paste special 

feature in Allocations. Existing allocations can be copied as is or modified for multiple 

attributes including Employee, Project, Start and End Dates, dependences and notification 

settings. 

 

Improved search techniques for dropdowns and CORE Lists 

A simplified search algorithm now returns results based on pattern matching without the 

need of any explicit wild card specifiers. Also, text filter search in CORE lists now applies the 

search term to all visible columns of the list, making search-based filtering more efficient 

and intuitive. 



 

Other improvements: 

• Allocation & Forecasting> Added a toggle to allow users to show tasks for active 

projects or all projects in the task view. 

• Allocation & Forecasting> Users can now filter forecasting views using Project 

custom fields. 

• Cloud Feeds> This update adds an inbuilt mechanism to detect duplicate feeds from 

third-party feeds sources and automatically mark them as ignored.  

• Allocation & Forecasting> Employee and approving managers are now notified that 

the PTO request is in conflict with an already scheduled project allocation, if the 

employee has been scheduled for a task in the same period. 

• Collections> Users can now choose to turn on the 'ePayment' column to visually 

know if any of the open invoices are enabled for online payment. 

• Contacts> Users can view a contact's mobile phone number from the list view. 

• Dashboard> To-Do widget now automatically shows the items which are due sooner 

on the top. 

• Documents> Users can now navigate to the underlying entry the document is 

attached by clicking the 'View associated entry' row action. 

• Estimates> Users can now generate the 'Estimate Details' report for a specific client. 

• Gantt Chart> Users will be able to move smaller interval tasks much easily as the 

system magnifies the task to ease drag/drop and linking actions. 

• General> Quick add function has been enhanced to also include lists like 'Classes', 

'Cost Pools' and 'Payment Terms' 

• General>Success notifications were made to fade away quicker than earlier. 

• Integration> Joint Invoices are now sent over as a single, unified invoice for the 

Customer when syncing CORE invoices to Xero.  

• Integration> QuickBooks Online integration now supports project currency. 

Customers that have been designated a custom currency in QuickBooks will have 

their project currency in CORE mapped to the currency preference in QuickBooks. 

The setting automatically flows to their invoice templates. 

• Invoices> Invoices that are automatically created to record client charges for 

bounced checks will be appended with '-BC’ specifier for easy identification and 

management. 

• Items> 'Code' field now allows users to enter up to 100 characters. 

• Project Templates> Users can now edit Project template name and description from 

the detail view.  

• Projects> Admin users can now set up project rules that control if non-billable time 

and expense entries should show up on invoices. This was previously available only 

as global setting but users can now selectively turn this setting on or off by Project. 

• Reports> Added important Project filters to 'Percentage Billed' report. 



• Reports> All budget reports were enhanced with important project filters like 

Project Status, Contract Type, Group, Manager etc. 

• Reports> AP Aging reports now offer Vendor group as a filter. 

• Reports> Choosing the 'All Dates' filter would un-necessarily restrict the reports for 

dates for a certain date range. This restriction was removed. 

• Reports> 'Collection Details' report was enhanced to show average delay 

information for the Client. 

• Reports> GL reports would not display the credit card refund entries correctly. This 

was fixed. 

• Reports> Project reports that allow custom groups will now also include an option 

to group by Project Principal or Originator. 

• Reports> Tax Registry report now allows users to filter for payment dates. 

• Reports> 'To-Do Tasks' report can now be filtered Type, Project, Client, Employee 

and Vendor. 

• Reports>'AR Aging with Credit Payments’ now allows users to select the 'Show 

General Journal' option without being forced to select 'show invoices' option. 

• Reports>Project time and expense reports now have an option to include or exclude 

WUD while calculating the charge amount. 

• Reviewer> Added 'Project Manager' as an optional column. 

• Reviewer> Users can now check the paid status of time and expense entries in the 

'Reviewer' by choosing to turn on the 'Paid' column. 

• Security> Admin users can now control which users have access to sensitive 

employee information like SSN and Birthdates.  

• Time & Expense>Users can now indicate if they want to re-calculate Markup/ WUD 

when assigning un-billed time and expense entries to existing invoices from the 

batch update utility in Time Entries, Expense Entries and Reviewer. 

• Time Card> Added column chooser in the 'Day view'. 

• Timers> The enhanced list view for Timers can now be sorted by current recorded 

time. 

• Timers> Users can optionally turn on the 'Start' and 'Stop' times columns. 

• To-Do> Users can now choose which employee completed the To-Do. This works 

great for To-Dos' assigned to a group of employees. 

• Vendor Credits> Vendor Credits now support 'Class' at the line item level. The 

system will pre-fill the default vendor class automatically. 

• Vendors> Accounting users can update multiple vendors for '1099' attribute using 

batch update. 

 

Other fixes: 



• Account Reconciliation>Users would not receive a prompt advising users of the 

effects of clicking the Undo All button. This was fixed. 

• Allocation & Forecasting> Users were experiencing a delay while saving an allocation 

record when there were significant number of allocations for the selected resource 

or project. This was corrected. 

• Budget>Outside Consultant vendor type records are missing from the Created By 

drop-down when creating a new budget. This was corrected. 

• Chart of Accounts>Users were not able to delete or merge ‘Payroll Expenses - 6560' 

non-system expense account. This was corrected. 

• Checks>Expense entries created in checks would not get imported again if you 

delete the check but keep the expense entries. This was corrected. 

• Client>Performance project dropdown were not displaying correct project structure 

order in certain scenarios. This was corrected. 

• Cloud Feeds> Users were not able to change the payee for a split transaction rule 

that used both item as well as accounts. This was corrected. 

• Cloud Feeds>Split transactions would not save as an expense entry to a project that 

had "memo required for expense entry" enabled even if memo was added. This was 

corrected. 

• Create Batch Invoice> Net Bill Amount was not getting calculated correctly if the 

user updated percent complete for 'Recurring Plus Hourly' contract type projects. 

This was fixed. 

• Dashboard> The 'Money Owed' widget would incorrectly clubbed multiple clients 

when an aging filter was applied. This was fixed. 

• Dashboard>Cash Flow widget would display incorrect cash amounts for payments 

on joint invoices. This was corrected. 

• Dashboard>Project Gross Margin would not display correct data when using 'This 

Month' Invoice Date filter. This was fixed. 

• Employee> Export to CSV would only export the first 25 records. This was corrected. 

• Estimates>Users could assign completed, cancelled and hold projects in the 

Estimate list view. This was corrected. 

• Expense Entries > For some users, the view by option would always show 'Employee' 

even they had previously changed it to 'Vendor' and selected a vendor from the 

given list. This was fixed. 

• Expense Entries>A billable expense would not change to non-billable when updating 

the project value to an overhead or marketing project type. This was corrected. 

• Expense Entries>Expense entry class values were not copied over when setting the 

class value in Cloud Feeds, Vendor Bill, Check or Credit Card transactions. This was 

corrected. 

• General>URL fields would not accept values without the 'www' specifier. This was 

corrected. 



• Invoices and Payments>Search was reported not working when applying the Void 

Invoices or Void Payments filter. This was corrected. 

• Invoices> The system would allow reuse of voided invoice numbers. This was 

corrected. 

• Invoices>In certain billing scenarios, the Phased Invoice and Phased Invoice by 

Expense did not display expense detail for all projects on a combined invoice. This 

was fixed. 

• LEDES>The 'LINE_ITEM_TAX_TOTAL' was displaying the line item total instead of the 

total taxes applied to the item. This was corrected. 

• Manage Subscriptions> Quick Search was working in Assign Subscription Dialog. 

This was fixed. 

• MYOB Integration>CORE vendor bills using the Account tab would not sync to MYOB 

AccountRight. This was corrected. 

• MYOB Integration>MYOB Mapping module had certain sorting issues when 

mapping unmapped MYOB records. This was corrected. 

• Payments>In certain scenarios, users were not able post or edit a payment entry. 

This was corrected. 

• Print Checks>Hyphen in the Zip Code field was not included when printing checks. 

This was corrected. 

• Project Template>The Duplicate row action option was reported not duplicating the 

project template correctly. This was corrected. 

• Project>Adding or updating the project Class value and choosing to update existing 

time and expense entries, would not update the Class value on existing expense 

entries or invoices. This was corrected. 

• Purchase Order> Purchase Order received and selected while creating a Vendor Bill 

would not reflect the correct value until the bill was saved. This was corrected. 

• Purchase Order>Using Quick Add to add a new client would not populate the new 

record in the Client field. This was corrected. 

• Quick Add>CORE would automatically change a Client record from a Company type 

to an Individual type when quick adding a Client. This was corrected. 

• QuickBooks Integration>CORE Client Record currency value would not be recorded 

when getting a Client record having Payment Currency set in QuickBooks. This was 

corrected. 

• Recurring Invoice> The system would fail to warn users if an invoice number of an 

invalid length was entered. This was corrected. 

• Recurring Invoice> Users on non-US time zones would face an issue with the invoice 

date for the automatic invoice being ahead by a day. This was fixed. 

• Reports>Employee Utilization report did not match 

Employee>Performance>Utilization widget in certain scenarios. This was corrected. 

• Reports>Profit and Loss by Class Cash Basis had an issue for negative credit card 

transactions. This was corrected. 



• Reports>Balance Sheet Accrual by Project report would not obey the project filter 

and display all projects. This was corrected. 

• Reports>'Budget Comparison by Employee' and 'Estimate Comparison' report would 

throw an error when 'Client Group' filter was applied. This was fixed. 

• Reports>Invoice detail where appearing as negative amounts when using drilling 

down feature in Profit & Loss reports. This was corrected. 

• Reports>Several Budget reports would not filter data when filtering by any Budget 

custom field. This was corrected. 

• Security>Project contract amount would show up in the split panel even when the 

user did not have security to view it. This was corrected. 

• Time and Expense Reviewer>Users could still see the cost amount grand total when 

their security profile had Time Entry>Show cost rate disabled. This was corrected. 

• Updated report templates. 

• Updated help and other documentation. 

• Numerous other medium and minor level fixes. 

 

 

 

VERSION 1.1.142 RELEASED ON NOVEMBER 16, 2019 

 

What’s new in this version?  

This update addressed some critical issues and added a few enhancements. Most notable: 

 

Drill down for Financial reports 

All CORE financial reports like Balance Sheet, P&L, General Ledger and Trial Balance now 

support deep level drill down to the underlying transactions. This much awaited feature 

not only saves accounting users countless hours in getting to the root of any discrepancies 

but also gives them an easy way to edit transactions right from the report. 

 

Improved Account reconciliations 

We made several enhancements to the Account reconciliation process including ajax driven 

auto save, more forgiving integrity checks that guarantee no reconciliation progress is lost 

even when conflicts are detected by the system. These changes make the reconciliation 



process simpler and more intuitive and ensure accounting users never have to redo a 

reconciliation session even if they forgot to save their progress or any of the entries were 

modified or deleted by other users while reconciliation was being performed. 

 

Enhanced ePayments 

Users can now send out retainer invoices with ‘Pay Now’ online payment options. Also, we 

added online payment options at the Client and Project level to allow users to control 

which of their Clients or Projects can have invoices with ePayment enabled. 

 

Automatic Allocations for approved PTO 

The system can now create automatic allocations when an employee PTO is approved to 

avoid scheduling issues. Admin users can now set up their company to take advantage of 

this feature by turning on a new global setting and keep scheduling teams always aware of 

upcoming PTOs’. 

 

To-Do group assignment 

This update adds a much-requested feature that allows assignment of To-dos' to employee 

or vendor groups. The assigned To Do will appear on To-do lists of all group members and 

allow them to record progress on the To Do as well as mark it as completed. 

 

New and Improved Widgets 

We have added two new dashboard widgets- ‘Project Allocation’ and ‘Project Allocation by 

Activity’. We have also improved our ‘Money Owed widget’ with a new Aging Days filter. 

Also, users can now click on the ‘Client’ column to navigate them to a filtered view of the 

Invoice Collections screen. 

 

Other improvements: 

• Allocation & Forecasting> Added ‘Project Groups’ and ‘Contract Type’ as filters for 

the Forecasting views. 

• Budgets & Estimates> Users can now assign a Project when creating a new budget 

or estimate. 



• Client> Performance screen now rolls up all widgets to reflect cumulative values 

when the selected project is a main project. 

• Dashboard> Added more ‘As of’ date filter options. 

• Dashboard> Filter options for a widget now sorted by name. 

• Gantt Chart> Users can now batch update multiple allocations by using the 'Select 

all' checkbox. 

• General> Added ‘Quick Add’ function for account dropdown all over the app. 

• General> Added the 'Attachment' column for Client, Project, Employee and Vendor 

lists. 

• General> We made it very easy to enter dates manually using keyboard. The system 

not only prefills that date format but predicts the date if the user entered a partial 

date. 

• HR Benefits> HR admin users can now batch assign benefit profiles to multiple 

employees at the same time. 

• Invoice Templates> Added 'Employee and Description' option to allow users to 

display time and expense entries grouped by employee and then by time entry 

description. 

• Invoice Templates> Phased Invoices template was enhanced to automatically show 

extra expenses and services as separate sections. 

• Notifications & Reminders> Notification panel was redesigned to allow for better 

separation of system generated notifications and reminders. 

• Payments> We now allow users to add payments by invoice number, client or 

project. A new Payment dialog presents all three options for the user.  

• Reports> 'Balance Sheet' reports now allow summarized as a report preview option. 

This option summarizes accounts by Asset, Liability or Equity sections. 

• Reports> Full access users can now delete schedule reports that were created by 

users who no longer have access to the application. 

• Reports>Project reports can now be filtered by Project Principal and Originator. 

• Reports>The 'Employee Paid Time Off Comparison' report now has a Balance 

column to let administrators know how much PTO is available for each employee. 

• Reports>The Statement by Client (Accountant) template has received several 

corrections to enhance its usability. 

• Reviewer>Added 'Type' column to the item filter to help identify the type. 

• Time Card> The memo box received several usability fixes including auto focus on 

keyboard shortcut, a new memo icon and re-organized memo box. 

• Time Entries> The 'Time Verification' report now groups by Project or employee 

depending upon the view by option for the screen. Also, the same report allows to 

show or hide the signature section when launched from the reports area. 

• To-Do> Users can now clone an existing To-do and be able to change any attribute 

before saving it as a new To-Do. 



• HR Reviews> Security admin users can now control if the HR Users can only see 

reviews that are assigned to them. 

• Reports> 'Workflow' report can now be filtered by employee. 

• Workflow>Users will now be able to see the name of the employee the entry was 

submitted to in the detail view of the entry. 

 

Other fixes: 

• Auto Complete> The system was not able to differentiate shortcuts that spelt the 

same but used different cases. This was corrected. 

• Budgets & Estimates>End users could not make budgets and estimates inactive 

when the create date had a date prior to the Company>Closing Date. This was 

corrected. 

• Budgets>Quick Add functionality was missing from the Resource drop-down. This 

was corrected. 

• Client>Users could not delete a client contact assigned to deleted project. This was 

corrected. 

• Credit Memo> This screen did not have the 'Amount' column as the last column in 

the list view. This was corrected. 

• Custom Fields> Some users could not use their custom fields as screen filters in 

certain scenarios. This was corrected. 

• Dashboard>In certain scenarios, the Utilization percentage found in the Staff 

Utilization Widget was not matching the Utilization percentage found in the 

Employee Performance screen. This was fixed. 

• General Journal>Row level action 'Reverse' to reverse a journal entry was labeled as 

Void. This was corrected. 

• General> Vendor Quick Add functionality was missing from the Checks, Credit Card 

and General Journal screens. This was corrected. 

• Integration>CORE invoice with pre-tax discount did not sync to QuickBooks Online 

with correct amount. This was fixed. 

• Invoice Templates>Extra expense entries were being included in the 'Previously 

Billed' column on phased invoice templates. This was corrected. 

• Manage Users> Admin users were not able to add a CORE user who had an 

apostrophe in their email address. This was fixed. 

• Manual Invoice> This screen was missing the 'Save and Add Another' feature. This 

was corrected. 

• Project>Project Rule 'Memo is required for time entry' was not allowing the update 

of time details in the Create Batch Invoice screen. This was fixed. 



• Project>Project structures created from a project template would be duplicated 

and/or display incorrect structure order when searching for these projects. This was 

fixed. 

• Project>Users were unable to change project manager on a project, if their assigned 

security profile has the Project>Show Contract Amount option unchecked. This was 

corrected. 

• Purchase Order> The project column in the PO list was getting truncated. This was 

fixed. 

• Reconciliations>Draft reconciliations would show up in the Manage reconciliation 

list. This was corrected. 

• Reminders>Reminder notification for past due vendor bill was not ignoring zero 

amount bills. This was fixed. 

• Reports>In certain instances, recurring bill transactions would not show up on the 

Profit and Loss Cash Basis report. This was corrected. 

• Reports>In certain instances, recurring bill transactions would not show up on the 

Transaction Details Cash Basis report. This was corrected. 

• Reports>In certain scenarios extra expenses were being included in contract 

amount in the 'Work in Progress Details' report. This was fixed. 

• Reports>In certain scenarios the 'Statement by Accountant’, the client balance 

amount would not match the same amount found in the Invoice screen and Aging 

reports. This was fixed. 

• Reports>Negative invoices were not shown in all statements reports. This was fixed. 

• Statements>The Statement by Client report would page break by Project and reset 

Client totals. This was fixed. 

• Time Entries>Incorrect Invoice Dates were being displayed in Time Entries>Batch 

Update>Invoices compared to dates found in Project>Transactions screen. This was 

fixed. 

• Vendor Bills> Users could not create vendor bills from imported time entries if the 

time entries had dates prior to Company>Closing Date. This was corrected. 

• Workflow>Pure vendors would show up in ‘Submit to’ drop down. This was 

corrected. 

• Updated report templates. 

• Updated help and other documentation. 

• Numerous other medium and minor level fixes. 

 

 

 

 



VERSION 1.1.141 RELEASED ON OCTOBER 12, 2019 

 

What’s new in this version?  

 

This update addressed some critical issues and added a few enhancements. Most notable: 

 

Quick Add New: Users can now create new Clients, Projects, Employees, Vendors, Activity 

and Expense codes, Budgets and Estimates by using the create new action conveniently 

placed on dropdowns. 

 

Column resizing: This update adds a highly requested feature allowing users to resize 

columns like Project, Client, Description etc. We have added it to a select list of screens 

including Time and Expense entry, Reviewer, Project, Invoices, Payment among others. 

 

Improved record editing: We have extended our implicit saving technique to Time entry, 

Expense entry, Activity items and Expense Items screens allowing users to modify records 

without requiring a page refresh.  

 

Power to the Vendor: CORE Vendors now have a default Expense account and Class. Also, 

a new 'Track payments for 1099' attribute allows admin users to flag vendors that need 

1099 forms. 

 

Improved Notifications: We have made several improvements to CORE's notification 

system. These include consolidated notifications, refined notification messages, include 

date and time of the notification and the time since. These improvements were also 

extended to our mobile push notifications. 

 

Default Home screen: Users can now set up their own start up screen. User can choose 

from options like Dashboard, a specific CORE screen or the last visited screen as their 

preference and CORE will automatically open their selected screen when logging into CORE. 

 

Reusable Vendor Bills: Accounts Payable users can now copy existing Vendors Bills along 

with the items and accounts. This huge time saver also allows them to tweak the new bill 

before saving it. 

 

Batch Invoice improvements: Batch Invoice list view was reworked to allow users to 

discover the 'Time & Expense details' action more easily and the details pop-up dialog now 

has full-screen capability. 

 



Configurable dropdowns: Users can now configure filter and other types of drop-downs 

for preferences like including in-active items, including vendors, including completed, 

cancelled or other projects etc. We have added separate settings for the most common 

drop downs, and these can be turned on or off anytime. 

 

Automatic Project Notes: A brand new global setting allows admin users to choose one or 

more project attributes that can be tracked by the system to create automatic project 

notes. Project notes are created when any of the tracked attributes of a project are 

changed. 

 

Xero Time Entry Sync: Integration users who rely on Xero payroll can now sync Time 

entries with their Xero company file. A huge feature for some of our Australian users. 

 

Support for LEDES 1998BI V2 format: This legal industry only feature is meant to add 

support to the 1998BI V2 export format for invoices. This new format keeps all of the same 

information as 1998B and adds additional fields for international billing and handling 

taxes.  

 

New and improved Widgets: We have made significant improvements to our Dashboard 

widgets including a brand new 'Project Gross Margin' widget, spent amount for Employee-

Activity group allocations in Allocation widgets and updated the 'Paid time off and Comp 

time widget' to make it work off HR benefit usage among other improvements. 

 

Save and Add Another: We extended this feature to all CORE screens. This update added 

it to Vendor Bills, Purchase Order and Payments. 

 

Custom fields for Budgets and Estimates: Users can now define custom fields for their 

Budgets and Estimates. 

 

Retainer Reconciliation: This brand-new report lists all retainer requests, retainers 

received, and retainers used and groups this information by Client. The perfect tool to 

reconcile your retainers. 

 

 

 

Other enhancements: 

 

• Allocation & Forecasting> Forecasting view now computes used value for allocations 

that are based on Employee and Activity group combinations. 

• Budgets and Estimates> Users can now search for Budgets and Estimates that have 

been assigned to projects, clients or not assigned at all. 

• Calendar> Calendar event invites can now be sent to Employee Groups. 



• Dashboard> ‘Paid Time off and Comp Hours’ widget can now report off HR module 

data as well. 

• Dashboard> Allocation widgets now compute the used portion for allocations that 

are based on Employee and Activity group combination. 

• Dashboard> 'Employee Allocation' widget now offers a custom date filter. 

• Dashboard> Added Project Manager filter to 'Cash Flow' widget. 

• Dashboard> ’Project Status' widget now shows grand totals for all projects shown in 

the widget. 

• Documents> Users can now attach documents to Deposits and Journal entries. 

• ePayment> This feature was enhanced to allow users to control automatic 

association of online payment accounts to new invoices. 

• Fee Schedules> Users can now also search for Fee Schedules that have not been 

assigned yet.  

• Filters> Added new date shortcut filters (Bi-Weekly, Semi-Monthly and Last 2 Weeks) 

• Gantt Charts> Users can export Gantt Charts to PDF and Excel formats. 

• General> All Accounting screens will now default 'Amount' to be the last column. 

• General> Project dropdowns and other lists that show Projects in hierarchical 

manner can now be sorted by other columns also. 

• Invoice Templates> Hourly Invoice by Employee now shows the details of the Time 

and Expense and shows subtotals by each employee. 

• Invoice Templates> Vendors can now be displayed by name or company. This is 

controlled by a setting in Invoice templates. 

• Invoices> Added the ability to filter by Class. 

• Notes> Notes view now includes an indicator for attachment count. 

• Notifications> Users will now get notified when an RFI or Submittal has been 

assigned to them. 

• Project> Project description field can now accommodate up to 100 characters. 

• Registers> Account Registers screen has been enhanced so the summary row 

remains fixed. 

• Reports> All Employee reports can now be filtered and grouped by Department, 

Manager and Groups. 

• Reports> Time entry reports can now be filtered by the recently added 'Paid' field. 

• Reports> Added Project Manager filter to 'Cash Flow Monthly Statement'. 

• Reports> Added Project Manager filter to 'Cash Receipts'. 

• Reports> All Employee reports now offer an employee status filter. 

• Reports> Employee Status filter now available for all Employee reports. 

• Reports> Time Details, Time Verification and Time and Expenses reports can now be 

filtered by Paid status 

• Reports> View your running totals on a Daily/Weekly/Monthly & Yearly basis in the 

Cash Receipt report 

• Security> Employee Security list view can now be filtered by Employee, Employee 

groups, title and departments. 



• Security> We added two new system defined profiles for HR administrator and HR 

User. These profiles focus on the HR functions only. 

• Time and Expense Reviewer> Added 'Classification' as an optional column. 

• Time and Expense Reviewer> Users are now prompted with more options when 

issuing an 'Update Rates' batch change. 

• Time and Expense> Users can now have an option to update classifications as well 

when issuing a bulk update for rates. 

• Timers> Timers have been enhanced to help differentiate between active and other 

timers. 

• Workflow> Added new global rule that requires approvers to enter a note when 

rejecting entries. 

 

Other fixes: 

 

• Batch update>Activity Items and Expense Items> The batch update function would 

not respect the 'allow access to bill and cost rates' security. This was fixed. 

• Expense Entries> CORE allowed paid reimbursable to be marked as non-

reimbursable using the batch update tool. This is now fixed. 

• Billing Schedules> Invoices processed from 'Billing Schedules' would not correctly 

interpret the 'Billing amount includes extra time and expense' option and 

markdown expenses to zero. This was fixed. 

• Create Batch Invoice> Disabling 'Allow Batch Change' security would not allow a 

biller to exclude expense entries when billing. This was corrected. 

• Dashboard and Task Allocation and Forecasting> 'Staff Workload' and 'Employee 

Allocation’ widgets fail to bring in ‘Used’ hours if the allocation includes activity 

group and the time was recorded to one of the activities of the group. This was 

fixed. 

• ePayment> Users could not add documents to payments made via ePayment 

feature. This is now fixed. 

• Expense Entries> Using Paste Special in certain entry scenarios would create entries 

with a blank cost rate. This was corrected. 

• Gantt Chart and Task Allocation and Forecasting>Using Batch Update> Pushed 

Tasks By Days option on the predecessor task of two linked tasks would not push 

the following task as well. This is now fixed. 

• Integrations> QuickBooks GET customers operation would fail in certain scenarios. 

This was fixed. 

• Invoice Templates> Certain combined invoice scenarios would not show expense 

line items on a Phased Invoice. This was fixed. 

• Invoices Templates> In certain scenarios, adjusting net bill amount displayed wrong 

service amounts on a Phased Invoice. This is now fixed. 

• Invoices Templates> The 'Current Services' amount would be zero when changing 

the net bill amount for certain Phased Invoices. This was fixed. 



• Invoices>Invoice Emailing> Certain scenarios would cause errors when emailing 

invoices to clients. 

• Statements> CORE would use the same client name to the statement file name 

when sending multiple client statements without preview. This was corrected. 

• Manage Subscriptions> Adding a new credit card payment method would set this as 

your default payment method when no payment method has been set. This was 

corrected. 

• Manual Invoice> Updating an Activity Code on an existing 'Draft Manual' Invoice 

would blank the amount when reprocessing as Draft or Final. This was corrected. 

• Print Checks> Blank check issue when previewing checks was reported by some of 

our Chrome browser users. This was corrected. 

• Project Template> Creating a Project from a Project Template would not inherit the 

Fee Schedule set at the Client> Billing Options screen. This is now fixed. 

• Project>Performance> The Contract Analysis widget was displaying double amount 

in the limit column when previewing at the root/parent project level. This was 

corrected. 

• Reports> Memorizing reports with set filters would duplicate these filters for these 

reports in all Report tabs. 

• Report Templates> Allocated Hours report was not reporting hours in the 

consumed hours column for allocations done using employee groups. This is now 

fixed. 

• Report Templates> There were certain scenarios where Profit & Loss Cash Basis and 

Profit & Loss Cash Basis By Class reports were not providing correct amounts. This 

was corrected. 

• Report Templates> Time Verification report was not displaying the correct Project 

Display As value set in Global Settings>User Interface. This was corrected. 

• Report Templates> Work in Progress Details report date column sort was not 

working. This is now fixed. 

• Statements>Batch Email> Message on Statement' does not get displayed on report 

if you email it without preview. This is now fixed. 

• Time and Expense Reviewer> The on-screen Time and Expense Details would not 

use the set Employee filter when displaying results. This was corrected. 

• Time Card>Day View> There were certain scenarios where CORE would display a 

memo for a time entry when none was present. This was corrected. 

• Time Entries and Expense Entries>Paste Special> When using Paste Special to paste 

entries to an employee group, CORE would not paste to all in the group if the group 

had inactive employee group members. This was fixed. 

• Time Entries> Batch Update and Invoices> Incorrect WUD calculations after adding 

time entries to invoices in several batch updates. This was fixed. 

• Updated report templates.  

• Updated help and other documentation.  

• Numerous other medium and minor level fixes.  



 

VERSION 1.1.140 RELEASED ON SEPTEMBER 7, 2019 

 

What’s new in this version?  

 

This update addressed some critical issues and added a few enhancements. Most notable: 

 

Introducing CORE ePayments 

CORE has partnered with leading online payment platform, Stripe to offer users the 

ability to accept online payments using Credit cards. In the first version of ePayments, 

CORE users will be able embed “Pay Now” links to invoices and emails that are sent to 

Clients. Clients will have the option to pay using Credit and Debit cards by clicking the 

“Pay Now” button. CORE users also get to choose which of their invoices can be paid 

using ePayments and can also set up multiple online payment accounts to control 

surcharges and other settings. Invoices paid using ePayments are instantly recorded 

and reconciled as Payment and Deposits in CORE. 

 

Send CORE Expenses to QuickBooks 

QuickBooks Online users can now send employee expenses from CORE to QuickBooks 

as bills. An intuitive, one-time mapping UI allows users to map CORE employees to 

QuickBooks Online vendors. 

 

Filter reports by Custom fields 

A much-awaited feature that will allow users to apply custom fields as filters to reports 

has been added in this update. Custom fields that have been set up for any CORE 

module will automatically appear as filter options for relevant reports. e.g. Project 

custom fields will appear for Aging and other billing reports. 

 

 

Faster, leaner Bill Payments 



We have now made it easier to review a vendor bill or a batch of vendor bills and 

process bill payments right from the Vendor Bill screen. This effective change allows 

you to drastically reduce your bill payment process to just a few clicks. 

 

Standalone budgets and estimates 

CORE now creates a copy of the budget or estimate when cloning a project from an 

existing project with a budget or estimate assigned to it. The new budget or estimate is 

automatically assigned to the new project and is given the same name as that of the 

project. 

 

Date your budgets and estimates  

Users can now track, filter and search their budgets and estimates by date. A brand-

new attribute in the budget and estimate screen allows user to define a date for the 

budget. 

 

Project templates with phase level editing 

Drastically reduce the time it takes to create and update your project setups using 

Project Templates. CORE now allows you update project options of all your phases 

found in your project templates. 

 

Send multiple Statements Instantly 

A new “Show Preview” option in Statement screen allows users to send multiple 

statements without the hassle of previewing and sending each email separately. 

 

Paid flag for Time entries 

Users now have ability to mark time entries as paid for AP purposes. This option that 

was already available for expense entries and allows users to exclude entries from 

appearing as payables in the Bill Payment screen. Users can also specify the date when 

the entry was paid. 

 

Batch actions for Time Card 



Time Card users now have more control over the entries that are suggested by the 

system based on previous usage. The new batch action menu allows users to remove 

suggestions and also submit time entries for approval. 

 

Cross linking in Projects 

Users can navigate to other screens right from the detail view of the project by just 

clicking the label next to the assigned entity. 

 

Quick Date filters 

We have modified our screen date filters to allow users to quickly switch between the 

various date ranges. 

 

 

Other improvements: 

Accounting>CORE users can now specify separate default "Discount" accounts for AR 

and AP accounting. 

Allocation and Forecasting>Forecasting screen can now be filtered by Project Manager. 

Batch Invoicing>Projects with rule "Always show in batch invoice" will now also be 

evaluated for active status before being auto populated in the batch invoice screen. 

Projects with status other than "active" would be not considered for billing even if they 

have the "Always show in batch invoice" rule applied. 

Batch Invoicing>Billers now are notified when the system detects un-approved time and 

expense entries for projects that are being billed. This is done via in-line notification 

that also provides an option to preview the “un-approved time and expenses report”. 

Bill Payment>"Credits Available" column now shows up by default when entering bill 

payments for vendors. 

Budget and Estimate>Users can now see line item cost amounts and their respective 

grand totals in the Budget and Estimate screens. 

Clients>CORE now requires users to enter a company if the Client is being marked of 

type “Company”. Similarly, when a Client is marked as "Individual", CORE will require the 

user to enter name for the Client. 

Cloud Feeds>Added quick search capabilities to our Cloud Feeds screen. 



Collections>Several improvements were done to enhance the user experience including 

adding a search feature, new batch actions and columns like Invoice terms etc. 

Currency>Hong Kong Currency now available in CORE 

Dashboard> Dashboard widgets that support date filters now get the all date range 

shortcuts as filter options. 

Dashboard>Added the ability to filter for inactive projects in the Due Projects widget. 

Dashboard>The To-Do Widget can now be filtered by Client, Employee, Invoices, Project 

and Vendor To-Do Types. 

Drop Down Lists>CORE now saves sort preference on all our dropdown lists. 

Filters>CORE will now show all selected items in filters at the top of the drop-down list. 

This has been added to lists and will be added to report filters soon. 

General>CORE now has a Save and Add new button for all CORE "Create New" screens 

to facilitate faster data entry. 

Global Settings>Email Settings>Users now have ability to use Client first name and the 

last name as smart fields. 

HR Performance Review>You can now email performance reviews directly from the 

Performance Review screen. 

Manual Invoice>CORE users now have "Draft & Preview" and "Final & Preview" options 

to preview their draft or final manual invoice. 

Payments>Users can now email payment receipts to Clients right from the payment list. 

Projects>CORE will now group all Joint and Phased invoices by Invoice number when in 

the parent project's Detail>Transaction Tab and its project type is set to Main. 

Project Structure>Adding a new phase now inherits Billing Options, Account and Class 

assignments from its parent project. 

Project Structure>Column Headings are now locked as you scroll down your project 

structure list. 

Project Structure>We have included a batch action menu to allow users to merge 

existing phases or delete any phases. 

Project>Added new "Settlement Calculator" feature that will allow users to recalculate 

project contract amounts on "percentage of contract" projects and recalculate 

percentage of total project and contract amounts for all phases of the entire project. 



Projects> Project clone feature now adjusts allocation start and end dates according to 

the new project start date. 

Projects>Users can now indicate if they want to see the Project list view expanded to 

reveal the hierarchical phases or as collapsed. The preference is available under the 

"More" menu in Project list and is remembered for the logged user. 

Projects>Users can now see the "Fee Schedule" associated to the project in the project 

list view. 

Projects>Users can now see the Purchase Order Number (PO#) in the project list view. 

Purchase Order>Users now have the ability of specifying vendor as address option. 

Reports>CORE Users can now filter all vendor related screens and reports by Vendor, 

Contract Employee and Outside Consultant vendor type. 

Time & Expense Reviewer>Added "Extra" as an optional column in this screen. 

Time and Expense Reviewer> Added "Cost" as an optional column in this screen. This 

column also includes a grand total. 

Time Card> Added the "Extra" check box in the memo box. Also, memo field now allows 

formatted memos to be entered. 

Time Card>Added an option to show the "Client" associated with selected Project. 

Time and Expense entry>Added an option to show the "Client" associated with selected 

Project. Users can also now filter by Client. 

Time Card>Added keyboard shortcut (CTRL+M) to open the memo box in the Time Card 

screen. 

Time Entries> CORE now prompts users when certain time entries are locked for client 

invoicing and provides the name of the biller locking these time entries. 

Time Entry, Expense Entry and Reviewer>CORE can now filter time and expense entries 

by Employee Manager 

Time Entry>Users can now Batch Update income/expense account assignment for all 

unbilled time entries. 

To-Do> CORE users can now streamline their To-Do search by filtering the To-dos by the 

Created By field. 

To-Do> Users can now see the status of their To-dos in the list view. 



To-Do>We streamlined the process of cloning To-dos by allowing to change the To-Do 

ID and type. 

To-dos> CORE will now automatically update the Percent complete field to 100% when a 

To-Do is marked completed. 

Vendor Bills> Add the "Attachment" column to indicate if there are attachments and the 

number of attachments tied to the vendor bill. 

Vendor Bills> Add the "Paid" and "Balance" to indicate the paid status of vendor bills. 

 

 

Other fixes: 

Accounting>Checks with expense items assigned to an expense account where being 

displayed under the default income account when running the "General Ledger" and 

“General Ledger Extended" reports. This was fixed. 

Allocation & Forecasting>Forecasting columns we reported to be no longer visible when 

scrolling down to the next page of allocations. This was fixed. 

Allocation & Forecasting>Using the Batch Update>” Delay and Push Task by Days” 

options would not update allocation start and end dates. This was fixed. 

Bill Payment>When trying to pay a Vendor Bill with both a credit and payment that 

added up to the sum of the Vendor Bill, the system in-correctly prompts about the 

payment being greater than the bill amount. This was fixed. 

Bill Payments and Expense Log>Partially paid employee reimbursable expenses would 

cause discrepancies on which expense entries were paid and which were not. This was 

fixed. 

Billing>CORE would use the wrong email address in the “To” and “Cc” fields when 

emailing invoice to the Client and to the project billing contact in certain scenarios. This 

was fixed. 

Dashboard>Widgets> Users with “Full Access” security with "Account Receivable' 

module view disabled were not able to see the income portion of ‘Income vs Expense' 

Widget. This was fixed.  

Documents>CORE users reported that they could not download .msg files. This was 

fixed. 



Expense Entries>It was reported that the on-screen Employee Expense Report would 

double the Grand Total amount. This was fixed. 

Expense Entries>There was an issue with viewing expense entry attachments using the 

Microsoft Edge browser. This was fixed. 

Expense Entries>Updating an expense entry from non-billable to billable on a project 

having the "Include billable expenses in contract amount" project rule enabled would 

mark the expense as Extra and not part of the contract. 

Expense Entry> Batch update of the reimbursable flag was not creating the necessary 

behind the scene accounting entries. This was corrected. 

Expense Entry>Fixed inconsistent Copy behavior when using Select All and mouse scroll 

wheel. 

Human Resources>Updating an Employee Performance review would cause the Score 

to be updated with an incorrect value. This was fixed. 

Invoices>Extra expenses were being included in the recurring amount in a Recurring + 

Hourly contract type. This was fixed. 

Invoices>Joint invoices that had project/phases with more than one project manager 

would not show in the Invoices list when filtering by only one of the project managers. 

This was fixed. 

Invoices>Users reported issues choosing a different invoice template in the Invoices 

screen when using their iPad tablet. This was fixed. 

Progressive scroll>Our automatic selecting of next page records when choosing the 

"Select All" option and using the mouse scroll button would not allow users to unselect 

records. This was fixed. 

Project Assignments>Copy Assignments>Performing a wild card search in this screen 

would display unrelated search results when scrolling past page 1 of results. This was 

fixed.  

Project>End users would sometimes receive an error when trying to create a project 

from a project template containing more than 100 phases and sub-phases in its project 

structure. This was fixed. 

Project>Our Australian customers reported that when creating a project, the start date 

would display in MM/DD/YYYY instead of DD/MM/YYYY format. This was fixed. 



Project>When updating client for the project, CORE would still update invoice and 

payments when end user clicked 'NO' to the “Do you want to update all 

previous/Existing invoices and payments to the new client?” prompt. This was fixed. 

Project>When using the Project Clone feature, CORE would not get the next available 

auto-increment project number set up in Global Settings>Master Information>Project. 

This was fixed. 

Projects>Australian customers would export project list to csv and all dates were in 

MM/DD/YYYY format. This was fixed. 

Projects>When creating new projects, it was reported that the project would not inherit 

options set up in Global Settings>Billing>Accounts Receivable>Options>Interest % per 

month, Payment term and Charge Interest after (Days). 

Purchase Order>Long Project “Display As” names would get truncated in the Purchase 

Order screen. This was fixed. 

Report Templates> "Vendor Bills", "Vendor Bill Status" and "Vendor Bills Paid" reports 

now display the “reference number” and can be filtered by this field. 

Reports>”Paid time and expense disbursements” report was missing the payment filter. 

This was fixed. 

Report>Project Time & Expenses report would filter its Account Summary when using 

dates. This was fixed. 

Reports> Financial> CORE users reported that vendor bill item transactions would not 

show up in the General Ledger and General Ledger Extended reports. This was fixed. 

Reports> Payment Details report shows a dollar sign instead of British Pound sign in the 

Grand Total for our UK customers. This was fixed. 

Reports> Some CORE users have reported performance time out issues when running 

General Ledger reports. This was fixed. 

Reports> The Client Retainer Summary report would not display correct retainer 

balance when refunding unused retainers. This was fixed. 

Reports>AR Aging with Credit Payments would report incorrect Credit column values 

when the All Dates filter. This was fixed. 

Reports>Australian users would report that CORE would use and display incorrect date 

ranges when using the "Last Month" and "This Month" date filters. This was fixed. 



Reports>Employee Performance report is incorrectly including unbilled times that are 

on overhead projects, vacation, sick, or holiday time in some of its calculations. This was 

fixed. 

Reports>Employee Time Detail report would not display any vendor expense entries 

when using the vendor in the Resource filter. This was fixed. 

Reports>It was reported that the contract amounts of Parent Projects with project 

status of Main were being included in the Contract Analysis report totals. This was fixed. 

Reports>Project Account Details report displays Client Hours instead of Hours data in 

the Hours/units Column. This was fixed. 

Reports>Running the "Employee Daily Time Card" Report would display no data when 

using the Time Entry Date "This Year to Date" filter. 

Reports>The Check Details report would not sort by check date then by check number. 

This was fixed. 

Reports>The “Contract Analysis” report would double the project contract amount 

when the report option "Hide Phases" was set to 'YES'. This was fixed. 

Reports>” Time Verification” report received many improvements to enhance report 

usability. 

Reports>” Work in Hand” report received many improvements to enhance report 

usability. 

Reports>” Work in Progress” Details report now has an option to show/hide Account 

Information if the user needs to reduce the number of pages produced.  

Reviewer>CORE would not clear system filters when ending the approver navigated to 

another screen. This was fixed. 

Security>Time Entry>Employee Managers could not see employees they manage in 

‘Staff Utilization’ widget unless “Allow Access to Entries of All Employees" security is 

enabled. This was fixed.  

Security>Certain security profiles would not allow users to see Cloud Feed accounts. 

This was fixed. 

Time and Expense Reviewer> Memo field would not display properly after scrolling to 

the next page and having the Reimbursable Flag column shown. This was fixed. 

Time Entries>Adding time entries to an invoice with no time entries via the Batch 

Update tool would not update accounting tables. This was fixed. 



Time Entries>Comp time would get calculated with a weekly frequency when the 

frequency was set to Bi-weekly. This was fixed. 

Vendor Bill>Importing time entries into a Vendor Bill would recalculate Bill Rate and 

Cost Rate already set in the Time Entries screen. This was fixed.  

Updated report templates. 

Updated help and other documentation. 

Numerous other medium and minor level fixes. 

 

 

 

VERSION 1.1.139 RELEASED ON JULY 12, 2019 

 

What’s new in this version?  

 

This update addressed some critical issues and added a few enhancements. Most notable: 

 

CORE HR release to market: 

Human resources management modules are now available as paid subscriptions. This 

update adds numerous new features and improvements to the Human Resource 

Management functions after successfully completing series of beta releases. This 

release to market version for CORE HR adds: 

HR Administrator subscription: Full access admin level subscriptions meant for HR 

managers. Users get access to all HR screens, reports and widgets. 

HR Standard subscription: Limited access subscription meant for regular users that 

allows them to view their Benefits, Salary history, Incidents, Journals and Reviews.  

 

Reimagined Progressive scrolling: 

In this update, we rewrote our list scrolling algorithms to achieve more responsive and 

light-weight page scrolling experience. The new approach keeps the page sizes at an 



optimum resulting in a responsive and fast paced user experience. Users are presented 

with the total number of records in the list and column totals thereby minimizing the 

need to scroll. This update makes it available in all master lists, Time and Expense entry 

screens, Reviewer and Allocations screen. 

 

Faster, leaner Batch Updates: 

This update replaces our batch update feature with the a more efficient and robust 

algorithm. The new technique not only processes batch update operations in a fraction 

of the time it took previously but also allows users to select all records at once. Users 

have the option to select all records that are in view or select all records that are 

present for the given list and filters. 

 

More to Batch update: 

This update adds batch update functions to some of the most requested areas of the 

application. Batch update function has been added to 

o Time and Expense Reviewer 

o Allocations 

o Gantt Chart 
 

Custom captions and new design for Dashboard widgets: 

Users can now rename widgets to suit their needs. This update also showcases the new 

design improvements that were made to Dashboard widgets to address accessibility 

and other concerns which included displaying long project, employee and other names, 

fixed column headers and handling multiple name columns. 

 

Cloud Feeds for Time and Expense Subscription users: 

This update opens the Cloud Feeds module to the Time and Expense users. 

Administrators can now designate an employee to Connected credit card and other 

accounts giving the employee access to all incoming feeds for that account. Time and 

Expense users are free to add these feeds as expenses to CORE or take other actions 

like ignore or match to existing CORE transactions. 

 

Cloud Feed improvements: 



This update adds the ability to batch add cloud feeds as well as split incoming feeds as 

multiple line items. These splits can also be memorized as rules by indicating a 

percentage or amount based preference. 

 

Standard Invoice templates redesign: 

All our standard invoice templates have been updated with a new design. The design 

changes focused on providing a higher contrast and improved other design aesthetics 

as well. 

 

Security updates 

This update also adds important security features to prevent and mitigate security 

vulnerabilities like Cross site scripting (XSS), Cross site request forgery (CSRF) and Cross 

origin resource sharing (CORS). 

 

 

Other improvements: 

• Batch Invoicing> A new global rule allows users to specify if they want to group 

joint invoices by root projects. 

• Cloud Feeds> Users can now edit the connected bank's nick name and 

associated employee. 

• Cloud Feeds> Added a new security setting that controls if managers have 

access to all accounts or accounts assigned to them only. 

• Cloud Feeds> Users can now indicate if a line item is billable while adding a 

cloud feed. 

• Expense Entry> Users can now specify zero cost rate for an expense and keep 

the charge amount unchanged. 

• Forecasting view> Added filters to all forecasting views. 

• Forecasting View>Added the ability to sort by Project or Resource column. 

• General> Users can now specify email addresses up to 254 characters. 

• HR Reviews> Added the ability to clone existing reviews to a new review. 

• HR Reviews> Reviewers are now being notified via email when they are assigned 

a review. 

• HR Reviews> Review templates list has sample data for admin users to get 

started on creating their own review templates. 

• Integration> Users can now choose if expense details should be sent over to 

AccountRight depending upon project contract or invoice type. 



• Integration> Users can now specify project level item accounts and Tax codes for 

summarized invoices when syncing invoices from CORE to Xero. 

• Integration> Users can now specify tax code settings for Invoices, Bills and 

Purchase Orders for CORE-AccountRight syncing. 

• Integration> Users can now specify tax rates at the item level when sending over 

invoices to Xero. 

• Integration> We allow users to specify tax rates at item level for Xero>Sync 

Settings. 

• Invoice Templates> All system invoice templates now default to hide units by 

default. 

• Invoice Templates> All system invoice templates now group expenses by date by 

default. 

• Invoice Templates> Client address was repositioned to show up correctly when 

mailed in an envelope. 

• Project Performance> Added "Cost" KPI to reveal the true cost metric for the 

project. 

• Projects> Users can choose from new Client Id based options for Project display. 

The new options combine the Client ID with other Project attributes. 

• Purchase Order> Added status as a filter for PO list view. 

• Report Templates> "Project Time and Expense" report received several 

enhancements to increase the report's utility and readability. 

• Report Templates> Added a brand-new report that showcases HR review 

templates. 

• Report Templates> Added the "Billable Work History" report that provides a 

history of billable work done in a company. Organized by project or client, the 

report displays historical billable hours and amount for services and expenses 

for the last 12 months. 

• Report Templates> Added the "Historical Billing" report that provides 

information about past billing of a company, thus indicating a billing pattern. 

Organized by client or project, the report displays historical invoice amounts for 

the last 12 months. 

• Report Templates> Employee reviews report was redesigned to match industry 

accepted designs for performance and other reviews. 

• Report Templates> RFI report now provides links to reveal a report that lists all 

documents that were attached to the RFI. 

• Reports Screen> Added "Project Manager" filter to overdue invoices report. 

• Reports> Added the "Active during" filter to Allocation reports. This filters the 

report for tasks that the resource will be working on for a given period 

regardless of the task start and end dates. 

• Reports> Report descriptions of several templates were updated to describe the 

report more accurately. 



• Security Profiles> Users can now update the name of custom Security profiles. 

• Security> Added “HR Administrator” and “HR User” security profiles to allow 

administrators to easily assign HR functions to managers and Time & Expense 

employees. 

• Security> Several security captions were modified to describe the setting more 

appropriately. 

• Usability> All list views now memorize the sort order specified by the user. 

 

 

Other fixes: 

• Time entries> Companies that widely use custom fields for time entries were 

experiencing performance issues. This was fixed. 

• Allocations> Users were not able to add multiple notification recipients to a task. 

This was fixed. 

• Calendar> "All Day" events would be assigned to the wrong day when the user 

was in certain non-US time zones. This was fixed. 

• Calendar> Clients and other entities would show up in the attendee list 

dropdown. This was fixed. 

• Credit Card>Purchase tax associated to expense entry line items was being 

ignored in accounting. This was fixed. 

• Currency Manager> A recent update had caused the list view to show duplicate 

records for some countries. This was corrected. 

• Custom Labels> User defined labels for Vacation, Sick and Holiday were not 

being followed in PTO Dashboard widget and other places. This was fixed. 

• Dashboard>"Due Projects" widget would only look at the due date of parent 

projects and ignore phase due dates. This was corrected. 

• Employee> Termination details would be reset if a terminated employee was set 

as active. This was fixed. 

• Employee> Users were able to add To-do’s to employees that were marked as 

terminated. This was fixed. 

• Expense Entry> The system would incorrectly reset the cost rate to zero if an 

existing entry was modified for the expense code. This was fixed. 

• Forecasting View> Forecasting views had a performance issue related to a large 

number of allocation entries being present in the system. This was fixed. 

• Integration> Sending over the time entries to QuickBooks Online would in-

correctly throw an exception if the user had synced the time entries earlier. This 

was fixed. 

• Invoice Templates> Hourly and Fixed Invoice -Accountants version and Cost Plus 

were missing the retainer summary. This was fixed. 



• Invoice> Emailing an invoice to the client in un-attended mode would not mark 

the invoice as posted. This was fixed. 

• Invoices>Auto invoice numbering would ignore leading zeros. This was 

corrected. 

• Payment> The "Close" button for "Bounced check" dialog was not working. This 

was corrected. 

• Print Checks> This list would show un-printed checks for inactive bank accounts. 

This was fixed. 

• Project> Billing contact would remain assigned even when the client was 

updated to a different client. This was fixed. 

• Recurring Checks> The system would not allow users to modify recurring checks 

if the start date of the recurring entry was older than the Company closing date. 

This was fixed. 

• Report Templates> "Collection Notes" would ignore the project manager filter 

and show data for all PMs'. This was fixed. 

• Report Templates> Contract Analysis report would produce erroneous results 

when grouping by parent projects. This was fixed. 

• Report Templates> Document reports would incorrectly group all documents 

under one estimate record when filtering for a certain date range and estimate 

documents only. This was fixed. 

• Report Templates>'Employee Missing Time week view' report would incorrectly 

include employees who had entered more than the required hours for a given 

week. This was fixed. 

• Report Templates>Fully paid invoice would show on AR Aging/AR Aging 8 Steps 

reports when grouped by "Master project". This was corrected. 

• Reports Screen> Users were not able to schedule reports that had an 

apostrophe in the memorized name of the report. This was fixed. 

• Updated report templates. 

• Updated help and other documentation. 

• Numerous other medium and minor level fixes. 

 

 

VERSION 1.1.138 RELEASED ON MAY 11, 2019 

 

What’s new in this version?  

 



This update addressed some critical issues and added a few enhancements. Most notable: 

 

• Report Scheduling> Custom reports can now be scheduled for automatic delivery. 

• Bill Payments> Users can now view the details of the vendor bills/reimbursable 

expenses that were paid using Bill Payment module. 

• Reconciliation> Added Beginning Balance column to the "Manage Reconciliations" 

list. 

• Time Card> Time card now maintains the order of entries when changing weeks 

after updating the time card. 

• Time Card> Time card now allows users to sort by project even if there is no time 

recorded for the week. 

• Cloud Feeds> Added "Created By" and "Last Updated By" fields to connected banks 

list view to display the user who added and last refreshed the cloud feed. 

• Navigation> Added quick add option for Credit Card entry in the left navigation. 

• Dashboard> Added review name column to "HR upcoming reviews" widget. 

• Dashboard> Users can now open the specific employee review record when they 

click on the review name in “HR Upcoming Reviews” widget. 

• Documents> Added "Provider" column to all document lists to reveal the cloud 

provider associated with the document. 

• Globalization> Added 57 new countries to the Country and currency lists. 

• Batch Billing> Users are now prompted if they want to mark time or expense as 

billed in Batch billing>Time or expense details, 

• Integration> Added "Payroll setting" to AccountRight sync settings to allow users to 

specify custom Payroll categories when sending over time entries to AccountRight. 

• Integration> CORE now allows AccountRight and Xero users to choose if they want 

to send MST and MET associated with invoices as line items. 

• Invoices> Added new invoice templates and settings that support custom ordered 

time and expense entry line items in a detailed format. 

• Projects> Added important columns like phone, email and contact type to Project 

contacts tab view. 

• Projects> Changing a project type from marketing to other contract types now 

prompts users if they want to mark the existing time and expense for the marketing 

project as billable. The user gets multiple options to choose from. 

• Projects> Users are now prompted if want to assign the budget, estimate or fee 

schedule to the phases of a project when any of these entities is assigned at the 

parent project level. 

• Purchase Order> Users are now prompted to confirm if they want to receive more 

than the ordered number of units when receiving items against purchase orders, in 

case they enter a quantity that is greater than the number of units ordered. 

• Report Templates> Added "Taxable Amount" column to Tax registry report to 

correctly indicate the value of entries that were taxed. 

• Report Templates> Added new group by options to "Invoice Register" report. 



• Security> Context driven reports for this screen now allows the user to filter the 

reports for selected employees only. 

• Security> It is no longer allowed to change the security profile of the owner account 

to anything else than "full access". 

• Security> Added a security feature that invalidates user access token on sign out. 

• Infrastructure> Added route extension capability that will allow us to redirect 

requests from apps like public API, CORE AI etc. to dedicated servers. 

 

Fixes: 

 

• Accounting> Some accounting screens like Checks, Credit Card and Vendor Credit 

would show the un-deposited funds in the account dropdown. This was corrected. 

• Allocations> Users were not able to select an employee or vendor group in the filter 

list. This was corrected. 

• Allocations> Users were wrongly being notified that the task has been completed 

while setting up notifications for the task. This was fixed. 

• Batch Billing> Project and Client Manager Dropdowns did not differentiate an 

employee from a vendor. This was fixed. 

• Billing Schedule >Progressive scrolling not working in billing schedule when sorting 

billing schedule in descending order on 'priority number' column. This was fixed. 

• Check> Check details report was not respecting Print status filter. This was fixed. 

• Checks> General Journal entry created when voiding a check was being incorrectly 

dated for today's date. This was fixed to reflect the check date. 

• Cloud Feeds> "Manage Rule's” screen did not remember column sorting. This was 

fixed. 

• Cloud Feeds> Users were able to select main type projects as project for the time or 

expense entry when adding feeds to CORE. This was fixed. 

• Cloud Feeds> Users were not able to add an accounts based cloud feeds without 

specifying a payee. This was corrected. 

• Cloud Feeds> When creating a transfer transaction from a bank feed, users were 

able to select income and expense accounts also. This was fixed. 

• Create Batch Invoice> A side effect of a recent enhancement would cause the time 

entries to stay locked even after the biller had exited the batch invoices screen. This 

was fixed. 

• Credit Memo> Users were being allowed to pay more than credit memo amount 

when paying off the credit memos in the pay bills screen. This was fixed. 

• Deposits> Users were able to edit deposits created from cloud feeds without a 

warning prompt letting them that the entry is connected to a feed. This was fixed. 

• Documents> File upload would occasionally fail for “Box” and “One Drive” users. This 

was corrected. 



• Employee> Performance screen widget was using the Client hours instead of the 

actual hours to calculate the Utilization. This was fixed. 

• Employee> Terminate employee function would check for HR subscription. This was 

fixed. 

• Fee Schedule> Employee Control was not working when an existing service or 

expense entry was being updated. This was corrected. 

• Fee Schedule> Users were not being prompted to enter all required fields when 

saving a service or expense line item. This was corrected. 

• General Journal> Cloning a general journal was using the date of the original entry. 

This was corrected to use today's date. 

• General Journal> Users were being restricted to pick only bank and credit card 

accounts when creating cash General Journal entries. This restriction was removed. 

• General Journal> Inactive employees and vendors were showing up in the linked 

field column dropdown. This was fixed. 

• General> CORE address fields would fail to show the address in Google maps. This 

was fixed. 

• Global Search> some characters like '#' would throw off the search and result in an 

error. This was fixed. 

• Global Setting> Updating project "display as" settings for a company with a very 

large project list would fail to complete. This was fixed. 

• Groups> Assign groups list view was un-necessarily showing already assigned items. 

This was fixed. 

• Groups> Quick search for unassigned entities would take too long to retrieve results 

for user with large data. This was fixed. 

• Integration> Sending over an invoice to Xero was incorrectly looking for CORE COA 

security. This was fixed. 

• Integration> CORE employees that were synced to QuickBooks would not appear as 

synced when they were converted to Vendors. This was fixed. 

• Integration> Invoices with line item taxes were not being synced to Xero. This was 

corrected. 

• Integration> Users with no access to invoices and payments were not able to send 

these entities to QuickBooks. This was fixed. 

• Integrations> "Show inactive only" would not work in QuickBooks project record 

mapping. This was fixed 

• Integrations> Last sync date would be set to empty if the user disconnected from 

the integrating software. This was fixed. 

• Invoice Templates> some templates would not show correct custom label for the fax 

field. This was fixed. 

• Invoices Templates> Joint invoices would not show the retainer summary even after 

the global setting rule for this setting was set to true. This was fixed. 

• Invoices> “Un-post” is now restricted to only those invoices that have no payments. 

• Invoices> Account Summary would not include the current invoices in the “Billed to 

Date” summary for draft invoices. This was fixed. 



• Invoices> CSV export would not respect all screen filters. This was fixed. 

• Invoices> the overdue column would not be calculated correctly for users other than 

US time zones. This was corrected. 

• Invoices> Users with no access to apply discount feature were being allowed to 

update invoices for discounts using the batch update feature. This was fixed. 

• Manage Subscriptions> Users were not able to sort records in Inactive subscription 

list. This was fixed. 

• Manual Invoice> "Link approved TE/EE" would fail to bring up any entry in edit draft 

invoice mode. This was fixed. 

• Manual Invoice> Filters in the approved Time expense view were not working. This 

was fixed. 

• Performance Reviews> Review templates would incorrectly add the “additional 

remarks” for free flowing text type questions. This was corrected. 

• Project> Project category notes created in invoice or collections screen were not 

showing up in the Project>Notes view. This was fixed. 

• Project> Users typed text for "Message on Invoice" was incorrectly being changed to 

sentence case. This was fixed. 

• Projects> A recent change would not allow fee schedule, budget and estimate to be 

assigned at the parent project level. This was fixed. 

• Projects> Batch update would ignore phases and only update parent projects. This 

was fixed. 

• Projects> Un-deposited funds account would show up in the income and expense 

account dropdowns. This was fixed. 

• Projects> Users were not able to assign multiple projects to groups using batch 

update. This was fixed. 

• PTO> Documents for this screen would only show the first 25 records. This was 

corrected. 

• Purchase Order> Users were not able to select projects of type main while entering 

line items for the PO. This was fixed. 

• QuickBooks> A certain scenario would cause the QuickBooks Online time entry to 

be synced to the wrong Project in CORE. This was corrected. 

• QuickBooks> Unmapped lists would behave erratically if the user would search for 

records in both the lists. This was corrected. 

• Manage Reconciliation > Column headers for this screen would not be persisted on 

scroll. This was fixed. 

• Manage Reconciliation> List would only displays 25 records. This was fixed. 

• Recurring Invoices> Next billing date would show an incorrect next billing date when 

the recurring invoice was set to process automatically. This was fixed. 

• Registers> Users were being allowed to pick both AP and AR accounts in the splits. 

This was corrected. 

• Report Templates> several financial and payments reports received a makeover and 

new options and filters. 



• Report Templates> “Time and Expense by Parent Project” was enhanced with new 

filters and options. 

• Report Templates> "1099/1096-MISC (US)" report’s “Show Check details" parameter 

fails in a user scenario. This was fixed. 

• Report Templates> "Employee Performance" report would not show correct data 

when the Last fiscal year filter was applied. This was fixed. 

• Report Templates> "Employee Utilization" report would consider comp time for 

calculating employee utilization. This was fixed. 

• Report Templates> "Employee Utilization" report would include billable sick, 

vacation and holiday hours. This was fixed. 

• Report Templates> "HR Benefit Usage" report was including vendors. This was 

corrected. 

• Report Templates> "Project Profitability" report did not display expense cost on the 

report. This was fixed. 

• Report Templates> "Work in Progress details" report would ignore cost rate and cost 

security. This was fixed. 

• Report Templates> 1099/1096 report would incorrectly double the amounts if the 

vendor had more than one address specified. This was fixed 

• Report Templates> Added "Provider" column to the documents reports. 

• Report Templates> “AP Aging” reports had a performance bottleneck and would fail 

on large user data. This was fixed. 

• Report Templates> “AP Aging with Credits” would not match with General Ledger 

Report for some users. This was fixed. 

• Report Templates> Benefit Usage report now provides sub totals for each 

employee. 

• Report Templates> Employees exceeding the required hours would show up on the 

"Missing Time" report. This was fixed. 

• Report Templates> some reports would use the legacy term A-Hours instead of 

Hours. This was fixed. 

• Reports> “HR Benefit Usage” would not filter the report for the provided period date 

when viewed through the Benefit usage screen. This was fixed. 

• Reviewer> Export as CSV would ignore the expense entries. This was fixed. 

• RFI> Filter by status would not work. This was fixed. 

• Security> "Allow Access to Custom Reports" security was being bypassed if the 

report was marked as favorite. This was fixed. 

• Security> Profile name with an apostrophe in the name would be titled incorrectly. 

This was fixed. 

• Submit-Approve> Approving a reimbursable expense would clear the income and 

expense accounts from the expense entry in a certain security scenario. This was 

fixed. 

• Time Card> the next and previous week buttons would not work correctly for some 

countries. This was corrected. 



• Time Entry> Fee schedules rates were not being applied when an existing time entry 

was set to overtime. This was fixed. 

• Timer> Deleting a timer was not deleting the documents attached to it. This was 

fixed. 

• Timers> Users were able to save timers with no description. This was fixed. 

• Vendor> A user data scenario would cause the transaction tab to not show vendor 

payments. This was fixed. 

• Vendor>Transactions would not be sorted correctly when sorted by descending 

date. This was fixed. 

• Updated report templates. 

• Updated help and other documentation 

• Numerous other medium and minor level fixes. 

 

 

 

 

VERSION 1.1.137 RELEASED ON APRIL 6, 2019 

 

What’s new in this version?  

 

This update addressed some critical issues and added a few enhancements. Most notable: 

 

• CORE HR Beta improvements: As promised, this installment offers powerful new 

features as well as major improvements to the existing HR offering, including: 

• Employee Performance reviews 

• Employee Incident management 

• Employee Journal management 

• HR Forms 

• Enhanced Benefit management 

• Time Card based benefit 

• PTO-Benefit association 

• Brand new HR widgets and reports 

• HR specific security profiles 

• In Beta and free till June 30th  

 



 

• Push Notification for Mobile: This update marks an important milestones for our 

mobile first design philosophy. CORE iOS and Android apps now support instant 

workflow and other notifications that are pushed to mobile devices of users that 

have enabled this feature in their CORE mobile apps. 

 

• Integrated Tooltips: All CORE lists and screens will now have tooltips. They offer a 

quick help option that explains certain data fields, Info Bars and Widgets. Users can 

use this on-demand option to get simple and effective explanations. 

 

 

• In-app Sample company access for paid Users: Paid users will now be able to use 

the switch to “Sample” option inside their company file. They can use this option to 

try any of our five sample company files. We have also placed a convenient “Exit 

Sample” option to sign them back in their original company file. 

 

• Benefit InfoBar for PTO: PTO Users will now get a full snap shot of their benefit 

information when requesting PTO. Non-CORE HR users that use Employee 

permissible hours and PTO can use this as well. 

 

• Send Time entries to MYOB AccountRight: CORE - MYOB AccountRight integration 

now supports sending time entries to MYOB AccountRight.   

 

• Combine Security Profiles: Admin users can now create new security profiles by 

combining one or more security profiles! The new profile will contain all security 

settings from all security profiles chosen. 

 

 

• Enhanced Global Search: Global search was enhanced for ease of use and better 

handling of search results. 

 

• Custom Labels for Time off categories: Admin users can now customize time off 

category labels like Vacation and Sick to a term that they use. 

 

Other Improvements: 

• Create Batch Invoice> Filters and parameters defined by the biller will now be 

remembered for the next billing cycle. 

• Create Batch Invoice>Added a new "Active Records only" switch that processes 

only active records for billing. 



• Check Printing>Voucher details option received several enhancements that 

improved the tear off section of the check to show more useful information and 

also handle several scenarios. 

• Invoices>Added a new "Un-post" batch action to allow billers to un-post invoices. 

• General>Added Client Column to all Project dropdowns in the application. 

• Statements>Users can now specify a personalized message for each Client 

before sending out statements. 

• Statements>Users can specify an "Aging Days" filter to narrow down clients with 

pending payments. 

• Report Templates>General Ledger reports now provide an easy option to show 

the report without details. 

• Report Templates>Statement reports now display the Statement date on the top 

of the report. 

• Report Templates>"AR Aging with Credit Payments" report now includes an 

option to show General Journal entries. 

• PTO>Time entries tied to a PTO entry are automatically updated when the 

underlying PTO is modified. 

• MYOB AccountRight Integration>Users can now specify a Tax code for activities 

that are sent over to AccountRight. This is important to handle taxes correctly 

when sending over invoices. 

• Subscription>Billing subscription has access to all three income and expense 

widgets now. 

• Subscription>Manager Subscription has access to "Work In Progress" report 

now. 

 

Fixes: 

• Activity and Expense> Item filter dropdown would include inactive items. This was 

fixed. 

• Allocation and Forecasting>Allocations that were reset to zero units in the manual 

view would still show in the Allocation view instead of being removed completely. 

This was fixed. 
• Allocation and Forecasting>In the Manual View, the spacing of columns would not 

adjust based on number of columns shown or hid. This was fixed. 

• Auto Complete>An issue with the feature would cause it to work erratically for a 

large list of similarly spelt Autocomplete shortcuts. This was fixed. 

• Batch Update>It was not possible to remove assigned fields like Budget, Estimate 

etc. using batch update. This was fixed. 

• Client>Retainer Balance and Margins widget were not working on last 

month/custom date filter. This was corrected. 

• Create Batch Invoice>Apply discount amount in percentage would cause the system 

to ignore the 'Apply discount to pre-tax’ Global rule. This was fixed. 



• Create Batch Invoice>Invoice Memos were not getting updated via batch update. 

This was corrected. 

• Create Batch Invoice>WUD Amount on an Extra Time Only Invoices was getting 

recorded as part of contract when changing the net bill amount. This was fixed. 

• Custom Fields>Users were not being allowed to delete custom fields when the view 

option was set to "All". This was fixed. 

• Dashboard>"Active Accounts" widget would include balance sheet accounts by 

default. This was fixed and the widget now defaults to income and expense type 

accounts only that are active in the current fiscal year. 

• Dashboard>Client Performance widget would incorrectly include debit payments. 

This was fixed. 

• Dashboard>Retainer balance widget was showing an unnecessary long list by 

including Clients with no retainer activity. This was corrected. 

• Dashboard>Some of the widgets would show entities like Accounts in all caps. This 

was fixed. 

• Dashboard>Staff workload widget would not handle the project filter correctly and 

fail to retrieve any data. This was fixed. 

• Documents>User defined attachments that had the same file name were being 

overwritten for Amazon storage users. This was corrected. 

• Expense Entry>Users with sufficient permissions to change the expense currency 

were not able to change it. This was fixed. 

• Fee Schedule>Bill rate multiplier would not work as expected for details that 

specified Employee groups. This was corrected. 

• Fee Schedule>Fee Schedule update would not work if the Fee schedule Cost rate 

was empty and the user has no access to Cost rate. This was fixed. 

• Gantt chart>Month names were not being localized as per user region. This was 

fixed. 

• Globalization>Fixed a bunch of issues related to decimal character for some 

countries like Belgium. 

• Invoice Templates>Invoice memo and TE memo setting specified for the template in 

GS were not being applied. This was fixed. 

• Invoice Templates>Phased Invoice template was not respecting the "Show GST" rule. 

This was fixed. 

• Invoice Templates>There were several instances when an invoice would not use the 

Employee display as field. This was corrected. 

• Manual Invoice>"Approved Time and Expense" option would fail to show approved 

entries for most manual invoice create options. This was fixed. 

• Payment>Add new alert that would inform the user if the required fields were not 

filed by the user.  

• Project Assignments>An issue in the project assignments for item groups would 

cause the time entries to be marked as non-billable by default. This was fixed. 

• Project> Users were not able to assign contract employee and outside consultants 

as Project managers. This was fixed. 



• Project>Users with country profile different than that of the Company were not able 

to save any projects. This was fixed. 

• Reconcile>Users were not able to reconcile system defined accounts that are eligible 

for reconciliation otherwise. This was fixed. 

• Recurring Invoice>Back dated period invoices when processed would have all the 

approved time and expense be associated with the first invoice being created. This 

was fixed. 

• Recurring Invoices>Invoices created for recurring type contract type projects would 

sometimes be created a day earlier than expected. This was fixed. 

• Report Template> Project Principal and Project Originator filter and group by option 

was added to multiple reports including "Work in Hand", "Contract Analysis", "Gross 

Margin" and "Project Profitability" 

• Report Templates> "Employee Utilization" report and "Staff Utilization" Dashboard 

widget would show different results in some cases. This was fixed. 

• Report Templates>"AR Aging" reports when memorized would leave the "Show GJ" 

option enabled even if the "Show Invoices" option was disabled. This was fixed. 

• Report Templates>All performance reports were enhanced with transaction date 

filters. 

• Report Templates>General Ledger reports now present a legend explaining the 

balance column. 

• Report Templates>Some reports would use project ID or Name instead of relying on 

the Display as attribute of the Project. This was corrected. 

• Report Templates>Taxes report would only show data if there were taxes collected. 

This was fixed so that other information like Service and Expense amounts shows 

up for the benefit of the user. 

• Reports Templates> Refunded retainer would not show up on the Cash Receipts 

report. This was corrected. 

• Report Templates>Added important grouping options like Project Manager, 

Originator, Contract Type etc. to many reports like 'Time and Expense by Parent 

Project' 

• Report Templates> “Trial Balance YTD” report was not respecting the fiscal year 

defined for the company. This was fixed. 

• Report Templates>”Project Performance” report was not using the correct formula 

for Earned value and Earned Value percentage fields. This was fixed. 

• Report Templates>Most financial reports were not respecting the fiscal year when 

filtering as of a certain date. This was corrected. 

• Scheduled Reports>When creating a scheduled report, the schedule time would be 

off by a minute for some specific time zone users. This was corrected.  

• Reviewer>A user with "Update" security was not able to update memo or 

description unless the user was also provided "Update Rates" security. This was 

corrected. 

• Time Card>The screen would allow users to input double decimals and not warn the 

users causing data loss. This was fixed. 



• Timer List>Newly created timers would not be displayed at the top of the list. This 

was fixed. 

• Vendor>Performance screen would not respect the cost rate security. This was 

corrected. 

• Xero Integration>Vendor address details would get duplicated if the vendor was 

updated in Xero. This was fixed. 

• Updated report templates. 

• Updated help and other documentation 

• Other minor fixes. 
 

 

---------------------------------------------------------- 

 

 

VERSION 1.1.136 RELEASED ON FEBURARY 23, 2019 

 

What’s new in this version?  

 

This update addressed some critical issues and added a few enhancements. Most notable: 

• Demo video for new users: New signups are now presented with an in-app 

"Getting Started" video during sign up. Trial users can also access this video by 

clicking the "demo" link located conveniently in the top menu. 

 

• Know your account and reconciled balances from the Dashboard: Added a 

brand new "Account Balances" widget that lists account and reconciliation balances 

in a bar chart graph. 

 

• Updated Accounting widgets: Recently added accounting widgets received a face 

lift and other optimizations. 

 

• Guaranteed Reconciliations: Account Reconciliation process now verifies integrity 

of the reconciled transactions before saving the reconciliation.  

 

• Account Reconciliation now supports date periods: Account Reconciliation 

screen now allows users control the transactions list by providing a date range filter. 



 

• Beginning balance in General Ledger reports: All General ledger reports were 

updated to include beginning balance for each account. This is very useful when 

running reports for date ranges. 

 

• Batch Merge Projects: Project list view now offers "Merge" as a batch action to 

combine multiple projects in a single click. 

 

• Configurable project dropdowns for report filtering:  Reports view now allows 

user to specify if they want inactive and other projects to appear in filter drop 

downs. 

 

 

• Choose your preview format: Report preview now allows users to specify the 

preferred output format. Users can choose "Viewer" or "PDF" and the choice will be 

remembered for the specific report. 

 

• Print CORE Subscription Invoices: Users can print/preview CORE subscription 

invoices from 'Billing History', Manage Subscriptions. 

 

 

• Xero integration now supports "Tracking Category": CORE classes can now be 

sent to Xero as "Tracking Category" and also imported as Classes. These two entities 

can mapped as well. 

 

• Project Accounting got stronger: General Journal now allow users to associate a 

Project to the line items. 

 

 

• Project multiplier report: Added "Project Cost Multiplier" report that calculates the 

cost multiplier based on project costs and billing amounts. 

 

• Report security made easy: Report template security has now been moved to a 

separate tab in Security module. 

 

Other Improvements: 

• Added Over time (OT) filter to all Time entry reports. 

• Added "Allow access to custom fields" to Invoice security. 

• Added Comp Time column to the Employee Paid Time off Hours report. 

• Some columns like "Cost Amount' were re-positioned in Expense entry for better 

UX. 



• Added "Assigned Project(s)" column to Purchase Order list view. 

• Users are now warned when modifying transactions that were imported from cloud 

feeds. 

• All AR Aging reports now provide uses an option to include General Journal entries. 

• Dashboard totals are now anchored to the bottom of the widget. Previously, they 

would move away on scrolling. 

• Most list views in CORE would incorrectly capitalize the first letter of Display as/ID 

fields. This was fixed. 

• Added grand totals to forecasting range columns in Forecasting tab of A&F. 

• Documents list would not show any contextual reports when viewing documents 

related to 'Budgets' and 'Estimates'. This was fixed. 

• Implemented "Add New" security to memorized and scheduled reports. 

• Added "Export Sales tax as a separate line item" setting to LEDES export. 

 

 

Fixes: 

• Billing schedule reminder date would not generate a reminder for the user. This was 

fixed. 

• Phased and Joint invoices were not displaying Cost Plus information. This was fixed. 

• Project Assignments report was not displaying the billable status for activity 

assignments. This was corrected. 

• DCAA compliance settings would not allow users to save vendor bills that were 

created from scratch. This was fixed. 

• AP Aging with Credits report was not able handle situations where a vendor bill was 

completely marked as paid using credits. This was fixed. 

• LEDES export would not handle “Send Item Level Sales Tax" correctly. This was fixed. 

• Updating an expense entry that is tied to a credit card would throw off the credit 

card amount. This was fixed. 

• Bill and Cost rates of existing employees would be reset to 1 when invited as users. 

This was fixed. 

• Deposit entries created from existing payments were not inheriting the class field 

specified for the project. This was fixed. 

• An issue with the Project manager drop down would cause employees other than 

the logged user to now show up. This would happen if the user had no access to the 

employee screen. This was fixed. 

• An issue in the AP Aging report would cause it show a balance different than the 

Balance Sheet. This was corrected. 

• Batch invoice, Export to CSV would only export the first 25 records in view. This was 

corrected. 

• Transaction details on Cash basis report would not respect the date filters. This was 

fixed. 



• An issue in Groups assignment would cause records outside the search results to be 

added to the group. This was fixed. 

• Auto increment invoice number feature would leave out leading zeros from the next 

invoice number. This was fixed. 

• Batch invoice would leave out some projects when using project groups. This was 

corrected. 

• Auto increment project Id feature would leave out leading zeros from the next 

project ID. This was fixed. 

• An issue in Invoice Collections>Payment history would add debit type payments 

causing wrong grand total. This was corrected. 

• Some validation errors would cause user frustration as they would not know which 

specific field is failing validation. This was overcome by bringing the specific tab into 

focus and red lining the field. 

• Several reports under Company, Employee and Project categories were enhanced 

for options, look and feel and other attributes. 

• "Group Assignment" report would fail to preview if group filters were applied. This 

was fixed. 

• Invoice template would fail to show the Tax ID if the masking for Tax ID was set to 

none in Global Settings. This was fixed. 

• Several users had complained about instances where their clients had received 

empty Cash receipts. This was fixed. 

• Merge Vendor function would cause some of the Bill Payments associated to the 

original vendor to not show up in Vendor>Transactions. This was fixed. 

• An issue in the "Employee Allocation" and "Staff workload" widgets would cause 

them to ignore tasks with activity groups. This was fixed. 

• Clicking on the notifications areas was not refreshing the badge number. This was 

fixed 

• The sum of item level taxes was not being included in the INVOICE_TOTAL field of 

the LEDES 1998B export. This was fixed. 

• Users with no access to any of the reports under one or more report categories 

would still these categories. This was fixed. 

• Users were unable to update the retainer amount in draft manual invoice. This was 

fixed. 

• Global setting rule "Zip email attachments" would cause payment receipts to be sent 

as zipped files. This was fixed. 

• Document tabs in Time and Expense entry view would only show the first 25 

documents. This was fixed. 

• User defined custom field now appear at the bottom of the filter list to facilitate 

ease of use. 

• Subscriptions, Billing History did not show more than 25 records. This was fixed. 

• Users were not being prompted with a proper message if the underlying cloud 

connection has been disconnected and the user was accessing a document 

connected to the account. This was fixed. 



• Merge Activity function was not copying the documents over to the merged record. 

This was fixed. 

• Profit and Loss widget would drop the profit line if the company has no expense 

entries for last 12 months. This was fixed. 

• Performing a sort in Time entry would cause certain column headers to use ellipsis 

instead of showing the full text. This was fixed. 

• Certain list view like Deposits, Fund Transfers and Credit Card screens would lose 

the sort caret after filers were applied. This was fixed. 

• Users were able to delete bill payments even if it failed the company closing date 

test. This was fixed. 

• Users were able to delete vendor credits even if it failed the company closing date 

test. This was fixed. 

• Client contact e-mail tag in LEDES XML file would display the client contact's fax 

details instead of e-mail. This was fixed. 

• GS > Auto apply retainer to invoices. The retainer was not being applied 

automatically to the invoices of projects that had an active billing schedule. This was 

corrected. 

• Void Invoice template would not display PO number. This was fixed. 

• “Estimate Comparison by Client” report would not group by Client. This was fixed. 

• An issue in the event detail view would prevent users from deleting attendees. This 

was fixed. 

• Updated report templates. 

• Updated help and other documentation  

• Numerous other fixes and optimizations. 

 

 

 

 

 

 

VERSION 1.1.135 RELEASED ON JANUARY 12, 2019 

 

What’s new in this version?  

This update addressed various issues and added a few enhancements. Most notable ones 

include: 



• Added brand new financial accounting widgets for comparative analysis of Balance 

Sheet and Profit and Loss statements.  

• Added ‘Account Balances’ widget that allows users to see monthly and YTD balances 

for active accounts. 

• Added the Vendor Group filter to all vendor-specific reports like 1099, Vendor Bills, 

Expenses by Vendor, etc. 

• Enhanced the ‘Expense by Vendor’ report to include all vendor transactions along 

with important details of the transaction. 

• Added an option to hide phases and roll up totals by parent project for few reports 

like ‘Project Profitability’ and ‘Contract Analysis’. 

• Added an option to hide late fee invoice transactions from A/R reports. 

• Added a new option to group Statement reports by client and then by project. 

• Added an option to edit the associated purchase order when receiving items for that 

PO. 

• Added the ability to specify individual vendor filters for getting vendors in Sync 

Settings section of Xero integration. 

 

Other fixes: 

• Checks and credit card transactions that were used to pay bills would not appear 

in the Cloud Feeds, ‘Find Match’ list for the specified CORE bank or credit card 

account. This was corrected. 

• An issue in rounding for MST and MET would cause the invoice total to be off by 

a penny. This was corrected. 

• Applying an adjustment for a credit card reconciliation account would show 

incorrect journal. This was corrected. 

• Bill Payments would not adjust the payment amount correctly if one or more 

existing entries were excluded. This would happen for non-US companies and 

was corrected. 

• An issue in the A/P reconciliation report would not display all un-cleared 

transactions. This was corrected and the un-cleared entries are now shown as a 

summarized item with an option to drill down. 

• Income vs. Expense widget had issues for the 12 weeks filter. This was corrected. 

• Google Drive users were reporting multiple issues regarding connection and 

accessing existing documents. These were fixed. 

• QuickBooks Online expenses would not come over to CORE if the payment 

method was not specified there. This was fixed. 

• Client statements emailed from the Statements screen would not respect the 

date filters. This was corrected. 

• Cloud Feeds screen had UI issues if the company had more than 25 connected 

accounts. This was fixed. 

• Bill Payments would not automatically reflect the correct balance for default 

payment account. This was fixed. 



• A recent update had caused the sort caret to disappear in multiple screens after 

the user had progressively scrolled the list. This was fixed. 

• Users were not able to delete the time and expense entries linked to a credit 

card, check or vendor, and marked as billed. This was corrected. 

• Bill Payments detail would not show the reference number for associated bills, 

credit memos or reimbursable expenses. This was fixed. 

• Users were able to apply payments for invoices prior to the company’s closing 

date. This was fixed. 

• The Change Invoice Date feature in Invoices would allow users to change the 

invoice date to dates prior to company’s closing date. This was fixed. 

• Emails sent by the Schedule Reports feature would add a system defined footer 

to the email. This was removed. 

• Phased Invoice with Expenses would incorrectly club the tax amount for extra 

expenses with non-extra expense amount. This was fixed. 

• The system would fail to prompt the user when deleting a reconciled bill 

payment. This was corrected. 

• An employee with default group ‘All’ was not being assigned a default group 

when converted to a vendor. This was fixed. 

• RFI screen based report would not respect the screen filters. This was fixed. 

• Info Bar in Vendor credits would not show correct summaries for some of the 

date filter ranges. This was fixed. 

• An issue in time and expense reports would only bring in expenses when date 

filter was specified. This was corrected. 

• A user specified credit card would not appear in the existing Credit Cards list 

when it was used at least once to purchase subscriptions. This was corrected. 

• Users were able to delete billed time and expense entries in the Credit Cards 

detail screen. This was fixed. 

• Credit card transactions would show the ‘Purchased From’ field as empty if the 

original vendor was merged to another vendor. 

• Billing reports were upgraded for cosmetic changes. 

• Updated report templates 

• Updated help and other documentation 

• Other minor fixes 
 

 

 

 

VERSION 1.1.134 RELEASED ON DECEMBER 15, 2018 

What’s new in this version?  



This update addressed various issues and added a few enhancements. Most notable ones 

include: 

• ‘Compose Email’ screen was enhanced to allow users to remove existing and new 

attachments. A new column was added as well to show the size of attachments, 

allowing them to make an informed decision before sending emails with 

attachments. 

• ‘Notes’ list under productivity tools now has an option to show all notes. 

• Users can now specify a free flowing mask for zip codes, phone numbers and other 

attributes that support masking.  

• Transactions like invoices can now be previewed using an in-line ‘Preview’ action in 

the transactions tab of Project detail view. 

• Users can now update invoice memos from the detail view of an invoice. 

 

 

Other fixes: 

• Notifications icon would not update the badge number to indicate recurring invoices 

that are ready to be processed. This was corrected. 

• The document hyperlink column in the document list view would navigate the user 

to the detail view of the document, instead of previewing the document. This was 

fixed. 

• Invoice list in payment detail view was not sorting correctly for project and invoice 

numbers columns. This was corrected. 

• Upon applying a new payment, users were incorrectly being navigated to the 

payment list even when the payment was initiated from ‘Invoices’ or ‘Invoice 

Collections’. This was fixed. 

• Contract Analysis report would not show non-active projects even when the report 

was filtered for the same. This was fixed. 

• Statement reports did not print the current date. This was corrected. 

• Added the ‘Show Tax’ parameter to ‘Billing Forecast’ report to specify if the 

computed amounts should include taxes. 

• Users were being allowed to void a check prior to the closing date. This was 

corrected. 

• Parent Project rules were not being copied to the underlying phases if the hierarchy 

was more than one level deep. This was fixed. 

• An issue in the Project template logic would prevent users to create template based 

projects, if one or more of the phases had the same phase description and the 

project ‘display as’ setting included ‘Phase Description’. This was corrected. 

• An issue in the Estimate detail screen would prevent users to update line item 

descriptions. This was fixed. 



• An issue in the Project structure tab would prevent users from updating contract 

amounts. This was fixed. 

• Invoices belonging to a project that used a custom invoice template would fail to 

preview when opened from the project detail view. This was corrected. 

• Creating a new budget with an apostrophe character in the budget name would 

throw an error. This was fixed. 

• ‘AP Aging with Credits’ report would show a balance even though credit memo 

transactions had been paid. This was fixed. 

• Client and Budget reports were refreshed with cosmetic updates. 

• An issue with ‘Fee Schedules’ report would make the report not hide the cost rate 

even if the security specified otherwise. This was fixed. 

• ‘Fund transfers’ list would not remember the last used date filter. This was fixed. 

• An issue in code would mark a reimbursable expense as non-reimbursable after the 

paid flag was updated to false. This was fixed. 

• The module column in ‘Document’ list view under productivity tools would show up 

as empty in certain scenarios. This was fixed. 

• Statement report would add a blank page between invoices that were associated 

with the same project but billed to different contact addresses. This was fixed. 

• ‘Bill Payment’ transactions that were already reconciled would appear as ‘not 

reconciled’ in the Credit Card register. This was fixed. 

• Few restricted account types such as ‘Accounts Payable’ were appearing in the 

income and expense account dropdown in Project view. This was fixed. 

• Time entry memo created out of text that was pre-formatted and copied to the 

memo box would appear garbled in the Invoice detail view. This was fixed. 

• The system was allowing users to create recurring invoices for projects that had 

already been completed. This was corrected. 

• Updated report templates. 

• Updated help and other documentation 

• Other minor fixes. 
 

 

 

 

 

 

 

 

 



 

 

 

VERSION 1.1.133 RELEASED ON DECEMBER 1, 2018 

What’s new in this version?  

This update addressed various issues and added a few enhancements. Most notable ones 

include: 

• Added the ability to update the ‘Principal’ and ‘Originator’ fields for multiple projects 

using the batch change action in Projects list. 

• Added default sort order to Clients, Employees, and Vendors, Classes, RFIs, To-Dos 

and Notes screens. 

• When changing Project Account in Projects > Billing Options, users can now decide if 

existing time and expense should be updated with the option to choose from ‘All’, 

‘Billed’, ‘Un-Billed’ or ‘None’.  

• Added the Payee column to ‘Accounts Reconciliation’ screen. 

• Invoice register report now provides an option to view draft invoices also. 

• Added the ‘Name’ column to ‘General Ledger-Extended’ report for vendor bill and 

other transactions. 

• CORE will now remember the search text in the any of the list views when the user 

navigates to the detail view and then navigate back to the list view. 

 

Other fixes: 

 

• Grouping the ‘Billing Forecast’ report by ‘Master Project’ would sometimes show 

incorrect billed amount for project phases on joint/combined invoices. This was 

fixed. 

• Overtime calculations were not consistent when using the Automatic Overtime 

feature versus the Overtime calculator. This was fixed. 

• When paying reimbursable expenses, users would get a "You cannot apply 

payments more than the pay amount" error. This was handled. 

• Added default sort to the Project column in the ‘Manual’ view of Allocation & 

Forecasting. 

• Project rule "Use rates from Activity Items screen" was re-labeled to clarify that it 

includes both cost and bill rates. 

• ‘Billing’ and ‘Manager’ Package users could see certain standard and custom 

financial accounting reports. This was prevented. 

• Using the Cloud Feeds > Find Match option would display a list of duplicate credit 

card payments entered in CORE. This was corrected. 



• Enabling the “Mark projects completed when 100% billed” in Global Setting would 

incorrectly update project phases on joint/combined invoices that were not billed 

100% of the contract amount. This was fixed. 

• Files added directly from the Documents or Purchase Orders screen would not get 

attached when a PO was emailed from the Email > Compose Mail screen. This was 

fixed. 

• When previewing a combined invoice, CORE would sometimes display incorrect PO 

number for projects with different PO numbers. This was corrected. 

• The Class assignment at the Project level would not be inherited by the project in 

the Edit Checks screen. This was fixed. 

• Employee Control ‘Billable’ flag setting was not being applied when creating 

transactions in the Checks, Credit Cards, Vendor Bills and Cloud Feeds screen. This 

was implemented. 

• Sort order was not remembered when refreshing some screens. This was fixed. 

• The Project Allocation and Employee Allocation Units reports would not show 

accurate data for allocation entries with no end date. This was fixed. 

• Memo added to a retainer invoice did not show up on previewing that invoice. This 

was corrected. 

• Employee Control was not being obeyed when using the Cloud Feeds > Find Match 

option. This was fixed. 

• Users were able to create purchase orders for ‘completed’ projects using Budgets > 

Create Purchase Orders option. This was fixed. 

• Updating the date of a check with linked time or expenses would also update the 

time and expense entry date. This was fixed. 

• Un-posted entries of accounts linked in Cloud Feeds were being included in the 

Cloud Feeds > Pending Transactions total. This was corrected. 

• Phased Invoice template would not display column headers on its second page. This 

was fixed. 

• When using the ‘As Of’ period filter in the Purchase Orders list screen, CORE would 

display duplicate POs when scrolling down to the next page of the list. This was 

fixed. 

• The on-screen Vendor Bill List report was applying the screen filters. This was fixed. 

• Help file was updated. 

• Several other minor general and report fixes were made. 

 

  



VERSION 1.1.132 RELEASED ON NOVEMBER 17, 2018 

What’s new in this version?  

This update addressed some critical issues and added a few enhancements. Most notable 

ones include: 

• Added the ‘Mailing Labels’ report with options to generate mailing labels from the 

client, project, employee and vendor address records. 

• Added the ‘Group Assignment’ report that displays assigned groups. This report can 

be run for projects, clients, employees, vendors, activity and expense codes. 

• A memorized report marked as public can now be customized by users other than 

the original author.  

• Scheduled reports can now be marked as public to make them available for other 

users. 

 

 

Other fixes: 

• Excluding a reimbursable expense in the Bill Payments screen would clear its 

‘Reimbursable’ flag. 

• There was no sort feature on the Memorized, Scheduled, Custom and Favorite tabs 

in the Reports screen. Also, the Group/Report grid list had an unnecessary 

Description field. That was removed. 

• Added the "Allow access to Custom Reports" security permission in the Security > 

Reports screen. 

• The Employee Control security permissions were not being implemented in the 

Checks and Credit Cards screen. 

• Employee Control was not being implemented in the Cloud Feeds screen. 

• Item level taxes on manual invoices would not show up in the Taxes report in some 

cases. 

• Credit-type, write-offs and debit payments were not being excluded from the Cash 

Flow widget calculations on the Dashboard. 

• The Expense Entries Multiplier field was editable for entries that were already paid 

or linked to vendor bills. 

• The Phased Invoice template did not include billable negative entries in its Grand 

Total calculations. 

• In the Project Assignments screen, the Project drop-down did not obey the Global 

Settings > User Interface > Display As settings. 

• Sometimes assigning an invoice template to the corresponding project from the 

Invoices > Preview > Choose Template screen would not save the new template 

setting. This happened to regular invoices as well as joint/combined invoices. 

• In the Account Reconciliation History screen, the Reconciled On date would not 

reflect the correct date when users actually did the reconciliation. 



• Notes in the Invoice Collections screen would not display in chronological order or 

sometimes would display blank values. 

• The ‘Retainer Details by Project’ report would not obey the "Payment Date As Of" 

filter. 

• In certain cases, HTML data would show up in the Time Detail memos while looking 

at the invoice details. 

• Purchase order reports would display duplicate or triplicate line items in case the 

vendors had two or three address records. 

• When adding attachments to an expense entry with filters on in the Expense Entries 

screen, it would remove the filters. 

• When changing the project Due Date label to a different value, the new label would 

not show up in the report filters. 

• At times, the Profit and Loss Accrual Basis report did not match the General Ledger 

report. 

• MYOB Record Mappings screen would display duplicate vendor bill entries in certain 

cases. 

• Column header did not remain fixed when scrolling down in the Cloud Feeds screen 

on both the Ignored and Included tab. 

• When combining invoices in the Create Batch Invoice screen, the % complete field 

would report a value above 100% in certain scenarios. 

• When exporting data using the More > Export to CSV option in Estimates, incorrect 

values were being exported. 

• The delay value set in the Allocation & Forecasting screen was not followed when 

the current task was a milestone and dependent on another task. 

• Errors would occur when making payments on a long list of invoices belonging to a 

single client. 

• When selecting a parent project to make a payment, a user was unable to see all the 

open invoices in the Payments screen. 

• Updated report templates. 

• Updated help file and documentation. 

• Several other enhancements and fixes were made. 

 

  



VERSION 1.1.131 RELEASED ON NOVEMBER 03, 2018 

What’s new in this version?  

This update addressed some critical issues and added a few enhancements. Most notable: 

• Added the much requested “Tax Tracking” report. This report lists taxes paid, 

collected and owed for each project. 

• Added search feature in “Create from existing budget” dialog in Budget screen. 

• Users now have the ability to clone a To-Do from the To-Do list under productivity 

tools. 

• Aging reports can now be grouped by originator, principal and project manager 

attributes of a project. 

• Added Time-off column to benefit usage list view in Employee. 

• Company Tax ID now uses a default mask of ‘XX-XXXXXXX’ for US companies. 

• Added enable/disable ‘Conflict checking’ option in Gantt Chart screen. 

• Users can now add multiple deposits and fund transfers using the ‘Save & Add New’ 

button. 

• Users can now preview attachments directly from the reviewer screen. 

 

Other fixes: 

 

• Allocation and Forecasting screen would incorrectly consider the accounting 

“Closing Date” of the company while making and updating task allocations. This was 

corrected. 

• Cloud Feeds balance column was not updating the balance column upon refresh. 

This was fixed. 

• Cloud feeds refresh would fail in scenarios where the user had connected non-

monetary accounts like rewards. This was corrected. 

• AP aging report would not reflect the credits used to pay vendor bills and show 

them as unpaid. This was fixed. 

• When using currency “Smart Fields”, currency fields were not properly formatted. 

This was fixed 

•  ‘Retainer Invoice’ would show incorrect client contact details under some scenarios. 

This was fixed. 

• The ‘Time Card Week View’ report would display data in incorrect week order for 

some users. This was fixed. 

• Phased Invoices for recurring contract type projects would incorrectly include time 

and expense details along with the recurring amount. This was corrected.  

• ‘Percentage Billed’ report would show a different contract balance when compared 

to the project structure screen. This was corrected. 

• Chart of Accounts screen would fail to retrieve all the sub-accounts upon list scroll. 

This was corrected. 



• Notifications related to Invoices submittal or approval would at times fail to 

generate. This was fixed. 

• Duplicate Vendor bills would appear in ‘Bill Payments’ screen under some rare 

scenarios. It was fixed. 

• Journal report would not consider purchase tax against a credit card entry. This was 

corrected. 

• Added the ability to sort ‘find match’ list of ‘Cloud Feeds’ screen. 

• Added new security setting ‘Show Salary Amount’ to control access to salary amount 

field in Employee screen. 

• Users with time and expense only subscription would fail to access the ‘Employee 

Half Monthly Time Card ‘report. This was fixed. 

• Items automatically reconciled by bank feed were not being flagged as cleared. This 

was corrected. 

• Statement of Cash Flows report would incorrectly include General Journal entry. This 

was corrected. 

• When selecting all invoices to show up on Statement reports, fully paid invoices 

would not show up. This was fixed 

• Updated reports for performance and bug fixes.  

• Updated documentation.  

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 

VERSION 1.1.130 RELEASED ON OCTOBER 20, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable: 

• Added the much requested, “Statement by Client (Accountant)” report that can be 

shared with clients with a listing of unpaid invoices and tear off section to remit 

payments. 

• Added the ability to show or hide the Invoice Number column in the Time and 

Expense Entry screens. 

• Added grand total to the amount column in the Payment screen. 

• The default duration for a new calendar event has been changed to one hour. 

• Added Date, Submittal Type and Project "Group By" report options to the Workflow 

Detail report. 

• The connection history list in integrations area can now be sorted by date. 

• The integrations area was refreshed with new design to comply with third party 

integration guidelines. 

 



Other fixes: 

 

• Sending tax invoices to Xero would create double tax invoices in Xero in certain 

scenarios. This was fixed. 

• The ID column in the Create from Existing Estimate screen would not accommodate 

long estimate names. This was corrected. 

• In certain scenarios, exporting an invoice to PDF would add an extra item, unit and 

amount column headers. This was fixed. 

• Manual invoices would create duplicate values in the Activity Performance Widget in 

some scenarios. This was fixed. 

• Projects with the "Prevent time entry for the project" project rule enabled, would 

not show up in the Add Checks>Project column dropdown list. This was fixed. 

• Exporting invoice records from the Invoices screen to CSV now includes Client 

column data. 

• Top N Expenses report would show incorrect report title in certain situations. 

•  Used Percentage column would incorrectly round below .5% usage to 0%. This was 

fixed. 

• In certain scenarios, the Auto Apply feature in the Payment screen would not work 

when editing a payment for 2 or more invoices. 

• When creating a Retainer Invoice with no due date, it did not display 'due upon 

receipt' under terms. This was fixed. 

• Deleting or voiding a NSF payment would create a negative invoice balance in 

certain scenarios. This was fixed. 

• Vendor screen filters were not being obeyed when previewing on-screen reports. 

This was fixed. 

• Summary total failed to update when adding a new allocation value in Allocation & 

Forecasting-Forecasting>Manual View. This was fixed. 

• Purchase Order screen filtered by vendor did not get applied to the "Purchase Order 

Time and Expense Details" report. This was fixed. 

• Column headers would not display as you scroll down the Security Profiles screen. 

This was fixed. 

• Group filters applied to Client, Employee and Project screens were not applied when 

running on-screen reports. This was fixed. 

• Journal report would show General Journal detail as negative debit value instead of 

a credit value in some scenarios. This was fixed. 

• Clicking yes to "Invoice includes vendor bill(s) would you like to review" Payment 

screen message would redirect to the Bill Payment screen. This was fixed. 

• In a scenario where ‘Project ID - Name' or 'Name-Project ID' value was more than 15 

characters, the forecasting screen was unable to display all of its columns. This was 

fixed. 

• The Status filter in the Submittal and Drawing screens was not being applied when 

running their respective on-screen reports. 



• Start and end date filters in the Benefit List screen were not being applied when 

running HR Benefit List on-screen report. This was fixed.  

• Time and Expense on-screen report did not use Vendor group filter in the Reviewer 

screen. This was fixed. 

• Spent column of Project contract status incorrectly included unapproved time and 

expense. This was fixed. 

• Line item total in LEDES 1998B file did not include expense entry markup. This was 

fixed. 

• Incorrect data issue when using a Client date type custom field when mapping the 

LEDES 1998B CLIENT_MATTER_ID. This was fixed. 

• Journal report would show incorrect debits and credits for Credit card refunds and 

credits. This was fixed. 

• Journal report was not correctly handling an invoice that had negative expense. This 

was corrected. 

• An unintended “[]” line terminator would show on every invoice line item when 

exporting a LEDES 1998B file. This was fixed. 

• “To Do” widget did not display vendor records in the “Assigned to” filter drop-down 

list. This was fixed. 

• Getting QuickBooks Online “Projects” to CORE and sending phases created under 

these projects to QuickBooks Online would error out. This was fixed. 

• Statement reports would incorrectly show all invoices instead of open invoices only. 

This was fixed. 

• Work In Hand report now sorts the Group by option alphabetically. 

• Getting MYOB AccountRight Project that had "Project Manager" Display As values 

that were not linked with a CORE employee record, would create additional 

employee records. This was fixed. 

• Updated reports for performance and bug fixes.  

• Updated documentation. 

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

  



VERSION 1.1.129 RELEASED ON OCTOBER 06, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable 

ones are: 

• Added a new report to track benefit usage. The report calculates earned, used and 

remaining benefits for employees. 

• The ‘AP Reconciliation’ report would not include un-cleared transactions. This was 

fixed. 

• An issue in the project structure view would in-correctly set the project contract 

amount to 0. This was fixed. 

• Certain Canadian customers would receive errors when scheduling a report. This 

was fixed. 

• Project List screen would not remember sort order when refreshing the screen. This 

was fixed. 

• Creating a new project structure using templates would not copy project 

assignments for the new structure. This was fixed. 

•  ‘Overdue Invoices’ report was updated to display the name of projects on when 

showing a joint invoice records. 

• The statement report would not obey the name that was set in the Global Setting 

screen using smart fields. This was fixed. 

• Fixed certain scenarios when Time Entry, Expense Entry and PTO Request Records 

would have a default to yesterday’s date instead of current date. This was corrected. 

• Resolved accounting mismatch on the Journal report for checks having positive and 

negative check line entries. 

• LEDES export now allows to associate either Client Id or Matter ID to client matter. 

• ‘Monthly Billing Statement’ report was fixed to not include retainer amounts applied 

during invoice creation. 

• ‘Statement of Cash Flows’ report would not obey the period 'Last week' filter. This 

was fixed. 

• Fixed an issue where cancelling a ‘create project from template’ action would still 

create the project structure. 

• Fixed issue where batch updating the invoice date would not update the underlying 

transaction date. This was fixed. 

• A certain bug would not allow statements to preview. This was fixed. 

• The ‘Budget Comparison by Employee’ report would incorrectly show 'Employee 

Name' instead of 'Employee Title' when viewed by title. This was corrected. 

• Updated Allocation and Forecasting report to display non-allocation 'Other Tasks' as 

a positive number instead of a negative one.  

• Custom Invoice template would not preview in Invoice Collections screen. This was 

fixed 



• Under some certain scenarios, un-cleared unreconciled transactions would show as 

cleared in Accounts Reconciliation screen. 

• A user with billing subscription but missing Manager Subscription was not able to 

filter invoices for projects. This was corrected. 

• Creating a report scheduling record would require at least one filter. This was 

corrected 

• Updated reports for performance and bug fixes.  

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 

VERSION 1.1.128.0 RELEASED ON SEPTEMBER 14, 2018 

What’s new in this version? 

Introducing CORE HR beta! CORE now offers powerful HR management features such as: 

• Benefits assignment and usage 

• Salary change and history 

CORE's HR feature gives managers the ability to track and regulate employee benefits, 

salary reviews and much more.  

 

We value your feedback, so if you have something to share then email us at 

corehr.feedback@bqe.com 

This update also addressed some critical issues and added a few enhancements. Most 

notable ones are: 

• Project Managers can now preview an invoice from the Project Transactions tab. 

• The pending transaction state of cloud feeds would cause the feeds to duplicate in 

CORE. It was corrected. 

• The ‘Law Firm ID’ and ‘Invoice Description’ fields were not getting populated on the 

LEDES export file. This was corrected. 

• ‘Law Firm Matter ID’ field was incorrectly considering the Global Settings >LEDES-

>Client ID and Project ID mapping settings. This is now mapped to the Project ID 

field. 

• 'Info Bar' of the Personal Time Off Requests screen would not default to the current 

YTD range. This was corrected. 

• Added various 'Transaction Type' filters to the 'General Ledger' report. 

mailto:corehr.feedback@bqe.com


• There was a data mismatch between 'General Ledger' and 'General Ledger 

Extended' reports in certain user company scenarios 

• Added period filter ‘Last Two Weeks’ in the Reports screen. 

•  The initial load performance for ‘'Time and Expense'’ report was optimized for large 

data files. 

• In certain scenarios, the user preference setting ‘Auto-fill Time Card with the last x 

projects/activities' would not display all time entries an end user entered in the Time 

Card. This was fixed. 

• The 'Contract Employee’ filter is now added to the 'Project Performance' report. 

• CORE would incorrectly change Workflow Status from 'Submitted' to 'Forward' or 

'Forward' to 'Submitted' when submitting a time entry multiple times. 

• The 'Client Transaction' report displayed no data when using 'All Dates' or 'As Of' 

date filters.  

• The 'Trial Balance Accrual' report would create duplicate entries when exporting to 

CSV file. 

• Formatting issues occurred when emailing or printing certain statement reports 

using reports options. These issues were found in the 'Reports' and 'Statements' 

screens. 

• Invoice Date would not default to the current date for our Australian region users. 

This would happen when creating invoices in both Create Batch Invoice and Manual 

Invoice screens. This was fixed. 

• The 'Percentage Billed' report showed incorrect 'Contract Bal' and '% Billed' column 

data in certain scenarios. This was corrected. 

• 'Credit' and 'Write off' payment types were not being sent to Xero during data 

integration. This was fixed. 

• When creating a new budget from an existing budget, the 'Create from Existing 

Budget' screen would not allow sorting. This was fixed. 

• Renamed 'Project Allocation Units Spent Forecast' report to 'Project Allocation Units 

Spent Distributive Forecast' and 'Project Allocation Earned Revenue Distributive 

Forecast' report added. 

• Added ‘Manager’ field to the Batch Update screen in ‘Projects’. 

• Updated reports for performance and bug fixes.  

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 



VERSION 1.1.127 RELEASED ON SEPTEMBER 01, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable 

ones are: 

• ‘General Ledger’ report load performance optimized for large data files. 

• Joint invoices would sometimes incorrectly round tax amounts.  

• Scheduled ‘Time Card Week View’ report would not obey filters.  

• ‘Bill Payment Credits Available’ and ‘Total Credits Used’ columns would not update 

when using the credits in the ‘Create Bill Payments’ screen.  

• Performing any actions in ‘Expense Details’ tab and then undoing these actions 

would cause the ‘Invoices’ screen to freeze. This was fixed. 

• ‘Fixed Fee – Accounting’ invoice templates would display HTML markup text instead 

of actual text on the Invoice field.  

• Certain ArchiOffice migrated company files would get duplicate invoices. 

• CORE project names with colons sent to MYOB projects would have incorrect project 

name values.  

• CORE would not remember ‘Show Entry Details’ setting when enabled for the end 

user in the Time Card screen. 

• In certain cases, having the Time Entries and Invoices screens open in two separate 

browser tabs would incorrectly show time entries as billed (status). This would 

happen when deleting an invoice and updating “billed” time entries in the Time 

Entries screen.  

• Parent project name having apostrophe would sometimes not show its phases in 

the ‘Create Batch Invoice’ screen when using the Filter by > Project > Individual 

Items. 

• ‘Project Contract Status’ report would not obey Project Status filter.  

• ‘Work in Progress Details’ report did not show the correct project manager in the 

Project field. 

• ‘Automatically assign this template to corresponding project’ option in Choose 

Template dialog in Invoices screen was not working.  

• In the Allocated Hours report, the ‘Assigned Hours’ and ‘Consumed Hours’ columns 

would show incorrect data in some cases.  

• Added tool-tip to the Class field in the Edit Check screen. 

• In the ‘Statement of Cash Flows’ report, the ‘Net Income’ field did not reconcile with 

the Profit & Loss report. 

• Added search capability to the ‘Email Recipients’ drop-down list when scheduling 

reports. 

• ‘AP Reconciliation Discrepancies’ report would not obey the ‘Accounts’ filter. 

• Invoices would disappear in the ‘Invoice Collections’ screen when showing ‘Closed’ 

invoices and changing the ‘Period’ filter.  

• ‘Vendor Bill List’ report would incorrectly show client hours instead of actual hours. 



• Batch Update would cause billing contacts to be removed in some cases in project 

screen. This was fixed. 

• Xero duplicate invoices were being created in certain scenarios when sending joint 

invoices and then sending payments on joint invoices to Xero. 

• When the user had a lot of bills to pay in the ‘Create Bill Payment’ screen, sorting by 

Payee caused ‘Page Unresponsive’ errors. Also, the ‘Print Checks’ screen became 

unusable. This was optimized. 

• ‘General Ledger’, ‘General Ledger Extended’ & ‘Trial Balance’ reports did not display 

‘Cash Type’ journal entries. 

• Projects with type ‘main’ look visually distinct now (greyed out and bold) in the 

‘Payments’, ‘Invoices’ and ‘Create Batch Invoice’ screens.  

• ‘Firm Reconciliation’ report would not show data when using the ‘Invoice Date’ filter. 

• Billing a ‘Fixed’ contract type project to 100% that also has extra time entry amount 

did not add the extra amount to the invoice created. Only the 100% contract 

amount got billed. This was fixed. 

• ‘Personal Time Off Requests’ screen ‘Info Bar’ would not obey the ‘Submitted’, 

’Rejected’ and ‘Approved’ filters.  

• Applying an ‘Interest Charge’ in the Account Reconciliations screen would not let 

user reconcile the account.  

• Users could not delete project structures because certain phases with ‘Hold’ project 

status would not show up in the Project list. This was fixed. 

• Allocation reports now obey the ‘First day of the week’ global setting.  

• Removed duplicate ‘Is Active’ filter for the ‘Purchase Order Invoice’ report.  

• Few customers were not able to add Google Drive as cloud storage destination. This 

was fixed 

• Bug fixes and stability improvements. 

_____________________________________________________ 

 

VERSION 1.1.126 RELEASED ON AUGUST 18, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable 

ones are: 

• Added new security setting to control access to bill and cost rate column in Fee 

Schedule screen. 

• The Invoice Collections screen now allows you to view the ‘Workflow History’ along 

with other transaction details. 

• Sending Vendor Bills to QuickBooks would skip if there were no project associations. 

We have improved sync error handling and logging; the log file now says which 

projects failed during the sync. 



• Added ‘Contract Type’ filter to all time and expense reports. 

• The period filter ‘Last Month’ would incorrectly display dates on the reports. This 

was corrected. 

• For Check Details report, the ‘Check Number’ filter drop-down would incorrectly 

show ‘To Be Printed’. This was corrected. 

•  ‘Message on Invoice’ field with long text would not display properly on Clients 

screen.  

• Creating a new project from a template with phases would not copy the phase 

structure project name from the template to the new project structure. This was 

fixed. 

• Revised Name and Description of many CORE invoice templates. 

• Users were unable to apply any filter in the Statements screen. This was fixed. 

• Added ‘Check Number’ filter to the ‘Expense Details’ report. 

• Adding a new allocation in the ‘Allocation & Forecasting’ screen using the keyboard 

would throw an error. This was fixed. 

• Client contact details like ‘Email’ and ‘Phone’ would not show up in the ‘Invoice 

Collections’ list view. This was fixed. 

• CORE® would fail to import a large number of invoices from Xero®. This was fixed. 

• ‘Company YTD Comparison’ report would not respect the Fiscal Year dates for both 

previous and current year. This was fixed. 

• ‘Project Performance’ widget on the Dashboard would allow everyone to see the 

projects even though their security setting ‘Allow Access to other Managers Data’ 

prevented it. This was fixed. 

• Under some rare conditions, editing a Purchase Order line item would sometimes 

duplicate the ‘Line Number’ of the entry. This was fixed. 

• The text under ‘Class’ dropdown list would appear truncated in ‘Edit Check’ screen. 

This was fixed. 

• ‘Balance Due’ field in Invoices would sometimes display the incorrect amount due to 

rounding issue. It is corrected now. 

• Using the From-To range filters would not send records to QuickBooks. This is fixed 

now. 

• Sending retainer payments created in CORE to MYOB would fail. This was fixed. 

• Syncing joint invoices from CORE to Xero would remain unlinked in CORE and get 

duplicated in Xero. This was fixed. 

• After getting MYOB Vendor Bills of Service and Professional types into CORE, if you 

re-sync them to MYOB, instead of overwriting, it would create duplicates in MYOB. 

This was fixed. 

• Accounts Payable report in the Registers screen would not respect Net Terms set in 

Vendor Bills. It would always show Term Net 30. This was fixed. 

•  ‘Purchase Order Time and Expense Details’ report would not respect the screen 

filter ‘Due Date’ and ‘Workflow Status’ filters. This was fixed. 

• Duplicate entries showed up when there were more than 25 checks in the Recurring 

Checks screen. This was fixed. 



• ‘Client Retainer Summary’ report would not display correct Retainer Used totals 

when using client and project retainers. This was fixed. 

• ‘General Ledger’ report did not display corresponding transactions when using the 

Time Entry Date filter. This was fixed. 

• When trying to update the Payee of a check through the Bank Account register, it 

did not update. This could be seen when editing the same check in the Edit Check 

screen. This was fixed. 

• With the LEDES setting ‘Send item level sales tax as a separate line item’, tax amount 

was displayed twice on the export file. This was fixed. 

• Changing the ‘State’ custom label would incorrectly apply the change to the screens 

and reports. This was fixed. 

• Project Retainer Available would not get displayed when creating payment via the 

Project drop-down option. This was fixed. 

• Selecting multiple draft invoices and exporting to LEDES 1998B format would display 

the same invoice number for all the records in the export file. Also, there was no 

way to differentiate between finalized and draft invoices when using LEDES 1998B 

format. This was fixed. 

• Changing project’s A/R account including existing invoices and payments did not 

change the Payment’s A/R account. This was fixed. 

• ‘Send attachments as single file’ setting would incorrectly include the invoice PDF file 

inside the zipped folder. Invoice pdf file should be separate from the zip file. This 

was fixed. 

• Updated reports for performance and bug fixes.  

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 

VERSION 1.1.125 RELEASED ON AUGUST 04, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable: 

• Users with privileged access can now manage timers for all users in the timer list 

view. 

• Added new security setting to control access to bill and cost rate column in budgets 

and estimates. 

• Employee missing time report was improved to only show employees that have not 

met the required daily hours specified for them in the Employee screen. The report 

also looks at the work days specified in the global settings to determine which 

employees are missing time for the specified week. 



•  Export to Excel feature for reports received a major overhaul to handle numeric 

and currency fields. Users can now use the excel output to create summary columns 

or add their own formulae. This update applies this fix to selected reports like 

Contract Analysis, Account Transactions and all PL reports. 

• This update adds a critical fix to a persistent issue which forced some of the users to 

clear their local cache immediately after an update.  

• Project structure tab in Project detail view was not able to correctly roll up spent and 

other amounts for a project structure that had main projects at a hierarchical level 

other than the top. This was fixed. 

• Scheduled tab in the reports area was not respecting custom labels. This was fixed. 

• Time expense reviewer would show duplicate rows after a sort was performed and 

the user would scroll to retrieve another page of results. This was corrected. 

• Memorizing a vendor bill with multiple accounts line items would duplicate the line 

items when processed. This was fixed. 

• A rare scenario in the time card would cause duplicate time entries being saved. 

This was fixed. 

• PTO InfoBar would incorrectly show zero values when submittal filters were applied 

to the list. This was fixed. 

• Overtime calculator would repeat time entries on progressive scroll of the list if no 

sort option was provide by the user. This was fixed. 

• Time and expense by parent project reports would not respect any filters provided 

by the user. This was fixed. 

• Screen reports in the reviewer screen did not respect the class filters. This was 

corrected. 

• Screen reports in the Credit memo screen did not respect any filters. This was 

corrected. 

• “Run Schedule” option for schedule reports would incorrectly zip the report pdf if 

the global setting, “Automatically zip multiple attachments” was checked. This was 

fixed. 

• Updated reports for performance and bug fixes. 

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 

VERSION 1.1.124 RELEASED ON JULY 20, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable: 

• Dashboard widgets now allow users to specify custom date ranges. 

• Time and expense entry screens now prefill the date field with the today’s date 

while creating a new entry. 



• This update implements an API engine enhancement that mitigates most issues 

related to concurrent record update scenarios. 

• Workflow accordion was added to Invoices, Vendor bills and Purchase orders. 

• Added Project Manager Column to Invoice list view. 

• Added the much requested “Missing Time” report to allow managers to actively 

monitor time card completion. 

• Funds transfer screen would limit the user to 25 records only. This was corrected. 

• Batch update of “Automatic overtime” field in Employee list view now allows to turn 

off this setting for one or more users. 

• Implemented wild card based search in assign screen of groups.  

• Account reconciliation screen would omit transactions of type “credit card credit”. 

This was corrected. 

• Work flow details report was enhanced to provide users with detailed log of 

submit/approve history. 

• Implemented a real time progress indicator for Xero sync. 

• Xero integration sync settings would not obey the filters specified by the user. This 

was fixed. 

• Xero integration would fail to retrieve all the records from the corresponding Xero 

module and restrict the sync to just 100 records. This was fixed 

• Project template edit view would not allow users to choose a custom invoice 

template. This was corrected. 

• Time entries send to QuickBooks were not being correctly calculated into hours in 

HH:MM format. This was corrected. 

• Payment list view would not load all historical payments when the list was filtered by 

a custom date range. This was corrected. 

• Batch update of “Message on Invoice” for selected projects would restrict users to 

message of certain length. This was fixed. 

• Activity list view would fail to retrieve all records if a batch update was performed. 

This was fixed. 

• An issue in the invited user on-boarding was preventing users from signing in after 

accepting the invite. This was fixed. 

• Completed projects were appearing in create new recurring invoice screen. This was 

fixed. 

• Top 10 revenue report would display duplicate filters. This was corrected. 

• Classification dropdown was missing the ability to sort. This was fixed. 

• Updating a project for an existing entry in Time card would not use the correct rates 

and classification, if the project had a fee schedule or an assignment. This was fixed. 

• Updated reports for performance and bug fixes. 

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 



VERSION 1.1.123 RELEASED ON JULY 6, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable: 

• Time card screen now allows users to view submittal status of an entry using 

specific icons. 

• Record mapping section added to CORE-Xero Account integration module. 

• Added two new Manual invoice templates: 

▪ With tax and percent complete  

▪ With Contract Summary 

• Added the ability to quick search, apply filters and sort the various columns in 

Deposit detail view. 

• Added descriptive legends in some specific reports that elaborate on the formulae 

used to calculate certain amount fields. e.g. Billing Analysis, Earned Value etc. 

• Certain project rules were not being applied to the parent project when using batch 

change. This was corrected. 

• Exporting a large list of vendor bills for CSV export would fail for certain users. This 

feature was optimized for performance, 

• Project detail view would show the Project name in the bread crumb instead of the 

display as. This was corrected. 

• Creating a new fee schedule from an existing schedule would not show the fee 

schedule list in any order. This was corrected. 

• CORE transactions shown in the vendor, transactions tab were being limited to 25 

records. This was corrected. 

• Retainer transaction shown in the Client, transactions tab were being limited to 25 

records. This was corrected. 

• Certain invoice templates did not respect the Project display as settings specified in 

the global settings. This was corrected. 

• Added the ability to attach multiple documents in the report viewer. 

• Added Project Performance and Firm reconciliation report to billing and manager 

subscriptions. 

• Security permission screen would also show inactive employees. This was corrected. 

• A certain scenario involving mid-way rounding was causing issues in the charge 

amount field of expense log. This was corrected. 

• Filter dropdowns would not follow the recently introduced sort order feature in 

memorized, favorite and scheduled reports tab. This was fixed. 

• Timer icons in the utility bar would indicate an incorrect badge number in certain 

scenarios. This was corrected. 

• Creating a new project or projects based on project template with hierarchy would 

not inherit the correct project or phase name. This was corrected. 

• A certain scenario would cause the cloud feeds, find match to not function as 

expected. This was fixed 



• Added a switch to control if details should show up for group reports. 

• Updated reports for performance and bug fixes. 

• Updated help content. 

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 

VERSION 1.1.122 RELEASED ON JUNE 14, 2018 

What’s new in this version? 

This update addressed some critical issues and added a few enhancements. Most notable: 

• Record mapping section added to CORE-MYOB Account Right integration. 

• Added a new global setting that enables users to send multiples attachments as a 

single file in zip file format. 

• Ability to preview invoices and other reports from the transaction tab in Projects. 

• Added a new OT filter in Reviewer. 

• Added “Phase Id-Phase Name” as a Project display option. 

• Group detail views had performance issues and did not implement progressive 

scrolling. This was fixed. 

• Statement module was not part of the Billing package. This was corrected. 

• Report and screen filters are now sorted alphabetically. 

• Added Google captcha validation at specific places in the application to enhance 

security. 

• Simplified the way application handles decimal precision for the amount fields. Now 

all amounts in CORE would follow a fixed precision of 2 places of decimal. 

• Cloud feeds reports are now accessible from the Cloud feeds screen. 

• Custom fields would not appear on the concerned reports. This was corrected. 

• Bill payment screen was optimized for performance. 

• Retainer balances widget would not take retainer refunds into consideration. This 

was fixed. 

• Existing tasks when copied from a project would not inherit the task follows 

attribute. This was corrected. 

• Updated reports for performance and bug fixes. 

• Updated help content. 

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 



VERSION 1.1.121 RELEASED ON JUNE 1, 2018 

What’s new in this version? 

This update addressed some critical issues esp. related to performance. Most notable: 

• Faster, leaner Time Card: CORE Time Card has been re-designed from scratch to 

allow for faster performance and Ajax based save. The app no longer imposes any 

limit on the number of time entries that can be shown per week and uses a 

combination of Ajax and progressive scroll to provide the best user experience. 

• Optimized batch change feature for Project, Client and Time and expense entry for 

performance. Also, Update rates and Project clone features were tweaked to 

improve performance. 

• Creating a time entry from a timer would take longer than expected. This was fixed. 

• Adding a new activity would take a long time if the activity list had over 200 entries. 

This was fixed. 

• Deleting existing deposit entries would take a long time if the action was performed 

for a batch of entries. This was fixed. 

• Added a new batch action to download documents. 

• Project structure tab in Project detail view was not calculating some parent level 

numbers correctly. This was corrected. 

• Paid filter in vendor bills would not work as expected and would fail to reflect bills 

that were fully or partially settled using vendor credits. This was fixed. 

• An issue with un-assign feature in budgets and estimates was causing the affected 

projects to also get reset for the assigned fee schedule. This was fixed. 

• CORE now remembers the show info bar setting in project, client and other lists. 

• CORE would send subscription notifications to all owner and admin accounts set for 

the company. This was changed to only send notification to the owner account. 

• Certain scheduled reports would fail to run if processed directly from CORE. This 

was fixed. 

• Budget details would sort the line items erratically after a new line item was added. 

This was corrected. 

• Fee schedules rates for expense codes were not being respected when update rates 

action was performed from the time and expense reviewer. This was corrected. 

• Users with billing subscription were not able to access purchase order module. This 

was fixed. 

• Time and expense entries that were approved for Payroll only were being un-

necessarily locked when the project was processed in batch invoicing. This was 

fixed. 

• Invoice number filter would show repeat the numbers for joint invoices. This was 

fixed. 

• Retainer list would not show the list if a client or a project was selected in the filter 

dropdown. This was fixed. 



• A recent change had caused the payment disbursement feature to fail. This was 

corrected. 

• Some users were facing issues with creating batch invoices for projects that had 

entries with multiple workflow types. This was fixed. 

• QuickBooks Online sync would incorrectly create retainer payments for payments 

that were brought over and did not have the underlying invoice in CORE. This was 

fixed. 

• Documents widget would not allow users to download the documents and would 

fail. This was fixed. 

• Users with restricted security for approving invoices were able to approve invoices. 

This was fixed. 

• Parent entry in General Journal would not be shown as the first entry in the General 

Journal detail view after a sort was performed. This was corrected. 

• Users were able to email Purchase order and vendor bill reports even if they did not 

have the appropriate security. This was fixed. 

• Expense entry cost was being reset to zero if the user changed the project or 

expense id. This was fixed. 

• A recent change had caused the custom fields to fail update. This was fixed. 

• Numerous other bug fixes and optimizations. 

 

_____________________________________________________ 

 

VERSION 1.1.120 RELEASED ON MAY 25, 2018 (HOT FIX) 

What’s new in this version? 

 

• Project, Transaction tab would fail to show more than 25 records. This was fixed. 

• Project structure, Balance column was not excluding the extra amount. This was 

corrected. 

• Get invoices from QuickBooks was not able to handle a very large list of invoices and 

would time out. This was fixed. 

• Existing time entries could not be assigned to a Joint invoice from the Time Entry, 

batch change screen. This was fixed.  

• Automatic billing would fail to inherit the billing memo when the invoice was 

processed. This was corrected. 

• Expense by vendor report would not work with account filters. This was fixed. 

 

_____________________________________________________ 

 



  



VERSION 1.1.119 RELEASED ON MAY 23, 2018 (HOT FIX) 

What’s new in this version? 

• Amount applied field in Create new payment was being auto filled with a value 

when a user scrolled the list of invoices while creating a new AR payment. This was 

fixed. 

• Time card reports would show data outside the designated filters when launched 

from the Time card screen. This was fixed. 

• Create new payment screen would un-necessarily show paid invoices along with the 

un-paid invoices. This was corrected. 

• Create new payment screen was missing certain column headers. This was 

corrected. 

_____________________________________________________ 

 

VERSION 1.1.118 RELEASED ON MAY 21, 2018 

What’s new in this version? 

This update addressed some performance and other issues. Most notable: 

• Manage priority screen in fee schedules, service and expense detail view would only 

allow users to manage the first 25 rows. This was fixed. 

• Employee control, add project would fail to show all the phases if they exceeded a 

certain number. This was corrected. 

• Assigning fee schedule to projects would restrict the list to top 25 records. This was 

fixed. 

• Bill number dropdown in create new bill payment was not optimized to handle a 

large list of vendor bills. This was fixed. 

• Create new bill payment was optimized to handle a large set of payments. 

• Create new check would get un-responsive if a large list of existing reimbursable 

charges was imported. This was fixed. 

• Process automatic/memorized billing on user login was optimized for performance. 

• Recipient dialog in report scheduling would not show the associated email address. 

Also, contacts that did not have a valid email address associated to them would also 

show up. Both these issues were fixed.  

• Users were not allowed to add payments to projects that were marked as 

completed. This was fixed. 

• Emailing a joint invoice to a client would un-necessarily add the client email address 

multiple times in the “To” field of the email compose screen. This was fixed. 

• Global search had stopped working due to a recent code change. This was fixed. 



• QuickBooks record mapping would not work as expected if one or more synced 

records were deleted in QuickBooks. This was fixed. 

• Update rates in Reviewer would in-correctly set expense rates to zero if the 

associated expense record did not have a valid cost rate. This was fixed. 

• Users were able to modify existing entries in vendor credit even if their date would 

fall before the closing date of the company. This was corrected. 

• Time or expense entries that were excluded from billing in “create new batch 

invoice” screen would stay locked even after billing was completed. This was fixed. 

• Users were able to modify their CORE login (email address) in User profile screen. 

This was fixed. 

• Users were not able to create allocations from a budget if the budget did not have 

at least one service line. This was corrected. 

• Numerous other bug fixes and performance improvements. 

 

_____________________________________________________ 

 

VERSION 1.1.117 RELEASED ON MAY 4, 2018 

What’s new in this version? 

Introducing integration with popular cloud storage services- Box and OneDrive: CORE users 

can now integrate with the popular cloud storage providers, Box and OneDrive to store and 

manage documents. 

This update also offered few other enhancements and fixes. Most notable: 

• CORE users who use QuickBooks integration can now set up account and tax codes 

at the project and Project group level. 

• CORE now aggregates help content from multiple sources, to provide quick and easy 

to find help topics. 

• A brand new Cost plus Contract rates report that calculates indirect rates based on 

cost pools for Cost plus contract type. 

• Added Parent project column to QuickBooks Online project mappings. 

• Several users had reported issues related to filters across many CORE lists. This was 

fixed. 

• Numerous other bug fixes and performance improvements. 

 

_____________________________________________________ 

 

  



VERSION 1.1.116 RELEASED ON APRIL 27, 2018 

What’s new in this version? 

• CORE reports can now be filtered by groups.  

• CORE invoice templates can now be set up to show client retainer summary 

information.  

• Added Project manager/Parent Project filter to all project reports. 

• Report performance optimizations across numerous reports. The most notable are 

Balance sheet, Profit and loss, Trial balance and Check details reports. 

• The country field on account sign up and create company now defaults to United 

States. 

• Added few important reports: 

o Cloud feeds 

o Connected banks. 

• Ability to sort General Journal details view by any visible column. 

• The overdue column in invoices would not show the correct value. This was 

corrected. 

• Time and expense details in Create new vendor bill can now be sorted by all visible 

columns. 

• Some users had issues with filters in Dashboard widgets. This was fixed. 

• Profit profitability widget in project performance view had an issue and would not 

show any data. This was corrected. 

• Scheduled reports were missing filter information. This was corrected. 

• Project groups filter was not working as expected in the create batch invoices 

screen. This was fixed. 

• COA info bar would not refresh when a quick search was issued. This was fixed. 

• Numerous other bug fixes and performance optimizations. 

 

_____________________________________________________ 

 

VERSION 1.1.115 RELEASED ON APRIL 14, 2018 

What’s new in this version? 

• Create batch invoices screen now supports discrete filters. Users can choose 

individual projects, managers, clients or groups to generate invoices based on 

approved WIP, recurring frequency or billing schedules. Previously, the filter options 

were limited to ranges only. 

• Added line number re-ordering in create manual invoice screen. 

• Added the ability for invoices to show Tax Id the in invoice header section. 

Australia/NZ would see this field appear as ABN #. 



• Allow users to specify times of the day in military format. This applies to start and 

stop times in time entry and calendar events and this option is provided as user 

preference. 

• Added a brand new global setting to specify the default discount account 

• Cost pool list now supports re-ordering of existing cost pools. 

• Users can now specify the class field while creating a new deposit. 

• Manual invoices line items that are inherited from budgets and estimates are now 

sorted by activity/expense code. 

• CORE was not able email invoices that had attachments over a certain size. This was 

fixed. 

• A period character in the invoice number was causing the invoice list to not load 

properly. This was fixed. 

• Check printing screen would use the employee “display as” instead of the employee 

name (or company name for vendor). This was fixed. 

• Vendor transaction history would just show checks that were used to pay bills for 

the vendor and skip checks that were directly cut for the vendor. This was fixed. 

• Project dropdown in create checks and credit cards would bring all items and not 

respect the project assignments. This was fixed. 

• Project performance widget now rolls up by parent project. 

• Users were not able enter employee birth dates for any date before 1970. This was 

corrected. 

• Bug fixing and stability. 

 

_____________________________________________________ 

 

VERSION 1.1.114 RELEASED ON APRIL 6, 2018 

What’s new in this version? 

• Implemented Get all and Send all for AccountRight integration. 

• Invoice list in create new payments is now sortable by all columns. 

• Added the following new reports  

• Payment Receipt  

• Credit Payment Receipt  

• Refund Retainer Receipt 

• Project Account Details 

• Added new filters to few important CORE reports. 

• Expense entries marked as paid would still appear in create new vendor bill screen 

if the user chose to select from existing time and expense for the vendor. This was 

fixed. 



• Draft invoices were being incorrectly marked as posted when emailed. This was 

corrected. 

• COA screen info bar was not looking at provided filters. This was fixed. 

• Quick payment for an existing invoice would open the payment screen even though 

the user was not permitted to create a new payment. This was fixed. 

• COA screen had issues when sorting by the account number field when the account 

numbers was pure numeric. This was fixed. 

• A user scenario was causing the print checks module to repeat check numbers. This 

was corrected. 

• A manual invoice being created out of an estimate would lose the sort ordering if it 

was saved as draft. This was corrected. 

• Descriptive text for some reminder and notification settings were re-phrased to 

describe the settings correctly. 

• Bug fixing and stability. 

 

_____________________________________________________ 

 

VERSION 1.1.113 RELEASED ON APRIL 2, 2018 (HOT FIX) 

What’s new in this version? 

This update addressed some urgent issues reported by CORE customers. Most notably: 

• Time and expense details view in billing screens were being restricted to users that 

had a time and expense subscription and not just the required billing subscription. 

This was fixed and now a billing subscription automatically allows users to view and 

edit specific attributes of entries linked to invoices. 

• Check printing screen would skip the trailing zeros in the amount field of a check. 

This was fixed. 

• Users were being restricted to reconcile only 25 items at a time. This was fixed. 

• Timer list would show timers belonging to other users even though the logged user 

had not initiated them. This was fixed. 

• Custom fields and lists were not available to time and expense users in time and 

expense entry. This was fixed. 

• Users were not able delete invoices for certain projects that had custom invoice 

numbering turned on but the optional fields, suffix or prefix, were not provided any 

value. This was corrected. 

_____________________________________________________ 

 

  



VERSION 1.1.112 RELEASED ON MARCH 21, 2018 

What’s new in this version? 

Introducing Xero Integration: CORE now integrates with the popular accounting software, 

Xero. CORE users can sync employees, clients, vendors. Invoices, payments, purchase 

orders, vendor bills, accounts, activity and expense items between the two applications.  

This update also added over 40 notable enhancements to the application apart from fixing 

numerous known issues. Some enhancements and fixes that are worth mentioning are: 

• An improved algorithm to process projects that are due for billing in the batch 

invoice screen. CORE now imposes no restrictions on the number of projects that 

can show up in this list and projects are progressively retrieved upon list scroll. 

• Users can now create automatic time entries for approved PTO requests. 

• CORE now allows users with the appropriate permissions to create timers for 

employees other than logged user. 

• A brand new info bar was added to the Invoice Collection screen. 

• Invoice module now supports Custom fields.  

• Users can now specify the class field while creating a bank feed rule. 

• Added several security enhancements including temporary account lockout for 

several login attempts with an incorrect password. 

• Updated Invoice templates options in Global Settings. Added show hours/amount, 

separate grouping field for expenses and other options under Layout section. 

• CORE now allows users to clone a project across multiple clients in one go when 

using the clone function from project list view. 

• CORE now automatically persists the order in which the General Journal line items 

were entered. This order is also maintained for GJ entries that are cloned from an 

original entry. 

• We added two more important columns to the Project structure tab, “contract 

billed” and “extra billed” to give managers insights into the breakup of billing for the 

project or its phases. 

• Batch invoice users can now separate individual phases that have been combined 

for Joint invoice purpose in the batch invoice screen. 

• CORE now allows users to set up customized file names for invoice, statement and 

reports that are sent as email attachments. 

• Added the popular ‘Due upon Receipt’ payment term.  

• Implemented a refined algorithm to prevent unnecessary time and expense entry 

locks during batch invoice processing. 

• Employee control list now provides a tristate checkbox to indicate if control is 

partially turned on, turned on or completely off for an employee. 

• Users can now sort on date and amount columns in the Accounts Reconciliations 

screen to save time when reconciling accounts 



• A brand new action in user preference section to clear out all screen filters for the 

logged user. 

• We had incorrectly tied the “Message on Invoice” field to an unrelated project rule 

and this field would not show up on invoices unless that rule was checked. This was 

fixed. 

• Vendor screen KPIs’ would exclude checks that included the vendor AP account as a 

detail item. This was corrected. 

• Added “Charge Amount” as an optional column in the time entries and reviewer 

screen. 

• Added “Comp” field as a batch update field for time entries. 

• CORE users with high resolution display would at times face scrolling issues for 

CORE lists to retrieve additional records. This was fixed was providing a “More” 

button at the end of list. 

• CORE now allows users to change security templates from the Employee detail view. 

• Users can now enter currency amounts for some percentage fields and CORE would 

automatically calculate the corresponding percentage. This feature was added in 

Expense entry and create batch invoice screen. 

• CORE transactions created from cloud feeds now inherit ref. field from the 

bank/credit card feed. 

• Custom label and mask management screen under Global settings now provides 

elaborative tooltips by exampling how these settings work. 

• There was no detail view in CORE for retainer invoices. Users can now view the 

detail of an existing retainer by clicking on the “detail” row action. 

• Added “CORE account balance” as a column in the Cloud Feeds list. 

• Popular date shortcuts like This Week, This Month, etc. were missing in the reports 

screen. These were added. 

• Admin users can now set up security to control which users has access to check 

printing function. 

• There was no option to assign a group of attendees to an event. This new option 

was added in the Calendar screen. 

• Custom fields’ management screen now allows user to create a new custom field 

from an existing custom field. 

• Added Classification column as an optional column to Time Entries screen.  

• A main project with no phases available for time or expense entry for the contextual 

user would show up in the drop down. This was corrected. 

• Added the following brand new reports 

▪ Top Ten in Revenue 

▪ Employee Time Card Half Monthly 

▪ Enhanced the 1099-MISC report to also show 1096 form 

▪ Fixed Invoice (% Complete) invoice template 

▪ Trial Balance YTD Accrual/Cash 

▪ Tax Registry 

▪ Credit Memo Receipt 



• ‘Show GST separately on invoices’ rule in Global Settings was renamed to ‘Show 

combined GST on invoices’ and is checked automatically for AU, NZ and Canadian 

companies. 

• Time and expense entry lists “submitted by” column was renamed to “last action by” 

to reflect the correct behavior of this field. 

• The Balance filter in Statement screen was made more usable by including options 

like <, >, = to give users more flexibility to enter approximate values and not 

necessarily exact values for filtering data. 

• Searching for phases in projects list would cause the project list to repeat phases. 

This was fixed. 

• Report scheduling would fail to deliver reports on scheduled intervals if the 

schedule or any of its underlying reports were updated for filters or any options. 

This was fixed. 

• There was a problem with accented characters display in CORE. This was fixed. 

• Global Settings > Accounting: Income Account for Services/Expenses was renamed 

to Income Account for Services/Expenses without Line Item. 

• Account reconciliation screen would list “CreatedOn” date as the transaction date 

for some accounting entries. This was corrected. 

• Time recorded against vendors in vendor bills would show up in the Hours widget. 

This was fixed.  

• The application allowed users to enable the auto-renew option for multi-year plans. 

This was corrected. 

• Removed the redundant date filter in filters panel in Invoice list and General Journal 

list. 

• Tasks assigned to an employee were not automatically removed when the employee 

was deleted. This was fixed. 

• Users were not able to update existing time entries for a project with ‘Prevent Time 

Entry’ rule set. This was fixed to allow users to update existing entries. 

• CORE would incorrectly set all existing time entries as non- billable when a project 

contract type was changed to Marketing or overhead. This was corrected and all 

contextual rules are respected while making this change. 

• Payments were not auto-posting the invoices. Applying a payment to an invoice is 

supposed to flag the paid invoice as posted. This was fixed. 

• Project structure spent column (and other places) did not reflect the correct value 

for spent time and expense until these entries were billed. This was fixed.  

• CORE would not automatically recycle an Invoice number if the associated invoice 

was deleted. This was fixed. 

• CORE invoice template would refer to activity description instead to time entry 

description. This was corrected. 

• Changing the charge amount of a time entry didn’t apply the corresponding WUD to 

the time entry. This was fixed. 

_____________________________________________________ 



VERSION 1.1.84 RELEASED ON MARCH 11, 2018 (HOT FIX) 

What’s new in this version? 

Introducing Gantt Charts: CORE now offers a fully featured Gantt chart that makes 

project/resource scheduling all the more powerful yet intuitive and easy to use. 

This update also addressed some urgent issues reported by CORE customers. 

• Creating a new estimate from an existing estimate did not copy the custom fields 

associated with the service and expense line items. This was fixed. 

• An issue in the code would reset user company logo on application updates. This 

was fixed 

• An issue in the memorized reports module would prevent users from accessing 

certain reports. This was corrected. 

• Updating a custom label would cause custom reports to disappear from the reports 

screen. This was fixed. 

• An issue in assign fee schedule dialog would falsely indicate a project was selected 

and confuse the user. This was fixed. 

• Batch invoice screen would fail to process an invoice if invoice percent complete was 

modified. This happened for companies on euro currency. This was fixed. 

• Invoice collection screen would not allow users to add quick notes to invoices that 

appeared after the first scroll. This was fixed. 

• Account filter in reports was not working as expected. This was fixed. 

 

_____________________________________________________ 

 

VERSION 1.1.82 RELEASED ON MARCH 2, 2018 (HOT FIX) 

What’s new in this version? 

This update addressed some urgent issues reported by CORE customers. 

• Users were not able to update an employee record, if the default group associated 

to the employee had been deleted. This was fixed. 

• Memorized reports were being incorrectly marked as private, if a user other the 

original owner of the report, customized any filters or any other options. This was 

fixed. 

• A report marked as favorite would disappear from the favorite tab upon preview. 

This was fixed. 

• In certain scenarios, payment date for a new payment would default to the previous 

day. This was fixed. 



• CORE payment screen would not restrict users from applying a retainer payment 

when the net retainer balance was in negative. This was fixed. 

• Project batch update would clear any billing contacts for projects. This was fixed. 

• CORE would incorrectly set the payment date to current date instead of the user 

specified date when creating a project balance brought forward invoice. This was 

fixed. 

• Merge project would fail in scenarios where the source project Id exceeded a certain 

length. This was fixed. 

• Users were not able to enter reimbursable expenses if they did not have 

permissions for the vendor bill module. This was fixed. 

• Project template detail view would not open and cause a UI crash. This was fixed. 

• Users were not able to associate a cloud feed to multiple CORE transactions even 

though the amounts would exactly match. This was fixed. 

• Users without the necessary permission were able to delete submitted/ approved 

time entries. This was fixed. 

• Fee schedule list would not show more than 25 records. This was corrected. 

• CORE would incorrectly update time entry bill rates to zero if the associated project 

fee schedule had zero rate defined for cost rates. This was fixed. 

• A filter issue in payments was preventing some users from viewing all payments. 

This was corrected. 

• QuickBooks Online sync would not work for time entry sync if the setting “skip 

vendor time” was checked. This was corrected. 

• QuickBooks Online mapping module would show CORE retainer invoices in 

unmapped invoices section. This was fixed. 

• Invoices that were emailed from the invoice list would not respect settings related to 

hide non-billable charges. This was fixed. 

• Voided checks would appear on the AP aging report. This was fixed. 

• Phased invoice templates were not showing the correct phase description. This was 

corrected. 

• Aging report was not excluding vendor bills that were fully paid. This was corrected. 

 

_____________________________________________________ 

 

VERSION 1.1.81 RELEASED ON FEBRUARY 16, 2018 (HOT FIX) 

What’s new in this version? 

This update aimed to address some urgent issues reported by CORE customers. 

• Create batch invoices screen would fail to retrieve all projects that were due for 

billing. This was fixed. 



• Time and expense entries associated to a vendor were being incorrectly updated to 

the current date when they were auto-imported in create vendor bill screen. This 

was corrected. 

• Spent column in project status widget and project structure tab was using an 

incorrect formula. This was fixed. 

• Users on accounting subscription were not able to assign groups to a vendor or an 

employee. This was fixed. 

• Email message defined in global settings/user preferences would incorrectly display 

HTML tags while composing an email for retainer invoice. This was fixed. 

• Time and expense entry memos that were originally copied from MS Excel/MS Word 

would cause issues in Time entry, Expense entry, and Reviewer and Time card 

screens. This was corrected. 

• Added “reimbursable” column to Reviewer. 

• Check printing would misspell amounts with decimals. This was fixed. 

• Some CORE users had reported that certain parent projects were incorrectly 

showing up at the end of the hierarchy when selecting projects in time and expense 

entry project dropdowns. This was fixed. 

• QuickBooks Online jobs with malformed geo-location information would not import 

to CORE. This was fixed. 

• A General Journal entry would fail to save if it took the user longer than 20 minutes 

to save it. This was fixed.  

• Payment screen would not allow users to create a credit type payment and mark it 

as a retainer. This was fixed. 

• A time entry that had a trailing space in the memo field would transfer to 

QuickBooks Online with un-necessary HTML tags. This was corrected. 

• Users were having issues with updating custom LEDES mappings. This was fixed. 

• Certain bill payments would not show up in bill payments list as the void flag was 

incorrectly set to null. This was corrected. 

• There was a severe performance issue while updating a vendor bill that had over 50 

line items. This was fixed. 

• Active status filters in Group details view were not working as expected. This was 

fixed.  

• Bill payment list would not show the correct Reference (ref) field value. This was 

fixed. 

• Added default values to all Boolean and small integer fields in the CORE user 

database. 

• Other fixes including reports. 

• (internal) Admin portal would fail to download large database backups. This was 

corrected. 

_____________________________________________________ 

 



VERSION 1.1.79 RELEASED ON JANUARY 19, 2018 (HOT FIX) 

What’s new in this version? 

This update addressed some urgent issues reported by CORE customers. 

• Project assignments based on activity groups would not work as intended when the 

logged user had security rule, “Use Project assignment on top of Employee control” 

checked. This was fixed. 

• Bill payment screen now implements progressive scrolling to handle large bill 

payment lists. 

• Modifying % complete for phases of a project in batch invoices was writing up one of 

the time entries linked to a random phase that is part of the invoice. This would 

happen if the one or more phases had no time or expense. This was fixed. 

• QuickBooks Online invoices for inactive clients were being associated with incorrect 

projects in CORE. This was fixed. 

• CORE would wrongly create employees with the same name as QuickBooks Online 

customers when getting vendor bills from QuickBooks Online. This was fixed. 

• Sync setting for QuickBooks Online would save the previous day’s date for Invoice 

GET section. This was fixed. 

• Un-mapped records in QuickBooks Online list would not show up in a certain 

scenario. This was fixed. 

• User with full permission to fee schedule module was not able to delete schedules. 

This was fixed. 

• A certain filter scenario would prevent time or expense to show up for a user with 

full permissions to the reviewer screen. This was fixed. 

• Forecasting screen would keep showing the loading indicator if there were no 

records in the forecasting range. This was fixed. 

• Some employee reimbursable would not show up in check screen. This was an issue 

in the sample files and is fixed now. 

• Check alignment screen background would appear distorted on Safari on Mac. This 

was fixed. 

• Recently added custom fields filter feature would not work as expected if the 

custom filter name matched any of the system filters. This was fixed. 

• Allocation would not show up correctly, if an employee was part of more than one 

allocation and was allocated as an employee group and as an individual employee. 

This was fixed. 

• Creating new project would fail if the company had turned on auto-increment 

project id and the next project id had a specific number of characters. This was 

fixed. 

• Merge project function would reset the project sort order. This was fixed. 

• Phase sort order was not being followed in budget, estimate and fee schedule. This 

was fixed. 

• A project with existing assignments could not be deleted. This was fixed. 



• Some core reports were not respecting hide cost rates security. This was fixed. 

• CORE invoices would incorrectly show activity description instead of time entry 

description. This was fixed. 

• Manual invoice would repeat the item description. This was fixed. 

• Bill number filter would not work for bill payments report. This was fixed. 

• Report, Misc1099 did not obey Company profile fed-id masking. This was fixed. 

• Vendor tax id number and company phone no - masking was not being 

implemented on MISC-1099 Report. This was fixed. 

• Manual invoice had an issue related to summary total. This was fixed. 

• The Hourly recurring invoice would not show the expenses if they were part of an 

invoice. This was fixed. 

• Joint invoice template was leaving a blank line between entries. This was fixed. 

 

______________________________________________________ 

 

VERSION 1.1.78 RELEASED ON JANUARY 13, 2018 

What’s new in this version? 

• Check alignment for precise check printing: CORE now allows users to customize 

system check templates to meet their precise check printing needs. Users can align 

all data driven fields for standard, wallet and voucher check styles as per the check 

stationary available to them. 

• Filter by Custom fields: Users can now filter CORE lists by custom fields. This useful 

feature further augments the power of custom fields in CORE.  

• In-line editing for Task allocation forecasting: Users would now be able to edit the 

allocation distributions in the Manual view forecasting screen. This brand new view 

not only allows user to provide distributions for existing tasks but users can create 

new tasks by simply providing units for any calendar day.  

 

Other fixes: 

 

• Users can associate reimbursable expenses to a check if the payee is an employee 

and has expenses that have not been paid yet. 

• Users can now initiate an invoice payment directly from the invoice list. 

• Parent project Documents, To-dos and Notes tab now show all entries rolled up to 

display all items linked to their phases.  

• Invoice list now displays all phases that are part of the invoice as a tooltip. 

• Budgets and estimates can now be emailed right from the list screens. 

• All CORE invoices now handle project level currency multipliers. 



• Record mapping views in QuickBooks Online integration can now be sorted by all 

available columns. 

• Added new filters to Statements screen. 

• Invoice list now allow batch change for invoice dates. 

• Users are now prompted if they want to update phases of a project, if any tax or 

currency information is changed for the parent project. 

• Added bill number column to expense entry and time entry. 

• Added new date shortcut filters in the reports area. 

• Added balance as a grand total for all CORE registers. 

• Implemented GST for Australia subscriptions. 

• Time card would now handle up to 100 project/activity combinations. This was 

increased from the earlier limit of 50. 

• While cloning a project or when a project was created from a template, assignment 

tied to the project/template were being dropped. This was fixed. 

• Employee control would not work as expected and would associate a group to all 

employees even though it was intended for one employee. This was fixed. 

• Time and expense users were not able to view or edit a To-do that was assigned to 

them. This was fixed. 

• Editing time entry hours would not work as expected in batch invoicing if the rule 

“memo is required” was turned on for the project. This was fixed. 

• Project status widget red flag tooltip would show incorrect information in certain 

scenarios. This was fixed. 

• Projects are now shown as a tooltip in Time and expense entry. 

• An un-necessary security restriction was preventing users from accessing Client and 

Project screens even though they had full access to these modules. This was fixed. 

• Retainer lists screen would only reflect the total for the first 25 entries. This was 

fixed. 

• CORE phased invoice would incorrectly drop some phases on preview. This was 

fixed. 

• CORE phased invoice would show incorrect invoice summary. This was fixed. 

• If a bill payment was voided, bills associated to the voided payment would fail to 

appear in the bill payment module. This was fixed. 

• A scenario caused the project ‘display as’ to be reset if the project record was 

modified. This was fixed. 

• A scenario would cause the time card to show no data on column sort. This was 

fixed. 

• Previewing retainer Invoice shows company label instead of actual company name 

when creating a Client or Project retainer invoice in Billing>Retainers module. This 

was fixed. 

• When saving a record, formatting for some fields would be reset. This was fixed. 

• Invoice totals were incorrect when using the "Hourly Invoice by Title" template. This 

was fixed. 



• Payment screen would not update the available amount when disbursing retainers. 

This was fixed. 

• PTO InfoBar did not respect user permissions. This was fixed. 

• CORE account registers now sort chronologically.  

• CORE would allow users to delete Income and expense accounts that were linked 

with time entries. This was fixed. 

• User entered statement balance would not get reflected in Accounting reconciliation 

screen. This was fixed. 

• Work in hand report would show up draft Invoices as well. This was fixed. 

• Project Retainer method payment was not reflected in Client transaction screen. 

This was fixed. 

• Expense entry memo would not display and time entry memo did not follow "Show 

memo on Invoices" rule. This was fixed. 

• Ajax was not working on the Accounts payable field of the Add Vendor bill screen. 

This was fixed. 

• CORE item based transaction created from a bank feed would not prompt the user 

to enter a memo even if memo was required for the project. This was fixed. 

• CORE email screen would not accept multiple emails in the CC field. This was fixed. 

• Allocation and forecasting screen would display a blank page if a user clicked on 

allocated hours/units notification item. 

• Updating % complete in Estimate, service and expense detail would error out. This 

was fixed. 

• Purchase order line ordering would not be persisted after updating a detail item. 

This was fixed. 

 

______________________________________________________ 

 

VERSION 1.1.61 RELEASED ON DECEMBER 15, 2017 

What’s new in this version? 

• Introducing CORE-QuickBooks Online Record Mapping: QuickBooks integration just 

got stronger with a comprehensive record mappings module. Users can view all 

matched and un-matched records and create or delete associations on the fly. 

• Sample Invoice Preview: CORE now offers users an instant preview of the invoice 

template while they are assigning project invoice templates or setting up them up in 

global settings. This feature has also been made available in the invoice template 

management area. 

• Introducing LEDES Export: CORE now offers legal industry users, the ability to export 

invoices to the popular LEDES format. Users can set up simple and advanced global 

rules to support their choice of export. 



• The power of custom reports: CORE now supports custom designed report 

templates for customers who wish to use our report customization services. Please 

contact BQE Support to get started. 

 

Other fixes: 

 

• A new action in invoices list allows users to change the preview template on the fly. 

User can also mark this change permanent and update the project template setting. 

• There was a performance issue in Project dropdowns for CORE users with large 

project lists. This was fixed 

• Processing batch invoices using Project group filter would create duplicate invoices 

if the project was part of multiple groups and group filters were used during invoice 

processing. This was fixed 

• Fixed progressive scrolling issues for the following screens: To-do, Statements, 

Credit Card, Documents, Purchase Order, Notes, Deposits, Checks, Timer, Vendor 

time and expense, 

• Added memo field to Time and Expense reviewer. 

• Added more filters to Project status and other dashboard widgets 

• Optimized QuickBooks sync to avoid any time outs during the sync process 

• Users where having trouble ascertaining if a menu had more items below the fold. 

This was fixed by increasing the width of the scroll bar. 

• Rebuild accounting received a performance boost and the process completes 

significantly faster than earlier. 

• An enhancement in assignments area will now allow users to copy project 

assignments or employee control to other projects/employees or a group. 

• CORE users will now be able to preview allocation and spent reports from the 

Allocation module. 

• Company admin users can upgrade subscription plans at any time. 

• Users are now shown the custom date range that is being applied in CORE 

transaction lists like invoices, payment, time entry etc. 

• An issue in the subscriptions module was creating incorrect invoice totals and line 

items on purchase/renewal of CORE subscriptions. This was corrected 

• CORE would compute client hours to zero if the minimum time increment was set to 

1 minute. This was corrected 

• Moving Calendar events around would not add them to the intended date for 

Australia region companies. This was fixed. 

• Creating two reimbursable expenses for the same employee on same dates would 

incorrectly display "duplicate bill number" prompt. This has been corrected. 

• Assign Project in Fee schedules now allows user to select from a hierarchical project 

list. 

• Project structure sort order was not being followed in project list and drop downs. 

This was fixed 



• QuickBooks sync progress bars would show incorrect progress at times. This was 

corrected. 

• Added a memo field for time and expense details in Batch invoicing. 

• Project active status filter would not fetch phases that were set to inactive. This was 

fixed. 

• Added entity (Id) field to To-dos', Notes and documents list. 

• Users can now initiate a renewal for subscriptions that have expired in the past and 

were not renewed. 

• CORE now prompts users for size recommendations on specific Dashboard widgets. 

• Added the ability to sort in Project and Client transactions list. 

• There was no way to go back to the main report unless you close and re-run the 

report once user drill down the report. It is fixed now. 

• Importing "Items Received" from a Purchase Order in the Add Vendor Bill Screen 

would not fetch the memo. This was corrected. 

• All CORE report templates now honor company country specific settings. 

• Time Card screen would sometimes incorrectly apply period filter. It is corrected 

now 

• Users are now allowed to set negative minimum amount as minimum bill amount 

during processing of batch invoices. 

• There were instances when creating new group would prompt the user with a 

"duplicate group" error. This was fixed. 

• Vendor and Outside Consultant type Vendors were showing up in the Staff 

Utilization Widget. These were fixed. 

• There was an issue related to Fee schedule screen when using Safari browser. This 

was fixed. 

• An existing Credit Card entry would disappear in Credit Card Register when we 

change the project account for expense account. It is fixed now 

• Under some scenarios, Service amount would be stored as zero in Estimate screen. 

It is fixed now. 

• Contract Analysis report would incorrectly exclude totals for phased projects. It has 

been resolved now. 

• Added cover sheet option for Hourly invoice templates. 

• Fixed an issue with some report templates that would show un-necessary header 

information on .csv export. 

• "Restrict Time/ Expense entry to Budgeted activities/expense or Employees" rule 

was being applied in Allocations tasks module. This was corrected. 

• Custom fields would show up for limited access users in Time and expense entry. 

This was fixed. 

• Implemented report security in context driven reports. 

• Removing a project contact would incorrectly delete from the Client contacts also. 

This was fixed. 

• "Show Ignored" dropdown would not display all transactions when "Last Quarter" 

filter was applied in Bank feed 



• There were issues related to sorting in COA list. These were fixed. 

• Processing draft invoices to final would not update the last invoice number. This was 

fixed. 

______________________________________________________ 

 

VERSION 1.1.37 RELEASED ON OCTOBER 22, 2017 

What’s new in this version? 

This update delivers over 150 improvements and fixes. The most notable are listed below. 

• Project Ajax drop-downs will now support parent-phase hierarchy and display 

results accordingly. Users can now search for main projects and all underlying 

phases would be available for selection. Conversely, searching for phase would 

display all matching phases and the complete hierarchy. 

• Batch change screens were not able to handle fields with a Yes or No value. This 

problem is now solved by providing indeterminate checkboxes 

• Project status dashboard widget now allows for view by contract or budget 

amounts. 

• CORE now makes a nomenclature distinction between a subscription and a package. 

All button and column heading now reflect the appropriate term. 

• CORE would now prompt the user if they wanted auto-assignment of subscriptions 

when purchasing the first subscriptions for the Company. 

• Project template module would not display the structure of a template in a 

hierarchical manner. This was fixed. 

• Projects created from project templates would not reflect the phase id of the 

underling template. This was fixed 

• Added WUD columns to Time entries and Time & Expense reviewer. 

• An issue in the batch invoicing module would reset the billing from and to dates if 

any time or expense entries were excluded. This was fixed. 

• QuickBooks Online sync module in CORE was not providing detailed logs during the 

sync process. This was fixed. 

• CORE accounts that had expired were still able to access the Sample companies. 

This was fixed 

• Users were able to update Company and profile information for Sample companies. 

This was fixed. 

• The Custom fields’ management screen was missing the Company module. This was 

fixed. 

• Time entry and Reviewer would fail to show up all entries even though there was no 

visible filter. This was fixed 

• Project Status widget now provides an option to view Contract or Budget amount. 

• Project Status widget now rolls up spent, billed and other amounts for all phases 

and shows them against the main project 



• Added new reports Contract Analysis, Project Profitability(Comprehensive), Billing 

Schedule-Tab 

• Info bars in all master screens did not adjust to the filters provided to the list view. 

This is fixed. 

• Expense entries marked as reimbursable were not picked up by the Check detail 

screen. This was fixed. 

• Several security recommendations were implemented to mitigate any risks from 

attacks. 

 

______________________________________________________ 

 

VERSION 1.1.28 RELEASED ON OCTOBER 8, 2017 

What’s new in this version? 

• Introducing Bank Feed Rules: CORE now allows bank feed users to set up rules that 

automatically import bank feeds into CORE. This brand new feature is 

complimented by powerful rule definition and management UI to completely 

automate the import feed process. 

• Introducing Report Scheduling: CORE now offers powerful report scheduling that 

users can set up for any interval and frequency. Users can add unlimited number of 

email recipients or simply specify employee or client groups as email recipients. 

• Project Status and Due Dates Dashboard widgets: These widgets provide a clear 

picture of the project/phase performance regarding billed, spent, WIP, open AR and 

other important metrics. This powerful, standalone widget now empowers project 

managers to make more informed decision while estimating project percent 

complete. The brand new project due dates widget provides an informative list of all 

projects that are approaching due dates. 

• The power of custom invoices: CORE now supports custom designed invoice 

templates for customers who use our invoice customization services. Please contact 

BQE Support to get started on this. 

 

 

Other fixes: 

 

• CORE users can now setup "Message on Invoice" in the global settings and all new 

projects would automatically inherit this setting. Also, users have the ability to issue 

a batch change for existing projects. 

• CORE Project transactions now offer the drill-down feature. Click on the transaction 

and view it in its own window. 

• Project Batch change interface now supports PO#. 



• Bank feed users now have the ability to view the type of transaction that would be 

created when adding a new feed to CORE.  

• Project rule that controls display of MST/MET on invoices is automatically set to true 

if values are entered for Project MST or MET fields. 

• Pay when paid features was enhanced to auto-launch a report that provides detail 

for the all vendor bills that are part of the invoice that is getting paid. 

• Added the much requested Project filter in Payment list 

• Added Project type filter to Project list and all project reports 

• Added the much requested Last Emailed column to Invoice List 

• Added Charge Amount field in Expense details in Batch Invoice Details. 

• Added the Cost field in the adjust reconciliation discrepancy interface. 

• CORE now allows users to specify a memo while adding a bank feed as time or 

expense line item 

• Account register for Opening balance equity account now provides a Journal report. 

• Time and Expense entry screens did not allow update of entries that were linked to 

projects that were either cancelled or put on hold. This was fixed. 

• Vendor bill list can now be filtered by time or expense entry status also. 

• Project drop-downs on Create Event interface now support ajax type ahead 

• Payment screen would not remember the columns that had been turned on by the 

user 

• Somme users would lose subscription permissions temporarily if they accessed the 

package drop-down in Manage Users. This was fixed.  

• There was an issue in the time verification report causing it to double the time 

entries. It was fixed. 

• An invited user was able to log in to the invited company if they had existing account 

in CORE without accepting the invitation. The desired behavior is to get the user 

click on the invite link and do the necessary on-boarding. This was fixed. 

• Sending CORE employees to QuickBooks Online would fail if a SSN had been 

specified for the employee. This was fixed. 

• Some filters for dashboard widgets would not function in the desired manner and 

not show up any data. This was fixed. 

• Some filters in the Reports area would not provide the correct UI for range filters. 

This was fixed. 

• Invoice template would double the hours for a manual invoice that had both 

amount paid and retainer. This was fixed. 

• Time and expense memo was getting ignored for vendor bills that were created 

from existing vendor entries. This was fixed. 

• Employee based report control would apply the control to all users and not just the 

intended employee. This was fixed. 

• Manual invoices created from existing estimate would not obey the date from and 

to that were specified in the Create Invoice dialog. This was fixed. 

• There was an issue related to entering memos when using Safari browser in the 

Time card. This was fixed. 



• Payment date would in-correctly be set yesterday's date although the user would 

specify today's date for the payment. This was fixed. 

• Bank feeds “find matches” algorithm would fail to retrieve credit card refund entries. 

This was fixed. 

• Dashboard group filters would not show the default "ALL" group as one the options. 

This was fixed. 

• Reversing the inclusion of bank feed would cause the underlying entry to be also 

deleted. This was fixed. 

• Create new account of any balance sheet type would error out on certain company 

country settings like Finnish. This was fixed. 

• Project time and expense report would not honor the "Show memo" setting. This 

was fixed. 

• Payment disbursement screen was not correctly calculating the disbursements if the 

invoice being paid had a discount or retainer. This was fixed. 

• PTO reports would fail to show the approver's note. This was fixed. 

• Bank feeds transaction would reset date filters to default after a transaction was 

marked as ignored by the user. This was fixed. 

• Employee allocations were not correctly getting forecasted in the Forecasting screen 

if the employee had non-standard day or week hours. This was fixed 

• Forecasting screen would ignore tasks that were linked to projects with the rule 

"Rates from Activity table" set to true. This was fixed. 

• Subscriptions created in CORE would show an expiry date which was a day short 

than the expected date. This was fixed. Also, the Manage user interface would not 

allow admin users to remove expired subscriptions from a CORE user. This was also 

fixed 

• CORE would not properly handle a scenario that involved a user selecting a mix of 

late fee and regular invoices for preview in the Invoice list screen. This was fixed. 

 

______________________________________________________ 

 

VERSION 1.1.13 RELEASED ON SEPTEMBER 3, 2017 

What’s new in this version? 

• Smart fields for Email Settings: Users can now set up company or user level email 

subject and message fields to use smart placeholders that are replaced with actual 

values while emailing invoice, reports, statements and payment receipts. 

• Pay when paid feature: CORE now prompts users to settle their payables as soon as 

they receive a client payment for an invoice that has time or expense entries linked 

to an unpaid vendor bill. 



• Time and Expense line item support for Bank Feeds: Bank feeds can now be 

imported into CORE as Time or Expense entries. These entries are imported into 

CORE as line items for check or credit card transactions. 

• CSV export for Report Viewer: Users now have option to export reports to an Excel 

CSV format. This format gives users the power to use report data for aggregation 

and charting in Excel. 

 

Other fixes: 

 

• Compose Email was not able to handle multiple email addresses. This was fixed. 

• Project opening balance feature would accept not a combination of opening balance 

fields whose sum was equal to zero. This was fixed. 

• General Journal, Credit Card and Custom Label quick text based filter feature was 

not working as expected. This was fixed 

• CORE would not allow vendors to be added as CORE users. This restriction was 

removed. 

• Vendors would not appear in the Security permissions list. This was fixed. 

• Users of type vendor were not able to fill in their time card. This was fixed. 

• Expense entry detail view was missing the paid status and paid date fields. These 

were added. 

• Company chooser screen that shows up for users with multiple CORE companies 

did not provide any information about the Company status. This was fixed. 

• There were issues if a user tried to delete a Vendor credit line item. This was fixed. 

• Some of the reports would not show correct Company name in the header when 

emailed from the reports area. This was fixed. 

• Reset Custom labels in Custom Labels section under Global Settings would 

incorrectly introduce masks for all custom labels. This was fixed. 

• Documents added in CORE would not show the correct date and time for the 

created on field. This was fixed. 

• QuickBooks and AccountRight set up page would open in the same window as 

CORE. This was fixed. 

• A duplicate General Journal warning would make the interface unresponsive to user 

input. This was fixed. 

• Invoices with hyperlinks as documents would fail to be emailed. This was fixed.  

• Project parent level rules were not getting coped to the project phases. This was 

fixed. 

• Many financial reports would incorrectly show non-posting accounts and types as 

filters. This was corrected. 

• CORE would not automatically update the Display As field while creating a new 

company if the value was first entered in the Company field. This was fixed. 

• Added Pay rate multiplier and OT multiplier to Fee Schedule, Service based line 

items. 



• An expense entry would not be submitted to the correct PM if the entry had been 

submitted earlier and the PM had changed since then. 

• A recurring check processed notification would not reflect the correct name of the 

user. This was fixed. 

• PTO screen and widgets would not show the correct data if the default codes for 

vacation, comp and sick were changed in global settings. This was fixed. 

• PTO screen, new entry would not default to the current day. This was fixed. 

• Credit card, checks and Vendor bill screen would also include inactive accounts in 

the account drop-downs. This was fixed. 

• Time and Expense reviewer would not show any records if a submitted time or 

expense was approved or rejected by a user via notifications area. This was fixed. 

• Phases that were being created by using templates would not respect the Project 

display as setting. This was fixed. 

• Add licenses feature was calculating an incorrect amount for the new subscriptions. 

This was fixed. 

• CORE would through up an error if a user clicked the detail view action for an 

“added in core” bank feed if the underlying core transactions were deleted. This was 

fixed. 

• More than 270 other fixes that improve application’s usability, reliability and 

performance. 

 

______________________________________________________ 

 

VERSION 1.1.6 RELEASED ON AUGUST 20, 2017 

This update fixes more than 150 known issues and adds few new critical features to the 

application.  

• Project structure tab in Project detail view now offers additional column options to 

allow Project managers’ to make a more informed decision while updating the 

percent complete. 

• Added a legacy feature that allows users to import existing vendor time and 

expense that is not part of a previous vendor bill. This feature is available from the 

Create Vendor bill screen. 

• CORE now offers users the ability to create vendor bills from received Purchase 

order line items that were not made part of a vendor bill during the items receipt 

process. 

• CORE now offers intuitive color coding for Forecasting screens to alert users for 

allocations that are over the assigned values. 

• CORE now allows QuickBooks integration users to initiate a ‘Get all’ and ‘Send all’ 

sync. 



• Manage companies module would not appear for CORE users that were marked as 

standard. This is fixed. 

•  Notifications related to time and expense submittal or approval would occasionally 

omit the sender name. This was fixed. 

• Time entry client hours (formerly known as B-Hours) would not get updated when 

an entry was updated in the Time card screen. This was fixed.  

• Some fields in batch invoicing screen would not reset to original values when the 

batch invoicing screen was refreshed. This was fixed. 

• Late fee invoices generated from the invoice screen would occasionally not have the 

correct next sequential invoice number. This was fixed. 

• Allocation screen would allow user to allocate units for projects of type ‘Main’. This 

was corrected. 

• Time entries would get duplicated if a user navigated to the next/previous week 

while the saving the time card. This was corrected. 

• On certain occasions, time or expense submit notification would not display the 

underlying entries when a user clicked on the submit notification. This was 

corrected. 

• CORE would not stop users from entering time for projects that were not active. This 

was corrected. 

•  Invoices that were over paid or had a negative amount were appearing in the create 

payment screen. This was fixed.  

• Subscription purchase shopping cart would display the wrong total amount if user 

navigated back to the subscription list and added a new subscription. This was 

corrected. 

• Owner account for a company was not able to login if the linked user was changed 

for owner account. This was corrected. 

• Email without preview was not available as an option in the Collections screen. This 

was fixed. 

• PTO info bar would show incorrect numbers for vacation and sick time if the 

employee had multiple PTO requests. This was corrected. 

• There was instances of modal dialogs overflowing the browser boundary and not 

display correctly. This was corrected for Dashboard and Batch invoices. 

______________________________________________________ 

 

VERSION 1.0.211 RELEASED ON JULY 30, 2017 

What’s new in this version? 



• CORE now offers trial users an easy way to switch between sample companies even 

when they are already signed in their company file. Users will also have the option 

to exit the sample file experience without logging out. 

•  CORE was not able to accept fresh signup requests from users who had aborted the 

signup process midway or the company creation had not successfully completed in 

a previous attempt. This was fixed.  

• Register screen will now offer the ability to view and enter memo for each 

transaction. 

• Register screen, View by “Account” drop down now supports type ahead search. 

• CORE was incorrectly prompting users to enter a check number while creating a 

new check in the Register. This was fixed. 

• Added Client column to Invoice list view. 

• The “Trial expiring in …” indicator would animate away for trial companies. This was 

fixed. 

• Users are now warned to not close the browser while a company file is being 

created.  

• General UI/UX improvements. 

• Other minor fixes related to CORE business logic. 

 

______________________________________________________ 

 

RTM VERSION 1.0.207 RELEASED ON JULY 19, 2017 

Dashboards 

Get a snapshot of your whole business every time you log in 

• See how your entire business is doing in an easy-to-understand graphical interface 

• Create unlimited, customizable dashboards to suit your needs 

• Display your business key performance indicators (KPIs) exactly how you want to 

see them 

• Easily change the size, shape, and color of pie charts, bar graphs, and interactive 

lists 

 

Time & Expense Tracking 

Know exactly where you stand 

• Flexible time entry – track time how you want to with simple timecards and timers 

• Easily start and switch between multiple timers  



• Record expenses in multiple currencies and attach receipts  

• Auto-populate your timesheet with previous week’s activities and projects  

• Track time and expenses on-the-go via free native iPhone and Android apps  

Project Management 

Make the best use of your resources for the greatest profitability 

• Watch the status of tasks by phase 

• Powerful multi-level submittal and approval process for time and expenses, 

budgets, estimates, vendor bills and invoices  

• Efficiently manage people with smart tools for resource scheduling, allocation and 

utilization  

• Track budget vs. actual hours and costs in real time 

• Track submittal-approval, drawing and RFI workflows   

 

Billing 

Cut your billing time in half and improve cash flow 

• Tailor your communications with dozens of professional and customizable invoice 

templates  

• Create different invoice types: percent complete, retainer, recurring, fixed, hourly, 

phased, joint and more  

• Send multiple invoices in a single email  

• Choose from convenient billing methods: Automatic, Progress, Manual and more  

 

Accounting 

Manage all your transactions in one place 

• Easily manage vendor bills and purchase orders  

• Write checks and reconcile bank accounts  

• Connect to bank feeds anywhere in the world  

• Quickly access General Journal Entries, Registers and General Ledger  

• Generate accrual and cash-based balance sheets, as well as profit & loss reports  

 

Reports  

Get actionable insights at your fingertips 

• Access hundreds of standard reports that are fully customizable  

• Create memorized reports and tag any report as your favorite  

• Customize reports and share them as PDFs, Word documents, or Excel files. 



• View breakdowns of utilization, realization and billable work for employees as well 

as consultants  

 

 

Mobile 

Manage your business on the go 

• Monitor to-dos and submit/approve workflows via dashboard  

• Enter and review time and expenses from any device 

• Use multiple timers to track every billable minute 

• Convert your project visits into time entries with visit tracking 

• Quickly create invoices and apply payments 

• Stay up-to-date with real-time notifications 

 

Integration 

Seamless integration with other products 

• QuickBooks®  

When you integrate CORE and QuickBooks®, you gain a lot more than elimination of 

duplicate data entry. You get a powerhouse that will that will save you time, money 

and resources.  

• MYOB AccountRight® (Australia) 

Whether you’re a one-person office or a large, network-based organization, CORE 

offers MYOB users a dramatically streamlined method for invoicing, tracking time 

and expenses, and much more.  

• Dropbox, Google Drive, and Amazon Web Services (AWS) 

• With CORE, you can work from anywhere in the cloud. Plus, you can simplify how 

your team works and share files through your favorite apps. CORE works with 

Dropbox, Google Drive, and Amazon Web 

 

 

 

 

 

 

 



 


